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Предисловие 

Благодарим Вас за приобретение приемника, геодезического инструмента 
или их принадлежностей  производства фирмы Topcon (далее «изделия»). 
Сведения, содержащиеся в этом руководстве (далее «руководстве») 
подготовлены фирмой Topcon Positioning Systems (далее «TPS»)  для 
владельцев изделий производства фирмы Topcon. Это руководство по 
эксплуатации поможет Вам использовать программное обеспечение 
(далее ПО). Эксплуатация изделия должна осуществляться при 
приведенных ниже условиях и положениях. 

 ПРИМЕЧАНИЕ 

Пожалуйста, внимательно ознакомьтесь с “Условиями и 
положениями”. 

Условия и положения 
ИСПОЛЬЗОВАНИЕ - Это изделие предназначено для 
профессионального использования. Пользователь должен иметь твердые 
знания  правил техники безопасности, установленных регулирующими 
органами, и строго их соблюдать. 

АВТОРСКИЕ ПРАВА - Все содержимое этого руководства является 
интеллектуальной собственностью фирмы TPS и защищено авторским 
правом. Все права сохранены. Запрещается использовать, получать 
доступ, копировать, хранить, отображать, использовать для создания 
составительских работ, продавать, изменять, публиковать, 
распространять, либо позволять третьей стороне получать доступ к 
любым рисункам, содержимому, информации либо данным из этого 
руководства без письменного разрешения TPS. Перечисленное выше 
содержимое может использоваться только для обеспечения 
использования приобретенного изделия. Информация и данные, 
содержащиеся в этом руководстве, являются ценным активом TPS, при 
создании которого были понесены существенные затраты труда, времени 
и денежных средств и являются плодом собственных усилий TPS по 
подборке, выбору и систематизации.
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ТОВАРНЫЕ ЗНАКИ – Topcon®, HiPer®, Topcon ToolsТМ, TopSURVТМ, 
Topcon LinkТМ  и Topcon Positioning SystemsТМ являются товарными 
знаками или зарегистрированными торговыми марками TPS. InstallShield® 
является зарегистрированной торговой маркой Installation Software 
Technologies, Inc. Windows® и ActiveSync® являются зарегистрированными 
торговыми марками Microsoft Corporation. Логотип Bluetooth® принадлежит 
Bluetooth SIG, Inc. и лицензирован Topcon Positioning Systems, Inc. 
Названия изделий или компаний, упомянутые в этом руководстве, могут 
быть товарными знаками соответствующих собственников. 

ОГРАНИЧЕНИЕ ГАРАНТИИ - ЗА ИСКЛЮЧЕНИЕМ ГАРАНТИЙНЫХ 
ОБЯЗАТЕЛЬСТВ И ЛИЦЕНЗИОННЫХ СОГЛАШЕНИЙ, 
ПРИЛАГАЕМЫХ К ИЗДЕЛИЮ И ПРИВЕДЕННЫХ В ПРИЛОЖЕНИИ К 
ЭТОМУ РУКОВОДСТВУ И НА ГАРАНТИЙНОЙ КАРТОЧКЕ, 
ПРИЛОЖЕННОЙ К ИЗДЕЛИЮ, ЭТО РУКОВОДСТВО И ИЗДЕЛИЕ 
ПОСТАВЛЯЮТСЯ “КАК ЕСТЬ”. ГАРАНТИЙНЫЕ ОБЯЗАТЕЛЬСТВА 
ДРУГОГО РОДА НЕ ПРЕДОСТАВЛЯЮТСЯ. ФИРМА TPS 
ОТКЛОНЯЕТ ЛЮБУЮ ПОДРАЗУМЕВАЕМУЮ ГАРАНТИЮ 
ТОВАРНОЙ ПРИГОДНОСТИ ИЗДЕЛИЯ ДЛЯ КАКОГО-ЛИБО 
КОНКРЕТНОГО ПРИМЕНЕНИЯ ИЛИ ИСПОЛЬЗОВАНИЯ. TPS И ЕЁ 
ПРЕДСТАВИТЕЛЬ НЕ НЕСУТ ОТВЕТСТВЕННОСТИ 
ЗА ТЕХНИЧЕСКИЕ ИЛИ РЕДАКТОРСКИЕ ОШИБКИ И ПРОПУСКИ, 
СОДЕРЖАЩИЕСЯ В ЭТОМ РУКОВОДСТВЕ, РАВНО КАК И ЗА 
УБЫТКИ СЛУЧАЙНЫЕ ЛИБО ЯВЛЯЮЩИЕСЯ ЗАКОНОМЕРНЫМ 
СЛЕДСТВИЕМ ПРИМЕНЕНИЯ, ИСПОЛЬЗОВАНИЯ ИЛИ 
ЭКСПЛУАТАЦИОННЫХ КАЧЕСТВ ЭТОГО РУКОВОДСТВА ИЛИ 
ИЗДЕЛИЯ. ТАКИЕ ОТКЛОНЯЕМЫЕ УБЫТКИ ВКЛЮЧАЮТ В СЕБЯ, 
НО НЕ ОГРАНИЧИВАЮТСЯ, ПОТЕРЯМИ РАБОЧЕГО ВРЕМЕНИ, 
УТЕРЕЙ ЛИБО ПОРЧЕЙ ДАННЫХ, УПУЩЕННОЙ ВЫГОДОЙ, 
ПОТЕРЯМИ ДЕНЕЖНЫХ СРЕДСТВ ЛИБО ДОХОДОВ, А ТАКЖЕ 
ПОТЕРИ ОТ ИСПОЛЬЗОВАНИЯ ИЗДЕЛИЯ. В ДОПОЛНЕНИЕ, TPS 
НЕ НЕСЕТ НИКАКОЙ ОТВЕТСТВЕННОСТИ И ОБЯЗАТЕЛЬСТВ ЗА 
УБЫТКИ ИЛИ ИЗДЕРЖКИ, ПОНЕСЕННЫЕ В СВЯЗИ С ЗАМЕНОЙ 
ИЗДЕЛИЯ ИЛИ ПРОГРАММНОГО ОБЕСПЕЧЕНИЯ, ИСКОВ 
ТРЕТЬИХ ЛИЦ, ВОЗМЕЩЕНИЯ НЕУДОБСТВ И ПРОЧИЕ РАСХОДЫ. 
В ЛЮБОМ СЛУЧАЕ TPS НЕ ДОЛЖНА НЕСТИ ОТВЕТСТВЕННОСТЬ 
ПО КОМПЕНСАЦИИ УБЫТКОВ ИЛИ РАСХОДОВ ПЕРЕД ВАМИ И 
ЛЮБОЙ ТРЕТЬЕЙ СТОРОНОЙ, ПРЕВЫШАЮЩУЮ ПРОДАЖНУЮ 
ЦЕНУ ИЗДЕЛИЯ. 
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ЛИЦЕНЗИОННОЕ СОГЛАШЕНИЕ - Использование любого 
программного обеспечения («ПО»), поставляемого TPS, в том числе и 
загружаемого с интернет-сайта фирмы, должно производиться при 
принятии условий и положений, указанных здесь, и этого лицензионного 
соглашения. Пользователю предоставляется персональное, 
неисключительное, не подлежащее передаче другому лицу разрешение 
использовать (лицензия) это ПО на указанных здесь условиях для одного 
изделия или одного компьютера. Вы не можете передавать или 
переуступать ПО или это разрешение без специального письменного 
разрешения TPS. Разрешение действует до его окончания. Вы можете 
прекратить действие лицензии в любой момент, уничтожив ПО и это 
руководство. TPS может прекратить действие лицензии в том случае, если 
Вы не выполняете любое из этих условий или положений. Вы должны 
уничтожить ПО и это руководство после того, как Вы прекратите 
использовать приемник. Все права собственности, авторские права и 
права на интеллектуальную собственность в ПО принадлежат TPS. Если 
Вы не согласны с вышеперечисленными условиями, предлагаем Вам 
вернуть не бывшие в употреблении руководство и ПО. 

КОНФИДЕНЦИАЛЬНОСТЬ - Это руководство, его содержимое и ПО 
(далее упоминаемые как «конфиденциальная информация») являются 
конфиденциальной информацией и принадлежат TPS. Принимая условия 
этого соглашения, Вы берете на себя обязательства сохранять эту 
информацию таким же образом, как наиболее ценные коммерческие 
секреты своей организации. Тем не менее, этот параграф не ограничивает 
Вас в предоставлении информации, нужной по роду деятельности Вашим 
работникам, занимающимся использованием и обслуживанием изделия. 
Таковые работники также обязаны не разглашать конфиденциальную 
информацию. В том случае, если вы будете вынуждены по закону 
раскрыть конфиденциальную информацию, Вы должны немедленно 
известить TPS с тем, чтобы мы могли ходатайствовать об охранном 
судебном приказе или соответствующих средствах правовой защиты. 

ИНТЕРНЕТ-САЙТ И ПРОЧИЕ ЗАЯВЛЕНИЯ - Данные условия и 
положения (в том числе лицензионное соглашение на ПО, ограничение 
гарантии и ограничения ответственности) не могут быть изменены 
заявлениями, опубликованными на Интернет сайте TPS (равно как и на 
любом другом Интернет сайте), в рекламных материалах и изданиях TPS, 
либо сделанные работником TPS или независимым подрядчиком TPS. 

МЕРЫ БЕЗОПАСНОСТИ - Неправильная эксплуатация изделия Topcon 
может быть причиной телесных повреждений, порчи собственности и/или 
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отказа изделия. Ремонт изделия должен производиться исключительно в 
центрах гарантийного ремонта, авторизованных Topcon. Пользователям 
следует ознакомиться с предупреждениями о технике безопасности, 
приведенными в руководствах, приложенных к изделию, и строго им 
следовать.  

РАЗНОЕ - Вышеупомянутые условия и положения могут быть в любой 
момент времени исправлены, изменены, заменены на другие либо 
отменены фирмой TPS. Вышеупомянутые условия и положения 
соответствуют и должны толковаться в соответствии с законами штата 
Калифорния без использования других юридических норм. 

Техническая поддержка 
Техническая поддержка осуществляется Topcon Positioning Systems через 
интернет-сайт http://www.topconsps.com или по адресу электронной почты 
support@topconsps.com
. 

Соглашения, принятые в 
руководстве 
В этом руководстве использованы следующие обозначения: 

Обозначение  Описание  

File > Exit   Выберите пункт меню File (Файл), затем Exit  
    (Выход). 
Enter Полужирным шрифтом выделено название 

клавиши клавиатуры. 
Topo    Полужирным курсивным шрифтом выделено  
    название заголовков окон, в том числе диалоговых. 
Notes  Курсивным шрифтом выделено название поля, 

 области или вкладки в диалоговом окне. 

Примечание переводчика: названия отображаемых на английском языке 
элементов пользовательского интерфейса (названия пунктов меню, заголовков 
окон, кнопок, элементов списка и пр.) приведены в оригинальном виде, в скобках 
сразу за ними дан поясняющий перевод, пример см. выше.  
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СОВЕТ 

Дополнительная информация, которая может помочь Вам 
при обслуживании и настройке системы. 

 ПРИМЕЧАНИЕ 

Дополнительная информация о факторах, которые могут 
оказать влияние на работу системы, ее технические 
характеристики, результаты измерений или личную 
безопасность. 

 ОСТОРОЖНО 

Уведомление о том, что операция может оказать 
неблагоприятное воздействие на работу системы, ее 
технические характеристики, целостность данных 
или личное здоровье. 
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Для заметок: 
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Что нового в Topcon 
Tools 
Ниже перечислены некоторые новые возможности и функции программы 
Topcon Tools. 

⇒ Добавлен модуль Imaging. Этот модуль позволяет обрабатывать 
стереоизображения и сеансы сканирования. 

⇒ Для стереопар доступны следующие возможности: 

• Импорт в текущий проект. 

• Просмотр в ориентированном и стереоскопическом видах. 

• Измерение точек. 

• Создание линий и поверхностей по стереопарам. 

⇒ Новые возможности для сеансов сканирования: 

• Импорт, просмотр и редактирование данных сеансов 
сканирования. 

• Возможность создания поверхностей по точкам сканирования. 

⇒ Расширенные возможности построения поверхностей: 

• Новый атрибут Breakline (граница) для слоев. Границы удобны 
при создании поверхностей. 

• Новые функции ручного и автоматизированного обновления 
поверхности при введении изменений. 

• Треугольники поверхности можно выбирать и (или) удалять в 
представлении CAD. 

⇒ Модуль Advanced предоставляет следующие дополнительные 
возможности: 

• В окне Residual View (Просмотр невязок) возможно 
редактирование сеансов спутниковых измерений. 

• В диалоговом окне Process Properties (Свойства обработки) 
добавлена вкладка Troposphere (Тропосфера) с 
метеорологическими параметрами для моделирования 
тропосферы. 
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⇒ Данные могут быть импортированы из карты памяти приемника 
Topcon (Topcon Memory Card). 

⇒ Фотопримечания могут быть применены к любой точке. 

⇒ Новая функция в инструментальной панели для отображения слоев. 
Стиль отображения новых объектов определяется выбором текущего 
слоя. 

⇒ Изменено отображение выбора типа систем координат. Список типов 
координат определяется в настройках ИГД/Проекции и установками 
параметров трансформации из СК проекции в местную СК в окне Job 
Configuration (Настройка проекта). 

⇒ Для импорта и экспорта в Topcon Tools добавлены новые форматы 
данных. 

⇒ Advanced options (Расширенные параметры) импорта и экспорта 
данных обновлены и изменены. 
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Глава 1  
Введение 

Благодарим Вас за приобретение программного продукта Topcon Tools™ - 
простой в работе и вместе с тем мощной программы для обработки 
полевых данных. Topcon Tools обеспечивает возможность выполнения 
обработки и уравнивания полевых измерений, производимых с помощью 
всех типов инструментов компании Topcon. В зависимости от 
приобретенных модулей, Topcon Tools обрабатывает тахеометрические 
данные, данные RTK, спутниковые измерения и комбинации 
перечисленных выше измерений. 
Начинающие и опытные геодезисты могут использовать Topcon Tools для: 

• Камеральной обработки (post-processing) базисов GPS; 

• Обработки тахеометрических и RTK измерений; 

• Уравнивания сетей; 

• Импорта файлов; 

• Экспорта файлов. 
Данные в Topcon Tools представляются в табличном и графическом 
представлениях: 

• Table view (Вид "Таблица”) используется для просмотра информации 
по точкам, сеансам измерений, базисам и сортировки в буквенном, 
цифровом, по времени, по увеличению или уменьшению величин 
порядках. 

• Map view (Вид “Карта“) используется для графического отображения 
конфигурации измерений и их поиска. 

• Occupation view (Вид “Сеанс“) предназначен для просмотра и 
анализа сеанса спутниковых измерений. 

• CAD view (Вид “САПР”, Система Автоматизированного 
Проектирования – Computer Aided Design) используется для 
отображения линейных построений и поверхностей с 
ассоциированными точками и линиями. 

• Design view (Вид “Проектирование") предназначен для создания, 
редактирования цифровых моделей рельефа (ЦМР) и для создания, 
просмотра и редактирования дорог и типовых поперечников. 
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• Imaging view (Вид “Изображение”) предназначен для работы со 
стереопарами и сеансами сканирования. 

Изменения, произведенные в любом из представлений (табличном или 
графическом), отражаются и в другом представлении, что позволяет 
выбирать наиболее удобный способ просмотра и редактирования данных. 

Установка Topcon Tools 
Программа Topcon Tools поставляется на компакт-диске и предназначена 
для установки на IBM-PC совместимый персональный компьютер. 
Выполняется также установка последней версии программы Topcon Link. 
Старые версии программ Topcon Tools и Topcon Link удаляются из 
компьютера во время установки новой версии. 
1. Вставьте компакт-диск с программой Topcon Tools в привод CD-ROM. 

Запустится программа-установщик. 
2. Щелкните на кнопке Next (Далее) для запуска процесса установки. 
3. Щелкните на кнопке Yes (Да) для принятия условий Лицензионного 

Соглашения (см. рис. 1-1). Щелкните на кнопке No (Нет), если Вы не 
согласны с условиями Лицензионного Соглашения. 

4. Введите Имя пользователя (User Name) и Название организации 
(Company Name), затем щелкните на кнопке Next (Далее) (см. рис. 1-1). 

5. Выберите для программы каталог по умолчанию или, щелчком на 
кнопке Browse (Просмотр), другой по вашему желанию. Щелкните на 
кнопке Next (Далее) для продолжения установки (см. рис. 1-1). 

 
Рисунок 1-1. Начало установки программы Topcon Tools 
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6. При необходимости, создайте каталог для программы. Затем щелкните 
на кнопке Next (Далее) (см. рис. 1-2). 
Программа Topcon Tools будет установлена (см. рис. 1-2). 

 
Рисунок 1-2. Выбор программного каталога и выполнение установки 

7. Щелкните на кнопке Finish (Завершить) для окончания процесса 
установки. 

8. Для быстрого доступа к программе создайте на рабочем столе 
компьютера ярлык Topcon Tools. 

 
Рисунок 1-3. Ярлык Topcon Tools  
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Установка и настройка 
Microsoft ActiveSync 
Для импорта данных из контроллера TPS в Topcon Tools, установите 
программу Microsoft® ActiveSync®. Эта программа осуществляет связь 
между персональным компьютером и мобильным устройством, например 
полевым  контроллером производства TPS. Мобильное устройство 
должно функционировать под управлением операционной системы 
Windows CE. Программа ActiveSync распространяется бесплатно и 
доступна для загрузки с интернет-сайта компании Microsoft 
(http://www.microsoft.com). 
Для установления соединения между компьютером и контроллером TPS 
необходимо выполнить следующие шаги: 
1. При необходимости, загрузить и установить Microsoft ActiveSync, 

следуя инструкциям программы установки ActiveSync InstallSield 
Wizard. 

2. Подключить устройство к компьютеру, используя доступный метод 
подключения (кабели USB или COM, сетевое подключение по Ethernet 
или Bluetooth®). 

3. Включите устройство и компьютер. 
4. Запустите программу Microsoft ActiveSync. 
5. Щелкните на кнопке Next (Далее) в диалоговом окне Get Connected 

(см. рис. 1-4). 

 
Рисунок 1-4. Программа ActiveSync – окно Get Connected 
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Компьютер установит соединение с устройством. Если устройство 
включено, и корректно выбран порт COM, USB или LAN, то отобразится 
диалоговое окно Connected (Подключено) (см. рис. 1-5). 

 
Рисунок 1-5. Компьютер и мобильное устройство подключены 

Также, в области пиктограмм панели задач операционной системы 
компьютера, значок ActiveSync окрасится в зеленый цвет, указывая на 
успешное подключение компьютера к устройству (см. рис. 1-6). 

 
Рисунок 1-6. Связь установлена 

 ПРИМЕЧАНИЕ 

TopSURV использует файлы в формате *.tsv, который 
можно открыть только в Windows CE устройстве, но не в 
персональном компьютере. При импорте этих файлов из 
контроллера TPS в компьютер, Topcon Tools 
конвертирует их в формат *.tslv. 

 ОСТОРОЖНО 

Для обеспечения сохранности полевых измерений при 
экспорте файлов в формате *.tsv, используйте 
только программы Topcon Tools или Topcon Link. 

Если компьютер оснащен только одним последовательным портом: 



Введение 

Topcon Tools- Руководство пользователя 1-6 

1. Запустите программу Microsoft ActiveSync. 
2. Выберите пункт меню File > Connecting Settings (Файл > 

Настройки подключения) (см. рис. 1-7). 

 
Рисунок 1-7. Выбор настроек подключения 

3. Выберите следующие параметры (см. рис. 1-8): 
• “Allow network (Ethernet) and Remote Access Service (RAS) 

server connection with this desktop computer” (Разрешить 
подключение по сети и к серверу дистанционного 
подключения на этом ПК). 

•  “Show status icon in Task bar” (Отображать иконку состояния 
в панели задач.) 

 
Рисунок 1-8. Параметры подключения 

В этом случае ActiveSync не резервирует последовательный (COM) порт 
после отключения полевого контроллера TPS от компьютера. Этот порт 
можно будет использовать для подключения к ПК спутникового приемника 
TPS GPS+ или тахеометра.
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Если компьютер оснащен двумя или более последовательными 
портами: 

1. Запустите программу Microsoft ActiveSync. 
2. Выберите пункт меню File > Connecting Settings (Файл > 

Настройки подключения). 
3. Выберите следующие параметры (см. рис. 1-9): 

• Поставьте флажок в поле Allow serial cable or infrared 
connection to this COM port (Разрешить подсоединение к 
этому порту через кабель или по инфракрасному каналу 
связи). 

• Выберите из выпадающего списка СОМ порт компьютера, к 
которому будет подключено устройство (обычно порт СОМ1). 

 
Рисунок 1-9. Настройки подключения при наличии нескольких последовательных 

портов 

Microsoft ActiveSync резервирует и будет опрашивать выбранный порт 
даже после отключения устройства. Этот порт будет доступен только 
для Windows CE устройств. 

 
СОВЕТ 

Используйте разные СОМ порты для подключения к 
компьютеру контроллера и приемника/тахеометра. 

При повторном подключении контроллера к компьютеру используйте 
последовательный порт, выбранный в окне Connection Settings 
(Настройки подключения). 
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Запуск Topcon Tools 
В зависимости от программного модуля для запуска программы нужно 
подключить ключ аппаратной защиты или ввести коды доступа. 

• Если программный комплект оснащен ключом аппаратной защиты 
(ключ USB или LPT), вставьте его в соответствующий порт 
компьютера (см. рис. 1-10). Это необходимое условие для запуска 
программы. 

• Первоначальный запуск других программные модулей требует 
введения кодов доступа. 

 
Рисунок 1-10. Ключ аппаратной защиты Topcon Tools – LPT ключ 

1. Запустить программу Topcon Tools, можно следующими способами: 
• Через пункт меню Windows Start > Programs > Topcon > Topcon 

Tools (Пуск > Программы > Topcon > Topcon Tools). 
• Двойным щелчком по ярлыку Topcon Tools. 

Далее изложен порядок работы для программных комплектов без 
аппаратного ключа. 

2. Запишите значение ключа (key value) (см. рис. 1-11 на стр. 1-9). 
СОВЕТ: для вставки значения в электронное письмо без ошибок 
скопируйте его. 

3. Свяжитесь с продавцом оборудования Topcon для получения кода 
доступа. 

4. После получения этого кода щелкните на кнопке Add code (Добавить 
код) и введите его в поле таблицы Available modules (Доступные 
модули). Нажмите на клавишу Ввод или щелкните курсором вне 
таблицы для принятия изменений. Если код принят, то доступные 
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модули появятся в списке Enabled modules (Разрешенные к 
использованию модули) (см. рис. 1-11 на стр. 1-9). 

5. Выделите нужные для работы в Topcon Tools модули (см. рис.  1-11). 
Щелкните на кнопке Close (Закрыть). 

6. Щелкните на кнопке ОК. Для разблокирования выбранных 
программных модулей закройте и вновь откройте программу Topcon 
Tools. 

 
Рисунок 1-11. Ввод кодов доступа модулей Topcon Tools 

Topcon Tools имеет также возможность работы в демонстрационном 
режиме, в котором программа является полнофункциональной, но  проект 
может состоять максимум из пяти точек. Для запуска программы в 
демонстрационном режиме щелкните на кнопке Demo Mode 
(Демонстрационный режим) диалогового окна Enter Access Code. 
При введенных кодах доступа или наличии в компьютере ключа 
аппаратной защиты программы, откроется основное окно программы 
Topcon Tools (см. рис. 1-12). 

 
Рисунок 1-12. Пример окна запуска Topcon Tools 
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Окно Startup (Управление проектами) (см. рис. 1-12 на стр. 1-9) дает 
возможность создания нового проекта или открытия ранее созданного. 

• Раздел "Знакомство с Topcon Tools" на стр. 1-11 знакомит с 
различными инструментами и пунктами меню программы Topcon 
Tools. 

• Окно Startup (Управление проектами) и работа с ним описана в 
главе “Работа с проектом” на стр. 2-1. 

• Виды представлений данных в программе Topcon Tools описаны в 
разделе “Виды представления данных” на стр. 4-1. 

Topcon Tools также поддерживает технику перетаскивания для открытия 
файлов. Проект Topcon Tools может быть открыт или закрыт. 
1. Запустите программу-проводник Windows Explorer и найдите 

необходимые файлы. 
2. Выделите файлы, щелкните на их названиях и удерживайте левую 

кнопку мыши нажатой. 
3. Перетащите выделенные названия файлов в открытое окно Topcon 

Tools. 

• При перетаскивании файла проекта в главное окно Topcon Tools, 
он будет открыт. 

• При перетаскивании файла проекта или данных в открытый 
(текущий) проект, проект или данные будут импортированы. 

 
Рисунок 1-13. Открытие файла техникой перетаскивания 
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Знакомство с Topcon Tools 
В этом разделе представляются различные функции, доступные в Topcon 
Tools для просмотра, настройки или редактирования файлов данных. 

 ПРИМЕЧАНИЕ 

В зависимости от приобретенных модулей, варианты  и 
виды представления данных и функции их обработки 
могут различаться. 

Программные модули Topcon Tools 
Программа Topcon Tools может комплектоваться различными 
комбинациями модулей исходя из конкретных требований. 
Модуль PostProcessing 

Содержит математический аппарат для камеральной обработки 
данных измерений приемников GPS+. 

Модуль RTK 
Содержит функции импорта, отображения, уравнивания, экспорта и 
создания отчетов данных RTK (данные, полученные в RTK режиме 
съемки с использованием программного обеспечения TopSURV или 
другого ПО сбора данных). 

Модуль TS 
Содержит возможности импорта, отображения, уравнивания, 
экспорта и создания отчетов съемки, произведенной электронным 
тахеометром. 

Модуль GIS 
Менее точная, менее сложная версия модуля PostProcessing для 
обработки GPS+ данных. 

Модуль Design 
Содержит возможности работы с цифровыми моделями поверхности 
и создания и редактирования дорог. 

Модуль Imaging 
Содержит возможности для работы с изображениями, стереопарами 
и сеансами сканирования. 

Модуль Advanced 
Содержит дополнительные функции обработки и уравнивания. 
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Главное окно Topcon Tools 
Главное окно Topcon Tools состоит из следующих элементов (см. рис. 1-
14): 

• Строка меню – содержит выпадающие меню для различных функций 
Topcon Tools. 

• Инструментальные панели – содержат кнопки быстрого доступа к 
наиболее часто используемым функциям. 

• Строка состояния – отображает информационные сообщения о 
Topcon Tools и различных файлах, а также выпадающие окна для 
быстрой смены единиц измерения и систем координат. 

 
Рисунок 1-14. Главное окно Topcon Tools 

При запуске диалоговое окно Startup (Управление проектами) 
отображает следующее (см. рис. 1-12 на стр.1-9): 

• список ранее созданных проектов с указанием их названий, 
расположения, даты создания и даты последнего обращения к ним. 

• кнопки для создания нового проекта, открытия проекта, поиска 
проекта и закрытия окна. 

 



Знакомство с Topcon Tools 

P/N 7010-0612 1-13 

Строка меню Topcon Tools 
Строка меню (см. рис. 1-15) дает доступ к большинству функций, 
доступных для использования в Topcon Tools. 

 
Рисунок 1-15. Строка меню Topcon Tools 

В таблице 1-1 описываются функции, доступные в каждом пункте меню. 

Таблица 1-1. Пункты меню Topcon Tools 
 

Пункт меню Функции 

Job (Проект) • создание, открытие, сохранение, 
сохранение копии и закрытие проекта. 

• печать информации из текущего проекта. 
• импорт из файла или экспорт в файл. 
• импорт из устройства или экспорт в 

устройство. 
• задание параметров печати. 
• задание параметров текущего проекта. 
• просмотр информации по проекту. 
• список последних открытых файлов. 

Edit (Редактирование) • отмена и повторное выполнение последней 
команды. 

• вырезать, копировать, вставить или 
удалить данные. 

• прокрутка и масштабирование 
изображения. 

• добавление слоев, точек, линий, 
поверхностей, площадей, дорог или 
поперечников. 

• добавление или вставка точек в линии. 
• запрет и разрешение использования точек 

и сеансов измерений в уравнивании или 
обработке. 

• отображение свойств выделенных данных. 
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Таблица 1-1. Пункты меню Topcon Tools (продолжение) 

Пункт меню Функции 
View (Вид)  • управление отображением строки состояния 

и различных видов (окон). 
• вызов диалогового окна Filters settings 

(Настройки фильтров). 
• управление отображением видов Tabular, 

Map, Occupation, CAD, Codes, 3D и Layers.  
• настройка инструментальных панелей. 
• установка параметров видов Map, 

Occupation, Tabular, CAD, Images и 
Stereopair. 

Select (Выбор)  • выбор точек, сеансов и отдельных 
измерений по критериям пользователя. 

Process (Обработка)  • обработка измерений GPS. 
• уравнивание. 
• расчет параметров перехода в местную 

систему координат. 
• отображение невязок хода. 
• обновление поверхностей. 
• настройка параметров обработки. 

Report (Отчеты)  • отображение отчетов в отдельных окнах, в 
т.ч. результатов уравнивания, 
детализированных отчетов по пикетам и 
измерениям и результатов контроля. 

• настройка и создание новых шаблонов  
отчетов. 

CoGo (Координатная 
геометрия)  

• решение обратной геодезической задачи. 
• расчет координат точек пересечения фигур и 

отображение их в виде CAD. 
• расчет объема фигуры, тела ограниченного  

двумя поверхностями. 
• расчет положения точки на заданной линии 

или луче. 
• расчет координат точек хода. 
• расчет смещения точек относительно 

заданной линии или луча. 
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Таблица 1-1. Пункты меню Topcon Tools (продолжение) 

Пункт меню Функции 
Window (Окно)  • упорядочивание открытых окон программы.

• упорядочивание значков. 
• отображение текущего вида (Map, 

Occupation, Codes). 

Help (Справка) 

  

• вызов контекстной подсказки. 
• отображение справочника Topcon Tools. 
• доступ к программе электронной почты, 

установленной в ПК для отправки отчета об 
ошибке программы или вопроса в службу 
технической поддержки Topcon. 

• доступ к интернет-сайту Topcon GPS. 
• отображение данных о кодах доступа к 

программным модулям 
• отображение версии, даты сборки и данных 

о разблокированных модулях Topcon Tools. 
 

Инструментальные панели 
Инструментальные панели программы Topcon Tools (см. рис. 1-16) 
содержат кнопки для быстрого доступа к наиболее часто используемым 
функциям. Подробно создание пользовательской инструментальной 
панели описано в разделе "Настройка инструментальной панели" на стр. 
1-20. 

 
Рисунок 1-16. Инструментальная панель 

После запуска программы инструментальная панель будет расположена 
под строкой меню. 

• Отображение или скрытие инструментальной панели производится 
через пункт меню View > Customize (Вид > Настройка). 

• Для перемещения инструментальной панели щелкните на ее 
подложку и, удерживая левую кнопку мыши нажатой, передвиньте 
панель на новое место. Отпустите кнопку мыши. 

Изменение состава инструментальной панели CAD, описывается в 
разделе "Настройка инструментальной панели" на стр. 1-20. 
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В таблице 1-2 описываются различные кнопки, доступные на стандартной 
инструментальной панели. 

Таблица 1-2. Иконки инструментальной панели 

Иконка Описание 

 
Новый проект – создание нового проекта 
1. Щелчок на иконке вызывает диалоговое окно Create a new 

job. 
2. Введите название создаваемого проекта и укажите его 

местоположение на жестком диске компьютера. 
3. Введите имя пользователя в поле Created by и, при 

необходимости, введите комментарии в поле Comments. 

 
Открыть проект – открытие выбранного проекта 
1. Щелчок на иконке вызывает диалоговое окно Open Job. 
2. Выберите проект из списка. 
3. Щелкните на кнопке Open Job. 

 
Сохранить – сохраняет проект в каталоге, указанном при его 
создании. 

 
Импорт из файлов – импортирует файлы в проект с жесткого 
диска компьютера, локальной компьютерной сети или сменного 
носителя данных. 
1. Щелчок на иконке вызывает диалоговое окно Import from 

Files. 
2. Выберите расположение, каталог, тип и имена 

импортируемых файлов. Щелкните на кнопке Open. 

 
Импорт из устройства – импортирует файлы в проект из 
приемников TPS GPS+, контроллеров, электронных тахеометров 
и карт памяти Topcon. 
1. Щелчок на иконке вызывает диалоговое окно Import Files 

from Device. 
2. Выберите устройство и щелкните на кнопке Next. 
Подробнее см."Импорт из устройства" на стр. 3-33. 

 
Экспорт в файл – экспортирует данные из файла проекта на 
жесткий диск компьютера, в локальную компьютерную сеть или 
на сменный носитель данных. 
1. Щелчок на иконке вызывает диалоговое окно Export to File 

(Экспорт в файл). 
2. Выберите расположение, каталог, тип и название 

экспортируемого файла. Щелкните на кнопке Save 
(Сохранить). 

 
Печать текущего окна или таблицы. 

 
Отмена последнего действия. 

 
Повторное выполнение последнего действия. 
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Таблица 1-2. Иконки инструментальной панели (продолжение) 

Иконка Описание 

 
Удаление выделенных объектов. 

 
Копирование выбранных объектов. 
 

 
Вставка объектов из буфера обмена Windows в текущее 
положение курсора. 

 
Увеличение – доступно в видах Map, Occupation и CAD. 

 
Уменьшение – доступно в видах Map, Occupation и CAD. 

 
Возвращение масштаба – доступно в видах Map, Occupation 
и CAD. 

 
Показать все – устанавливает масштаб (в видах Map, 
Occupation и CAD), при котором в одном окне отображаются 
все имеющиеся объекты. 

 
Сдвиг – изображение курсора становится "рукой", в видах 
Map, Occupation и CAD можно передвигать содержимое 
окна. 

 
Применение определяемых пользователем фильтров для 
измерений и точек. 
1. Щелчок на иконке вызывает диалоговое окно Filters. 
2. Выберите нужные фильтры и щелкните на кнопке Apply. 

 
Tabular View (Вид Таблица)  – открывает и закрывает 
представление данных проекта в форме электронной 
таблицы. 

 
Вид "Карта” – открывает графическое представление 
измерений и пикетов. 

 
Вид “Проектирование” – открывает окно с проектными 
данными (точками, линиями, дорогами и поверхностями). 

 
Вид “Сеанс” – открывает и закрывает окно с графическим 
представлением сеансов спутниковых измерений, входящих 
в проект. 

 
Коды – открывает таблицу с кодами проекта. 

 
Камеральная обработка GPS+ – используется для запуска 
процесса обработки всех спутниковых измерений проекта. 

 
Уравнивание сети. 

 
Настройка отчетов – открывает окно настройки отчетов. 

 



Введение 

Topcon Tools- Руководство пользователя 1-18 

Таблица 1-2. Иконки инструментальной панели (продолжение) 
 
Иконка Описание 

 
Контекстная подсказка – отображает подсказку о выбранном 
виде, кнопке, и т.п. 
1. Щелкните на иконке. Курсор изменится на значок вопроса. 
2. Щелкните на объекте. Во всплывающем окне будет дана 

подсказка.  
3. Для закрытия окна подсказки щелкните вне него. 

 
Иконки инструментальной панели CAD (САПР) 

Иконка Описание 

 
Добавление точки в проект. 
1. Щелкните на иконке. Вид курсора изменится на указатель 

"добавление точки". 
2. Щелкните в любой части вида CAD. 
3. Введите данные точки в диалоговом окне Add Point. 
4. Щелкните на кнопке ОК. Повторно щелкните на иконке для 

возвращения курсора в обычный вид. 

 
Добавление линии в проект. 
1. Щелкните на иконке. Курсор изменится на указатель 

"добавление линии". 
2. Щелкните в произвольном месте вида CAD или на заранее 

заданной точке. Линия создается между двумя точками. 

 
Добавить поверхность – создание новой поверхности из 
выбранных точек и линий. 

 
Добавляет точки в конец линии. 

 
Добавить точку в линию – разрывает линию в задаваемой точке, 
по существу создавая две линии из одной. 

 
Добавляет точки и/или линии к поверхности. 

 
Удаляет выбранный объект. 

 
Добавление дороги. 
1. Щелкните на иконке. 
2. Введите данные дороги в диалоговом окне Add road. 
3. Щелкните на кнопке ОК. 

 
Создать типовой поперечник. 
1. Щелкните на иконке. 
2. Введите данные типового поперечника в диалоговом окне 

Add X-Section Template. 
3. Щелкните на кнопке ОК. 
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Иконка Описание 

 
Добавить площадь – замыкает созданные линии. 

 

Добавить слой. 
1. Щелкните на иконке. 
2. Введите данные о слое в диалоговом окне Add Layer. 
3. Щелкните на кнопке ОК. 

 Управление слоями. 
1. Щелкните на выпадающем списке. 
2. Щелчок на названии слоя делает его текущим. 

 

Строка состояния 
Строка состояния (см. рис. 1-17) отображает различные информационные 
сообщения о текущих действиях и данных Topcon Tools. 
Двойной щелчок по выпадающим спискам обеспечивает быстрый доступ к 
наиболее часто изменяемым параметрам настройки проекта (см. рис. 
1-17): 

• Единицы измерения линейных и угловых величин. 

• Системы координат и проекции. 
Окно в правом углу строки состояния отображает значок фильтра, если он 
используется в проекте. 

 
Рисунок 1-17. Строка состояния и выпадающие списки
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Настройка инструментальной 
панели 
Стандартная инструментальная панель содержит наиболее часто 
используемые функции. Существует возможность изменить ее 
содержимое, или же убрать целиком. 
1. Для настройки инструментальной панели выберите пункт меню View > 

Customize (Вид > Настройка). Во вкладке Toolbars 
(Инструментальные панели) диалогового окна Customize toolbars 
(Настройка инструментальных панелей) отобразятся все 
инструментальные панели, доступные для включения или отключения. 
Здесь же можно создать и удалить инструментальные панели (см. рис.  
1-18). 

 
Рисунок 1-18. Настройка инструментальной панели 

2. Щелкните на кнопке New (Новая) для добавления новой 
инструментальной панели в главное окно. Введите ее название и 
щелкните на кнопке ОК (см. рис. 1-19). 

 
Рисунок 1-19. Добавление новой инструментальной панели  
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Созданная инструментальная панель будет добавлена в список Toolbars 
(Инструментальные панели) и отобразится как пустая инструментальная 
панель в главном окне программы (см. рис. 1-20). 

 
Рисунок 1-20. Новая инструментальная панель 

3. Выберите вкладку Commands (Команды). В левой панели отобразится 
список пунктов меню, а в правой – команды, доступные для выбранного 
пункта меню (см. рис. 1-21). 

 
Рисунок 1-21. Команды инструментальной панели 

4. Для добавления команды выберите пункт меню, затем выделите и 
перетащите иконку команды в пустую (или любую по Вашему выбору) 
инструментальную панель (см. рис. 1-22 на стр.1-22). 
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Рисунок 1-22. Добавление иконок команд к инструментальной панели 

5. После добавления всех необходимых команд в инструментальную 
панель, их можно расставить в нужном порядке, выделив и перетащив 
иконку (см. рис. 1-23). Настройка инструментальной панели 
производится только в том случае, когда диалоговое окно Customize 
toolbars (Настройка инструментальной панели) открыто. 

 
Рисунок 1-23. Выбор размещения иконок на инструментальной панели 

См. также разделы "Редактирование инструментальной панели" на стр. 
1-23 и "Создание собственной инструментальной панели” на стр. 1-24. 

6. После завершения настройки инструментальной панели щелкните на 
кнопке Close (Закрыть), в диалоговом окне Customize toolbars. 
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Редактирование инструментальной 
панели 
Выберите пункт меню View > Customize (Вид > Настройка) для настройки 
инструментальной панели, при этом откроется диалоговое окно Customize 
toolbars (Настройка инструментальной панели). 
Для настройки команды в инструментальной панели щелкните правой 
кнопкой мыши на иконке инструмента, что приведет к появлению меню с 
командами  настроек (см. рис. 1-24 на стр. 1-24): 

• Delete Button (Удалить иконку) – удаление выбранной команды из 
инструментальной панели. 

• Copy Button Image (Копировать изображение иконки) – копирует 
изображение иконки в буфер обмена. 

• Paste Button Image (Вставить изображение кнопки) – вставка 
изображения в иконку из буфера обмена. 

• Set Default Image (Установить исходное изображение иконки) –
для выбранной команды устанавливается исходное изображение. 

• Begin a Group (Создать группу) – вставка разделителя перед 
иконкой для создания группы. Галочка показывает начало группы. 
Повторный выбор этого пункта меню приводит к удалению группы и 
галочки. 

• Command Properties (Свойства команды) – вызов диалогового 
окна Command Properties, в котором можно выбрать каталог и 
установки экспорта и импорта для команд инструментальной 
панели. См. также "Создание собственной инструментальной 
панели” на стр. 1-24. 

• Button Settings (Параметры иконки) – вызов диалогового окна 
Button Settings, в котором можно задать название кнопки (поле 
Button Name) - когда курсор находится над иконкой, появляется это 
название. См. также "Создание собственной инструментальной 
панели” на стр. 1-24. 

• Show Bitmap (Показать изображение) – показывает иконку 
команды. 

• Show Text (Показать текст) – показывает название команды. 
• Show Bitmap and Text (Показать изображение и текст) – 

показывает иконку и название команды. 
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Рисунок 1-24. Меню команд настройки инструментальной панели 

Подробнее см. ниже. 

Создание собственной 
инструментальной панели 
Пользовательская инструментальная панель в Topcon Tools является 
полностью функциональной и интерактивной. Многие свойства иконок и 
режимы их отображения могут быть настроены для конкретного проекта, 
типа данных или исходя из предпочтений пользователя. 

Свойства команды 
Диалоговое окно Command Properties (Свойства команды) позволяет 
выбрать каталог и установки экспорта и импорта для команд 
инструментальной панели. 
Например, удобно задать несколько иконок импорта или экспорта на 
инструментальной панели для выполнения функций импорта или экспорта 
в конкретный каталог или устройство. Это особенно полезно, когда данные 
различных типов хранятся в разных каталогах, а также для упрощения 
импорта из внешних устройств. 
Для выполнения этого, перетащите две или более иконок на 
инструментальную панель. Установите индивидуальные свойства иконок 
для обращения к конкретному каталогу и типу файлов через диалоговое 
окно Command Properties. Задайте уникальное название командам при 
помощи диалогового окна Button Settings. 
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1. Щелкните по правой кнопке мыши на иконке Импорт или Экспорт 
инструментальной панели и в меню команд выберите пункт Command 
Properties (Свойства команды) (см. рис. 1-25).  

 
Рисунок 1-25. Пункт Command Properties (Свойства команды) 

2. В диалоговом окне Command Properties (Свойства команды), 
щелкните на кнопке …(выбор каталога) для выбора каталога, который 
будет использоваться для импорта (экспорта) файлов (рис. 1-26). 

3. В выпадающем списке Filter (Фильтр) выберите тип импортируемых 
(экспортируемых) файлов (рис. 1-26). 

4. Щелчок на кнопке ОК сохраняет настройки и закрывает диалоговое 
окно. 

 
Рисунок 1-26. Ввод свойств команды 

5. Еще раз щелкните по правой кнопке мыши на той же иконке 
инструментальной панели и в появившемся меню выберите пункт 
Button Settings (Параметры иконки). Задайте уникальное название 
команды и настройте ее текстовое представление в соответствии с 
разделом "Параметры иконки" на стр. 1-26. 
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Параметры иконки 
В диалоговом окне Button Settings (Параметры иконки), выбирается 
название команды и вид ее представления. 
1. Щелкните по правой кнопке мыши на иконке и в появившемся меню  

выберите пункт Button Settings (Настройки иконки) (см. рис. 1-27). 

 
Рисунок 1-27. Пункт Настройки иконки 

2. В диалоговом окне Button Settings (Настройки иконки), введите 
название команды (или используйте название, предлагаемое по 
умолчанию) (см. рис. 1-28). 

3. Выберите вид представления команды (см. рис. 1-28): 
• Show Bitmap (Показать изображение) – показывает изображение 

иконки. 
• Show Text (Показать текст) – показывает название команды. 
• Show Bitmap and Text (Показать изображение и текст) – 

отображает иконку и название команды. 
4. Щелчок на кнопке ОК сохраняет настройки и закрывает диалоговое 

окно. 

 
Рисунок 1-28. Ввод настроек иконки
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На рис. 1-29 показаны различные виды представления команд. 

 
Рисунок 1-29. Виды представления команд на инструментальной панели 

Ввод кодов доступа 
Коды доступа (коды активации), подтверждают приобретение 
программных модулей Topcon Tools. Код доступа может быть включен или 
отключен, добавлен или удален для обеспечения наибольшего контроля 
над возможностями программы. Для просмотра кодов доступа и состояния 
активации модулей, выберите пункт меню Help > Access Codes (Справка 
> Коды доступа). 
Диалоговое окно Enter Access Code (Ввод кода доступа) (см. рис. 1-30 
на стр. 1-28) предоставляет следующую информацию: 

• Key Value (Значение ключа) – идентификационный номер 
компьютера. 

• Available modules (Доступные модули) – таблица со списком кодов 
для приобретенных модулей, состояние каждого кода и модули, 
включенные в каждый код. 

• Enabled modules (Включенные модули) – флажки для разрешения 
(запрещения) использования каждого модуля. 

Для копирования Key Value (Значения ключа): 
Выделите значение ключа двойным щелчком, после чего щелкните 
на кнопке Copy (Копировать). Это действие используется для 
быстрой записи значения и при передаче его в Topcon. 

Для добавления кода доступа: 
Щелкните на кнопку Add code (Добавить код). Введите новый код в 
поле в таблицы Available modules (Доступные модули). Нажмите 
клавишу Enter для завершения ввода. 
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Для удаления кода доступа: 
Выберите код и щелкните  на кнопке Delete code (Удалить код). 

Для включения или отключения модуля: 
Щелкните по флажку в таблице Enabled modules (Включенные 
модули). Галочка в поле означает, что модуль подключен. Если 
модуль отключить, то обеспечиваемые им функции в Topcon Tools 
будут недоступны. 

 
Рисунок 1-30. Коды доступа Topcon Tools 

 

Обратная связь 
Пункт меню Help > Feedback (Справка > Обратная связь) дает 
возможность получения технической поддержки. Здесь же имеется ссылка 
для прямого обращения к интернет-сайту Topcon GPS. Эти возможности 
доступны только тогда, когда ПК подключен к сети Internet. 
Для отсылки отчета об ошибке программы: 

При выборе пункта меню Help > Feedback > Send Bug Report 
(Справка > Обратная связь > Послать отчет об ошибке) будет 
вызвана установленная почтовая программа компьютера и файл 
отчета будет автоматически прикреплен к письму. В тексте письма 
опишите действия, приведшие к ошибке программы, и отошлите 
письмо в службу технической поддержки TPS. 

Задать вопрос можно следующим образом: 
Выберите пункт меню Help > Feedback > Question To Support. 
(Справка > Обратная связь > Вопрос службе поддержки). 
Введите текст вопроса, детально опишите произведенные вами 
действия и отошлите по электронной почте в службу технической 
поддержки TPS.
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Печать выбранного вида 
Все представления данных (виды) в программе Topcon Tools доступны для 
печати. 

 
СОВЕТ 

Многие виды лучше всего печатать с альбомной 
ориентацией страницы. Пункт меню Job > Page Setup 
(Проект > Параметры страницы) позволяет произвести 
соответствующие настройки. Пункт меню Job > Print 
Preview (Проект > Предварительный просмотр) позволяет 
провести просмотр печатаемой страницы. 

Для печати видов Map, Occupation или CAD: 
Выберите нужный вид щелчком по нему, а затем выберите пункт 
меню Job > Print (Проект >Печать). 
Эти виды автоматически масштабируются до оптимального 
заполнения страницы. 

Для печати вида Codes: 
Для печати кодов из вида Codes, щелкните на левой панели этого 
вида, после чего выберите пункт меню Job > Print. 
Для печати атрибутов из вида Codes, выделите коды с атрибутами в 
левой панели и щелкните на одном из атрибутов, размещенных в 
правой панели, после чего выберите пункт меню Job > Print. Для 
печати атрибутов для нескольких кодов выделите коды, удерживая 
клавишу Shift, а затем щелкните на левой панели до начала печати. 

Для печати вида Таблица: 
Для печати вкладок Points, GPS Occupations и GPS Obs выберите 
нужную таблицу, после чего выберите пункт меню Job > Print. 
Для печати левой панели таблиц TS Obs или Tape Dimension, 
щелкните на левой панели, после чего выберите пункт меню Job > 
Print. 
Для печати правой панели таблиц TS Obs или Tape Dimension, 
щелкните на ней, после чего выберите пункт меню Job > Print.  
Для нескольких строк левой панели, выделите их, удерживая 
нажатой клавишу Shift, а затем щелкните на правой панели перед 
началом печати.  
Если панели не умещаются в страницу по горизонтали, то они будут 
распечатаны в несколько колонок. 
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Для заметок: 
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Глава 2  
Работа с проектом 
Файл проекта Topcon Tools содержит импортированные данные 
измерений, предназначенные для обработки, а также параметры 
просмотра и обработки. В каждый момент времени может быть открыт 
единственный проект. При открытии другого проекта программа Topcon 
Tools автоматически сохраняет и закрывает текущий проект. 

Диалоговое окно управления 
проектами 
При запуске программы Topcon Tools автоматически открывается 
диалоговое окно Startup (Управление проектами) (рис. 2-1), используя  
которое можно создать новый или открыть существующий проект. 
Таблица содержит список созданных проектов. Щелкнув по названию  
колонки, их можно отсортировать в возрастающем или убывающем 
порядке по: 

• Названию проекта. 
• Названию каталога, в котором находится проект. 
• Дате создания проекта. 
• Дате последнего обращения к проекту. 

Кнопки этого диалогового окна позволяют открыть существующий проект 
(Open job), создать новый (New job), осуществить поиск проектов в 
файловой системе (Browse), удалить проект (Delete job) и закрыть 
диалоговое окно (Close). 

 
Рисунок 2-1. Диалоговое окно Startup (Управление проектами) 
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Создание нового проекта 
При создании нового проекта Topcon Tools будет открыт пустой файл 
проекта, который будет автоматически сохранен в указанном каталоге. 
1. Создать новый проект можно одним из перечисленных ниже способов 

(см. рис. 2-2): 
• Щелчком на кнопке New job (Новый проект) диалогового окна 

Startup (Управление проектами). 
• Щелчком на иконке New (Новый) инструментальной панели. 
• Выбором пункта меню Job > New Job (Проект > Новый проект). 

 
Рисунок 2-2. Способы создания нового проекта 

2. Введите перечисленные ниже данные (рис. 2-3): 
• Job name (Название проекта), Created by (Кем создан) и  

Comment (Комментарий). 
• Щелкните на кнопке "..."(Просмотр) для выбора каталога, в 

котором следует сохранить проект. 
• Выберите набор настроек из выпадающего списка Configurations 

(Наборы настроек) или щелкните на кнопке Edit configuration 
(Изменение настроек). Подробнее см. раздел "Настройка 
проекта" на стр. 2-5 ). 

 
Рисунок 2-3. Создание нового проекта 

3. После щелчка на кнопке ОК создается новый проект, после чего он 
сохраняется и остается открытым для работы (текущим). 
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Открытие проекта 
Вы можете открыть проект Topcon Tools из программы двойным щелчком 
по названию файла с расширением ttp или "перетащив" такой файл на 
главное окно программы Topcon Tools. 
1. Для открытия проекта используйте указанные выше или 

перечисленные ниже способы (см. рис. 2-4): 

• Дважды щелкните по проекту в списке диалогового окна Startup 
(Управление проектами). 

• Выделите проект в списке диалогового окна Startup, а затем 
щелкните на кнопке Open Job (Открыть проект). 

• Щелкните на кнопке "..." (Просмотр) диалогового окна Startup, 
найдите проект в файловой системе ПК и выделите его. 

• Щелкните на иконке Open (Открыть) инструментальной панели. 

• Выберите пункт меню Job > Open Job (Проект > Открыть 
проект). 

 
Рисунок 2-4. Способы открытия проекта 

2. Откройте каталог проекта и найдите в нем проект, после чего выделите 
его и щелкните на кнопке Open (Открыть). Topcon Tools откроет 
выбранный проект. 
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Сохранение проекта 
Для сохранения проекта воспользуйтесь одним из перечисленных ниже 
способов (см. рис. 2-5): 

• Щелкните на кнопке Save (Сохранить) инструментальной панели. 

• Выберите пункт меню Job > Save Job (Проект > Сохранить 
проект). 

• Выберите пункт меню Job > Save Job As (Проект > Сохранить 
проект как) для сохранения копии проекта. Введите новое название 
проекта в диалоговом окне Save As (Сохранить как). 

 
Рисунок 2-5. Возможности сохранения проекта 

Когда открывается другой проект или закрывается программа, Topcon 
Tools отображает окно сообщения о необходимости сохранения текущего 
проекта. 

Закрытие проекта 
Для закрытия проекта без выхода из программы Topcon Tools выберите 
Job > Close Job (Проект > Закрыть проект) (рис. 2-6). 

 
Рисунок 2-6. Закрытие проекта 

Если проект был изменен без сохранения, появится диалоговое окно с 
запросом о сохранении. Щелкните на кнопке Yes (Да) для сохранения 
проекта в том каталоге, в котором он был открыт. 
Выберите Job > Exit (Проект > Выход) для закрытия программы Topcon 
Tools после сохранения и закрытия проекта. 
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Удаление проекта 
Проект Topcon Tools состоит из трех файлов: собственно файла проекта, 
файла опций и файла настроек. Для удаления проекта вручную следует 
удалить все три файла. 
1. Для удаления проекта выберите проект в диалоговых окнах Open a job 

(Открыть проект) или Startup (Управление проектами) и 
щелкните на кнопке Delete (Удалить) (рис. 2-7). Щелкните на кнопке ОК 
для подтверждения действия. 

 
Рисунок 2-7. Удаление выбранного проекта 

 

Настройка проекта 
Используйте диалоговое окно Job configuration (Настройка проекта) 
(рис. 2-8) для задания параметров просмотра и обработки данных 
программой Topcon Tools. 
Для настройки этих параметров выберите пункт меню Job > Job 
configuration (Проект > Настройка проекта) или щелкните на кнопке Edit 
Configuration (Настройка параметров) диалогового окна Create a new job 
(Создание нового проекта). 

 
Рисунок 2-8. Настройка проекта 

• В левой панели диалогового окна отображаются элементы, которые 
можно настроить для проекта. Подробное описание каждого 
элемента приводится ниже. 
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• В правой панели показывается список параметров выбранного 
элемента. 

• Щелчок на кнопке List configurations (Отобразить наборы 
настроек), вызовет диалоговое окно Configuration List (Список 
наборов настроек) (рис. 2-9). В нем перечислены 
предопределенные наборы настроек для различных типов проектов, 
отличающиеся заданными системами координат и точностями для 
Points (пикетов), GPS Obs (спутниковых измерений), TS Obs 
(тахеометрической съемки), DL Obs (нивелирных ходов), Loop 
Closure (тахеометрических ходов). 

 
Рисунок 2-9. Список наборов настроек 

Пользователь может выбрать из списка наиболее подходящий для 
своего проекта набор настроек. Например, системы координат: 
− Ground (Местная) установлена в наборах Design, Imaging, TS. 
− Datum System (Исходные геодезические даты, ИГД) 

установлена в наборах DGPS и GPS+. 
В этом диалоговом окне можно переименовать или удалить наборы 
настроек. Щелкните на кнопке Load (Загрузить) для применения 
выбранного набора настроек в текущем проекте. 

• Кнопка Save Configuration (Сохранить набор настроек) открывает 
диалоговое окно Enter configuration name (Задайте название 
набору настроек), в котором следует задать название нового 
набора настроек (рис. 2-10). См. также "Создание нового проекта" на 
стр. 2-2. 

 
Рисунок 2-10. Ввод названия нового набора настроек 

• Кнопка Cancel (Отмена) отменяет изменения набора настроек, 
произведенные в правой панели диалогового окна Job 
configuration.
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Параметры отображения 
Элемент Display (Отображение) содержит следующие параметры: 

• Во вкладке Precisions (Точности) (см. рис. 2-11) устанавливается 
количество отображаемых десятичных знаков после запятой для 
разных величин. 

 
Рисунок 2-11. Настройка проекта –вкладка Precisions (Точности) 

• Во вкладке Time (Время) (рис. 2-12) выбирается часовой пояс для 
местного времени (задается относительно шкалы времени GМТ - 
Гринвич). 

 
Рисунок 2-12. Настройка проекта – вкладка Time (Время) 
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• Во вкладке Roads (Дороги) (рис. 2-13), выбирается тип 
представления координат осевой линии дороги. 

 
Рисунок 2-13. Настройка проекта – вкладка Roads (Дороги) 

• Во вкладке Angles (Углы) (рис. 2-14) выбирается формат 
представления угловых величин. 

 
Рисунок 2-14. Настройка проекта – вкладка Angles (Углы) 

Выбор системы координат 
Любой проект Topcon Tools содержит точки, координаты которых даются в 
системе координат (СК) проекции в выбранных исходных геодезических 
датах (ИГД) или местной СК. Для отображения координат точек в нужной 
системе координат выберите соответствующую проекцию и ИГД в 
диалоговом окне Coordinate Systems (Системы координат) (рис. 2-15 
на стр. 2-9) или в строке состояния. 
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Рисунок 2-15. Настройка проекта – Coordinate systems (Системы координат) 

• Выпадающий список Projection (Проекция) дает возможность 
выбора предопределенных картографических проекций для 
проекта. Раздел "Добавление специальной проекции" на стр. 2-12 
содержит подробное описание методики добавления проекций, 
задаваемых пользователем. 

• Когда проекция (за исключением Localization или None) выбрана, 
становятся разрешенными преобразования Grid - > Ground (СК 
проекции - >Местная СК). 

 
• Если кнопка-флажок Grid - > Ground окна Coordinate Systems 

(Системы координат) не выделена, то вариант Ground (Местная 
СК) не отображается в окне выбора систем координат диалогового 
окна Coordinate Systems и выпадающем списке систем координат 
строки состояния. 

 
• Если кнопка-флажок Grid - > Ground окна Coordinate Systems 

выделена, то варианты Ground (Местная СК), Grid (СК проекции) и 
Datum (ИГД) отображаются в окне выбора систем координат окна 
Coordinate Systems и выпадающем списке систем координат строки 
состояния. 
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• Если кнопка-флажок Grid - > Ground выбрана, то щелчком на 
расположенной от нее справа кнопке “...” вызывается диалоговое 
окно, позволяющее установить параметры перехода из СК проекции 
в местную СК. Если кнопка-флажок не выбрана, то переход из СК 
проекции в местную СК и обратно невозможен. См. "Параметры 
перехода между СК проекции и местной СК" на стр. 2-15. 

• Для отображения координат точек в местной системе координат 
(например, в системе координат, не связанной с государственной 
системой), выберите из выпадающего списка Projection, варианты 
Localization (Трансформированная) или None (Не применять). 

− выбор варианта Localization (Трансформированная) приводит 
к тому, что координаты отображаются в местной СК, причем 
преобразование в нее из координат в СК проекции 
производится по набору параметров, полученных расчетным 
путем по специальной процедуре. 

− выбор варианта None (Не применять), приводит к тому, что 
отображаются только координаты в местной СК. 

• При выборе вариантов Localization или None из списка проекций, 
кнопка-флажок Grid - > Ground будет неактивна, а вариант Grid в 
списке Coordinate type (Тип СК) окна Coordinate Systems и 
выпадающем списке систем координат строки состояния не 
предлагается. 

 
• Выпадающий список Datum (исходные геодезические даты, ИГД), 

устанавливает ИГД (например, WGS84), в которых задаются 
координаты. Эти же ИГД используются в уравнивании. Этот список 
доступен только тогда, когда текущей является местная система 
координат или текущая картографическая проекция допускает 
использование различных ИГД (как, например, проекции UTMNorth, 
UTMSouth или UPS). 

 
Рисунок 2-16. Пример выбора ИГД для проекции UTM (Зона 7) 
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Во всех остальных случаях проекция однозначно связана с ИГД, которые 
являются референц-эллипсоидом, на котором развита соответствующая 
проекция. 

 
Рисунок 2-17. Пример выбора ИГД для проекции JAPAN_01 

• Topcon Tools дает пользователю возможность выбора следующих 
ИГД для проекций с использованием референц-эллипсоида NAD-83: 

− NAD83 с приведенными ниже параметрами трансформации по 
отношению к эллипсоиду WGS-84 (смещения, развороты и 
масштаб): 

DX = -0.9956 m, DY = 1.9013 m, DZ = 0.5215 m 
RX = -0.025915'', RY = -0.009426", RZ = -0.011599'' 
Scale = 0.00062 

Это последние обновленные параметры ITRF2000. 
− NAD83(ITRF96) с приведенными ниже параметрами 

трансформации по отношению к эллипсоиду WGS-84 
(смещения, развороты и масштаб): 

DX = -0.991 m, DY = 1.9072 m, DZ = 0.5129 m 
RX = -0.02579'', RY = -0.00965", RZ = -0.01166'' 
Scale = 0.0 

 ПРИМЕЧАНИЕ 
Вариант ИГД NAD83<->ITRF96 использовался в Topcon 
Tools до версии 5.04. Используйте этот набор параметров 
для совместимости со старыми версиями. 

− Набор NAD83_NO_TRANS имеет нулевые величины 
параметров трансформации (смещения, развороты) и 
единичный масштаб по отношению к WGS-84. 

 ПРИМЕЧАНИЕ 
Для использования NAD83 при обработке данных 
спутниковых измерений в сетях опорных станций 
CORS/VRS используйте нулевые параметры 
трансформации. 
См. раздел “Добавление Исходных Геодезических Дат” на стр. 2-14. 

• Когда ИГД не выбраны, кнопка-флажок Grid - > Ground в окне 
Coordinate Systems будет неактивна, в списке Coordinate type и в 
выпадающем списке в строке состояния доступен исключительно 
вариант "Ground": 
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• В выпадающем списке Geoid (Геоид), выбирается модель геоида, 

которая будет применяться в проекте. Выберите из списка нужную. 
Добавлении модели геоида подробно рассматривается в разделе 
"Добавление модели геоида" на стр. 2-17. 

• В выпадающем списке Coordinate type (Тип координат), 
устанавливается тип представления координат в проекте. Эта 
настройка также доступна в выпадающем списке строки состояния. 

• Если файл модели геоида загружен в проект и геоид покрывает всю 
площадь точек проекта, то 

− ортометрические высоты точек будут показаны, если выбраны 
системы координат “Grid“,“Ground“ или 
“Datum,Lat,Lon,Elevation“. 

В этом случае в колонке Elevation вкладки Points (Точки) 
отображаются ортометрические высоты. 

− геодезические высоты (высоты над эллипсоидом) точек будут 
показаны при выборе систем координат "WGS84,Lat,Lon,Ell.H”
 или “Datum,Lat,Lon, Ell.H“. 

В этом случае в колонке Ell.Height вкладки Points 
отображаются геодезические высоты.  

Добавление специальной проекции 
Для задания специальной проекции: 
1. Щелкните на кнопке Custom (Специальная), расположенной правее 

выпадающего списка Projection. 
2. В окне Custom Projection List (Список специальных проекций) (рис. 

2-18 на стр. 2-13): 

• Щелкните на кнопке Add (Добавить) для добавления 
специальной проекции. 

• Или щелкните на кнопке Remove (Удалить) для удаления 
специальной проекции. 
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Рисунок 2-18. Список специальных проекций 

3. В диалоговом окне New Custom Projection (Новая специальная 
проекция), введите перечисленные ниже данные и щелкните на кнопке 
ОК (рис. 2-19): 

• Name – название проекции. 
• Projection Type (Тип проекции) – выберите из выпадающего 

списка тип проекции Transverse Mercator (Поперечная 
Меркатора), Lambert (Ламберта), Double Stereographic (Двойная 
Стереографическая), Cassini-Soldner (Кассини-Зольднера), 
Stereographic (Стереографическая), Oblique Mercator (Косая 
Меркатора) или Albers Equal Area (Альберса Равных Площадей). 

• Region (Регион) – описание зоны, к которой будет применена эта 
проекция. 

• Notes – произвольные комментарии. 
• Datum – ИГД, на которых будет развита проекция 

Проекция будет добавлена в список доступных для применения 
проекций. 

4. Когда будет завершено задание или удаление специальных проекций, 
щелкните на кнопке Close (Закрыть) окна Custom Projection List. Новые 
проекции будут доступны для выбора в выпадающем списке Projection 
(Проекция). 

 
Рисунок 2-19. Новая специальная проекция 



Работа с проектом 

Topcon Tools- Руководство пользователя 2-14 

Добавление Исходных Геодезических Дат 
Для задания специальных ИГД: 
1. Щелкните на кнопке Custom (Специальные), расположенной правее 

выпадающего списка Datum. 
2. В списке Custom Datum List (Список специальных ИГД) (см. рис. 2-

20): 

• Для добавления специальных ИГД щелкните на кнопке Add 
(Добавить). 

• Для удаления специальных ИГД щелкните на кнопке Remove 
(Удалить). 

 
Рисунок 2-20. Список специальных ИГД 

3. В диалоговом окне New Custom Datum (Новые специальные ИГД), 
введите перечисленные ниже данные и щелкните на кнопке ОК (см. 
рис. 2-21): 

• Name – название ИГД. 

• Ellipsoid – выберите эллипсоид для создания ИГД. 

• DX, DY, DZ – три сдвига вдоль координатных осей. 

• RX, RY, RZ – три угла поворота вокруг осей. 

• Scale – масштабная поправка. 

• Notes – произвольные комментарии. 

 ПРИМЕЧАНИЕ 
Эти семь параметров, связывают координаты точки в 
новых ИГД (new_datum) и WGS-84 по следующей формуле: 
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4. Когда будет завершено задание или удаление специальных ИГД, 
щелкните на кнопке Close (Закрыть) окна Custom Datum List (Список 
специальных ИГД). Новые ИГД будут доступны для выбора в 
выпадающем списке Datum (ИГД). 

 
Рисунок 2-21. Новые ИГД пользователя 

Параметры перехода между СК проекции и 
местной СК 
Местная система координат получается путем масштабирования, 
разворота и сдвига начала счета высот на средний горизонт точек проекта 
плоской прямоугольной СК (СК проекции). Координаты точек в местной СК 
могут быть преобразованы обратно в координаты СК проекции. 
Topcon Tools предлагает два способа ввода параметров перехода от СК 
проекции в местную СК (Grid -> Ground): 
Первый способ: Вращение местной СК производится вокруг начала СК 
проекции. Для этого выберите селективную кнопку Parameters 
(Параметры) (рис. 2-22) и выполните следующие шаги: 

 
Рисунок 2-22. Создание местной СК с использованием параметров 

• Установите величину масштабного фактора, используя один из 
следующих методов: 

1. из выпадающего списка Map Scale 
Factor в окне Grid->Ground, выберите 
Avj Job Height и введите среднюю 
высоту, определенную для всех точек  
проекта и Mapping Scale (масштаб карты).  
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или 
2. из выпадающего списка Map Scale 

Factor, выберите  Scale Factor и 
введите величину масштабного 
коэффициента (Scale Factor). Эта 
величина может быть взята из поля 
Combined Grid to Ground Scale Factor во вкладке Points (Точки).  

 
• Введите смещения в северном и восточном направлениях (Northing/ 

Easting offsets) начала координат местной СК относительно начала 
СК проекции. 

• Введите угол вращения (Azimuth Rotation) между СК проекции и 
местной СК. Этот угол задает направление счета для дирекционных 
углов местной СК. 

Второй способ: Вращение местной СК производится вокруг некоторой 
точки, входящей в проект. Для этого выберите селективную кнопку Ground 
Origin (Начало СК) (рис. 2-23) и выполните следующие шаги: 

 
Рисунок 2-23. Создание местной СК с началом в заданной точке 

• Выберите из списка точек проекта ту, которая будет использоваться 
в качестве начала координат. После выбора точки, в полях Northing/ 
Easting (северная и  восточная координаты), отобразятся 
координаты этой точки в СК проекции. 

• Введите в поля Northing/Easting координаты точки начала в местной 
СК. 

• В поле Ground Azimuth (азимут в местной СК), установите значение 
азимута некоторого направления в местной СК. 

• В поле Grid Azimuth (азимут в СК проекции), установите значение 
азимута того же направления (см. выше) в СК проекции. 

Для вызова окна калькулятора для расчета азимута (используется вместо 
ввода азимута вручную) направления между двумя точками в проекте, 
щелкните на кнопке Compute (Рассчитать), что вызовет появление окна 
Compute Azimuth (Рассчитать азимут). Выберите начальную и 
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конечную точки для расчета направления и введите значение угла, 
которое будет добавлено к азимуту: 

 
Рисунок 2-24. Окно расчета азимута 

Добавление модели геоида 
Если список моделей геоидов пуст, то проделайте перечисленные ниже 
действия: 
1. Щелкните на кнопке Geoid List (Список геоидов), которое вызовет 

появление окна Geoid List, позволяющего импортировать модель 
геоида в Topcon Tools. Щелкните на кнопке Add (Добавить) (рис. 2-25). 

 
Рисунок 2-25. Добавление моделей геоидов в список 
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2. В открывшемся диалоговом окне Open (Открыть), найдите файлы 
геоидов в компьютере и щелкните на кнопке Open (Открыть) для 
добавления новых моделей в список Topcon Tools (рис. 2-26). 

 
Рисунок 2-26. Открытие и добавление моделей геоидов в список 

3. В списке геоидов щелкните по правой кнопке мыши на названии 
выбранного геоида и в появившемся меню выберите пункт Properties 
(Свойства). Появится окно Properties (см. рис. 2-27). 

 
Рисунок 2-27. Список геоидов и диалоговое окно Properties (Свойства) 

В этом окне будут указываться: название геоида, расположение на 
жестком диске компьютера и вершины углов покрываемой площади. 

4. Для удаления модели геоида из списка геоидов Topcon Tools, 
выделите файл и щелкните на кнопке Remove (Удалить). 
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Выбор единиц измерения 
Элемент Units (Единицы измерения) содержит набор линейных и угловых 
единиц измерения для проекта (рис. 2-28). 

 
Рисунок 2-28. Настройка проекта – единицы измерения 

Настройка сохранения проекта 
В элементе Save (Сохранение) устанавливается каталог резервного 
копирования файлов. В нем будут сохраняться файлы с измерениями, 
загруженные из инструментов и интервал автоматического сохранения 
(AutoSave) (рис. 2-29). Автосохранение позволяет предотвратить потерю 
данных. Автосохранение происходит в каталог "C:\Documents and 
Settings\<имя пользователя>\TopconTools\TopconToolsAutoSave". 

 
Рисунок 2-29. Настройка проекта – Сохранение 
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Настройки контроля качества 
Элемент Quality Control (Контроль качества) включает в себя 
перечисленные ниже группы параметров, задающие контроль качества в 
проекте: 

• Во вкладке Point Precisions (Точности точек) устанавливаются 
плановые и высотные допуски точностей пикетов, координаты 
которых получены из статической  кинематической обработки (рис. 
2-30). Если плановые (Std Dev Hz) и высотные (Std Dev u) 
погрешности хуже, чем установленные величины, точки будут 
отображаться красным цветом во вкладке Points (Точки), виде Map 
(Карта) и в отчетах. 

 
Рисунок 2-30. Настройка проекта – точности пикетов 

• Во вкладке TS Obs Precisions (Точности тахеометрической 
съемки) устанавливаются допуски для измерений дальности, 
горизонтального и вертикального углов тахеометрических 
измерений (рис. 2-31 на стр. 2-21). Если величины погрешностей для 
дальности, горизонтального и вертикального углов, полученные из 
сетевого уравнивания по критерию отбраковки по результатам 
контроля качества (Rejection Criterion – By Control), будут превышать 
установленные допуски, то измерения будут отображаться красным 
цветом во вкладке TS Obs (Тахеометрическая съемка), виде Map и 
в отчетах. Эти измерения не будут использоваться при 
окончательном уравнивании сети. 
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Рисунок 2-31. Настройка проекта – допуски на тахеометрические измерения 

• Во вкладке GPS Obs Precisions (Точности GPS измерений) 
устанавливаются допуски для плановой и высотной точности RTK 
местоопределений, а также полученных статическим и 
кинематическим методами камеральной обработки спутниковых 
измерений (см. рис. 2-32 на стр. 2-21). Если величины плановых 

( )( ) ( )( )22 ReRe nses +  и высотных погрешностей для RTK и 
обработанных сеансов, полученные из сетевого уравнивания по 
критерию отбраковки по результатам контроля качества (Rejection 
Criterion – By Control), будут превышать установленные допуски, то 
измерения будут отображены красным цветом во вкладке GPS Obs 
(Спутниковые измерения), в виде Map и в отчетах. Эти измерения 
не будут использоваться при окончательном уравнивании сети. 

 
Рисунок 2-32. Настройка проекта – Точности GPS местоопределений 
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• Во вкладке DL Obs Precisions (Точности нивелирования) 
устанавливаются допуски для нивелирных измерений (рис. 2-33). 
Если величины высотных погрешностей, полученные из сетевого 
уравнивания по критерию отбраковки по результатам контроля 
качества (Rejection Criterion – By Control), будут превышать 
установленные допуски, то измерения будут отображены красным 
цветом во вкладке DL Obs (Нивелирование) и в отчетах. Эти 
измерения не будут использоваться при окончательном уравнивании 
сети. 

 
Рисунок 2-33. Настройка проекта – допуски нивелирования 

• Во вкладке Automatic Tests (Автоматические тесты) определяется 
состав тестов контроля качества, которые будут выполняться в 
фоновом режиме при работе с проектом. Пикеты и сеансы 
измерений, не прошедшие тесты, отображаются красным цветом 
(см. рис. 2-34 на стр. 2-24). Снятие выделения любой кнопки-
флажка, также отменяет красную маркировку и отображение 
текстового описания во вкладке QC диалогового окна Properties 
(Свойства). Если тест выбран, то в первую очередь он применяется 
к уже имеющимся данным, а затем будет применяться в фоновом 
режиме. Доступны следующие тесты контроля качества: 

− Тест Warm Float Solution – местоопределения с “плавающим”  
решением (фазовая неоднозначность не разрешена до целых 
чисел) отображаются красным цветом в видах Table и Map, а 
также в отчетах. 

− Тест RTK Precision - RTK местоопределения с точностью хуже 
параметра точности RTK местоопределений из вкладки 
Precisions (Точности), отображаются красным цветом в видах 
Table и Map, а также в отчетах. 

− Тест PP Static Precision – статические (оба приемника 
неподвижны) местоопределения с точностью хуже параметра 
точности статических местоопределений из вкладки Precisions 
отображаются красным цветом в видах Table и Map, а также в 
отчетах. 
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− Тест PP Kinematic Precision – кинематические (один из 
приемников неподвижен) местоопределения с точностью хуже 
параметра точности кинематических местоопределений из 
вкладки Precisions отображаются красным цветом в видах Table 
и Map, а также в отчетах. 

− Тест Point Standard Deviations - если в процессе уравнивания 
среднеквадратические ошибки координат точек будут хуже 
установленного допуска, то эти точки отображаются красным 
цветом в видах Table и Map, а также в отчетах. Во вкладке 
Quality Control окна Properties для таких точек содержится 
сообщение: “Failed to match the desired precision“ (“Низкая 
точность“). 

− Тест Identical Points (Точки совпадают) состоит в обнаружении 
слишком близко (определяется типом точек и 
соответствующими параметрами из вкладки Precisions) 
расположенных точек. Такие точки отображаются красным 
цветом в видах Table и Map, а также в отчетах. Во вкладке 
Quality Control окна Properties для таких точек содержится 
сообщение: “This point is very close to point <point name>. They 
are probably identical" ("Эта точка очень близка к точке 
<название точки>. Вероятно, что это одна и та же точка"). 

− Тест Misnamed GPS Occupations (Неверно названные сеансы 
спутниковых измерений). Выполняется только для статических 
измерений. Тест отсеивает сеансы измерений, по которым 
местоопределения более чем на 30 м отличаются от координат 
точки и эти сеансы, скорее всего, названы неправильно. Такие 
точки и сеансы отображаются красным цветом в видах Table и 
Map, а также в отчетах. 

− Тест Misnamed Autotopo Rovers (Неверно названные 
кинематические сеансы спутниковых измерений) производится  
только для кинематических измерений. Тест отсеивает сеансы 
измерений, по которым местоопределения более чем на 30 м 
отличаются от координат точки и эти сеансы, скорее всего, 
названы неправильно. Такие точки и сеансы отображаются 
красным цветом в видах Table и Map, а также в отчетах. 
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Рисунок 2-34. Настройка проекта – автоматические тесты 

• Во вкладке Loop Closures (Невязки замкнутых ходов), 
устанавливаются плановые и высотные допуски на невязки 
замкнутых ходов (рис. 2-35). 

 
Рисунок 2-35. Настройка проекта – невязки замкнутых ходов 
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Параметры обработки 
Правая панель элемента Process (Обработка) состоит из перечисленных 
ниже вкладок (см. также "Обработка, уравнивание и трансформирование 
точек" на стр. 6-1): 

• Во вкладке Adjustment (Уравнивание) выставляются уровень 
доверительной вероятности, критерий отбраковки для контроля 
качества и выбираются тесты, проводимые до уравнивания сети 
(рис. 2-36). По умолчанию, уровень доверительной вероятности 
равен 95% и применяется критерий отбраковки By Quality Control (По 
результатам контроля качества). 

 
Рисунок 2-36. Настройка проекта – уравнивание 

• Во вкладке TS – Computations (Тахеометрические расчеты) 
выбирается коэффициент рефракции для измерений электронного 
тахеометра (рис. 2-37). По умолчанию, коэффициент рефракции 
равен 0.14. 

 
Рисунок 2-37.  Настройка проекта – тахеометрические расчеты 
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• Во вкладке GPS+ PostProcess (обработка спутниковых измерений) 
(рис. 2-38) выбирается минимальный угол возвышения, 
используемая спутниковая навигационная система, минимальная 
продолжительность статического сеанса данных (Авто или 
Фиксированное время), включение или отключение режима 
непрерывной кинематики. 

 
Рисунок 2-38. Настройка проекта – обработка спутниковых измерений 

 

Информация о проекте 
Выбор пункта меню Job information (Информация о проекте) вызывает 
появление диалогового окна, в котором содержатся основные данные о 
настройках и установках проекта. 
Для получения доступа к этой информации выберите пункт меню Job > 
Job info (Проект > Информация о проекте). Отобразится диалоговое 
окно Properties (Свойства) текущего проекта (рис. 2-39). При 
необходимости, заполните поля Created by (Кем создан)  и Comments 
(Комментарии). Щелкните на кнопке ОК для сохранения этих данных. 

 
Рисунок 2-39. Свойства проекта 



 

P/N 7010-0612 3-1 

Глава 3  
Импорт данных 
До импорта файла из компьютера или прибора (полевого контроллера) 
откройте проект Topcon Tools. Импортированные данные доступны для 
выбора во всех окнах программы. 

Импорт из файла 
Topcon Tools импортирует файлы следующих форматов: 
 
• Координатные файлы (Coordinate 

files) 
TopSURV Coordinates (*.txt) 
CORS Coordinate files (*.txt) 
CR-5 Files (*.CR5) 
Файлы формата пользователя 
(*.*) 
FC-4 Points (*.xyz, *.fc4, *.pnt) 
FC-5 Points (*.xyz, *.fc5, *.pnt) 
GTS-210/310-10 Points (*.xyz, 
*.pnt) 
GTS-210/310-12 Points (*.xyz, 
*.pnt) 
GTS-7 Points (*.xyz, *.pnt) 
Name,E,N,Z,Code (*.csv) 
Name,Lat,Lon,Ht,Code (*.csv) 
Name,N,E,Z,Code (*.csv) 
NGS Datasheet file (*.htm, 
*.html) 

• Файлы цифровых нивелиров (DL 
Obs File) (*.dl, *.txt, *.lev) 

• Данные Field Orientation (*.foe, 
*.fos) 

• Данные Field Scan (*.fsc) 
• Файлы ГИС (GIS files) 

Shape files (*.shp) 
 

• Файлы цифрового проектирования 
(Design files) 

DWG (*.dwg) 
DXF (*.dxf) 
LandXML (*.xml) 
TN3 Surface (*.tn3) 

• Файлы GPS базисов (GPS Obs Files) 
Файлы формата пользователя (*.*) 
Topcon Vectors (*.tvf) 
TDS RW5 GPS Obs (*.rw5, *.raw) 
Topcon XML GPS Obs (*.xml) 

• Файлы GPS+ измерений (GPS+ Raw 
Data Files) 

Compact RINEX files (*.??D, *.??G, 
*.??N) 
RINEX files (*.??O, *.??G, *.??N) 
SP3 & SPC3 files (*.sp3) 
TPD files (*.tpd) 
TPS / JPS files (*.tps, *jps) 

• Файлы трансформирования 
(Localization Files) (*.gc3) 

• TDS Raw Data Files (*.rw5, *.raw) 
• Проекты Topcon Tools (Topcon Tools 

Jobs) (*.ttp) 
• Файлы Topcon XML (Topcon XML Files) 

(*.xml) 
• Файлы проектов TopSURV PC 

(TopSURV PC Job Files) (*.tlsv) 

(Продолжение таблицы на следующей странице) 
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• Файлы тахеометрических 
измерений (TS Obs Files) 

Файлы формата пользователя 
(*.*) 
FC-5 Raw (*.raw, *.dat, *.fc5) 
GTS-210/310 Raw (*.raw, *.dat, 
*.gts, *.gt6) 
GTS-6 No Station Raw (*.raw, 
*.dat, *.gts, *.gts6, *.gt6) 
GTS-6 Raw (*.raw, *.dat, *.gts, 
*.gts6, *.gt6) 
GTS-7 Raw (*.raw, *.dat, *.gts, 
*.gts7, *.gt7) 
GTS-7+ Raw (*.raw, *.dat, *.gts, 
*.gts7, *.gt7) 
TDS RW5 TS Obs (*.rw5, *.raw) 
Topcon XML TS Obs (*.xml) 
TDS TP5 (*.tp5, *.xlt, *.xst, *.xml) 
Topcon SSS XS-Template (*.xtl) 
Topcon XML X-Section Template 
(*.xml) 
TopSURV XS Template (*.xst) 

 

• Библиотеки кодов (Code Library) 
DBF Code Library File (*.dbf) 
TDD Code Library File (*.tdd) 
XML Code Library File (*.xml) 

• Файлы дорожного проектирования 
(Roads File) 

CLIP Road Files (*.PLT) 
ISPOL Road Files (*.ALI) 
TDS Road Files (*.RD5) 
Topcon MC Road Files (*.RD3) 
Topcon SSS Road Files (*.HAL) 
TopSURV Road Files (*,.THL) 
LandXML Roads (*.xml) 
Topcon XML Roads (*.xml) 
VGP Roads (*.VGP) 

 

 
При импорте файлов, вы можете выбрать сразу несколько файлов одного 
формата: при нажатой клавише Shift клавишами стрелка вверх и стрелка 
вниз выделите файлы, названия которых следуют одно за другим, или, 
удерживая кнопку Ctrl, мышью выделите файлы, размещенные в 
произвольном порядке. Topcon Tools также позволяет переносить файлы в 
текущий проект методом “drag-and-drop” (“перетаскиванием”). 
1. Откройте Topcon Tools и нужный проект. 
2. Запустите Windows Explorer, найдите нужный файл (ы). 
3. Выделите каталог или файл (ы) для импорта. 
4. Выделите и удерживайте при "перетаскивании" файлы в Topcon Tools 

(в вид Карта или Таблица) (см. рис. 3-1 на стр. 3-3). 

• При использовании способа импорта с удержанием левой кнопки 
мыши Topcon Tools пытается автоматически распознать тип и 
формат файла (или всех выделенных файлов или всех файлов в 
выделенном каталоге). 
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Рисунок 3-1. Импорт данных в выбранный проект способом "перетаскивания" 

• При использовании способа импорта с удержанием правой кнопки 
мыши отобразится диалоговое окно Drop options для 
расширенного управления импортом (рис. 3-2). Щелкните на 
кнопке ОК для продолжения. 

− Выберите тип формата. 

− Выставьте флажок Recurse folders для импорта данных из 
всех каталогов, вложенных в выбранный. 

 
Рисунок 3-2. Drop options при импорте данных способом "перетаскивания" 

Если конкретный формат не выбран (при использовании способов 
"перетаскивания" или через пункт меню Import), Topcon Tools будет 
пытаться определить формат файла в зависимости от расширения файла 
и его содержания. 
Обратите внимание, что эта функция не гарантирует абсолютной 
достоверности определения формата файла. Очень хорошо 
определяются типы бинарных файлов, таких как файлы измерений GPS, 
файлы TopSURV и большинство форматов данных тахеометрических 
измерений, но иногда ошибочно определяются типы текстовых файлов, 
особенно списков координат со знаком запятой в качестве разделителя. 
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Импорт файлов – списков 
координат 
Файлы-списки координат используются для ввода и обмена точками с 
известными координатами и кодами. "Name,N,E,Z,Code" ("название, 
северная, восточная координаты, высота, код"), "Name,E,N,Z, Code" 
("название, восточная, северная координаты, высота, код"), "Name, Lat, 
Lon, Ht, Code" ("название, широта, долгота, высота, код"), наиболее 
простые и часто использующиеся файлы-списки координат - со знаком 
запятой в качестве разделителя. Для создания и редактирования таких 
файлов может использоваться любой текстовый редактор. Точки также 
могут быть экспортированы из TopSURV, TopconLink, большинства 
контроллеров третьих производителей, геодезических и ГИС программных 
пакетов. 
Для формата "Name, Lat, Lon, Ht, Code", используется несколько 
форматов задания широты и долготы, включая "[-]dd[d]mm sshhhh[NSEW]" 
и "[-]dd[d].mmsshhhh[NESW], где 'd' градусы, 'm' – минуты, 's' – секунды, 'h' 
– десятичные доли секунд; знак минуса записывается перед широтой 
(долготой) или же используется буква, определяющая часть света: 
N,E,S,W (Север, Восток, Юг, Запад). Этот формат использует две или три 
цифры для градусов, по две для минут и секунд и произвольное 
количество знакомест для долей секунд. 

• Для импорта файла-списка координат в текстовом формате с 
нестандартным форматированием воспользуйтесь "Custom Text 
Format" ("Специальный формат текстового файла") с описанием 
структуры (подробнее см. "Импорт и создание файлов специального 
формата" на стр. 3-8). 

• Формат "TopSURV Coordinates" – это формат файлов-списков 
координат со знаком запятой в качестве разделителя, может быть 
экспортирован из TopSURV и содержит атрибутивную информацию, 
координаты и коды точек. 

• Файлы формата "CR-5" могут быть получены из программного 
обеспечения полевых контроллеров TDS. 

• Форматы "FC-4 Points", "FC-5 Points", "GTS-210/310-10 Points", "GTS-
210/310-12 Points" и "GTS-7 Points" – файлы-списки координат 
тахеометров Topcon. 

• Файлы форматов "CORS Coordinate files" и "NGS Datasheet file", 
могут быть взяты с интернет сайтов CORS и NGS. 

1. Для импорта файла-списка координат в текущий проект Topcon Tools 
выберите пункт меню Job > Import (Проект > Импорт), нажмите 
клавишу F3 или щелкните на кнопке Import (Импорт) 
инструментальной панели. 
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2. Выберите название формата Coordinate File, или же дополнительно 
щелкните по знаку "+" и выберите конкретный тип файла. 

3. Найдите и выделите файл в файловой системе ПК. 
4. Не каждый файл-список координат содержит информацию о единицах 

измерения и типе системы координат. По умолчанию, данные в файле 
считаются приведенными в текущей СК проекта и в установленных в 
настоящий момент единицах измерения. 
Выберите кнопку-флажок Advanced options (Расширенные настройки) 
для установки дополнительных параметров каждого координатного 
формата. Обычные параметры расширенных настроек следующие: 

 
Рисунок 3-3. Расширенные настройки (Advanced options) для файла-списка 

координат формата TopSURV 

Используя Advanced options (Расширенные настройки), установите 
перечисленные ниже параметры открываемого файла: 

• Metric unit (Единицы 
измерения 
расстояний):  
 

• Coordinate type (Система координат):  
 
 
 
 

• В зависимости от 
выбора СК поле ИГД (Datum) дает возможность выбора из 
следующего набора: 

− Если выбрана Ground (местная СК), то выбор ИГД не 
предлагается:  

− Если выбрана Lat, Lon, Ell.H (Широта, Долгота, 
Геодезическая высота) или Lat, Lon, Elevation (Широта, 
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Долгота, Ортометрическая высота) в поле Datum (ИГД) 
появятся ИГД (Исходные Геодезические Даты) проекта и в 
выпадающем списке отобразится список доступных для 
выбора ИГД: 

 
− Если выбрана WGS-84 Lat, Lon, Ell.H (WGS-84 Широта, 

Долгота, Геодезическая высота), то в поле Datum 
предлагается ИГД WGS-84. 

 
• Выбор порядка перечисления координат доступен только при 

выбранной СК Ground (местная СК). 

 
• Тип для всех точек может быть выбран поле Point type. 

 
 

 ПРИМЕЧАНИЕ 
Набор параметров, установленный в проекте, маркирован 
значком Default (По умолчанию):  

Если выбраны настройки по умолчанию, то линейные единицы и СК в 
импортируемом файле-списке координат принимаются равными 
линейным единицам и СК, установленным при настройке проекта. 

Другим форматам файлов-списков координат, которые Topcon Tools 
может импортировать в текущий проект, приписаны другие наборы 
полей Advanced options (Расширенных настроек). Например, 
Advanced options форматов "GTS-210/310-10 Points", "GTS210/310-12 
Points", "Name,E,N,Z,Code", "Name,N,E,Z,Code", "GTS-7 Points", "FC-4 
Points", "FC-5 Points"  имеет следующие поля:  

 
Для этих форматов допускается выбор только тип точек. 
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 ПРИМЕЧАНИЕ 
Поле Coordinate type неактивно для выбора в Advanced 
options,  если проект допускает использование 
единственной системы координат. 

Когда все СК (Ground, Grid, Datum) доступны в проекте, список типов 
координат для файлов-списков координат ("GTS-210/310-10 Points", 
"GTS210/310-12 Points", "Name,E,N,Z,Code", "Name,N,E,Z,Code", "GTS-
7 Points", "FC-4 Points", "FC-5 Points") выглядит следующим образом: 

 
Если выбрана система Grid, то в поле Projection (Проекция) появится 
название СК проекции, установленной для проекта, и существует 
возможность выбора из выпадающего списка других проекций: 

 
5. После щелчка на кнопке Open (Открыть) окна Import (Импорт), 

выбранные файлы-списки координат будут импортированы в проект. 
Данные о введенных точках отображаются во вкладке Points. 

 
Рисунок 3-4. Импорт файлов-списков координат 
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Импорт и создание файлов 
специального формата 
Помимо общепринятых форматов, Topcon Tools также поддерживает 
импорт определенных пользователем форматов текстовых файлов. 
1. Для импорта файла-списка координат в текущий проект Topcon Tools 

выберите пункт меню Job > Import (Проект > Импорт) нажмите 
клавишу F3 или щелкните на кнопке Import (Импорт) 
инструментальной панели. 

2. Выберите название формата Coordinate File и щелкните по знаку "+", 
после чего выберите Custom Text Format (Специальный текстовый 
формат). 

3. Найдите файл в файловой системе ПК и выделите его. 
4. Выберите кнопку-флажок Advanced options (Расширенные настройки) 

(см. рис. 3-5 на стр. 3-9): 

• Задайте тип проекции, ИГД и единицы измерения расстояний. 

• Если кнопка-флажок Orthometric Height (Ортометрическая 
высота) выделена, то все импортируемые высоты считаются 
ортометрическими. В противном случае подразумевается то, 
что в файле приведены геодезические высоты (высоты над 
эллипсоидом). 

• При выборе типа импортируемых точек Control все 
импортируемые точки получат статус исходных пунктов. В 
противном случае, точки будут считаться рядовыми. 

 

 ПРИМЕЧАНИЕ 

По умолчанию, высоты полагаются ортометрическими 
(для СК проекции и местной СК) или геодезическими (для 
представления координат в виде широта/долгота), а 
точкам приписывается статус исходных пунктов. 
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5. Щелкните на кнопке Open (Открыть) (или Save (Сохранить) при 
экспорте) для настройки специального формата. 

 
Рисунок 3-5. Импорт файла специального формата 

6. В диалоговом окне Custom format properties (Свойства 
специального формата) выберите применяемые разделители 
(Delimeters) и тип системы координат (Coordinate system) из 
выпадающих списков (см. рис. 3-6). 

 
Рисунок 3-6. Выбор разделителей и типа системы координат 
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7. Выберите элементы для включения в формат из левой колонки и 
щелкните на кнопке “>>” для добавления в правую колонку (рис. 3-7). 
Используйте кнопку “<<” для удаления выделенных элементов из 
формата. 

 
Рисунок 3-7. Добавление элементов в специальный формат 

8. Для упорядочивания включенных в формат элементов используйте 
кнопки Move Up (Передвинуть вверх) и Move Down (Передвинуть 
вниз). 

9. Если выбрана позиция Ignore first line (Пропустить первую строку), 
то Topcon Tools пропустит первую строку файла. 

10. В зависимости от типа кодов, включаемых в специальный формат, 
выберите нужный вариант: 

• Для полных кодов, содержащих коды, строковые и управляющие 
коды (codes, strings, control), см. рис. 3-8. 

 
Рисунок 3-8. Пример формата файла-списка координат с кодом, 

последовательным кодом и управляющим кодом 



Импорт из файла 

P/N 7010-0612 3-11 

После импорта файла-списка координат этого формата в 
проект для точек будут показаны следующие данные  во 
вкладке CAD (рис. 3-9 на стр.3-11). 

 
Рисунок 3-9. Свойства точки – вкладка CAD 

• На рис. 3-10 показан полный код, содержащий коды и атрибуты. 

 
Рисунок 3-10. Формат файла-списка координат с кодом и атрибутами 

После импорта файла-списка координат этого формата в проект 
для точек будут показаны следующие данные во вкладке CAD: 

 
Рисунок 3-11. Свойства точки – вкладка CAD 

Выставление обеих флажков позволяет включить в 
специальный формат смешанные полные коды; 

 
Рисунок 3-12. Смешанные полные коды 

Если формат файла содержит элемент «полные коды» (Full Codes), то 
этот элемент должен быть последним по списку в правой панели окна 
Custom format properties. 
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Не выбирайте в качестве разделителя пробел (Space) в форматах, 
содержащих коды с атрибутами. Для этих случаев, выбирайте 
запятую, табуляцию или точку с запятой (comma, tab, semicolon). 

11. Задание название и расширение формата включает его в список 
форматов импорта Format name list (рис. 3-13). 

• Если формату не присвоено название или расширение, 
Topcon Tools присвоит произвольное (случайное) название и 
расширение формата пользователя для использования до 
окончания выполнения программы. 

• После присвоения названия новому формату и его сохранения 
им можно пользоваться повторно. 

 
СОВЕТ 

Перед тем, как щелкнуть на кнопке ОК, проверьте 
следующее: "Point Number" всегда должен быть на правой 
панели; "Full Codes" всегда должен быть последним по 
списку и, если формат содержит коды с атрибутами, 
используйте в качестве разделителя запятую, табуляцию 
или точку с запятой (comma, tab, semicolon), а не пробел 
(space). 

12. Щелкните на кнопке ОК для импорта выбранного файла в 
соответствии с настройками формата. 

 
Рисунок 3-13. Ввод имени формата и расширения файла 
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Импорт файлов цифровых 
нивелиров 
Файлы цифровых нивелиров (DL Obs Files), используются для записи 
полевых измерений, полученных из измерений цифровыми нивелирами 
Topcon. 
1. Для импорта файла измерений цифрового нивелира в текущий проект 

Topcon Tools выберите пункт меню Job > Import (Проект > Импорт), 
нажмите клавишу F3 или щелкните на кнопке Import инструментальной 
панели. 

2. Выберите название формата как DL Obs File (Файл цифрового 
нивелира). 

3. Найдите файл в файловой системе ПК и выделите его. Этому типу 
файлов не приписаны специфические Advanced options (Расширенные 
настройки). 

4. Щелкните на кнопке Open (Открыть) для импорта файла (рис. 3-14). 

 
Рисунок 3-14. Импорт файла измерений цифрового нивелира 

Импорт файлов ГИС 
Файлы SHP – это наиболее популярный обменный формат, используемый 
для передачи данных ГИС между различными программными пакетами. 
Это собственный формат ArcInfo™. 
1. Для импорта файла в формате SHP в текущий проект Topcon Tools 

выберите пункт меню Job > Import (Проект > Импорт), нажмите 
клавишу F3 или щелкните на кнопке Import инструментальной панели. 

2. Выберите название формата GIS File  -> SHP (*.shp). 
3. Найдите файл в файловой системе ПК и выделите его. 

SHP файл не содержит информацию о единицах измерения и типе 
системы координат. По умолчанию, данные в SHP файле считаются 
заданными в СК проекта и в принятых в нем единицах измерения.  
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. 
4. Выберите кнопку-флажок Advanced options (Расширенные настройки) 

для настройки дополнительных параметров SHP файла. В 
соответствующем наборе настроек позиции Advanced options 
(Расширенные настройки), отобразятся следующие поля (рис. 3-15): 

 
Рисунок 3-15. Импорт файла формата Shape 

Используя поля Advanced options (Расширенные настройки), 
выделите следующие параметры для открываемого файла: 

• Metric unit 
(Единицы 
измерения 
расстояний):  
 

• Coordinate type 
(система 
координат):  
 

• В зависимости от выбора СК, поле ИГД (Datum), дает 
возможность выбора из следующего набора: 

− Если выбрана Ground (местная СК), то выбор ИГД не 
предлагается:    
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− Если выбрана Lat, Lon, Ell.H (Широта, Долгота, 
Геодезическая высота) или Lat, Lon, Elevation 
(Широта, Долгота, Ортометрическая высота) в поле 
Datum (ИГД) появятся ИГД (Исходные Геодезические 
Даты) проекта и в выпадающем списке отобразится 
список доступных для выбора ИГД: 

 
− Если выбрана WGS-84 Lat, Lon, Ell.H (WGS-84 Широта, 

Долгота, Геодезическая высота) в поле Datum (ИГД) 
появятся ИГД WGS-84. 

 
• Выбор порядка перечисления координат доступен только при 

выбранной СК Ground (местная СК). 

 
 

 ПРИМЕЧАНИЕ 
Набор параметров, установленный в проекте, маркирован 
Default. 

Если выбраны настройки по умолчанию, то линейные единицы и СК в 
импортируемом файле-списке координат принимаются равными 
линейным единицам и СК, установленным при настройке проекта. 

5. После щелчка на кнопке Open (Открыть) окна Import (Импорт) 
выбранные файлы будут импортированы в проект. Данные по 
введенным точкам отображаются во вкладке Points. 

 
Рисунок 3-16. Импорт файла ГИС 
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Импорт файлов 
автоматизированного 
проектирования  
Topcon Tools обеспечивает возможность импорта следующих форматов 
файлов автоматизированного проектирования (Design Data Files): 

• DWG и DXF  
• LandXML  
• TN3 Surface  

Файлы этих форматов могут содержать информацию о точках, линиях и 
поверхностях. Файлы формата LandXML также могут содержать 
информацию об элементах дорог. 
1. Для импорта Design файла в текущий проект Topcon Tools выберите 

пункт меню Job > Import (Проект > Импорт), нажмите клавишу F3 или 
щелкните на кнопке Import (Импорт) инструментальной панели. 

2. Выберите требуемый формат из списка Design форматов. 
3. Найдите файл в файловой системе ПК и выделите его. Обратите 

внимание на то, что файлы этих форматов не содержат данных о 
единицах измерения и типе системы координат. По умолчанию данные 
в файле считаются приведенными в текущей СК проекта и в 
установленных в настоящий момент единицах измерения. 

4. Выбор кнопки-флажка Advanced options (Расширенные настройки) 
позволяет установить дополнительные параметры для любого из типов 
файлов автоматизированного проектирования. Набор настроек 
следующий (рис. 3-17): 

 
Рисунок 3-17. Импорт файла формата Land XML 
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Используя Advanced options (Расширенные настройки), установите 
перечисленные ниже параметры для открываемого файла: 
• Metric unit (Единицы 

измерения 
расстояний):  
 

• Coordinate type (Система координат):  
 
 
 
 

• В зависимости от выбора СК, поле ИГД (Datum), дает 
возможность выбора из следующего набора: 

- Если выбрана Ground (местная СК), то выбор ИГД не 
предлагается:  

- Если выбрана Lat, Lon, Ell.H (Широта, Долгота, 
Геодезическая высота) или Lat, Lon, Elevation (Широта, 
Долгота, Ортометрическая высота) в поле Datum (ИГД) 
появятся ИГД (Исходные Геодезические Даты) проекта и в 
выпадающем списке отобразится список доступных для 
выбора ИГД: 

 
- Если выбрана WGS-84 Lat, Lon, Ell.H (WGS-84 Широта, 

Долгота, Геодезическая высота), то в поле Datum 
предлагается ИГД WGS-84. 

 
• Выбор порядка перечисления координат доступен только при 

выбранной СК Ground (местная СК) 

 
 

 ПРИМЕЧАНИЕ 
Набор параметров, установленный в проекте, маркирован 
Default. 

Если выбраны настройки по умолчанию, то линейные единицы и СК в 
импортируемом файле-списке координат принимаются равными 
линейным единицам и СК, установленным при настройке проекта. 
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5. После щелчка на кнопке Open (Открыть) окна Import (Импорт) 
выбранные файлы будут импортированы в проект. Данные по 
введенным точкам отображаются во вкладках Points (Точки), Linework 
(Линии), Surfaces (Поверхности), Roads (Дороги) (в зависимости от 
содержащихся в файле данных). 

Импорт GPS местоопределений 
Topcon Tools поддерживает импорт файлов спутниковых 
местоопределений  (GPS Obs Files) в следующих форматах: 

• Topcon Vectors 
• Topcon XML GPS Obs 
• TDS RW5 GPS Obs 
• Специального текстового формата  

Формат спутниковых местоопределений (*.tvf) - это простой формат 
данных, разработанный ф. Topcon, предназначается для обмена данными 
местоопределений между различными программными пакетами. 
1. Для импорта GPS Obs файла в текущий проект Topcon Tools выберите 

пункт меню Job > Import (Проект > Импорт), нажмите клавишу F3 или 
щелкните на кнопке Import инструментальной панели. 

2. Выберите требуемый формат из списка форматов GPS Obs Files. 
3. Найдите файл в файловой системе ПК и выделите его. Данные по 

введенным точкам отображаются во вкладках Points (Точки), GPS 
Occupations (сеансы GPS), GPS Observations (GPS измерения). 

4. Щелкните на кнопке Open (Открыть) окна Import (Импорт) для 
импорта выбранного файла (рис. 3-18). 

 
Рисунок 3-18. Импорт файла GPS местоопределений (GPS Obs file) 
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Импорт и создание файлов GPS 
местоопределений специального 
формата 
Topcon Tools также поддерживает импорт файлов GPS местоопределений 
в специальном формате. Импортированные данные доступны для 
просмотра во всех видах. 
1. Для импорта Obs файла в текущий проект Topcon Tools выберите 

пункт меню Job > Import (Проект > Импорт), нажмите клавишу F3 или 
щелкните на кнопке Import (Импорт) инструментальной панели. 

2. В выпадающем списке Format name (Название формата) выберите 
категорию GPS Vector File и подкатегорию Custom Vector Format 
(Специальный формат базисов). 

3. Найдите файл в файловой системе ПК и выделите его. 
4. Выбор кнопки-флажка Advanced options (Расширенные настройки) 

позволяет установить единицы измерения расстояний и способ, 
которым было сделано местоопределение (если он известен). 

5. Щелкните на кнопке Open (Открыть) (или Save (Сохранить) при 
экспорте) для установки свойств формата (рис. 3-19). 

 
Рисунок 3-19. Импорт файла GPS местоопределений специального формата 
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6. В диалоговом окне Custom vector format properties (Свойства 
специального формата GPS местоопределений) выберите 
разделители (Delimeters) из выпадающего списка (см. рис. 3-20). 

 
Рисунок 3-20. Выбор разделителей 

7. Выберите элементы для включения в формат из левой колонки и 
щелкните на кнопке “>>” для добавления в правую колонку (рис. 3-21). 
Используйте кнопку “<<” для удаления выделенных элементов из 
формата. 

 
Рисунок 3-21. Добавление элементов в специальный формат GPS 

местоопределений 

8. Для упорядочивания включенных в формат элементов используйте 
кнопки Move Up (Передвинуть вверх) и Move Down (Передвинуть 
вниз). 

9. Задание названия и расширения формата позволяет включить его в 
список форматов импорта Format name list (рис. 3-21). 

• Если формату не присвоено название или расширение, Topcon 
Tools присвоит произвольное (случайное) название и 
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расширение формата пользователя для использования до 
окончания выполнения программы. 

• После присвоения названия новому формату и его сохранения 
им можно пользоваться повторно. 

10. Щелкните на кнопке ОК для импорта выбранного файла в 
соответствии с настройками формата. 

Импорт файлов с измерениями 
GPS+  
Topcon Tools поддерживает импорт файлов с измерениями GPS+ в 
следующих форматах: 

• RINEX – общепринятый стандартизированный формат записи 
измерений GPS. Для сеанса статических измерений создается 2 или 
3 файла. Расширение первого из них обычно заканчивается 
символом ‘О’ и содержит данные измерений. Расширение второго 
типа обычно заканчивается символом ‘N’ для GPS или ‘G’ для  
ГЛОНАСС, и содержит эфемериды (орбитальные параметры) для 
этого сеанса измерений. Topcon Tools использует файлы с 
эфемеридами автоматически при соблюдении правил по 
наименованию файлов RINEX, и если эти файлы находятся в том же 
каталоге, что и файлы с данными измерений. Если вы именуете 
файлы другим способом, или навигационные файлы находятся в 
другом каталоге, их нужно импортировать отдельно. При отсутствии 
эфемеридных данных обработка измерений невозможна. 

• Compact RINEX (или файлы, сжатые по методу Хатанаки) – это 
видоизмененные файлы измерений RINEX. Расширение этого типа 
файлов заканчивается символом ‘D’. 

• SP3– общепринятый стандартизированный формат точных 
эфемеридных данных, может использоваться Topcon Tools при 
обработке измерений. 

• TPS/JPS - файлы с данными необработанных измерений, 
записываемые приемниками Topcon. 

• TPD – файлы с данными необработанных измерений формата, 
разработанного Topcon, используются для резервного копирования 
или для обмена данными между различными проектами. 

1. Для импорта файла со спутниковыми измерениями в текущий проект 
Topcon Tools выберите пункт меню Job > Import (Проект > Импорт), 
нажмите клавишу F3 или щелкните на кнопке Import (Импорт) 
инструментальной панели. 
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2. В выпадающем списке Format name (Название формата), выберите 
категорию GPS raw data file или щелкните по знаку "+" и выберите 
конкретный формат файла. 

3. Найдите и выделите файл в файловой системе ПК. 
4. Щелкните на кнопке Open (Открыть) для импорта файла. 
На примере, показанном ниже, выделено несколько файлов для импорта. 

 
Рисунок 3-22. Импорт файлов с измерениями GPS 

Импорт файлов трансформации 
Формат *.gc3 разработан Topcon и предназначен для обмена 
координатами и параметрами расчета трансформации (перехода между 
системами координат) между TopSURV, Topcon Tools и программным 
обеспечением систем управления дорожно-строительной техникой 
(Pocket-3D, 3D-Office и т.п.). 
1. Для импорта файла трансформации (Localization file) в текущий проект 

Topcon Tools выберите пункт меню Job > Import (Проект > Импорт), 
нажмите клавишу F3 или щелкните на кнопке Import (Импорт) 
инструментальной панели. 

2. В выпадающем списке Format name (Название формата), выберите 
категорию Localization files (Файлы трансформации). 

3. Найдите файл в файловой системе ПК и выделите его. 
4. Щелкните на кнопке Open (Открыть) для импорта файла (рис. 3-23 на 

стр. 3-23). 
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Рисунок 3-23. Импорт файла трансформации 

Импорт проектов Topcon Tools 
Проект Topcon Tools может быть импортирован в другой проект. 
Например, вы можете выполнять работу каждый день в различных 
проектах, а затем все полученные данные объединить. 
1. Для импорта файла проекта (Topcon Tools job) в текущий проект 

Topcon Tools выберите пункт меню Job > Import (Проект > Импорт), 
нажмите клавишу F3 или щелкните на кнопке Import (Импорт) 
инструментальной панели. 

2. В выпадающем списке Format name (Название формата) выберите 
категорию Topcon Tools job (Проект Topcon Tools). 

3. Найдите и выделите файл в файловой системе ПК. 
4. Щелкните на кнопке Open (Открыть) для импорта файла (рис. 3-24). 

 
Рисунок 3-24. Импорт проекта Topcon Tools (Topcon Tools job) 
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Если набор настроек импортируемого проекта отличается от набора 
настроек проекта, в который производится импорт, то появится 
диалоговое окно Override Job Configuration (Изменение настроек 
проекта). Выберите нужные параметры и щелкните на кнопке ОК (рис. 3-
25). 

 
Рисунок 3-25. Пример сообщения об изменении набора настроек проекта 

 

Импорт файлов Topcon XML 
Файлы Topcon XML в формате XML, могут использоваться для экспорта 
координат, GPS местоопределений, поверхностей, дорог и типовых 
поперечников из Topcon Tools. Этот же формат также может 
использоваться для обмена координатами пикетов и тахеометрическими 
измерениями между проектами. 
1. Для импорта файла Topcon XML в формате XML в текущий проект 

Topcon Tools выберите пункт меню Job > Import (Проект > Импорт), 
нажмите клавишу F3 или щелкните на кнопке Import (Импорт) 
инструментальной панели. 

2. В выпадающем списке Format name (Название формата), выберите 
формат импортируемого файла Topcon XML. 

3. Найдите и выделите файл в файловой системе ПК. 
4. Выберите кнопку-флажок Advanced options (Расширенные настройки) 

(рис. 3-26 на стр. 3-25): задайте СК, тип проекции, ИГД, единицы 
измерения углов и расстояний. 
Обратите внимание, что файлы Topcon XML не содержат информации 
о единицах измерения, типе проекции и ИГД. По умолчанию единицы 
измерения, тип проекции и ИГД для файла формата Topcon XML 
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принимаются равными соответствующим параметрам из настроек 
текущего проекта. 

5. Щелкните на кнопке Open (Открыть) для импорта файла. 

 
Рисунок 3-26. Импорт файла Topcon XML 

Импорт проектов TopSURV PC 
Файлы базы данных TopSURV PC являются рабочими проектами, 
созданными программным обеспечением TopSURV. 
1. Для импорта файла TopSURV PC в текущий проект Topcon Tools 

выберите пункт меню Job > Import (Проект > Импорт), нажмите 
клавишу F3 или щелкните на кнопке Import (Импорт) 
инструментальной панели. 

2. Выберите название формата TopSURV PC File. 
3. Найдите и выделите файл в файловой системе ПК. 
4. Щелкните на кнопке Open (Открыть) для импорта файла (рис. 3-27 на 

стр. 3-26). 
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Рисунок 3-27. Импорт файла TopSURV PC 

Если набор настроек импортируемого проекта отличается от набора 
настроек проекта, в который производится импорт, то появится 
диалоговое окно Override Job Configuration. Выберите нужные параметры 
и щелкните на кнопке ОК (рис. 3-28). 

 
Рисунок 3-28. Пример сообщения об изменении набора настроек проекта 

 ПРИМЕЧАНИЕ 

Проекты Topcon Tools и TopSURV должны применять ту 
же модель геоида для расчета ортометрических высот 
точек, в противном случае высоты точек будут 
рассчитаны неверно (появится окно с соответствующим 
сообщением). 
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Импорт файлов тахеометрических 
измерений 
Файлы тахеометрических измерений (TS Obs Files) предназначены для 
хранения результатов полевых работ, выполненных с использованием 
электронных тахеометров. 
1. Для импорта файла TS Obs в текущий проект Topcon Tools выберите 

пункт меню Job > Import (Проект > Импорт), нажмите клавишу F3 или 
щелкните на кнопке Import (Импорт) инструментальной панели. 

2. В диалоговом окне Import (Импорт) выберите формат TS Obs File   
или щелкните по знаку "+" и выберите конкретный формат файла. 

3. Найдите и выделите файл в файловой системе ПК. 
4. Выберите кнопку-флажок Advanced options (Расширенные настройки) 

(рис. 3-29) и задайте: тип проекции, параметры перехода от СК 
проекции к местной СК, порядок перечисления координат и, если 
известен, тип измерения вертикального угла. 
Обратите внимание на то, что файлы тахеометрических измерений не 
содержат информации о порядке перечисления координат и типе 
проекции. По умолчанию эти параметры считаются равными 
соответствующим настройкам проекта. 
При импорте файла TS Obs в выбранный проект координаты пикетов, 
содержащиеся в файле, будут преобразованы в выбранную систему 
координат проекта. Данные по введенным точкам отображаются во 
вкладках Points (Точки) и TS Obs (Тахеометрия). 

5. Щелкните на кнопке Open (Открыть) для импорта файла. 

 
Рисунок 3-29. Импорт файла тахеометрических измерений (TS Obs File)  
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В электронных тахеометрах вертикальные углы можно измерять двумя 
способами: от зенита (zenith mode) и от горизонта (level mode). После 
импорта TS Obs файла в проект, во вкладке TS Obs появятся значения 
вертикальных углов в следующих колонках: 

• Zenith – вертикальный угол от зенита. 
• Horizontal Level – вертикальный угол от горизонта. 

Файлы измерений тахеометров не содержат информации о режимах 
измерения вертикального угла. Тем не менее, этот режим может быть 
выбран во время импорта TS Obs файла в проект: в поле Horizontal Level 
(рис. 3-30) укажите метод измерения. 

 
Рисунок 3-30. Поле режима измерения вертикального угла при импорте файла 

тахеометра 

 

Импорт и создание 
тахеометрических файлов 
специального формата 
Topcon Tools также поддерживает импорт файлов тахеометрических 
измерений в формате, задаваемом пользователем (TSRaw file). 
Импортированные данные будут доступны для просмотра во всех 
обзорных окнах. 
1. Для импорта файла формата TSRaw в текущий проект Topcon Tools 

выберите пункт меню Job > Import (Проект > Импорт), нажмите 
клавишу F3 или щелкните на кнопке Import (Импорт) 
инструментальной панели. 

2. В выпадающем списке Format name (Название формата) выберите 
категорию TS Raw Data File и в ней выберите Custom TSRaw Format 
(специальный формат тахеометрии). 

3. Найдите и выделите файл в файловой системе ПК. 
4. Выберите кнопку-флажок Advanced options (Расширенные настройки) 

(рис. 3-31 на стр. 3-29): задайте СК, тип проекции, ИГД, единицы 
измерения углов и расстояний, порядок перечисления координат и, 
если известен, тип измерения вертикального угла. 
Обратите внимание на то, что файлы TS Raw Data не содержат 
информации о порядке перечисления координат и типе проекции. По 
умолчанию эти параметры считаются равными соответствующим 
настройкам проекта. 
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При импорте файла TS Raw Data в выбранный проект координаты 
пикетов, содержащиеся в файле, будут преобразованы в выбранную 
СК проекта. Данные по введенным точкам отображаются во вкладке 
Points (Точки). 

5. Щелкните на кнопке Open (Открыть) для импорта. 

 
Рисунок 3-31. Импорт файла тахеометрии специального  формата  (TS Raw Data) 

6. В диалоговом окне TSRaw custom format properties (Свойства 
специального формата тахеометрии) выберите разделители 
(Delimeters) полей в файле из выпадающего списка (см. рис.3-32). 

 
Рисунок 3-32. Выбор разделителя 

7. Выберите элементы для включения в формат из левой колонки и 
щелкните на кнопке “>>” для добавления в правую колонку (рис. 3-33 
на стр. 3-30). Используйте кнопку “<<” для удаления выделенных 
элементов из формата. 
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Рисунок 3-33. Добавление элементов в специальный формат (TSRaw File) 

8. Для упорядочивания включенных в формат элементов, используйте 
кнопки Move Up (Передвинуть вверх) и Move Down (Передвинуть 
вниз). 

9. Задание названия и расширения формата включает его в список 
форматов импорта Format name list (рис. 3-7). 

• Если формату не присвоено название или расширение, Topcon 
Tools присвоит произвольное (случайное) название и 
расширение формата пользователя для использования до 
окончания выполнения программы. 

• После присвоения названия новому формату TSRaw и его 
сохранения им можно пользоваться повторно. 

10. Щелкните на кнопке ОК для импорта выбранного файла в 
соответствии с настройками формата. 
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Импорт файлов дорожного 
проектирования (Road Files) 
Файлы дорожного проектирования содержат данные по дорогам. Topcon 
Tools импортирует дорожные данные в следующих форматах: TopSURV 
(*.THL), 3D-Office (*.RD3), Standard Survey Software (*.HAL), TDS RD5 
(*.RD5), CLIP (*.PLT), ISPOL (*.ALI), LandXML Roads (*.XML), Topcon XML 
Roads (*.xml). Также, могут быть импортированы типовые поперечники 
следующих форматов: Standard Survey Software (*.rd), TopSURV (*.trd) и 
TDS (*.TD5). Импортированные данные будут доступны для выбора во 
всех соответствующих программных окнах. 
1. Для импорта дорожного файла в текущий проект Topcon Tools 

выберите пункт меню Job > Import (Проект > Импорт) нажмите 
клавишу F3 или щелкните на кнопке Import (Импорт) 
инструментальной панели. 

2. Выберите название формата Road File или дополнительно щелкните 
по знаку "+" и выберите конкретный тип файла. 

3. Найдите и выделите файл в файловой системе ПК. 
4. Щелкните на кнопке Open (Открыть) для импорта файла (рис. 3-34). 

 
Рисунок 3-34. Импорт дорожного файла 
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Импорт файлов типовых 
поперечников 
Topcon Tools позволяет импортировать параметры типовых поперечников 
(X-Section Template), сохраненные в следующих форматах: Topcon SSS 
XS-Template (*.xtl), TopSURV XS Template (*.xst), Topcon XML X-Section 
Template (*.xml), TDS TP5 (*.tp5). 
1. Для импорта дорожного файла в текущий проект Topcon Tools 

выберите пункт меню Job > Import (Проект > Импорт), нажмите 
клавишу F3 или щелкните на кнопке Import (Импорт) 
инструментальной панели. 

2. Выберите название формата X-Section Template, или же 
дополнительно щелкните по знаку "+" и выберите конкретный тип 
файла. 

3. Найдите и выделите файл в файловой системе ПК. 
4. Щелкните на кнопке Open (Открыть) для импорта файла. 

 
Рисунок 3-35. Импорт файла типового поперечника (X-Section Template) 



Импорт из устройства 

P/N 7010-0612 3-33 

Импорт из устройства 
Topcon Tools имеет возможность импорта данных из приборов с 
использованием файловый менеджер Windows® Explorer или средства 
самой программы Topcon Tools. 
Начиная импорт файлов напрямую в текущий проект, создайте резервную 
копию импортируемых файлов для полной уверенности в том, что данные 
не будут утеряны. См. раздел "Настройка сохранения проекта" на стр. 2-19. 

Импорт из устройства с помощью 
Windows Explorer 
При установке программы Topcon Tools в компьютере дополнительно 
создаются каталоги инструментов и устройств (рис. 3-36). Каталог "Mobile 
Device" создается после установки на ПК программы Microsoft ActiveSync®. 

 
Рисунок 3-36. Каталоги инструментов и устройств Topcon 

1. Для импорта данных из устройства через Windows Explorer подключите 
устройство к компьютеру, и затем щелкните на соответствующем 
каталоге. При необходимости обратитесь к справочной документации 
устройства для уточнения способа подключения. 

2. При использовании контроллера убедитесь, что программа Microsoft 
ActiveSync® установлена в ПК и она подключилась к устройству. 
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3. Перейдите по дереву каталогов до папки, обозначающей нужное 
устройство и выделите ее при помощи курсора. 

• После обнаружения нужного устройства выполните описанные 
ниже действия; в противном случае продолжите поиск 
подключенных устройств, пока нужное не будет найдено. 

• Для обновления списка подключенных устройств выбранного 
типа, щелкните на элементе Search for connected <device type> 
(Поиск подключенных <тип устройства>). 

• Для тахеометров и цифровых нивелиров, добавьте новое 
устройство при необходимости. 
1. Вызовите выпадающее меню щелчком по правой кнопке мыши 

и выберите пункт Add New <Station or Digital Level> 
(Добавить новый <Тахеометр или Цифровой нивелир>). 

2. Заполните или выберите из выпадающих списков значения 
полей появившегося диалогового окна: Name (Название), Note 
(Примечание), Port (Порт) ПК, к которому подключено 
устройство, и его Model (Тип), а также параметры порта, 
используемого для связи: Baud Rate (Скорость передачи), 
Parity (Четность), Data Bits (длина слова), Stop Bits 
(Количество стоповых бит) и Protocol (Протокол передачи). 

3. Щелкните на кнопке ОК для добавления устройства. 
• Для просмотра информации об обнаруженном устройстве 

вызовите выпадающее меню щелчком по правой кнопке мыши и 
выберите пункт Properties (Свойства). 

4. Когда подключенное устройство будет обнаружено, щелкните на 
каталоге устройства для просмотра имеющихся в нем файлов данных. 
Для электронных тахеометров и цифровых нивелиров, следуйте 
подсказкам контекстного окна. 

5. Для загрузки файлов из устройства в компьютер создайте каталог для 
копируемых файлов и выделите файлы, предназначенные для 
копирования. 

• Для файлов спутниковых приемников используйте метод 
копирования или технику "перетаскивания" в каталог 
копирования. 

• В процессе копирования файлов контроллера в компьютер 
файлы с расширением *.tsv, преобразовываются и получают 
расширение *.tslv. 

6. После импорта файлов из устройств в компьютер, импортируйте их в 
проект Topcon Tools, используя пункт меню Job > Import from Device 
(Проект > Импорт из устройства). Детально этот пункт меню описан в 
разделах: 

• "Импорт из приемника" на стр. 3-35. 
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• "Импорт из контроллера TPS" на стр. 3-37 
• "Импорт из электронного тахеометра" на стр. 3-38 
• "Импорт из цифрового нивелира" на стр. 3-40 
• "Импорт из карты памяти" на стр. 3-42 

Импорт из приемника 
 

 ПРИМЕЧАНИЕ 

Перед подключением приемника к компьютеру по порту 
USB, на ПК следует установить драйвер TPS USB. Этот 
драйвер предоставит продавец оборудования Topcon. 

1. В руководстве пользователя приемника Topcon описана процедура 
подключения к компьютеру. 

• Подключите приемник к компьютеру, используя кабель RS232 или 
USB, а затем включите приемник. 

• Если приемник и компьютер оснащены модулями Bluetooth®, 
используйте этот способ подключения. 

2. Запустите Topcon Tools, откройте проект и выберите пункт меню Job > 
Import from Device (Проект > Импорт из устройства). 

3. В диалоговом окне Import from Device щелкните на кнопке Topcon 
Receivers (Приемники Topcon) (см. рис. 3-37). Topcon Tools будет искать 
все подключенные к компьютеру (по COM или USB портам) приемники. 
Когда поиск будет завершен, появится список всех подключенных 
приемников. 
Для просмотра информации о конкретном приемнике правым щелчком 
мыши вызовите выпадающее меню и выберите пункт Properties 
(Свойства) (рис. 3-37). 
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Рисунок 3-37. Подключенные устройства и их свойства 

4. Для просмотра имеющихся файлов в приемнике щелкните на 
выбранном приемнике. 

5. Для импорта файлов из приемника в текущий проект выделите нужные 
файлы, установите соответствующий формат в поле Format name 
(Название формата) и щелкните на кнопке Open (Открыть) (рис 3-38). 

 
Рисунок 3-38. Выбор файла измерений (Raw Data File) для импорта 

Новые точки из файла GPS данных после успешного импорта в текущий 
проект Topcon Tools отобразятся в видах Map  и CAD и во вкладке Points 
(Точки). Файлы с расширением *.tps будут сохранены в каталоге, указанном 
в настройках проекта в поле Folder For Backup (Каталог резервного 
копирования). 
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Импорт из контроллера TPS 
1. Следуйте указаниям фирмы-производителя контроллера для его 

подключения к компьютеру. 
2. Откройте проект, после чего выберите пункт меню Job > Import from 

Device (Проект > Импорт из устройства). 
3. После того, как программа Microsoft ActiveSync® подключится к 

контроллеру, дважды щелкните по Mobile Device (Мобильное 
устройство) в диалоговом окне Import from Device (рис. 3-39). 
Для просмотра информации о контроллере щелчком по правой кнопке 
мыши вызовите выпадающее меню и выберите пункт Properties 
(Свойства). 

 
Рисунок 3-39. Подключенные устройства и их свойства 

4. Для просмотра имеющихся файлов в контроллере, щелкните по 
каталогу с файлами, имеющими расширение *.tsv. 

5. Для импорта файлов из контроллера в текущий проект и 
преобразования их в формат *.tslv, выделите нужные файлы, 
установите соответствующий формат в поле Format name (Название 
формата), и щелкните на кнопке Open (Открыть) (рис. 3-40). 

 
Рисунок 3-40. Выбор TSV файлов для их преобразования и импорта 

Новые точки и измерения из файла TopSURV после успешного импорта в 
текущий проект Topcon Tools отобразятся в соответствующих таблицах, а 
также видах Map и CAD. Файл будет сохранен в каталоге, указанном в 
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настройках проекта в поле Folder For Backup (Каталог резервного 
копирования). 

Импорт из электронного тахеометра 
При импорте файлов из роботизированного электронного тахеометра 
передача данных должна быть инициирована из тахеометра после того, как 
он будет подключен к компьютеру. Процедура подключения к компьютеру 
описана в справочном руководстве электронного тахеометра. 
1. Откройте проект, после чего выберите пункт меню Job > Import from 

Device (Проект > Импорт из устройства). 
2. В диалоговом окне Import from Device дважды щелкните по Topcon 

Total Stations (Тахеометры Topcon). 
3. Для добавления нового типа тахеометра щелкните по правой кнопке 

мыши на пункте Add New Station (Добавить новый Тахеометр) и 
выберите Create Station (Создать Тахеометр) (см. рис. 3-41). 

 
Рисунок 3-41. Добавление нового типа тахеометра 

4. Заполните поля  Name (Название), Note (Примечание), Port (Порт) 
компьютера к которому будет подключено устройство, и Model (Модель). 
А также параметры, используемые для связи: Baud Rate (Скорость 
передачи), Parity (Четность), Data Bits (Длина слова), Stop Bits 
(Количество стоп-бит) и Protocol (Протокол передачи) (рис. 3-42). 
Щелкните на кнопке ОК для добавления устройства. 

 
Рисунок 3-42. Свойства тахеометра 
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5. Дважды щелкните по значку тахеометра для импорта координат и 
измерений из устройства в текущий проект. 

6. В диалоговом окне Import from Device (Импорт из устройства), 
введите название файла, например, "file.txt" и выберите тип файла. 

 
Рисунок 3-43. Импорт из электронного тахеометра 

7. Следуйте шагам, указанным в диалоговом окне Download File From 
Total Station (Загрузка файла из тахеометра) (рис. 3-44). 

8. Выделите файл в тахеометре, предназначенный для передачи в 
компьютер. 

9. Щелкните на кнопке Start (Старт) в диалоговом окне Download File 
From Total Station (Загрузка файла из тахеометра). Когда данные 
будут готовы к передаче в компьютер, нажмите клавишу F3. 

 
Рисунок 3-44. Инструкции для тахеометра – подготовка к импорту 

Новые точки из файла тахеометра после успешного импорта в 
текущий проект Topcon Tools, отобразятся в программных окнах 
Карта (Map view) и CAD (CAD view) и во вкладках Points (Точки) и TS 
Obs (Тахеометрия) окна Таблица (Tab view). Файл "file.txt", должен 
быть сохранен в каталоге, указанном в настройках проекта в поле 
Folder For Backup (Каталог резервного копирования). 
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Импорт из цифрового нивелира 
При импорте файлов из цифрового нивелира передача данных должна 
быть инициирована из нивелира после того, как он будет подключен к 
компьютеру. Обратитесь к справочному руководству цифрового нивелира 
Topcon для ознакомления с процедурой подключения к компьютеру. 
1. Откройте проект, после чего выберите пункт меню Job > Import from 

Device (Проект > Импорт из устройства). 
2. В диалоговом окне Import from Device дважды щелкните по Topcon 

Topcon Digital Levels (Нивелиры Topcon) (рис. 3-45). 
3. Для добавления нового типа нивелира щелкните по правой кнопке 

мыши на пункте Add New Station и выберите Create Digital Level (см. 
рис. 3-45). 

 
Рисунок 3-45. Добавление нового типа нивелира 

4. Заполните поля Name (Название), Port (Порт) компьютера к которому 
будет подключено устройство, Baud Rate (Скорость передачи), Parity 
(Четность), (см. рис. 3-46). Щелкните на кнопке ОК для добавления 
устройства. 

 
Рисунок 3-46. Свойства цифрового нивелира 

5. Дважды щелкните по значку нивелира (рис. 3-47 на стр. 3-41). 
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6. В диалоговом окне Import from Device (Импорт из устройства), 
введите название файла, например "file.dl" и выберите тип файла "DL 
Raw Data File". 

 
Рисунок 3-47. Импорт из цифрового нивелира 

7. Следуйте шагам, указанным в диалоговом окне Download File From 
Digital Level (Загрузка файла из нивелира). 

8. Выделите файл в тахеометре, предназначенный для передачи в 
компьютер (см. рис. 3-48). 

 
Рисунок 3-48. Инструкции для цифрового нивелира – подготовка к импорту 

Новые точки из нивелира после успешного импорта в текущий проект 
Topcon Tools отобразятся во вкладках Points (Точки) и DL Obs 
(Нивелирование). Файл "file.dl", будет сохранен в каталоге, указанном в 
настройках проекта в поле Folder For Backup (Каталог резервного 
копирования). 
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Импорт из карты памяти 
Для импорта данных из карты памяти (Memory Card), используя проводник 
Window Explorer, проделайте следующие шаги: 
1. Вставьте карту памяти приемника (SD card) в соответствующий слот 

компьютера. 
2. Откройте проект, после чего выберите пункт меню Job > Import from 

Device (Проект > Импорт из устройства). 
3. В диалоговом окне Import from Device, выберите Memory Card (Карта 

памяти). Если карта памяти была форматирована в файловой системе 
приемника, значок диска, назначенного в качестве карты памяти Topcon 
(Topcon Memory Card), будет красного цвета (рис. 3-49). 

4. Для просмотра файлов полевых данных на карте памяти щелкните по 
иконке диска. После проверки файловой системы отобразится список 
файлов с расширением *.tps. 

 
Рисунок 3-49. Импорт из карты памяти 

5. Для импорта файлов из карты памяти в текущий проект выделите 
нужные файлы, выберите формат TPS в поле Format name (Название  
формата), и щелкните на кнопке Open (Открыть). 
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6. Если карта памяти была форматирована в другой файловой системе, 
значок карты памяти отображается в сером цвете. В этом случае Topcon 
Tools не сможет прочитать информацию. Для форматирования карты 
памяти, дважды щелкните по иконке карты памяти и щелкните на кнопке 
Yes (Да): 

 
Рисунок 3-50. Неформатированная карта памяти 
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Для заметок: 
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Глава 4  
Просмотр, выбор и 
фильтрация данных  
При открытии проекта Topcon Tools становятся доступными несколько 
видов представления информации. Карта пикетов и спутниковых 
определений, а также табличное представление данных измерений 
представляет проект в разнообразных видах, каждый из которых 
оптимален для определенного рода обработки. Печать каждого вида дает 
возможность детального анализа. 

Виды представления данных в Topcon Tools являются интерактивными и 
данные, выбранные в одном виде, также становятся выбранными во всех 
открытых  видах. Выбор данных также дает доступ к другим функциям, 
например изменение свойств или параметров. Данные проекта могут быть 
выбраны с использованием функции фильтрации по типу, времени или 
коду. 

Строка меню и инструментальная панель обеспечивают доступ к видам и 
функциям Topcon Tools. Эти элементы пользовательского интерфейса 
могут быть настроены для доступа к видам и выбору данных в 
соответствии с предпочтениями пользователя. 

Виды представления данных 
Topcon Tools предоставляет несколько видов представления данных для 
их редактирования и обработки. 

• Табличный вид или вид Таблица (Tabular view) – содержит таблицы 
с информацией по точкам, сеансам спутниковых измерений и 
результатам их обработки, линиям, дорогам, типовым 
поперечникам, поверхностям, обмерам рулеткой, изображениям, 
стереопарам и сеансам сканирования проекта. 

• Вид Карта (Map view) дает графическое представление точек и 
спутниковых местоопределений проекта. 

• Вид Сеансы [спутниковых измерений] (Occupation view) – временной 
график сеансов спутниковых измерений.
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• Вид CAD (CAD view) отображает линии, дороги и поверхности в 
различных слоях. Объекты отображаются в соответствии с 
настройками слоев (цвет/толщина/стиль). Выбор соответствующего 
атрибута в слое или при помощи фильтрации позволяет показывать 
или скрывать объекты слоя. 

• Вид 3D (3D view) представляет линии, поверхности и дороги в 
перспективном изображении. Цвета поверхностей и дорог 
отображаются в соответствии с цветом слоя поверхности. Цвета 
линий можно установить. 

• Вид Коды (Codes view) представляет собой список всех кодов 
проекта и их атрибутов. Этот вид также используется для 
добавления новых кодов. 

• Вид Слои (Layers view) показывает список всех слоев проекта и их 
параметров. Этот вид также используется также для добавления 
новых слоев. 

Пикеты, сеансы спутниковых измерений, спутниковые местоопределения и 
прочие измерения обозначены разнообразными кодированными 
символами и цветами, что обеспечивает наглядное представление 
информации. Окна Legend (Легенда) в видах Карта и Сеансы содержат 
описание применяемых обозначений. 

Вид Таблица 
По умолчанию вид Таблица открывается при открытии проекта. Для 
вызова или закрытия окна Таблица выберите пункт меню View > Tabular 
View (Вид > Таблица), воспользуйтесь комбинацей клавиш Ctrl+T или 
щелкните на кнопке Tabular View (Таблица) инструментальной панели. 

Вид Таблица содержит вкладки с различными типами данных. Типы 
данных в проекте определяют отображаемые вкладки. Вкладка Points 
(Точки) отображается всегда. 

• Points (Точки) содержит названия точек (пикетов), их координаты и 
относящуюся к ним информацию. 

• GPS Occupations (Сеансы спутниковых измерений) содержит 
названия точек, информацию по антеннам, продолжительность, 
метод измерения, расположение файла в компьютере и 
идентификационный номер приемника (Receiver ID). 

• TS Observations (Тахеометрические измерения) содержит названия 
станций стояния и пикетов, высоты инструмента и отражателя, 
измеренные величины, невязки уравнивания и другие данные о 
точках тахеометрических измерений. 
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• GPS Observations (GPS Местоопределения) – содержит названия 
исходных и определяемых пунктов, время наблюдения, приращения 
координат и другую информацию о решении, невязках уравнивания и 
прочие характеристики. 

• Tape Dimensions (Обмеры рулеткой) – содержит информацию о 
начальной и конечной точках периметра, номера пунктов измерений, 
измеренные расстояния и дату измерений. 

• Linework (Линии) – содержит коды, слои, печатные стили, 
порядковые номера и информацию о начальной и конечной точках 
для вида CAD.  

• Images (Изображения) – содержит изображения, связанные с 
точками, линиями и поверхностями. 

• Surfaces (Поверхности) – содержит названия поверхностей, 
количество точек, количество треугольников, минимальные и 
максимальные значения северной, восточной координат и высоты, 
другие данные по всем поверхностям проекта. 

• DL (Нивелирование) – содержит названия станций нивелирных 
наблюдений, полные длины ходов, дату производства измерений, 
порядок выполнения измерений в проекте, типы измерений, невязки 
и прочую информацию о нивелировании. 

• Roads (Дороги) – отображает плановое положение и профили 
осевой линии дороги и поперечников. 

• X-Section Templates (Типовые поперечники) – содержит созданные 
или импортированные типовые поперечники, которые могут быть 
использованы при создании проекта дороги. 

• Stereopairs (Стереопары) – содержит стереопары в 
ориентированном и стерео видах, а также точки, линии и 
поверхности на стереопарах. 

• Scan Session (Сеансы сканирования) – отображает сеансы 
сканирования, линии, поверхности и присоединенные изображения. 
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Points (вкладка Точки) 
Выберите вкладку Points (Точки). Таблица состоит их следующих 
столбцов (см. рис. 4-1): 

• Icon (Пиктограмма) – символьное представление точки. 
• Name (Название) – название точки. 
• Point coordinates (Координаты точки) – колонки с координатами 

точек. Тип координат определяется настройками проекта. 
• Code (Код) – первичный код точек. 
• Control (Контроль) – состояние точки (опорная или подлежащая 

уравниванию). 
• Note (Примечание) – комментарии пользователя. 
• Photo Notes (Фото примечание) – фотоизображение, использованное 

в качестве примечания. 
• Layer (Слой) – название слоя, в котором находится точка. 
• Standard Deviations (Среднеквадратическое отклонение) – 

среднеквадратическое отклонение для точки, полученное после 
уравнивания, выражено в установленных для проекта единицах 
измерения. 

• String and Control Code (Строковый и Контрольный коды) – поля, 
используемые при создании линий задействуются при экспорте 
данных в форматы ГИС (DWG, DXF). 

• Combined Scale Factor (Комбинированный масштабный 
коэффициент) – масштабный коэффициент, применяемый при 
пересчете расстояний из картографической проекции в местную СК. 

• Convergence (Сближение меридианов) – угол между направлением 
геодезического меридиана и направлением оси абсцисс 
используемой проекции. 

 
Рисунок 4-1. Вкладка Точки (Points Tab) 

Щелчком по заголовку таблицы можно отсортировать ее содержимое в 
прямом или обратном алфавитном порядке по названиям точек, или по 
координатам в порядке уменьшения или увеличения. 
Редактирование содержимого таблицы (кроме столбца Std.Dev. (СКО), 
который редактированию не подлежит) описано в разделе 
“Редактирование в табличном виде” на стр. 5-1. 
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GPS Occupations (вкладка Сеансы 
Спутниковых Измерений) 
Вкладка GPS Occupations отображается, если проект содержит данные 
спутниковых измерений и в Topcon Tools разрешены к использованию 
модули PP, RTK или GIS. 
Щелкните на вкладке GPS Occupations для просмотра данных по сеансам 
спутниковых измерений (рис. 4-2 на стр. 4-6). 
Таблица состоит из следующих колонок: 

• Icon (Пиктограмма) – символьное представление сеанса. 
• Point Name (Название точки) – название точки (пункта) стояния. 
• Original Name (Исходное название точки) – первоначальное 

название точки. 
• Antenna Type (Тип антенны) – используемый при измерении тип 

антенны. 
• Antenna Height (Высота антенны) – измеренная высота антенны над 

точкой. 
• Antenna Height Method (Метод измерения высоты антенны) – 

используемый метод измерения высоты антенны над точкой. Может 
быть наклонным измерением (Slant) или вертикальным (Vertical).  

• Start Time and Stop Time (Время начала и конца сеанса) – 
отображаются начальные и конечные даты в формате 
день/месяц/год и моменты времени первой и последней эпох сеанса 
измерений. 

• Duration (Продолжительность) – продолжительность сеанса, 
вычисленная по формуле: продолжительность = время окончания 
сеанса – время его начала.  

• Method (Метод) – метод геодезической съемки, используемый при 
производстве измерений: Static, Stop-and-Go, Kinematic, RTK (RTK 
base, RTK Topo, RTK Autotopo) или Autonomous. 

• Note (Примечание) – комментарии пользователя. 
• Source (Источник данных) – информация о размещении файла с 

измерениями на жестком диске компьютера, в локальной 
компьютерной сети или на съемном носителе. 

• Interval (Интервал) – интервал записи данных в сеансе. 
• Receiver (Приемник) – идентификационный номер использованного 

приемника. 
• Offset Azimuth (Смещение по азимуту) – элемент приведения 

фазового центра антенны к центру знака – азимут опорного 
направления. Далее перечислены остальные элементы приведения. 

• Offset Dist (Смещение по дальности) – смещение в плане вдоль 
опорного направления. 

• Offset dHt (смещение по высоте) – высота над центром. 
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• Offset Across (Смещение поперек)– смещение в плане 
перпендикулярно опорному направлению. 

Рисунок 4-2. Вкладка сеансы спутниковых измерений (GPS Occupations) 

Щелчком по заголовку таблицы можно отсортировать ее содержимое в 
прямом или обратном алфавитном порядке по названиям точек, типам 
антенн и номерам приемников или по координатам (или времени) в 
порядке уменьшения или увеличения. 
Редактирование данных во вкладке GPS Occupations (колонки Start Time, 
Stop Time, Duration, Method, Source и Receiver редактированию не 
подлежат) описано в разделе “Редактирование в табличном виде” на стр. 
5-1. 

TS Obs (вкладка Тахеометрия) 
Вкладка TS Obs (Тахеометрия) отображается только при  наличии данных 
тахеометрических измерений и разрешенном к применению модуле 
Topcon Tools TS. 
Щелкните на вкладке TS Obs (Тахеометрия) для просмотра информации 
по тахеометрическим измерениям (рис. 4-3 на стр. 4-7). 
В таблице вкладки TS Obs (Тахеометрия), могут присутствовать 
следующие столбцы: 

• Icon (Пиктограмма) – символьное представление измерения. 

• # (№) – номер точки. 

• Point Name (Название точки) – название точки (пункта) стояния. 

• Instrument Height (Высота инструмента) – измеренная высота 
инструмента над центром. 

• Instrument Type (Тип прибора) – тип используемого прибора.  

• Point From and Point To (Начальная и Конечная точки) – точка 
стояния и точка, на которую производится измерение. 

• Reflector height (Высота отражателя) – измеренная высота 
отражателя.  

• Azimuth (Азимут) – (если задан) азимут направления. 
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• Measured values (Измеренные величины) – в зависимости от 
выбранных параметров диалогового окна могут быть отображены 
следующие величины: Horizontal Circle (горизонтальный угол или 
ГУ), Vertical Angle (вертикальный угол или ВУ), Zenith Angle 
(зенитное расстояние), Slope Distance (наклонное расстояние), 
Horizontal Distance (горизонтальное проложение), Vertical Distance 
(Превышение). 

• Date (Дата) – дата проведения измерения. 
• Note (Примечание) – комментарии пользователя. 
• Code (Код) - первичный код точки. 
• Type (Тип) – тип измерения (BS, SS, FS, BKB или обратная засечка). 
• Auto Reject (Автоматическая отбраковка) – разрешение 

автоматически отбраковывать измерения по результатам 
уравнивания. 

• Adjustment status (Уравнивание) – указатель того, что измерение 
было уравнено, не было уравнено, отключено или отбраковано. 

• Azimuth Residual (Азимутальная ошибка) – невязка по азимуту, 
полученная в процессе уравнивания. 

• Residuals (Невязки) - в зависимости от выбранных параметров в 
диалоговом окне Options (Опции) могут быть отображены 
следующие невязки: Horizontal Circle Residual (невязка 
горизонтального угла), Vertical Angle Residual (невязка вертикального 
угла, Zenith Angle Residual (невязка зенитного расстояния), Slope 
Distance Residual (невязка наклонного расстояния), Horizontal 
Distance Residual (невязка горизонтального проложения), Vertical 
Distance Residual (невязка превышения). 

 
Рисунок 4-3. Вкладка Тахеометрия (TS Obs) 

Щелчком по заголовку таблицы можно отсортировать ее содержимое в 
прямом или обратном алфавитном порядке. 
Для редактирования данных во вкладке TS Obs (Тахеометрия) (колонки 
Point From, все типы измерений, Date, Type, Adjustment status и Residuals 
редактированию не подлежат) см. раздел “Редактирование в табличном 
виде” на стр. 5-1. 
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GPS Observations (вкладка базисы GPS) 
Вкладка GPS Obs отображается, если проект содержит данные 
спутниковых измерений и в Topcon Tools разрешены к использованию 
модули PP, RTK или GIS. 
Щелкните на вкладке GPS Obs для просмотра данных по 
местоопределениям, полученным после обработки сеансов спутниковых 
измерений (рис. 4-4 на стр. 4-9). 
Таблица состоит из следующих столбцов: 

• Icon (Пиктограмма) – символьное представление местоопределения. 
• Point From, Point To (Начальная и Конечная точки) – опорная и 

определяемая точки. 
• Start Time (Время начала) – время первой общей эпохи наблюдения 

базиса. 
• Duration (Продолжительность) – продолжительность наблюдения 

базиса.  
• Note (Примечание) – комментарии пользователя. 
• Horizontal Precisions, Vertical Precisions (точность в плане и по 

высоте)  – данные о достигнутых в результате определения базиса 
плановых и высотных точностях. 

• GPS observations solution components (Компоненты базиса, 
полученные по GPS) – отображаются приращения координат 
определяемого базиса в нескольких вариантах отображения: 
север/восток/превышение, x/y/z, азимут/превышение/длина. 
ПРИМЕЧАНИЕ: метод PP дает координаты центров пунктов базиса, 
метод RTK – координаты фазовых центров антенн (элементы 
приведения не учитываются). 

• Method (Метод) – метод измерений, использованный при съемке. 
• Solution type (Тип/метод решения) – тип решения, примененный для 

определения базиса. Варианты: Fixed (Фиксированное) – все 
фазовые неоднозначности разрешены до целых величин, Float 
(Плавающее) – оцениваемые неоднозначности не разрешены до 
целых величин, Fixed/ Float (смешанное решение) или mmGPS для 
RTK решения при использовании технологии mmGPS. 

• Orbit (Набор эфемеридных данных) – если базис еще не 
обрабатывался, отображаются доступные варианты наборов 
эфемеридных данных, которые можно использовать при обработке 
(Broadcast, Precise или None), если базис уже определен, 
отображается тип использованного в решении набора эфемеридных 
данных. Не применяется для RTK обработки. 

• AutoReject (Автоматическая отбраковка) – разрешение 
автоматически отбраковывать базис по результатам уравнивания. 
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• Adjustment status (Статус уравнивания) – указатель того, что базис 
был уравнен, не был уравнен, отключен или отбракован. 

• Residuals (Невязки) – ошибки компонент базиса после уравнивания в 
нескольких вариантах отображения: Res n/ Res e/Res u, Res x/ Res y/ 
Res z или Res Az/ Res El/ Res Dist. 

• Epochs (Эпохи) – количество эпох спутниковых измерений, 
используемое в определении базиса. 

• GPS Satellites / GLONASS Satellites (спутники  GPS / ГЛОНАСС) – 
количество спутников GPS и  ГЛОНАСС. Для RTK базисов дается 
общее количество спутников одновременно наблюденных на  
базовом и мобильном пунктах в последнюю общую эпоху. Для 
базисов, полученных методом PP, дается общее количество 
отслеживаемых спутников на протяжении всего сеанса наблюдений. 

• HDOP/VDOP – плановый/высотный геометрические факторы 
ухудшения точности в последнюю общую наблюденную эпоху для 
RTK базисов (данные берутся из проекта TopSURV с данными RTK 
съемки). 

Для базисов, предназначенных для РР обработки, компоненты решения, 
точности и тип решения отображаются только после проведения 
обработки. 

Рисунок 4-4. Вкладка базисы GPS (GPS Obs) 

Щелчком по заголовку таблицы можно отсортировать ее содержимое в 
прямом или обратном алфавитном порядке, а также  в порядке 
уменьшения или увеличения (время, продолжительность). 
Редактирования информации в таблице GPS Obs (колонки Point From, 
Point To, Start Time, Duration, Precisions, GPS observations, Method, Solution 
type, Orbit, Adjustment status и Residuals редактированию не подлежат) 
описано в разделе “Редактирование в табличном виде” на стр. 5-1. 



Просмотр, выбор и фильтрация данных 

Topcon Tools- Руководство пользователя 4-10 

Tape Dimensions (вкладка Обмеры) 
Вкладка Tape Dimensions (Обмеры) отображается только при  наличии 
данных обмеров рулеткой и разрешенном к использованию модуле Topcon 
Tools TS. На рисунке 4-5 показан пример обмеров. 

 
Рисунок 4-5. Пример обмеров 

Щелкните на вкладке Tape Dimensions (Обмеры)  для просмотра 
информации по обмерам  (рис. 4-6 на стр. 4-11). 
Вкладка Tape Dimensions (Обмеры) содержит две панели. В левой панели 
отображается начальная и конечная точки, а в правой все измерения. 
Вкладка Tape Dimensions (Обмеры) может состоять из перечисленных 
ниже колонок: 

• Icon (Пиктограмма) – символьное представление измерения лентой 
(рулеткой). 

• Start Point (Название начальной точки) – название точки начала 
обмера (точка с известными координатами). 

• End Point (Название конечной точки) – название точки конца обмера 
(точка с известными координатами). 

• # (номер точки) – номер точки.  
• Point To (До точки) – конец базиса. 
• Distance (Длина) – измеренное расстояние, где каждый 

последующий отрезок ортогонален (расположен под углом 90° к 
предыдущему) отрезку. При этом отрезку, находящемуся слева от 
предыдущего, приписывается длина со знаком минус, справа – со 
знаком плюс. 

• Date (Дата) – дата проведения измерения. 
• Note (Примечание) – комментарии пользователя. 
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Рисунок 4-6. Вкладка Обмеры (Tape Dimensions Tab) 

Щелчком по заголовку таблицы можно отсортировать ее содержимое в 
прямом или обратном алфавитном порядке, а также  в порядке 
уменьшения или увеличения (время, длина). 
Редактирование информации во вкладке Tape Dimensions (Обмеры) 
(колонка Date редактированию не подлежит) описано в разделе 
“Редактирование в табличном виде” на стр. 5-1. 

Linework (вкладка Линии) 
Вкладка Linework (Линии) отображается при наличии в проекте линейных 
(или составленных из нескольких линий) объектов. 
Щелкните на вкладке Linework для просмотра данных (см. рис. 4-7 на стр. 
4-12). 
Вкладка Linework (Линии) содержит две панели. В левой панели 
отображаются все линии (коды, слои и печатные стили) проекта, а в 
правой - все сегменты выделенной линии. Таблица Linework состоит из  
следующих столбцов: 

• Icon (Пиктограмма) – символьное представление линии или ее 
сегмента. 

• Layer (Слой) – слой, в котором расположена выбранная линия. 

• Code/String (Код/Строковый код) – первичный и управляющий коды, 
использованные для линии или ее сегмента. 

• Color/Line Style/ Line Width (Цвет/Стиль/Толщина) – стиль 
отображения выбранной линии.  

• Type (Тип) – тип выбранной линии или площади. Если выбрана 
площадь, то линия, содержащая более одного сегмента, будет 
замкнута автоматически. 

• Length (Длина) – полное горизонтальное проложение линии в 
выбранной системе координат. 
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• Order (Порядок) – порядковый номер точки (вершины  сегмента) в 
выбранной линии. 

• Point (Точка) – название точки - вершины линии. 

• Control Code (Контрольный код) – контрольный код для вершины. 
- Arc Start (Начало дуги): начальная точка дуги. 
- Arc End (Конец дуги): конечная точка дуги. 
- Rectangle (Прямоугольник): если выбраны три точки, Topcon 

Tools рассчитает координаты четвертой точки и свяжет все 
четыре точки в четырехугольник. 

- Close (Завершение): последняя точка замкнутой линии. 

Рисунок 4-7. Вкладка Линии (Linework) 

Щелчком по заголовку таблицы можно отсортировать ее содержимое в 
прямом или обратном алфавитном порядке (по полю Код), а также  в 
порядке уменьшения или увеличения (по полю Порядок). 
Редактирования информации в таблице Linework (колонка Date 
редактированию не подлежит) описано в  разделе “Редактирование в 
табличном виде” на стр. 5-1. 
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Images (вкладка Изображения) 
Вкладка Images отображается только тогда, когда проект содержит 
данные, связанные с изображениями, например примечания, сделанные 
для фотографии на точке или данные измерений электронного тахеометра 
GPT-7000i в том случае, когда в Topcon Tools разрешены к использованию 
модули TS или Imaging. 

 ПРИМЕЧАНИЕ 
При копировании 
проекта TopSURV PC 
вручную в текущий 
проект Topcon Tools, 
удостоверьтесь, что 
подкаталог с 
изображениями и 
файл *.tlsv, 
расположены в одном 
каталоге. 

Щелкните на вкладке Images для просмотра данных (рис. 4-8). 
Таблица Images (Изображения) состоит из двух панелей: 

• В левой панели отображаются эскизы всех изображений в файле.  
Изображений в панели приводятся в возрастающем порядке 
(алфавитном или цифровом) названий. 

• В правой панели отображается выбранное изображение с 
измеренными точками, линиями и поверхностями, содержащимися 
на фотографии. Символы точек и линий соответствуют настройкам в 
окне Layers (Слои), вызываемой из инструментальной панели. 

 
Рисунок 4-8. Вкладка Изображения (Images) 

Методика редактирования в правой панели вкладки Изображения 
изложена в разделе “Редактирование в табличном виде”  на стр. 5-1.  
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Stereopairs (вкладка Стереопары) 
Вкладка Stereopairs (Стереопары) отображается, если проект содержит 
стереопары и в Topcon Tools разрешен к использованию модуль Image. 
Стереопары могут быть импортированы из электронного тахеометра 
(GPT-7000i) или созданы из отдельных фотоизображений во вкладке 
Images (Изображения). Во вкладке Stereopairs (Стереопары) возможно 
представление в ориентированном и стереоскопическом видах. 
В виде Orientation View (Ориентированный вид) каждое изображение 
стереопары отображается, как исходное изображение, взятое с некоторым 
углом к базовой линии, связывающей съемочные точки. 
В виде Stereo View (Стереоскопический вид) каждое изображение из 
стереопары трансформировано по данным ориентации снимка. 
Изображения трансформируются на плоскость, параллельную базису на 
основании данных внешнего ориентирования (координаты станций точек 
фотографирования, вертикальные и горизонтальные углы оси 
фотографирования). В этом случае оба изображения ориентированы по 
оси Y. Это означает, что в стереоскопическом представлении виде любая 
точка, определенная на левом и правом изображениях будет иметь 
одинаковую Y-координату в системе координат монитора. 

 
Рисунок 4-9. Трансформация стереопары в стереоскопическом виде 
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Для отображения стереопары следует выбрать систему координат 
проекции или местную СК в поле Ground / Grid (Местная СК / СК 
проекции) на панели состояния. Щелкните на вкладке Stereopairs 
(Стереопары) для просмотра данных. 
Вкладка Stereopairs (Стереопары) состоит из двух панелей: 

• В левой панели отображаются эскизы всех стереопар в файле. 

• В правой панели отображаются в стереоскопический или 
“ориентированный” вид выделенной стереопары. В Stereo View 
изображения отображаются в трансформированном виде, в 
Orientation View (Ориентированном виде) отображаются исходные 
изображения. Правая панель разделена на четыре части. Две 
верхние части (в исходном состоянии меньшие по размеру и 
редактируемые), являются эскизами для правого и левого 
изображений. Две нижние части представляют собой увеличенные 
участки левого и правого изображений соответственно. В верхней 
части красный прямоугольник обозначает, какая именно часть 
видима в нижней части. Пользователь может двигать красное 
просмотровое окно для левого или правого изображений. 
Увеличение изображений с использованием кнопок 
инструментальной панели (Zoom In - Ближе, Zoom Out - Дальше, 
Restore All – Восстановить исходный масштаб и  Pan - Панорама) 
или колесом прокрутки мышки производится только в нижних окнах. 
В Orientation View можно изменять размеры левого и правого 
изображений независимо. В Stereo View применяется единый 
масштаб отображения правого и левого изображений. Режим 
панорамирования независим для каждого изображения стереопары 
только в горизонтальной плоскости. В нижних окнах возможно 
отображение всех точек, линий и поверхностей текущего проекта, 
попадающих на изображение. Символы точек связаны с 
настройками, указанными в окне Layers (Слои) инструментальной 
панели. Если измерения координат точки могут быть вычислены по 
изображению, то они показаны синим ( ) цветом, в противном 
случае – красным ( ). 
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Рисунок 4-10. Ориентированный вид 

Редактирование в левой или правой панелях вкладки Stereopairs 
(Стереопары) подробно описано в главе 10.  

 
Рисунок 4-11. Стереоскопический вид 
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Surfaces (вкладка Поверхности) 
Вкладка Поверхности (Surfaces) отображается только в том случае, если 
проект содержит цифровую модель рельефа и в Topcon Tools разрешен к 
использованию модуль Design. 
Щелкните на вкладке Surfaces для просмотра данных о поверхностях  (см. 
рис. 4-12).  
Таблица состоит из следующих колонок: 

• Icon (Пиктограмма) – символьное представление поверхности. 

• Name (Название) – название поверхности. 

• Focus Point (Фокусная точка). Если колонка пустая, это означает то, 
что построение треугольников выполнено относительно плоскости 
горизонта. Если присутствует некоторая выбранная точка, то 
построение треугольников будет выполнено относительно этой 
точки.  

• Layer (Слой) – слой, в котором расположена выбранная 
поверхность.  

• Number of Points (Количество точек) – количество точек в 
поверхности, включая точки с координатами и точки пересечений 
линий, образующих используемую модель рельефа. 

• Number of Triangles – количество треугольников, из которых состоит 
поверхность. 

• Area (Площадь) – сумма площадей проекций треугольников на 
плоскость горизонта (если построение треугольников выполнено 
относительно плоскости горизонта) и на вертикальную плоскость 
(если построение треугольников выполнено относительно фокусной 
точки для выбранной поверхности). 

• Minimum/Maximum Northing/Easting/Elevation (Минимум/Максимум 
Север/Восток/Высота) – минимальные и максимальные величины 
соответствующих координат точек поверхности. 

• Comment (Комментарий) – любая дополнительная информация о 
поверхности. 

 
Рисунок 4-12. Вкладка Surfaces (Поверхности) 
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Щелчком по заголовку таблицы можно отсортировать ее содержимое в 
порядке уменьшения или увеличения. 
Редактирование данных в таблице Surfaces  описано в разделе 
“Редактирование в табличном виде” на стр. 5-1. 

DL Obs (вкладка Нивелирование) 
Вкладка DL Obs (Нивелирование) отображается только в том случае, если 
проект содержит измерения цифровых нивелиров и в Topcon Tools 
разрешены к использованию модули TS, PP или RTK. На рисунке 4-13 
показан пример данных цифрового нивелира. 

 
Рисунок 4-13. Пример нивелирных измерений 

Щелкните на вкладке DL Obs для просмотра данных по нивелирным 
измерениям  (рис. 4-14 на стр. 4-20).  
Таблица состоит из двух панелей. Левая отображает начальную и 
конечную точки хода, а правая содержит все нивелирные измерения 
текущего хода. 
Левая панель состоит из следующих столбцов: 

• Icon (Пиктограмма) – символьное представление нивелирного хода. 
• #  – номер хода.  
• From (От) – начальная точка хода. 
• To (До) – конечная точка хода.  
• Job (Ход) – название нивелирного хода, созданного в цифровом 

нивелире Topcon. 
• Date (Дата) – дата (день / месяц / год) и время наблюдения. 
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• Note (Примечание) – комментарии пользователя. 

• Distance (Длина) -- полная длина нивелирного хода. 

• Balance (Баланс) – сумма превышений по ходу. 
Правая панель таблицы DL Obs состоит из перечисленных ниже колонок. 
Колонки признаков уравнивания и невязок по высоте появляются только 
после уравнивания. 

• Icon (Пиктограмма) – символьное представление точки хода. 

• # (Номер измерения) – номер измерения. 

• Point (Точка) – название точки хода. 

• BS – измерение на заднюю точку. 

• FS – измерение на переднюю точку. 

• Distance (Длина) – измеренное расстояние. 

• Vertical Offset (Вертикальное смещение) – вертикальное смещение 
от горизонтальной плоскости точек до хода и вне его. 

• Elevation (Превышение) – ортометрические превышения точек (или 
высоты точек, рассчитанные от точки с известной высотой). 

• Date (Дата) – дата и время нивелирного измерения. 

• AutoReject (Автоматическая отбраковка) – разрешение 
автоматически отбраковывать нивелирное измерение в 
уравнивании. 

• Adjustment status (Состояние уравнивания) – указатель того, что 
измерение было уравнено, не было уравнено, отключено или 
отбраковано. 

• HT residual (Невязка) –невязка по высоте после уравнивания. 

• Note (Примечание) – комментарии пользователя. 

• Std Dev (СКО) – среднеквадратическое отклонение измерения. Эта 
величина формируется в цифровом нивелире. 

• Job (Ход) – название нивелирного хода. 

• Source (Источник данных) – полный путь к файлу данных. 
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Рисунок 4-14. Вкладка Нивелирование (DL Obs) 

Щелчком по заголовку таблицы можно отсортировать ее содержимое в 
порядке уменьшения или увеличения. 
Редактирование данных в таблице DL Obs (Нивелирование) подробно 
описано в разделе “Редактирование в табличном виде” на стр. 5-1. 

Roads (вкладка Дороги) 
Вкладка Roads (Дороги) отображается только в том случае, если проект 
содержит проект дороги и в Topcon Tools разрешен к использованию 
модуль Design. 
Щелкните на вкладке Roads для просмотра данных по дорогам, 
включенным в текущий проект  (см. рис. 4-15).  

 
Рисунок 4-15. Вкладка Дороги (Roads) 

В левой панели вкладки Roads (Дороги) отображаются названия дорог, в 
средней панели – плановые / высотные элементы и поперечники 
выбранной дороги, а в правой панели - графическое представление 
элементов дороги. 
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В таблице Horizontal alignment (Плановые элементы) показывается список 
плановых элементов дороги. Таблица плановых элементов может 
состоять из перечисленных ниже столбцов: 

• Icon (Пиктограмма) – символьное представление элементов дороги: 

 

  
• Order (Порядковый номер) – порядковый номер элемента в 

плановом проекте дороги. 

• Type (Тип) – тип элемента (линия, дуга, спираль или пересечение). 

• Azimuth (Азимут) – азимут элемента (смотри "Задание азимута" на 
стр. 9-20). 

• Length (Длина) – длина элемента, редактируемая для всех 
элементов за исключением Intersection (Пересечение). 

• Turn (Поворот) – направление поворота для дуги, спирали и 
пересечения. "Right" ("Направо") указывает поворот по часовой 
стрелке, "Left" ("Влево") указывает поворот против часовой стрелки. 

• Start Radius/End Radius (Начало радиуса/Конец радиуса) – радиус 
дуги или спирали. 

• Northing/Easting (Север/Восток) – координаты точки пересечения. 

• Spiral 1 Len/Spiral 2 Len (Спираль 1 длина/Спираль 2 длина) – длина 
спирали до и после точки пересечения. 

• End Station (Конечная точка) – номер конечной точки для элемента. 

• Intersection Pt (Точка пересечения) – название точки пересечения. 

• Tangential to prev element (По касательной к предыдущему 
элементу) – отображается как "True" или "False". True – когда азимут  
этого элемента совпадает с азимутом последнего участка  
предыдущего элемента, False – азимут этого элемента 
произвольный. 

• End Northing/End Easting  – координаты конечной станции элемента. 

• End Azimuth (Азимут конечного участка) – азимут, определяемый  
касательной к последнему участку элемента. 

 Линия 
 
Спираль 

 
Дуга Пересечение 
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• Spiral Dir  – направление спирали. 

• Delta (Дельта) - угол между радиусами составной кривой. 

• Chord (Хорда) – длина хорды (отрезка, соединяющего начальную и 
конечную точки) дуги. 

• Tangent (Тангенс) – длина отрезка, касающегося дуги. 

• Mid Ord (Средняя ордината) – расстояние от средней точки хорды 
до середины дуги. 

• External (Внешний) – расстояние от средней точки дуги до точки 
пересечения тангенса. 

• Spiral Const (Константа спирали) – квадратный корень из 
произведения длины и радиуса спирали. 

• Spiral Const 1/Spiral Const 2 (Константа спирали 1 / Константа 
спирали 2) – константы спирали, используемые для определения 
составной дуги (смотри "Добавление пересечения" на стр. 9-25). 

• Start Deg Chord/End Deg Curve (Начальный угол хорды / Конечный 
угол дуги) – угол, используемый для расчета радиуса дуги при ее 
длине равной 100 единицам. 

В таблице Vertical alignment (Высотные элементы) показывается список 
высотных элементов дороги. Таблица высотных элементов может 
состоять из перечисленных ниже столбцов: 

• Icon (Пиктограмма) – символьное представление элементов дороги: 

 
 
 
 
 

• Type (Тип) – тип элемента (откос, парабола или длинный участок). 

• Sta/Chainage (Станция/Пикетаж) – номер начальной станции или 
пикета для откоса, параболы или длинного участка. 

• Order (Порядок) – порядок элемента в вертикальном 
проектировании. 

• Length (Длина) – длина вертикального элемента для откоса и 
параболы и длина дуги длинного участка. 

 Откос  Круговая дуга 

 Парабола  Круговой 
длинный участок 

 Параболический 
длинный участок  
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• Start Grade / End Grade (Начало уклона / Конец уклона) – начальный 
и конечный процент уклона элемента. Если уклон растущий, то его 
величина положительная, если ниспадающий – то отрицательная. 

• Elevation (Высота) – высота конечной станции откоса и параболы и 
высота пикета, использованного для создания длинного участка. 

• Radius (Радиус) – радиус элемента. Для круговой дуги – радиус, для 
кругового длинного участка – заданный пользователем радиус 
круговой дуги. 

Таблица X-Section (Поперечник) показывает список пикетов, в которых 
используются типовые поперечники и эскиз поперечника. 

• Station (Станция) – название пикета, в котором применен типовой 
поперечник. 

• Side (сторона) – левая или правая сторона от осевой линии дороги, 
на которой применен типовой поперечник. 

• Template (Типовой поперечник) – название типового поперечника 
(выбирается из списка заданных в проекте типовых поперечников). 

Редактирование дороги во вкладке Roads (Дороги) подробно 
рассматривается в главе 9. 

 
Рисунок 4-16. Вкладка Roads (Дороги) 
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X-section Templates (вкладка типовых 
поперечников) 
Вкладка X-section Templates (Типовые поперечники) отображается только 
в том случае, если проект содержит данные дорожного проектирования и в 
Topcon Tools разрешен к использованию модуль Design. 
Щелкните на вкладке X-section Templates для просмотра данных о 
заданных в проекте типовых поперечниках (рис. 4-17). 

 
Рисунок 4-17. Вкладка типовых поперечников (X-section Templates) 

В левой панели таблицы показаны названия типовых поперечников и 
величины уклонов выемки и насыпи в процентах. В правой панели 
отображаются сегменты выбранного типового поперечника в табличном и 
графическом представлениях. 
Правая панель таблицы типовых поперечников (X-section Templates) 
содержит следующие столбцы, описывающие сегмент выбранного 
поперечника: 

• Icon (Пиктограмма) – символ сегмента. 

• Order (Порядок) – порядок сегмента в поперечнике. 

• Code (Код) – используемый для сегмента код. 

• Hz. Dist (Гор. Расст.) – горизонтальное расстояние от оси дороги. 

• V. Dist (Верт. Расст.) – вертикальное расстояние от оси дороги. 

• Grade% (Уклон) – отношение горизонтального проложения к 
превышению, выраженное в процентах. 
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• Hz. Offset from CL (m) (Плановое смещение (м)) – горизонтальное 
смещение от оси дороги для начальной точки элемента. 

• V. Offset from CL (m) (Высотное смещение (м)) – высотное смещение 
от оси дороги для начальной точки элемента. 

Map View (вид Карта)  
Окно Map view (Карта) открывается выбором пункта меню View > Map 
View (Показать > Окно Карта), комбинацией клавиш Ctrl+M или щелчком 
на кнопке Карта инструментальной панели. 
В окне Карта графически отображаются точки в координатах 
широта/долгота или прямоугольных северная/восточная, измерения и 
карта-подложка (рис. 4-18). 

• Утолщенные линии обозначают повторные измерения, линии 
различных цветов означают различные типы измерений и их 
состояние. 

• Используйте правую кнопку мыши для вызова выпадающего меню и 
колесико мыши для изменения масштаба изображения в окне. 

• Изображение панорамируется нажатием на колесо мыши или в 
режиме Панорама. 

 
Рисунок 4-18. Вид окна Карта 

Для редактирования данных в окне Карта щелкните по точке или базису 
правой кнопкой мыши и вызовите выпадающее меню Properties 
(Свойства). Подробнее см. раздел "Редактирование свойств данных" на 
стр. 5-52. 
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Occupation View (вид Сеансы 
спутниковых измерений) 
Окно Occupation view открывается выбором пункта меню View > 
Occupation View (Показать > Окно Сеансов) или щелчком на кнопке 
Окно сеансов инструментальной панели. 
В окне Occupation view графически отображаются пункты, на которых 
проводились сеансы измерений и их временной график (используется 
шкала времени GPS), см. рис.4-19. В этом окне сеансы измерений можно 
представить различными способами, например: 

• Сеансы по пунктам наблюдений. 

• Сеансы по приемникам. 

• Сеансы (с показом слежения по спутникам) по точкам. 

• Сеансы (с показом слежения по спутникам) по приемникам. 
После вызова окна Occupation view отобразится график вида “Сеансы по 
пунктам наблюдений ”, как на примере: 

 
Рисунок 4-19. Вид окна Сеансы по пунктам наблюдений 

Для изменения масштаба используйте окно, появляющееся при нажатии 
на правую кнопку мыши или колесико мыши. 

• Перетаскивание окна просмотра возможно с помощью перемещения 
колеса мыши или выбором режима Панорама. 

• Щелчком по знаку +/- вызывается вывод на экран окна график 
слежения по каждому спутнику сеанса измерений. 
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Для просмотра отдельных эпох наблюдения спутников в сеансе щелкните 
по узлу, соответствующему пункту наблюдений. При раскрытии узла 
отображаются времена доступности конкретных спутников в каждом 
сеансе. 

 
Рисунок 4-20. Слежение по спутникам в сеансе 

В окне Occupation view возможно редактирование путем частичного 
удаления данных измерений по конкретному спутнику. Для удаления части  
спутниковых измерений сеанса выделите нужные спутники, а затем 
правой кнопкой мыши вызовите выпадающее меню и щелкните на кнопке 
на пункте Disable (Отключить). 

 
Рисунок 4-21. Удаление спутниковых измерений 

Программа обработки спутниковых измерений Topcon Tools не будет 
использовать вырезанные интервалы в обработке. 
При выборе представления сеансов "по приемникам" на вертикальной оси 
графика отображаются их идентификационные номера. 

 
Рисунок 4-22. Вид окна Сеансы по приемникам 
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Если в настройках проекта (производится выбором пункта Job > Job 
Configuration (Проект > Настойки проекта), см. рис. 4-23) выбран 
местный часовой пояс, то что на горизонтальной оси графика указывается 
местное время. 

 
Рисунок 4-23. Выбор часового пояса относительно Гринвича 

Подробнее см. "Редактирование свойств данных" на стр. 5-52. 

Вид CAD 
Если вид CAD был открыт при закрытии программы, он откроется при ее 
очередном запуске. Для открытия окна CAD view выберите пункт меню 
View > CAD View (Вид > Вид CAD). 
Вид CAD – это графическое представление линий, дорог и поверхностей с 
соответствующими точками (рис. 4-24 на стр. 4-29). При отсутствии отбора 
данных в нем отображается следующая информация: 

• Точки и их условные знаки. Если точке не присвоен условный знак, 
будет использоваться символ пикета. 

• Линии отображаются на основе настроек кодов и слоев, стиля и 
толщины. 

• Если линии приписаны контрольные коды /AS, /AE, /R, /C, то она 
будет отображаться как дуга, замкнутый или разомкнутый 
прямоугольник соответственно. 

• Если код включает объект полигона, линия будет замкнута и залита 
(если заранее выбран цвет заливки). 

• Щелчок по правой кнопке мыши по контрольному изображению в 
левой панели вкладки изображений дает его увеличенный размер во 
вспомогательном виде CAD. Координаты в этом виде определяются 
как горизонтальный и вертикальный углы относительно опорного 
направления. Будут показаны только те точки и линии, которые 
вписываются в изображение. 
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• Поверхности и дороги отображаются цветом соответствующего 
слоя. 

 
Рисунок 4-24. Вид CAD с линиями 

Для редактирования в виде CAD щелчком по правой кнопке мыши на 
точке или линии вызовите выпадающее меню и выберите пункт Properties 
(Свойства). Смотри раздел "Редактирование свойств данных" на стр. 5-52 
для детального ознакомления с правилами редактирования в диалоговом 
окне Properties (Свойства).  

Вид CAD для изображений 
Если данные имеют связанные изображения, например, данные 
электронного тахеометра GPT7000i или фотопримечания к точкам, 
специальный вид CAD, позволяет просматривать увеличенные 
изображения выбранных фотографий (рис. 4-25 на стр. 4-30). 
Для просмотра вида CAD для изображений щелчком 
по правой кнопке мыши на изображении в левой 
панели вкладки Images (Изображения) вызовите 
выпадающее меню и выберите пункт Image View 
(Просмотр Изображения):  
 
 
 
 

• Точки и линии, связанные с этим изображением, будут показаны на 
нем, а также выбраны в других таблицах и видах. 

• Выберите точку или линию и используйте меню, выпадающее по 
щелчку на правой кнопке мыши для быстрого редактирования или 
просмотра свойств точки и/или линии. Этим же способом можно  
добавить точку к линии. 
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• Используйте кнопку масштабирования изображения для изменения 
размеров представления изображения. 

 
Рисунок 4-25. Вид Изображения (Image View) 

Для изменения параметров просмотра щелкните по правой кнопке мыши, 
установив курсор вне изображения, и в появившемся выпадающем меню 
выберите пункт Options. 

Вид 3D 
Вид 3D (перспективное изображение) отображает поверхности, дороги и 
линии, используя трехмерное представление данных (см. рис. 4-26 на стр. 
4-31). Поверхности и дороги будут отображаться в цветах слоев, в которых 
они размещены, линия в цвете, установленном для нее. Если это окно 
было открыто при завершении программы, то при очередном ее запуске 
оно будет отображаться. 
Для просмотра или скрытия окна 3D, выберите пункт меню View > 3D View 
(Вид > Вид 3D). 
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Рисунок 4-26. Вид 3D для различных объектов 

Используйте колесо мыши для панорамирования изображения (при 
перемещении мыши следует удерживать ее колесико в нажатом 
состоянии) или масштабирования (колесико следует вращать вперед или 
назад). Удерживая нажатой правую кнопку мыши, изображение можно 
вращать. Удерживая нажатыми правую кнопку мыши и клавишу Ctrl 
клавиатуры, можно менять положение источника света (см. рис. 4-27). 

Рисунок 4-27. Изменение положения источника света 
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3D изображение может быть представлено как объемная монолитная 
модель или как каркасная модель. Для выбора модели представления 
изображения, щелкните по правой кнопке мыши вне изображения и в 
появившемся меню выберите тип представления (см. рис. 4-28). Solid – 
монолитная объемная модель, Wireframe – каркасная. 

 
Рисунок 4-28. Типы представления 3D изображения 

Программа Topcon Tools также предоставляет возможность применения 
текстуры и выбора изображения для использования в качестве текстуры. 
Для выбора текстуры проделайте следующие действия: 

• Создайте поверхность на изображении или на стереопаре. 
• Выберите пункт меню View > 3D View (Вид > Вид 3D). 
• Выберите вкладку Image. Щелкните по правой кнопке мыши на  

изображении в левой панели и вызовите выпадающее меню, в нем 
выберите пункт Set as Surface Texture (Выбрать в качестве 
текстуры поверхности): 

 
Рисунок 4-29. Поверхность с текстурой изображением 



Виды представления данных 

P/N 7010-0612 4-33 

Вид Слои 
Отображение и скрытие окна Layers (Слои) производится выбором пункта 
меню View > Layers (Вид > Слои). 
Вид Слои показывает список всех слоев в проекте и их печатные стили  
(см. рис. 4-30 на стр. 4-33): 

• Name – название слоя. 
• Visible (Видимый) – слой видим в видах CAD View (Вид CAD) или 3D 

View (Вид 3D), если выбран пункт Yes (Да) или невидим, если 
выбран No (Нет). 

• Line Style/Line Width/Line Color/Point Symbol (Стиль линии/ Толщина 
линии/ Цвет линии/ Символ точки) – стили (атрибуты) отображения 
слоя. 

• Note (Примечание) – пользовательские комментарии. 
• Fill Area (Заливка площади) – признак Yes приводит к использованию 

заливок при отображении площадных объектов слоя, Not – заливка 
не применяется.  

• Breakline types (Тип линии ограничения) – отображается типом слоя. 
Если тип линии ограничения выбран Auto (Автоматически), 
триангуляция будет автоматически определена по границе, выемкам 
и линиям ограничения. Если тип линии ограничения такой как 
Breakline (Ограничение), Boundary (Граница) или Exclusion (Выемка), 
разбиение на треугольники будет производиться в строгом 
соответствии с установленным условием. 

Рисунок 4-30. Вид Слои (Layers View) 

Редактирования данных в виде Слои детально описано в разделе 
“Редактирование линий” на стр. 5-15. 
Слои часто используются для разбиения данных по функциональным 
группам, назначения типов линий, цветов и прочих атрибутов для 
выделения групп данных. По умолчанию, каждый проект Topcon Tools 
содержит слой под названием 0 (ноль). Слой 0 не может быть удален или 
назван по-другому. Тем не менее, атрибуты для этого слоя можно 
изменить. Новые слои могут быть добавлены в проект или импортированы 
из других файлов. 



Просмотр, выбор и фильтрация данных 

Topcon Tools- Руководство пользователя 4-34 

Для создания нового слоя в текущем проекте воспользуйтесь одним из 
перечисленных ниже способов: 

• Выберите пункт меню Edit > Add > Layers (Редактирование > 
Добавить > Слои). Или в виде Layers (Слои), выберите в 
выпадающем меню пункт Add Layers (Добавить Слои). 

• Выберите комбинированный список 
Layer (Слой), щелчком по правой 
кнопке мыши вызовите выпадающее 
меню и выберите пункт Add Layer 
(Добавить слой): 

1. Задайте следующие основные данные 
о слое во вкладке General (Основные 
параметры) (рис. 4-31): 

• Name – название слоя. 
• Visible (Видимый) – слой видим в видах CAD View (Вид CAD) или 

3D View (Вид 3D), если выбран пункт Yes (Да) или невидим, если 
выбран No (Нет). 

• Note (Примечание) – пользовательские комментарии. 
• Breakline type (Тип линии ограничения) – выберите 

соответствующий тип Auto, Breakline, Boundary или Exclusion) 
для линий, включенных в поверхность. 

2. Выберите следующие параметры отображения объектов, 
размещенных в слое во вкладке Plotting Styles (Печатаемые стили) 
(рис. 4-31): 

• Line Style (Стиль линии) – выбор типа отображения линии. 
• LineWidth (Толщина линии) – выбор толщины линии. 
• Color (Цвет линии) – выбор цвета линии. 
• Point Symbol (Символ точки) – выбор символа для 

представления всех точек слоя. 
3. Щелкните на кнопке Yes (Да) для заливки замкнутых площадей. 

 
Рисунок 4-31. Ввод и выбор свойств слоя 
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Любой созданный слой можно выбрать в качестве текущего. Для 
назначения слоя проекта текущим выберите его в комбинированном окне 
Layer (Слой) инструментальной панели. Все создаваемые точки, линии, 
поверхности и дороги будут иметь стиль, определяемый текущим слоем: 

 
Рисунок 4-32. Комбинированное окно показывает текущий слой 

Выбор слоя для новых кодов 
При создании нового кода можно задать слой. В этом случае стиль 
отображения этого кода будет заимствован из настроек слоя. 

 
Рисунок 4-33. Коды и слои 

Для редактирования стиля отображения любого кода со слоем или без 
такового используйте параметры, устанавливаемые во вкладке Plotting 
styles диалогового окна Properties (Свойства) для кодов. 

 
Рисунок 4-34. Редактирование стилей отображения (символ точки) для кода 

Если слой для кода не выбран, код будет автоматически связан со слоем 
0 (Layer 0). Этот слой также используется для всех кодов в проекте Topcon 
Tools, равно как и для импортированных файлов без поддержки слоев. 
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Назначение слоя новой или существующей 
точке 
Для размещения новой точки в нужном слое выберите его во вкладке 
General (Основные параметры) диалогового окна Add Point (Добавить 
точку) (рис. 4-35). Атрибуты (цвет и стиль точки) выбранного слоя будут 
применены к новой точке. Пользователь может переместить выбранные 
точки в другой слой. Для этого выберите необходимые точки, щелчком по 
правой кнопке мыши вызовите выпадающее меню и выберите в нем пункт 
Properties (Свойства). Установите слой для выбранных точек. 

 
Рисунок 4-35. Выбор слоя для точки 

Для назначения кодов (вместо слоев) для точки выберите нужный код в 
поле Code (Код) и выберите значение "BYCODE" в поле Layer (Слой). 
Атрибуты (цвет и стиль точки) слоя будут применены для этой точки. На 
рисунке 4-36 показан пример для точки с кодом "101" в виде CAD. Для 
этой точки слой был установлен как "BYCODE(For Points)", а этому коду 
присвоен слой "For Points". 

 
Рисунок 4-36. Назначение кода точке и ее просмотр 

• Если точка имеет несколько кодов, то принятие слоя "BYCODE" 
устанавливает ее принадлежность нескольким слоям. 

• Если точка не имеет кода, то выбор слоя "BYCODE" устанавливает 
ее принадлежность к слою 0 (ноль). 

 
Рисунок 4-37. Назначение слоя при принятии кодов 
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Назначение слоя новой или существующей 
линии 
Для размещения новой линии в слое выберите любой слой из списка 
существующих слоев на инструментальной панели. Стиль отображения 
новой линии будет заимствован из соответствующих установок текущего 
слоя (рис. 4-38). 

 
Рисунок 4-38. Назначение слоя линии 

Для смены слоя для выбранной линии воспользуйтесь одним из 
следующих способов: 

• Дважды щелкните по колонке Layer (Слой) и выберите новый слой 
из выпадающего списка в левой панели таблицы Linework (Линия): 

 
• Щелчком по правой кнопке мыши на линии (или выбранной линии) в 

виде CAD вызовите выпадающее меню, в нем выберите пункт 
Properties (Свойства). В появившемся окне Properties выберите 
новый слой из выпадающего списка. 
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Назначение слоя новой или существующей 
поверхности 
Для назначения слоя новой или существующей поверхности, выберите 
слой, используя диалоговое окно Add Surface (Добавить поверхность) 
или Properties (Свойства). Стили отображения текущего слоя будут 
применены к поверхности (рис. 4-39). 

 
Рисунок 4-39. Назначение слоя поверхности 

Для смены слоя существующей поверхности вызовите выпадающий 
список в таблице Surfaces (Поверхности) двойным щелчком по колонке 
Layer (Слой) и выберите другой слой (рис. 4-40). 

 
Рисунок 4-40. Назначение слоя существующей поверхности 

Назначение слоя новой или существующей 
дороге 
Для назначения слоя новой или существующей дороге выберите слой, 
используя диалоговое окно Add Road (Добавить дорогу) или Properties 
(Свойства). Стили отображения выбранного слоя будут применены к 
дороге (рис. 4-41). 

 
Рисунок 4-41. Назначение слоя дороге 
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Вид Коды 
Для просмотра или скрытия окна Codes (Коды) выберите пункт меню View 
> Codes (Вид > Коды) или щелкните на кнопке инструментальной панели 
Codes List (Список кодов). 
Вид Коды (Codes view) содержит список всех кодов и их атрибутов, 
используемых в проекте (рис. 4-42). 

• Для кодов в левой панели: 
- Icon (Пиктограмма) - символ кода. 
- Code (Код) - название кода. 
- Layer (Слой) - название слоя, в котором используется код. 

• Для атрибутов в правой панели: 
- Icon (Пиктограмма) - символ атрибута. 
- Name - название атрибута. 
- Default Value (Величина по умолчанию): код, присвоенный точке по 
умолчанию. 
- Type (Тип) - тип ввода кода к точке: Integer (Целое число), Real 
Number (Вещественное число), Text (Текст), Menu (Меню). 

Редактирование в виде Коды детально описано в разделе 
"Редактирование кодов в виде Коды" на стр. 5-35. 

 
Рисунок 4-42. Вид Коды (Codes View) 
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Настройки окон (видов) 
Параметры настройки окон (видов) используются для отображения 
данных различными способами, упорядочении столбцов в таблицах и т.п. 
Возможность пользовательской настройки отображения предоставляется 
только для видов Map, Occupation и Table. 

Настройки вида Map (Карта) 
Настройки просмотра окна Карта включают отображение сетки координат, 
легенды символьных обозначений и выбора подписей к точкам. 
1. Выберите пункт меню View > Map View Options (Вид > Опции вида 

Карта) или щелкните правой кнопкой мыши по пустому месту вида 
Карта и из выпавшего меню выберите пункт Options (Опции). 

2. Во вкладке Show (Показать) выберите необходимые настройки (рис. 
4-43 на стр. 4-41). Щелкните на кнопке Apply (Принять) для 
сохранения настроек и принятия сделанных изменений. 

• Show grid (Показать сетку) – выводит в окне Карта 
картографическую сетку.  

• Show legend (Показать легенду) – выводит окно с описанием 
символов точек и измерений, используемых в окнах Карта и 
Таблица.  

• Show ellipses (Показать эллипсы) – показ или скрытие 
графического представления ошибок для уравненных точек и 
спутниковых местоопределений. Плановая ошибка 
изображается эллипсом, полуоси которого равны 
среднеквадратическим ошибкам определения координат точки в 
северном и восточном напрвлениях (Std n и Std e). Высотная 
ошибка представлена отрезком, длина которого равна 
среднеквадратической ошибке по высоте (Std u) определения 
координат точки. 

• Background Map File (Файл карты-подложки) – отображает 
выбранный файл с растровой картой, используемой как карта-
подложка в видах Карта и CAD.  
Поддерживаемые форматы: DWG (*.dwg), DXF (*.dxf), GEOTIFF 
(*.tif), MrSID (*.sid) и файлы формата World files (*.tfw, *.jgw, *.gfw, 
*.bpw). 

3. Во вкладке Labels (Подписи), установите нужные параметры (рис. 4-43 
на стр. 4-41). Щелкните на кнопке Apply (Принять) для сохранения 
настроек. 



Настройки окон (видов) 

P/N 7010-0612 4-41 

• Name (Название) – разрешает вывод названия точек в окне 
карты, возле курсора и в строке состояния. 

• Code (Код) – разрешает вывод кода точки в окне карты, возле 
курсора и в строке состояния. 

• Height (Высота) – разрешает вывод высоты точки в окне карты, 
возле курсора и в строке состояния. 

4. Щелкните на кнопке ОК для сохранения настроек и закрытия 
диалогового окна. 

 
Рисунок 4-43. Опции отображения окна Карта 

Настройки вида Occupation (Сеанс) 
Настройки просмотра вида Occupation view включают настройку 
отображения временной шкалы, легенды и выбор отображаемого сеанса 
измерений. 
1. Выберите пункт меню View > Occupation View Options (Вид > 

Настройка вида Сеанс) или щелкните по пустому полю окна 
Occupation view и в появившемся меню выберите пункт Options. 

2. Во вкладке Show (Показать) сделайте необходимые изменения (см. 
рис. 4-44 на стр. 4-42). Щелкните на кнопке Apply (Применить) для 
сохранения изменений. 

• Show grid (Показать сетку) – разрешает отображение шкалы GPS 
времени. 

• Show legend (Показать легенду) – разрешает показ окна с 
описанием использованных в виде символов. 
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Рисунок 4-44. Настройка вида Сеанс 

3. Во вкладке Occupation View выберите необходимые параметры (см. 
рис. 4-45). Щелкните на кнопке Apply (Принять) для сохранения 
изменений. 

• Show occupations by receivers (Показать сеансы по приемникам) 
– построение графиков сеансов измерений, произведенных 
приемниками. 

• Show occupations by points (Показать сеансы по пунктам) – 
построение графиков сеансов измерений, произведенных на 
пунктах. 

 
Рисунок 4-45. Параметры вида Сеанс 

4. Щелкните на кнопке ОК для сохранения настроек и закрытия 
диалогового окна. 

Настройки вида CAD 
Настройки просмотра вида CAD включают отображение координатной 
сетки, настройки картографической подложки и выбора подписей для 
точек. 
1. Щелчком по правой кнопке мыши по пустому месту в окне CAD 

вызовите выпадающее меню и в нем выберите пункт Options. 
2. Во вкладке Show (Показать) выберите нужные настройки (рис. 4-46 на 

стр. 4-43). Щелкните на кнопке Apply (Применить) для сохранения 
настроек и принятия сделанных изменений. 

• Show grid (Показать сетку) – отображение картографической 
сетки в окне CAD. 

• Background Map File (Файл карты-подложки) – отображает 
выбранный файл с растровой картой, используемой как карта-
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подложка в видах Карта и CAD.  
Поддерживаемые форматы: DWG (*.dwg), DXF (*.dxf), GEOTIFF 
(*.tif), MrSID (*.sid) и файлы формата World files (*.tfw, *.jgw, *.gfw, 
*.bpw). 
− Щелкните на кнопке Browse и, перемещаясь по дереву 

каталогов файловой системы компьютера, найдите 
необходимый файл. 

− Щелкните на кнопке Open (Открыть), а затем Apply 
(Применить). 

3. Во вкладке Labels (Подписи) установите нужные параметры (рис. 4-46). 
• Name (Название) – разрешает вывод названия точек в окне 

карты, возле курсора и в строке состояния. 
• Code (Код) – разрешает вывод кода точки в окне карты, возле 

курсора и в строке состояния. 
• Height (Высота) – разрешает вывод высоты точки в окне карты, 

возле курсора и в строке состояния. 
4. Щелкните на кнопке ОК для сохранения настроек и закрытия 

диалогового окна. 

 
Рисунок 4-46. Настройки отображения окна CAD 
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Настройки видов Таблица 
Каждая вкладка вида Таблица имеет пункт Options (Параметры) для 
настройки отображения столбцов и их упорядочивания. Единственное 
исключение – вкладка Images (Изображения), для нее диалоговое окно 
Options не предусмотрено. 
1. Выберите пункт меню View > Tabular View Options (Вид > Настройка 

вида Таблица) или щелчком по правой кнопке мыши по выбранной 
таблице вызовите выпадающее меню и выберите пункт Options. 

2. Выберите и расставьте в нужном порядке информационные колонки 
(см. рис. 4-47). 

• Используйте кнопки >> и << для перемещения выбранных 
колонок между полями. 

• Используйте кнопки Move Up (Вверх) и Move Down (Вниз) для 
сортировки выбранных колонок в поле Selected columns 
(Выбранные колонки). 

3. Щелкните на кнопке ОК для принятия изменений в таблице. 

 
Рисунок 4-47. Пример параметров таблицы для Точек и Тахеометрии 
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Настройка вида Images 
(Изображения) 
Опции для таблицы Image (Изображения) включает подписи для 
отображения точек и опции отображения изображений. 
1. Щелчком по правой кнопке мыши на пустом поле таблицы Image 

(Изображения) вызовите выпадающее меню и выберите пункт 
Options. 

 
Рисунок 4-48. Таблица Image (Изображения) – Опции подписи и показ 

2. Во вкладке Labels (Подписи), выберите нужные настройки (рис. 4-48). 
Щелкните на кнопке Apply (Применить) для сохранения настроек и 
принятия выполненных изменений. 

• Name (Название) – разрешает вывод названия точек в окне 
карты, возле курсора и в строке состояния. 

• Code (Код) – разрешает вывод кода точки в окне карты, возле 
курсора и в строке состояния. 

• Height (Высота) – разрешает вывод высоты точки в окне карты, 
возле курсора и в строке состояния. 

3. Во вкладке Show (Отображение), выберите нужные настройки (рис. 
4-48). Щелкните на кнопке Apply (Применить) для сохранения 
настроек и принятия выполненных изменений. 

• Filter by Station or Surface (Фильтр по точке стояния или 
поверхности) – разрешает отбор. Если используется отбор, 
будут отображаться только те точки, которые были определены 
с заданной точки стояния. При фильтрации по поверхности, 
будут показаны точки, созданные по поверхности сканирования. 

• Show images (Показ изображений) – выберите кнопки-флажки 
показа изображений определенных типов: 
− Wide (Обзор) – изображения, полученные при работе с 

электронным тахеометром GPT 7000i в обзорном режиме. 
− Telescopic (Детально) – изображения, полученные при 

работе с электронным тахеометром GPT 7000i в детальном 
режиме. 
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− Note (примечание) – любое примечание в виде фотографии. 
Фото примечания (формат *.jpg) могут быть присоединены к 
точкам. Для точки может быть выбрано несколько фото 
примечаний. 

− Scan (Сканирование) – любые изображения, 
присоединенные к сеансу сканирования. 

4. Щелкните на кнопке ОК  для принятия изменений и закрытия 
диалогового окна. 

Настройка вида Stereopairs 
(Стереопары) 
Настройки отображения вкладки Stereopairs (Стереопары) включают в 
себя ярлыки точек. Щелкните на пустом пространстве вкладки Stereopairs 
и вызовите выпадающее меню, в нем выберите пункт Option: 
Во вкладке Labels (Ярлыки) сделайте нужные настройки (рис. 4-49). Нажав 
на кнопку Apply (Применить), вы сохраните произведенные изменения. 

• Name (Название) – разрешает вывод названия точек в окне карты, 
возле курсора и в строке состояния.  

• Code (Код) – разрешает вывод кода точки в окне карты, возле 
курсора и в строке состояния.  

• Height (Высота) – разрешает вывод высоты точки в окне карты, возле 
курсора и в строке состояния 

Щелкните на кнопке ОК  для принятия изменений и закрытия диалогового 
окна. 

 
Рисунок 4-49. Настройка вида Стереопары 
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Выбор данных 
В программе Topcon Tools данные могут быть выбраны или визуально, 
используя мышь, или же через пункт меню Select (Выбор). Выбор данных 
дает возможность просмотра и редактирования данных о точках и 
базисах. Выбор только части данных для обработки или экспорта может 
быть более продуктивным, чем обработка или экспорт всех данных 
проекта. Данные, выбираемые в одном виде (окне) программы, также 
выбираются во всех остальных. 
Диалоговые окна Select (Выбор) поддерживают возможность 
использования групповых символов (* и ?) для выбора данных с общими 
элементами. Например, для выбора всех точек с названиями, 
начинающимися с символов "TS", в диалоговом окне Select Points 
(Выбор точек) введите в поле Name (Название) строку "TS*". Остальные 
поля окна оставьте без изменений и щелкните на кнопке ОК. Все точки с 
названиями, начинающимися на "TS", будут выбраны во всех открытых 
видах программы. Вы можете также комбинировать критерии для выбора 
данных, отвечвющих всем установленным критериям. 

Выбор данных в видах Map, 
Occupation и CAD 
Для выбора данных в видах Map, Occupation и CAD (Карта, Сеансы и 
CAD): 

• Щелкните по нужной точке, базису, сеансу, эпохе или линии. Для 
выбора нескольких объектов выделите нужные данные, удерживая 
клавишу Shift нажатой. Используйте клавишу Ctrl для выбора или 
отмены выбора элементов. 

• Щелкните и обведите прямоугольником нужные точки, базисы, 
сеансы, эпохи или линии. При прорисовке прямоугольника слева 
направо выбираются все попавшие полностью или частично в 
прямоугольник объекты. При прорисовке справа налево выбираются 
только те объекты, которые полностью находятся внутри 
прямоугольника выбора. Для выбора несмежных групп данных 
повторите описанную выше процедуру, удерживая нажатой клавишу 
Shift. Используйте клавишу Ctrl для выбора или отмены выбора 
элементов. 

• При использовании описанного выше способа для выбора эпох 
измерений будут выбраны все эпохи, заключенные в пределах 
временного интервала, обозначенного прямоугольником. 

Редактирование выбранных данных описывается в разделе 
"Редактирование свойств данных" на стр. 5-52. 



Просмотр, выбор и фильтрация данных 

Topcon Tools- Руководство пользователя 4-48 

Выбор данных в видах Таблица и 
Коды 
Для выбора данных в видах Таблица или Коды: 

• Щелкните курсором на нужной ячейке. 
• Для выбора группы ячеек выделите нужные данные, удерживая 

клавишу Shift. Используйте клавишу Ctrl для выбора или отмены 
выбора отдельных элементов. 

В видах Таблица и Коды некоторые ячейки данных содержат также 
выпадающие списки, в которые вводится новая или обновляется 
имеющаяся информация. Редактируемые поля различны для каждой 
таблицы и панели, некоторые ячейки данных не редактируются. 

• Для получения доступа к выпадающим спискам и редактируемым 
полям и окошкам счетчика выделите ячейку и нажмите клавишу F2 
или дважды щелкните, но не подряд, а через паузу. После этого 
щелкните вне ячейки или нажмите клавишу Enter (Ввод). 

• Для выполнения одинаковых изменений в однотипных ячейках 
выделите нужные строки, удерживая нажатой клавишу Shift для 
выбора подряд расположенных ячеек или клавишу Ctrl для выбора 
элементов произвольно расположенных строк. Щелкните по 
выбранным ячейкам однократно, введите новые данные и нажмите 
клавишу Enter (Ввод). 

Для отмены режима редактирования нажмите клавишу Esc. 
Дополнительно см. разделы “Редактирование в табличном виде” на стр. 5-
1 и "Редактирование кодов в виде Коды" на стр. 5-35. 

Выбор точек 
Для выбора точек по установленным Вами критериям выберите пункт 
меню Select > Select Points (Выбор > Выбор точек) или воспользуйтесь 
комбинацией клавиш Ctrl+Shift+P. 
В диалоговом окне Select Points (Выбор точек) введите перечисленные 
ниже параметры и щелкните на кнопке ОК (рис. 4-50 на стр. 4-49). 

• Name / Note / Code (Название / Примечание / Код) – введите 
название / примечание / код или часть названия / примечания / кода 
и групповой символ для выбора всех точек с указанными 
элементами. 

• Std Dev Horizontal / Std Dev Vertical (СКО в плане / СКО по высоте) – 
выберите критерий сравнения величины ошибки Less than (Менее), 
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Greater than (Более) или Don't use (критерий не используется). 
Введите величину ошибки в метрах. 

• Point type (Тип точки) – выберите тип для точки из списка. Для 
отбора точек без измерений выберите Unconnected 
(Неподключенная). 

• Enabled for adjustment (Используется при уравнивании) – выберите 
Enabled (Используется), Disabled (Не используется) или Don't use 
(Параметр игнорировать). 

• Clear current selection (Очистить текущий выбор) – выделение всех 
выбранных к моменту начала поиска объектов будет снято. Если 
этот параметр не выбран, уже выбранные объекты останутся 
выбранными. 

Щелчок на кнопке Set default (По умолчанию) принимает все установки в 
окне согласно настройкам по умолчанию (см. рис. 4-50). 

 
Рисунок 4-50. Выбор точек 

Выбор тахеометрических станций 
Для выбора тахеометрических станций по установленным Вами критериям  
выберите пункт меню Select > Select TS Occupations (Выбор > Выбор 
тахеометрических станций) или воспользуйтесь комбинацию клавиш 
Ctrl+Shift+Т. 
В диалоговом окне Select TS Occupations (Выбор тахеометрических 
станций) введите перечисленные ниже параметры и щелкните на кнопке 
ОК (см. рис. 4-51 на стр. 4-50). 

• Point name / Source (Название точки / Источник) – введите название 
точки/месторасположение или часть названия/источника и 
групповой символ для выбора всех станций с указанными 
элементами. 

• Instrument height (Высота инструмента) – выберите критерий 
сравнения высоты инструмента - Less than (Менее), Greater than 
(Более) или Don't use (критерий не используется). Введите величину 
высоты инструмента в метрах. 
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• Related point (Пикеты) – если этот пункт выбран, то все пикеты, 
взятые с этой станции, также будут выбраны. 

• Related obs (Связанные измерения) – если этот пункт выбран, то все 
измерения, выполненные с этой точки стояния, также будут 
выбраны. 

• Clear current selection (Очистить текущий выбор) – выделение всех 
выбранных к моменту начала поиска объектов будет снято. Если 
этот параметр не выбран, уже выбранные объекты останутся 
выбранными. 

Щелчок на кнопке Set default (По умолчанию) принимает все установки в 
окне согласно настройкам по умолчанию (см. рис. 4-51). 
. 

 
Рисунок 4-51. Выбор тахеометрических станций 

Выбор GPS сеансов 
Для выбора GPS сеансов по установленным Вами критериям выберите 
пункт меню Select > Select GPS Occupations (Выбор > Выбор сеансов 
GPS) или воспользуйтесь комбинацией клавиш Ctrl+Shift+G. 
В диалоговом окне Select GPS Occupations (Выбор сеансов GPS), 
введите перечисленные ниже параметры и щелкните на кнопке ОК (рис. 
4-52 на стр. 4-51). 

• Point name / Original name / Point code / Source (Название точки / 
Исходное название / Код точки / Источник данных) – введите 
название точки/код/месторасположение или часть 
названия/кода/источника и групповой символ для выбора всех GPS 
сеансов с указанными элементами. 

• Method (Метод) – выберите метод обработки данных из списка для 
всех GPS сеансов, выполненных этим методом.  

• Antenna height (Высота антенны) – выберите критерий сравнения 
величины высоты антенны Less than (Менее), Greater than (Более) 
или Don't use (критерий не используется). Введите величину высоты 
антенны в метрах. 

• Start time / End time (Время начала / Время окончания) – выберите 
критерий сравнения Less than (Менее), Greater than (Более) или 
Don't use (критерий не используется). Если используется выбор 
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данных по времени начала или окончания сеанса, введите дату и 
время начала или окончания сеанса. 

• Durations (Продолжительность) – выберите критерий сравнения 
(Less than (Менее), Greater than (Более) или Don't use (критерий не 
используется). Если используется выбор данных по 
продолжительности сеанса, введите продолжительность сеанса 
измерений (дни, часы, минуты и секунды). 

• Related point (Связанная точка) – если этот пункт выбран, то все 
точки, на которых производились выбранные сеансы измерений, 
также будут выбраны. 

• Related obs (Связанные измерения) – если этот пункт выбран, то все 
измерения, входящие в сеансы GPS, также будут выбраны. 

• Clear current selection (Очистить текущий выбор) – выделение всех 
выбранных к моменту начала поиска объектов будет снято. Если 
этот параметр не выбран, уже выбранные объекты останутся 
выбранными. 

Щелчок на кнопке Set default (По умолчанию) принимает все установки в 
окне согласно настройкам по умолчанию (см. рис. 4-52). 

 
Рисунок 4-52. Выбор сеансов GPS 

Выбор тахеометрических 
измерений 
Для выбора тахеометрических измерений по установленным Вами 
критериям выберите пункт меню Select > Select TS Obs (Выбор > Выбор 
тахеометрических измерений) или воспользуйтесь комбинацией клавиш 
Ctrl+Shift+M. 
В диалоговом окне Select TS Obs (Выбор тахеометрических 
измерений) введите перечисленные ниже параметры и щелкните на 
кнопке ОК (рис. 4-53 на стр. 4-52). 

• From point / To point (От точки / До точки) – введите название от 
точки/до точки или часть имени от точки/до точки и групповой 
символ для выбора всех тахеометрических измерений с указанными 
элементами. 
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• Enabled (Включен) – выберите Enabled, Disabled или Don't use 
(Включен, Отключен или Не используется) для управления 
включением точек в уравнивание. 

• Hz residual / V residual (Горизонтальная невязка / Высотная невязка) 
- выберите критерий сравнения Less than (Менее), Greater than 
(Более) или Don't use (критерий не используется). Если 
используется отбор данных по невязке, введите ее величину в 
метрах. 

• Reflector height (Высота отражателя) – выберите критерий сравнения 
Less than (Менее), Greater than (Более) или Don't use (критерий не 
используется). Если используется отбор данных по высоте 
отражателя, введите ее величину в метрах. 

• Hz angle / V angle / Z angle (ГУ / ВУ / ЗР) – – выберите критерий 
сравнения Less than (Менее), Greater than (Более) или Don't use 
(критерий не используется). Если используется отбор данных по 
углу, величина вводится в градусах. 

• Hz dist / V dist / Slope dist (Горизонтальное проложение / 
Превышение / Наклонное расстояние) – выберите критерий 
сравнения Less than (Менее), Greater than (Более) или Don't use 
(критерий не используется). Если используется отбор данных по 
расстоянию, величина вводится в метрах. 

• Related point (Связанная точка) – если этот пункт выбран, станция, с 
которой производится измерение, также будет выбрана. 

• Clear current selection (Очистить текущий выбор) – выделение всех 
выбранных к моменту начала поиска объектов будет снято. Если 
этот параметр не выбран, уже выбранные объекты останутся 
выбранными. 

Щелчок на кнопке Set default (По умолчанию) принимает все установки в 
окне согласно настройкам по умолчанию (см. рис. 4-53). 
. 

 
Рисунок 4-53. Выбор тахеометрических измерений 
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Выбор базисов GPS 
Для выбора базисов GPS по установленным Вами критериям используйте 
пункт меню Select > Select GPS Obs (Выбор > Выбор базисов GPS) или 
воспользуйтесь комбинацией клавиш Ctrl+Shift+О. 
В диалоговом окне Select GPS Obs (Выбор базисов GPS), задайте 
перечисленные ниже параметры и щелкните на кнопке ОК (см. рис. 4-54 
на стр. 4-54). 

• From point / To point (От точки / До точки) – введите название или его 
часть и групповой символ для выбора всех базисов GPS с общей 
частью введенного элемента. 

• Type (Тип) – выберите тип базисов из списка. 
• Start time (Время начала) – выберите критерий сравнения времени 

начала сеанса, по которому определен этот базис Less than (Менее), 
Greater than (Более) или Don't use (критерий не используется). Если 
этот параметр используется, введите дату и время начала 
измерений на базисе. 

• Durations (Продолжительность) – выберите критерий сравнения Less 
than (Менее), Greater than (Более) или Don't use (критерий не 
используется). Если используется выбор данных по 
продолжительности сеанса, введите продолжительность сеанса 
измерений (дни, часы, минуты и секунды). 

• Solution type (Тип решения) – для выбора базисов, полученным 
исключительно указанным методом, выберите его из списка. 

• Hz precision / V precision (Плановая точность / Высотная точность) – 
выберите критерий сравнения величины точности Less than (Менее), 
Greater than (Более) или Don't use (критерий не используется). 
Введите точность в метрах.  

• Hz residual / V residual (Горизонтальная невязка / Высотная невязка) 
выберите критерий сравнения величины невязки Less than (Менее), 
Greater than (Более) или Don't use (критерий не используется). 
Введите величину невязки в метрах. 

• Length (Длина) – выберите критерий сравнения длины базиса Less 
than (Менее), Greater than (Более) или Don't use (критерий не 
используется). Если используется выбор данных по длине базиса, 
ее величина вводится в метрах. 

• Enabled (Включен) – выберите Enabled, Disabled или Don't use 
(Включен, Отключен или Не используется) – выбор базисов для 
включения в уравнивание. 

• Clear current selection (Очистить текущий выбор) – выделение всех 
выбранных к моменту начала поиска объектов будет снято. Если 
этот параметр не выбран, уже выбранные объекты останутся 
выбранными. 
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Щелчок на кнопке Set default (По умолчанию) принимает все установки в 
окне согласно настройкам по умолчанию (см. рис. 4-54 стр. 4-54). 

 
Рисунок 4-54. Выбор базисов GPS 

 

Отмена выбора данных 
Для быстрой отмены выбора сеансов спутниковых измерений или базисов 
и одновременного выбора сеансов или базисов используйте инструмент 
Topcon Tools под названием Invert Selection (Обращение выбора). 
Для обращения выбора выберите пункт меню Select > Invert Selection 
(Выбор > Обращение выбора) или воспользуйтесь комбинацией клавиш 
Ctrl+Shift+I.  
Выбранные сеансы или базисы перестанут быть выбранными и наоборот 
(см. рис. 4-55). 

 
Рисунок 4-55. До и после обращения выбора 
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Фильтрация данных 
Применяемые фильтры данных дают возможность скрытия или 
отображения точек, сеансов и измерений по типу, времени и (или) коду 
используя диалоговое окно Filters (Фильтры) (см. рис. 4-56). Скрытые 
точки, сеансы и измерения не будут использоваться в обработке, 
уравнивании, экспорте и при составлении отчетов. 

 
Рисунок 4-56. Фильтры 

 
СОВЕТ 

При использовании фильтрации данных по множественным 
параметрам (тип, время, код) выбранные фильтры 
комбинируются по принципу логического ИЛИ. 

Topcon Tools отображает состояние фильтра в строке состояния (см. 
раздел "Строка состояния" на стр. 1-19). 

Фильтрация по типу 
1. Для скрытия или отображения данных определенного типа выберите 

пункт меню View > Filters (Вид > Фильтры) или щелкните на кнопке 
Filters (Фильтры) инструментальной панели. 

2. Во вкладке By Type (По типу) поставьте флажок возле типа данных, к 
которым необходимо применить фильтр (см. рис. 4-57 на стр. 4-56). 

• Маркированные красным крестиком данные будут скрыты, а 
зеленым флажком – отображаться. 
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• Точка, принадлежащая различным типам данных одновременно 
(например, одна и та же точка стояния для тахеометрического 
хода и базиса GPS), будет скрыта только в том случае, если все 
ее типы данных будут скрыты. 

 
Рисунок 4-57. Фильтр по типу  

3. Щелкните на кнопке Apply (Применить) для сохранения настроек 
фильтрации. Щелкните на кнопке Close (Закрыть) для принятия 
настроек фильтрации и закрытия окна. 

Фильтрация по времени 
1. Для скрытия данных измерений, проведенных в конкретный 

промежуток времени, выберите пункт меню View >  Filters (Вид >  
Фильтры) или щелкните на кнопке Filters (Фильтры) 
инструментальной панели. 

2. Во вкладке By Time (По времени) выберите время начала (From) и 
время окончания (To) интервала 1 и интервала 2 (interval 1, interval 2) 
(см. рис. 4-58 на стр. 4-57). 
ПРИМЕЧАНИЕ: будут скрыты только сеансы и измерения 
находящиеся внутри выбранных интервалов. Точки будут скрыты, если 
их координаты были получены по измерениям, проведенным в 
выбранный временной интервал фильтра. 

3. Щелкните на кнопке Reset (Сброс)  для сброса настроек выбранных 
временных интервалов. 

4. Щелкните на кнопке Apply (Применить) для сохранения настроек 
фильтрации. Щелкните на кнопке Close (Закрыть) для принятия 
настроек фильтрации и закрытия окна. 
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Рисунок 4-58. Фильтрация по времени 

Фильтрация по коду 
1. Для фильтрации по коду выберите пункт меню View >  Filters (Вид >  

Фильтры) или щелкните на кнопке Filters (Фильтры) 
инструментальной панели. 

2. Во вкладке By Code (По коду) введите код, к которому будет применен 
фильтр (см. рис. 4-59 на стр. 4-58). 

 
СОВЕТ 

Используйте групповой символ (* или ?) для применения 
фильтра к данным с кодами, имеющими общую часть. 
Допускается одновременное применение нескольких кодов 
(разделите их запятыми). 

3. Щелкните на кнопке Apply (Применить) для сохранения настроек 
фильтрации. Щелкните на кнопке Close (Закрыть) для принятия 
настроек фильтрации и закрытия окна. 
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Рисунок 4-59. Фильтрация по коду 

 

Фильтрация по показателям 
контроля качества 
1. Для установки фильтра по контролю качества выберите пункт меню 

View > Filters (Вид > Фильтры) или щелкните на кнопке Filters 
(Фильтры) инструментальной панели. 

2. Во вкладке By QAQC (Контроль качества) выберите необходимые 
параметры, к которым будет применен фильтр (рис. 4-60). 
Маркированные красным крестиком данные будут скрыты, а зеленым 
флажком – отображаться. 

3. Щелкните на кнопке Apply (Применить) для сохранения настроек 
фильтрации. Щелкните на кнопке Close (Закрыть) для принятия 
настроек фильтрации и закрытия окна. 

 
Рисунок 4-60. Фильтрация по показателям контроля качества данных 
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Просмотр свойств данных 
Каждый тип данных имеет собственный вид диалогового окна Properties 
(Свойства) с отображением соответствующих данных, его 
характеризующих. При выборе нескольких объектов одного типа все они  
будут представлены в одном диалоговом окне. При выборе данных 
различных типов будет открыто столько диалоговых окон, сколько 
выбрано типов данных. 
Для просмотра диалогового окна Properties (Свойства) для одного или 
нескольких объектов в видах Таблица, Карта, Сеансы или CAD (Tabular, 
Map, Occupation, CAD view) (рис. 4-61) проделайте следующие операции: 

• Выберите точку/измерение/сеанс/линию в графическом или 
табличном видах и выберите пункт меню Edit >  Properties 
(Редактирование >  Свойства). 

• Щелчком по правой кнопке мыши на точке/ измерении/ сеансе/ 
линии в графическом или табличном видах вызовите выпадающее 
меню и выберите пункт Properties (Свойства). 

 
Рисунок 4-61. Вызов диалогового окна Properties (Свойства) 

Содержимое диалогового окна Properties (Свойства) зависит от 
количества выбранных данных и от их типа. 

• В свойствах точек поле Name (Название) и вкладка CAD не доступны 
для просмотра при выборе нескольких точек. 

• В свойствах сеансов спутниковых измерений тип сеанса определяет 
доступные поля (камеральная обработка или RTK). 

• В свойствах базисов GPS тип базиса определяет доступные поля 
(статика или кинематика). 

• При выборе нескольких линий в их свойствах отображается только 
вкладка General (Основные параметры). 

• Для таблиц TS Obs, Tape Dimension и Linework (Тахеометрия, 
Обмеры и Линии) панель, в которой осуществлялся выбор объектов, 
определяет отображаемые свойства. 

Диалоговые окна Properties (Свойства) детально описаны в разделе 
"Редактирование свойств данных" на стр. 5-52. 
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Для заметок: 
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Глава 5  
Редактирование 
данных 
Программа Topcon Tools предоставляет различные возможности по 
изменению свойств данных, их объединению и обновлению при 
подготовке к камеральной обработке и уравниванию. 

Редактирование в табличном 
виде 
Многие ячейки таблиц могут быть отредактированы с использованием 
окон с прокруткой значений выбора, выбором из выпадающих списков или 
непосредственным вводом значений. 
Для редактирования информации в ячейке дважды щелкните по ней через 
паузу или щелкните по уже выделенной ячейке или выделите ячейку и 
щелкните на кнопке F2 для отображения данных для выбора или 
редактирования. 
Для ввода одинаковых значений для нескольких ячеек выделите 
необходимые ячейки, удерживая нажатой клавишу Shift. Щелкните по 
одной из выделенных ячеек, отредактируйте данные и нажмите на 
клавишу Enter (см. рис. 5-1). Нажатие клавиши Esc отменяет 
произведенные изменения. 

• В окнах с прокруткой значений выбора щелкните по стрелке вверх 
или вниз для перехода к следующему значению или введите это 
значение с клавиатуры. 

• В выпадающих списках щелкните по нужному значению. При 
необходимости, щелкните по пункту More (Больше) для показа всех 
значений. 

• Для полей с непосредственным вводом значений введите новые 
данные и, при необходимости, удалите старые. 

 
Рисунок 5-1. Поля редактирования данных 
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В Таблице 5-1 приведен список редактируемых и не редактируемых полей 
вкладок вида Таблица. 

Таблица 5-1. Редактируемые поля Табличного вида 

Вкладка Редактируемые поля Нередактируемые поля 

Point (Точки) 

Name (Название) 
Coordinates (Координаты) 
Code (Код) 
Control (Исходный) 
Note (Примечание) 
String (Строковый код) 
Control Code (Контрольный код) 
Layer (Слой) 

Icon (Пиктограмма) 
Standard Deviation (СКО) 
Stringa (Строковый код) 
Control Codeb(Контрольный код) 
Combined scale factor 
(Комбинированный масштаб) 
Convergence (Сходимость) 
Photo Notes (Фото примечание) 

GPS Occupations 
(Сеанс спутниковых 
измерений) 

Point Name (Название точки) 
Original Name (Исходное 
название) 
Antenna Type (Тип антенны) 
Antenna Height (Выс. ант.) 
Antenna Height Method (Способ 
измерения высоты антенны) 
Note (Примечание) 
Offset Distance (Смещение дл.) 
Offset Height (Смещение выс.) 
Offset Across (Смещение 
поперек) 

Icon (Пиктограмма) 
Interval (Интервал) 
Start Time (Время начала) 
Stop Time (Время окончания) 
Duration (Продолжительность) 
Method (Метод) 
Source (Источник данных) 
Receiver (Приемник) 

TS Obs, Left Panel 
(Тахеометрия, левая 
панель) 

# (Номер) 
Point Name (Название точки) 
Instrument Height (Высота 
инструмента) 
Instrument Type (Тип 
инструмента) 

Icon (Пиктограмма) 
 

TS Obs, Right Panel 
(Тахеометрия, правая 
панель) 

# (Номер точки) 
Point To (Конечная точка) 
Reflector Height (Высота 
отражателя) 
Azimuth (Азимут) 
Note (Примечание) 
Code (Код) 
AutoReject (Автоматическая 
отбраковка) 
Offsets (Элементы приведения) 

Icon (Пиктограмма) 
Point From (Начальная точка) 
Horizontal Circle (Гор. угол) 
Slope Distance (Наклонное 
расстояние) 
Zenith Angle (Зенитное расстояние) 
Vertical Angle (Верт. угол) 
Horizontal Distance (Гор. прол.) 
Vertical Distance (Превышение) 
Date (Дата) 
Type (Тип) 
Adjustment Status (Уравнивание) 
Residuals (Невязки) 
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Вкладка Редактируемые поля Нередактируемые поля 

GPS Obs (GPS 
базисы) 

Note (Примечание) 
AutoReject (Автоматическая 
отбраковка)  
Point To (До точки - только для 
RTK траекторий) 

Icon (Пиктограмма) 
Point From (От точки) 
Point To (До точки) 
Start Time (Время начала) 
Duration (Продолжительность) 
Precisions (Точности) 
Solutions (компоненты базиса) 
Method (Метод измерений) 
Solution Type (Тип решения) 
Orbit (Эфемериды) 
Adjustment Status (Статус 
уравнивания) 
Residuals (Невязки) 
HDOP, VDOP (Геом. факторы) 
GPS / GLONASS Satellites 
(Спутники GPS/ГЛОНАСС) 
Epoch (Эпохи) 

Tape Dimension 
(Обмеры) 

Start Point (Начальная точка) 
End Point (Конечная точка) 
# (Номер точки) 
Point To (До точки) 
Distance (Дальность) 
Note (Примечание) 

Icon (Пиктограмма) 
Date (Дата) 

DL Obs, Left Panel 
(Нивелирование, 
левая панель) 

# / № 
Note (Примечание) 
Name of DL job (Название 
нивелирного хода) 

Icon (Пиктограмма) 
From (От) 
To (До) 
Date (Дата) 
Distance (Дальность) 
Balance (Сумма превышений по 
ходу) 

DL Obs, Right Panel 
(Нивелирование, 
правая панель) 

Point (Точка) 
Note (Примечание) 
AutoReject (Автоматическая 
отбраковка) 
Vertical Offset (Смещение по 
высоте) 

# (Номер измерения) 
Elevation (Превышение) 
Instrument Elevation (Высота 
инструмента) 
Icon (Пиктограмма) 
BS (Изм. на заднюю точку) 
SS (Изм. на точку вне хода) 
FS (Изм. на переднюю точку) 
Distance (Дальность) 
Standard Deviations (СКО) 
Date (Дата) 
Adjustment Status (Статус 
уравнивания) 
Height Residual (Невязка по высоте) 
Job (Ход) 
Source (Источник данных) 

Linework, Left Panel 
(Линии, левая панель) 

Layer (Слой) 
Color (Цвет) 
Line Style (Стиль линии) 
Length (Длина) 
Line Width (Толщина линии) 

Icon (Пиктограмма) 
Type (Тип) 
Code (Код) 
String (Строковый код) 
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Вкладка Редактируемые поля Нередактируемые поля 

Linework, Right Panel 
(Линии, правая 
панель) 

Order (Порядок) Icon (Пиктограмма) 
Point (Точка) 
Control Code 2 (Контрольный код 2) 
Control Code (Контрольный код) 

Images (Изображения) 
Отсутствуют Отсутствуют 

Surfaces 
(Поверхности) 

Name (Название) 
Comments (Комментарии) 
Layer (Слой) 
Focus point (Фокус) 

Icon (Пиктограмма) 
Number of Points (Количество точек) 
Number of Triangles (Количество 
треугольников) 
Min/Max Northing (Мин./Макс. 
Северная координата) 
Min/Max Easting (Мин./Макс. 
Восточная координата) 
Min/Max Elevation (Мин./Макс. 
высота)  
Need Update (Необходимость 
обновления) 
Auto Update (Автоматическое 
обновление) 

Stereopairs 
(Стереопары) 

Отсутствуют Отсутствуют 

Scan Session, Left 
Panel (Сеансы 
сканирования, левая 
панель) 

Name (Название) Icon (Пиктограмма) 
Instrument Point (Точка 
Инструмента) 

Roads, Left Panel 
(Дороги, левая 
панель) 

List of Roads (Список дорог) Отсутствуют 

Roads, Right Panel 
Horizontal alignment for 
Line (Дороги, правая 
панель; Плановое 
проектирование 
линии) 

Order (Порядок) 
Azimuth (Азимут) 
Length (Длина) 
Tangential to prev (По 
касательной к предыдущему 
элементу) 

Icon (Пиктограмма) 
Type (Тип) 
End Sta/Chainage (Пикетаж 
последней точки) 
End Northing (Северная координата 
последней точки) 
End Easting (Восточная координата 
последней точки) 
End Azimuth (Азимут последнего 
отрезка) 

Roads, Right Panel 
Horizontal alignment for 
Curve (Дороги, правая 
панель; Плановое 
проектирование 
кривой) 

Order (Порядок) 
Azimuth (Азимут) 
Length (Длина) 
Turn (Поворот) 
Tangential to prev (По 
касательной к пред. элементу) 
Start Radius (Начальный 
радиус) 
Delta (Дельта) 
Chord (Хорда) 
Tangent (Тангенс) 
Mid Ord (Средняя ордината) 
External (Внешний) 

Icon (Пиктограмма) 
Type (Тип) 
End Radius (Радиус последнего 
участка) 
End Sta/Chainage (Пикетаж 
последней точки) 
End Northing (Северная координата 
последней точки) 
End Easting (Восточная координата 
последней точки) 
End Azimuth (Азимут последнего 
участка) 
End Deg Chord (Окончательный 
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Вкладка Редактируемые поля Нередактируемые поля 

Start Deg Chord (Начальный 
угол хорды) 
Start Deg Curve (Начальный 
угол кривой) 

угол хорды) 
End Deg Curve (Окончательный 
угол кривой) 

Roads, Right Panel 
Horizontal alignment for 
Spiral (Дороги, правая 
панель; Плановое 
проектирование 
спирали) 

Order (Порядок) 
Azimuth (Азимут) 
Length (Длина) 
Turn (Поворот) 
Start Radius (Начальный 
радиус) 
Tangential to prev (По 
касательной к пред. элементу) 
Spiral Dir (Направл. спирали) 
Spiral Const (Постоянная 
спирали) 
Start Deg Chord (Угол начала 
хорды) 
Start Deg Curve (Начальный 
угол кривой) 
End Deg Chord (Угол конца 
хорды) 
End Deg Curve (Угол конца 
кривой) 

Icon (Пиктограмма) 
Type (Тип) 
End Radius (Радиус последнего 
участка) 
End Sta/Chainage (Пикетаж 
последней точки) 
End Northing (Северная координата 
последней точки) 
End Easting (Восточная координата 
последней точки) 
End Azimuth (Азимут последнего 
участка) 
 

Roads, Right Panel 
Horizontal alignment for 
Intersection (Дороги, 
правая панель; 
Плановое 
проектирование 
пересечения) 

Order / Порядок 
Start Radius (Начальный 
радиус) 
Northing (Северная координата) 
Easting (Восточная координата) 
Spiral 1 Len (Спираль длина 1) 
Spiral 2 Len (Спираль длина 2) 
Intersection Pt (Точка 
пересечения) 
Spiral Const 1 (Постоянная 
спирали 1) 
Spiral Const 2 (Постоянная 
спирали 2) 
Start Deg Curve (Начальный 
угол кривой) 

Icon (Пиктограмма) 
Type / Тип 
Length / Длина 
Azimuth / Азимут 
Tangential to prev (По касательной к 
предыдущему элементу) 
End Sta/Chainage (Пикетаж 
последней точки) 
End Radius (Радиус последнего 
участка) 
End Northing (Северная координата 
последней точки) 
End Easting (Восточная координата 
последней точки) 
End Azimuth (Азимут последнего 
участка) 

Roads, Right Panel 
Vertical alignment for 
Grade ( Дороги, 
правая панель. 
Высотное 
проектирование 
уклона) 

Order (Порядок) 
Length (Длина) 
Start Grade (Начальный уклон) 

Icon (Пиктограмма) 
Type / Тип 
End Sta/Chainage (Пикетаж 
последней точки) 
End Grade (Окончательный уклон) 
Elevation (Превышение) 
Radius (Радиус) 

Roads, Right Panel 
Vertical alignment for 
Parabola (Дороги, 
правая панель 
Высотное 
проектирование 
параболы) 

Order (Порядок) 
Length (Длина) 
Start Grade (Начальный уклон) 
End Grade (Окончательный 
уклон) 

Icon (Пиктограмма) 
Type (Тип) 
End Sta/Chainage  
Elevation (Превышение) 
Radius (Радиус) 
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Вкладка Редактируемые поля Нередактируемые поля 

Roads, Right Panel 
Vertical alignment for 
Parabola Long Section 
(Дороги, правая 
панель Высотное 
проектирование 
длинного участка 
параболы) 

Length (Длина) 
End Sta/Chainage (Пикетаж 
последней точки) 

Icon (Пиктограмма) 
Type (Тип) 
Order (Порядок) 
Start Grade (Начальный уклон) 
End Grade (Окончательный уклон) 
Radius (Радиус) 

Roads, Right Panel 
Vertical alignment for 
Circular Arc (Дороги, 
правая панель Выс. 
проектирование 
круговой дуги) 

Order (Порядок) 
Radius (Радиус) 
Start Grade (Начальный уклон) 
End Grade (Окончательный 
уклон) 
 

Icon (Пиктограмма) 
Type (Тип) 

Roads, Right Panel 
Vertical alignment for 
Circular Arc Long 
Section (Дороги, 
правая панель. Выс. 
проект. длинного 
участка круговой дуги) 

Length (Длина) 
End Sta/Chainage (Пикетаж 
последней точки) 
Elevation (Превышение) 
Radius (Радиус) 

Icon (Пиктограмма) 
Type (Тип) 
Order (Порядок) 
Start Grade (Начальный уклон) 
End Grade (Окончательный уклон) 

Roads, Right Panel X-
Section (Дороги, 
правая панель. 
Поперечник) 

End Sta/Chainage (Пикетаж 
последней точки) 
Side (Сторона) 
Template (Типовой поперечник) 

Icon (Пиктограмма) 
 

X-Section Templates, 
Left Pane (Типовой 
поперечник. Левая 
панель) 

Name (Название) 
Cut Slope (1:n) (Откос выемки 
(1:n)) 
Fill Slope (1:n) (Откос насыпи 
(1:n)) 

Icon (Пиктограмма) 
 

X-Section Templates, 
Left Pane (Типовой 
поперечник. Правая 
панель) 

Order (Порядок) 
Code (Код) 
Hz. Dist (Горизонтальное 
расстояние) 
V. Dist (Вертикальное 
расстояние( 
Grade (Уклон) 

Icon (Пиктограмма) 
Hz. Offset from CL (Смещение от 
оси в плане) 
V. Offset from CL (Смещение от оси 
по высоте) 

a. Для Control Code (Контрольного кода) столбец Code (Код) должен 
содержать данные для редактирования. 

b. Для String (Строкового кода) столбец Code (Код) должен содержать 
данные для редактирования. 
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Изменение параметров 
антенн 
Параметры антенн являются одними из наиболее часто редактируемых 
полей данных. Таблица 5-1 на стр. 5-2 содержит список редактируемых 
ячеек. 
Элемент списка под названием Custom Antenna (Антенна, задаваемая 
пользователем) позволяет пользователю добавлять антенны с новыми 
характеристиками. 

Вариант 1: Редактирование в 
табличном виде 
1. Выделите сеанс измерений, свойства которого нужно изменить. 

Для выбора сеансов спутниковых измерений по определенным 
критериям используйте диалоговое окно Select GPS Occupations (см. 
"Выбор GPS сеансов" на стр. 4-50). 

2. Щелкните на выделенной ячейке (или нажмите клавишу F2) и 
отредактируйте необходимые параметры (см. рис. 5-2). 

• В поле Antenna Type (Тип антенны) выберите нужный тип 
антенны из выпадающего списка. 

• В поле Antenna Height (Высота антенны) введите высоту 
антенны над центром. 

• В поле Antenna Height Method (Метод измерения высоты 
антенны) выберите (из выпадающего списка) метод измерения 
высоты антенны над центром. 

 
Рисунок 5-2. Редактируемые параметры антенн в табличном виде 

3. После окончания редактирования параметров щелкните вне ячейки 
или нажмите клавишу Enter для сохранения изменений. 

4. Повторите шаги 2 и 3 для всех редактируемых ячеек (см. рис. 5-3 на 
стр. 5-8). 
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Рисунок 5-3. Измененные параметры антенн 

 

Вариант 2: Редактирование в 
диалоговом окне Свойства 
1. Выделите сеанс измерений, свойства которого нужно изменить. 

Для выбора сеансов спутниковых измерений по определенным 
критериям используйте диалоговое окно Select GPS Occupations (см. 
"Выбор GPS сеансов" на стр. 4-50). 

2. Щелчком по правой кнопке мыши на ячейке сеанса измерений 
вызовите выпадающее меню и выберите пункт Properties (Свойства) 
или выберите пункт меню Edit > Properties (Редактирование > 
Свойства) (см. рис. 5-4). 

 
Рисунок 5-4. Способы вызова диалогового окна Properties (Свойства) 

3. Во вкладке Antenna (Антенна), если требуется, отредактируйте поля 
Antenna Type (Тип антенны), Antenna Height (Высота антенны) и Ant 
Height Method (Метод измерения высоты антенны) (см. рис. 5-5 на 
стр. 5-9). 

4. Щелкните на кнопке ОК для сохранения произведенных изменений, 
что отразится в таблице GPS Occupations (сеансы спутниковых 
измерений) (см. рис. 5-3). 
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Рисунок 5-5. Ввод новых параметров 

 

Редактирование элементов 
приведения антенны 
1. Для редактирования элементов приведения антенны щелчком по 

правой кнопке мыши на произвольной ячейке таблицы вызовите 
выпадающее меню и в нем выберите пункт Options (Опции) (см. рис. 
5-6). 

2. В диалоговом окне Options (Опции) занесите названия колонок 
элементов приведения в окно Selected columns (Выбранные колонки) 
(рис. 5-6). Щелкните на кнопке ОК. 

 
Рисунок 5-6. Просмотр опций 

3. Щелчком по правой кнопке мыши по таблице GPS Occupations 
(Сеансы спутниковых измерений) вызовите выпадающее меню и 
выберите в нем пункт Properties (Свойства). Выберите вкладку 
Offsets (Элементы приведения) для редактирования элементов 
приведения антенны для выбранного сеанса измерений (см. рис. 5-7 
на стр. 5-10). 
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Рисунок 5-7. Свойства сеансов спутниковых измерений – вкладка Элементы 

приведения 

4. Щелкните на кнопке Apply (Применить) для принятия изменений или 
ОК для закрытия окна. 

Добавление антенн из списка, 
задаваемого пользователем 
Каждый тип антенны имеет уникальные параметры фазового центра, 
полученные в результате проведения калибровочных тестов и 
сохраненные в файле ANTENNA.XML. Эти параметры изменению не 
подлежат. Тем не менее, в список антенн, задаваемых пользователем 
(Custom Antenna List), можно добавить новые типы антенн, которые 
доступны для просмотра, редактирования и удаления из списка. 
1. Для добавления нового типа антенны в список или редактирования 

уже заданного, щелчком по правой кнопке мыши по сеансу 
спутниковых измерений вызовите выпадающее меню и выберите в 
нем пункт Properties (Свойства) (рис. 5-8). 

 
Рисунок 5-8. Открытие окна Properties (Свойства) 
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2. Во вкладке Antenna (Антенна) щелкните на кнопке Custom 
(Пользовательская) (рис. 5-9) для вызова диалогового окна Custom 
Antenna List (Пользовательский список антенн). 

 
Рисунок 5-9. Пользовательский список антенн 

3. Щелкните на кнопке Add (Добавить) (рис. 5-10). Для удаления 
антенны выделите обозначающую ее строку и щелкните на кнопке 
Remove (Удалить). 

 
Рисунок 5-10. Новая антенна, задаваемая пользователем 

4. Во вкладке General (Основные параметры) заполните поля NGS Name 
(Название по списку национальной геодезической службы США), 
Name (Название), Manufacturer (Производитель) и Notes (Примечания) 
(рис. 5-11). Затем щелкните на кнопке Apply (Применить) для 
принятия изменений. 

5. Во вкладке Parameters (Параметры) антенны введите Radius 
(Радиус), offsets (смещения) и Measured Height Method (Метод 
измерения высоты) (см. рис. 5-11). 

 
Рисунок 5-11. Новая антенна, заданная пользователем – вкладки General и 

Parameters 
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6. Во вкладке PCV (Phase Center Variation, положение фазового 
центра как функция угла возвышения), введите информацию о 
положении фазового центра антенны. 

 
Рисунок 5-12. Новая антенна пользователя – вкладка PCV (положение фазового 

центра) 

7. Щелкните на кнопке ОК.

Редактирование точек 
Основные возможности редактирования точек включают изменение их 
названий, объединение, обновление имен точек съемки (Rover points) и 
добавление точки вручную. Редактирование точки в одном из видов 
программы (Таблица, Карта) или диалоговом окне (Свойства), приводит к 
изменению ее свойств во всех видах, таблицах и диалоговых окнах. 
Таблица 5-1 на стр. 5-2 содержит список редактируемых ячеек. 

Вариант 1: Редактирование в 
табличном виде 
Имена точек могут быть изменены в таблицах Points (Точки), GPS 
Occupations (Сеансы спутниковых измерений) и TS Obs (Тахеометрия). 
Обратите внимание на существенные различия при редактировании 
названий точек в различных таблицах: 

• При редактировании названий точек во вкладке Points (Точки), 
изменить можно только название точки, и новое название будет 
отображено во всех видах. 

• При редактировании названия точки во вкладках сеансов или 
базисов, сеансу измерений будет назначена другая точка. 

• При изменении названия точки в сеансе или базисе будет создана 
копия выбранной точки (с новым именем). Если других сеансов 
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наблюдений с этой точки не проводилось, то старая точка будет 
удалена. 

1. Выделите щелчком мыши (или нажмите клавишу F2) ячейку с 
названием точки (см. рис. 5-13). Для выбора по определенным 
критериям используйте соответствующее диалоговое окно (см. "Выбор 
данных" на стр. 4-47). 

 
Рисунок 5-13. Выбор названия точки для редактирования 

2. Выберите или введите новое название точки. Щелкните вне ячейки 
или нажмите клавишу Enter для принятия изменений (рис. 5-14). 

 
Рисунок 5-14. Редактирование названия точки 

Вариант 2: Редактирование в 
диалоговом окне Свойства 
Названия точек могут быть изменены в диалоговых окнах Properties 
(Свойства) для Точек (Points), сеансов спутниковых измерений (GPS 
Occupations) и для Тахеометрии (TS Occupations). 
1. Щелчком по правой кнопке мыши на точке, сеансе или 

тахеометрическом измерении вызовите выпадающее меню и выберите 
в нем пункт Properties (Свойства) или выделите данные и выберите 
пункт меню Edit > Properties (Редактирование > Свойства). 
Для выбора по определенным критериям используйте 
соответствующее диалоговое окно (см. "Выбор данных" на стр. 4-47). 
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2. Во вкладке General (Основные параметры) диалогового окна 
Properties (Свойства), отредактируйте название точки и щелкните на 
кнопке ОК для сохранения изменений (рис. 5-15). 

 
Рисунок 5-15. Редактирование названия точки 

Объединение точек 
Иногда используется объединение двух точек, которое приводит к тому, 
что подпрограммы уравнивания, обработки, контроля качества и т.п. 
полагают, что координаты двух точек равны (точки совпадают). 
1. В таблице Points (Точки) выберите первую точку для объединения. 
2. Нажмите клавишу F2 и введите название второй точки в поле ввода 

названия. 
3. Нажмите клавишу Enter  для объединения двух точек.

 

Редактирование имен точек GPS 
съемки 
Программа обработки спутниковых измерений, выполненных в режиме 
RTK, по умолчанию использует автоматическую нумерацию точек 
траекторий по стандартной схеме. При импорте двух различных проектов 
с траекторными измерениями с точками, нумерованными по стандартной 
схеме, разные точки будут иметь одинаковые названия. 
В программе Topcon Tools запрещается наличие двух точек с 
одинаковыми названиями, если они находятся ближе 30 м друг от друга. В 
итоге, в описанной выше ситуации некоторые точки будут объединены при 
импорте. Для предотвращения этого отредактируйте имена "Point to" ("До 
точки") в таблице GPS Obs (базисы GPS). Параметр Auto-resolve point 
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name collisions during import (Автоматическое разрешение противоречий 
с дублирующимися названиями при импорте) присваивает 
импортируемым точкам, находящимся на расстоянии более 30 м, 
дополнительный суффикс "DUP". 
1. В таблице GPS Obs (базисы GPS) выберите название в столбце Point 

to (До точки) для редактирования. 
2. Нажмите клавишу F2 и введите новое название точки. 
3. Нажмите клавишу Enter. 
4. Повторите эти шаги для каждой точки съемки. 

Редактирование линий 
Topcon Tools позволяет пользователю редактировать линии в виде CAD и 
таблице Linework (Линии). Для редактирования линии в текущем проекте, 
выберите пункт меню View > Cad View (Вид > Вид CAD) и выберите 
таблицу Linework (Линии). В данном случае, пользователь может 
выполнить следующее: 

• добавить новую точку. 
• удалить выбранную точку. 
• создать новую линию и добавить точки к линии. 
• изменить код и последовательный код линии. 
• вставить точки в линию. 
• построить дугу. 
• построить прямоугольник. 
• построить замкнутые объекты. 
• удалить произвольную линию. 

Создание новой точки 
Этот процедура позволяет добавить точку в видах CAD и Карта и в 
таблице Points (Точки). 
1. Для добавления точки воспользуйтесь одним из описанных ниже 

способов: 
• Выберите пункт меню Edit > Add > Point (Редактирование > 

Добавить > Точка). Используя курсор, щелкните в нужном месте 
вида CAD. 

• Нажмите клавишу Alt и щелкните в нужном месте вида CAD. 
2. В диалоговом окне Add Point (Добавить точку) (см. рис. 5-16 на стр. 5-

16) можно изменить название точки (название по умолчанию 
присваивается название "User n", где n – это число), координаты в 
текущей системе координат проекта, ввести код, строковую 
переменную, контрольные коды, примечания и установить параметры 
качества исходных координат. Щелкните на кнопке ОК. 
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Рисунок 5-16. Диалоговое окно добавления точки 

Для установки текущего слоя проекта воспользуйтесь комбинированным 
окном Layer (Слой) инструментальной панели. В этом случае любая 
созданная точка будет иметь стиль отображения, определенный для этого 
слоя (рис. 5-17). 

 
Рисунок 5-17. Текущий слой 

Слой для размещения точки устанавливается во вкладке General 
(Основные параметры) диалогового окна Add Point (Добавить точку) 
(см. рис. 5-17). Для этой точки будут применены атрибуты (цвет и стиль 
точки) выбранного слоя. 

 
Рисунок 5-18. Выбор слоя для точки 

Для принятия кодов (вместо слоев) для точки выберите код в поле Code 
(Код) и установите "BYCODE" в поле Layer (Слой). Атрибуты (цвет и стиль) 
слоя будут применены к точке. Рисунок 5-19 на стр. 5-17 иллюстрирует 
пример точки с кодом "101" в виде CAD. Для этой точки слой был выбран 
"BYCODE (For Points)" и этот код использует слой "For Points" ("Для 
точек"). 
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Рисунок 5-19. Выбор кода для точки и просмотр точки 

• Если точка имеет несколько кодов, выбор слой "BYCODE" приводит 
к ее размещению в нескольких слоях. 

• Если точка кода не имеет, установка слоя "BYCODE" приводит к ее 
размещению в слое 0 (нулевом). 

 
Рисунок 5-20. Определение слоя при принятии кода 

Виды Карта, CAD и таблица Points (Точки) отобразят созданную точку 
(точки) (см. рис. 5-21). 

 
Рисунок 5-21. Созданные точки в видах Карта, CAD и в таблице Points (Точки) 

3. Для выхода из режима создания точки выберите пункт меню Edit > 
Add > Point (Редактирование > Добавить > Точка). 
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Удаление точки 
Для удаления точки из текущего проекта вызовите выпадающее меню 
щелчком по правой кнопке мыши на выбранной точке, и в появившемся 
меню выберите пункт Delete (Удалить). 

Создание линии 
Перед созданием новой линии следует выбрать слой. Слой размещения 
новой линии выбирается из списка существующих. Стили отображения 
созданной линии будут взяты из настроек текущего слоя. 

 
Рисунок 5-22. Выбор слоя для линии 

Доступны три способа создания новой линии: 

• Между двумя существующими точками. Для добавления линии 
выберите пункт меню Edit > Add > Line (Редактирование > 
Добавить > Линия) или щелкните на кнопке инструментальной 
панели Add Line (Добавить линию), щелкните курсором на первой 
точке, а затем на второй. После этого между точками будет создана 
линия. 

 
Рисунок 5-23. Построение линии между двумя существующими точками 

В этом случае в правой панели таблицы Linework (Линии), 
отобразятся концы отрезка: 
 
 
 

• Между выбранными точками. Topcon Tools позволяет подключать 
выбранные точки к линии. Для этого щелкните на кнопке Add Line 
(Добавить линию) инструментальной панели и выберите точки в 
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виде CAD или в таблице Points (Точки). После этого между 
выбранными точками будет создана линия. 

 
Рисунок 5-24. Подключение выбранных точек к линии 

• Без заранее созданных точек. Для этого щелкните по кнопке Add 
Line (Добавить линию) и щелкните в любом месте вида CAD. При 
необходимости повторите это действие (рис. 5-25). К линии будут 
добавлены новые вершины. Эти вершины не будут иметь названий, 
в таблице Points (Точки) их координаты не отображаются. Правая 
панель таблицы Points (Точки) содержит только значки и порядковые 
номера вершин (см. рис. 5-25). 

 
Рисунок 5-25. Линия в виде CAD 
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Редактирование созданной линии 
Если линия создана в Topcon Tools, то стиль ее отображения 
определяется исключительно слоем, в котором она размещена. Для 
изменения параметров линии следует отредактировать параметры слоя 
или переместить ее в другой слой. 
Для смены слоя для выбранной линии воспользуйтесь одним из 
перечисленных ниже способов: 

• В левой панели Linework (Линии) двойным щелчком по колонке Layer 
(Слой), вызовите выпадающий список и выберите нужный слой. 

 
• Вызовите выпадающее меню щелчком по правой кнопке мыши на 

линии (или на выбранных линиях) в виде CAD и выберите пункт 
Properties (Свойства). Выберите из выпадающего списка нужный 
слой. 

 
Для изменений параметров слоя воспользуйтесь одним из перечисленных 
ниже способов: 

• Двойным щелчком по 
комбинированному окну Layer (Слой) 
инструментальной панели выберите 
слой из выпадающего списка и 
нажмите  

• Выберите пункт меню View > Layers (Вид > Слои) и щелчком по 
выбранному слою вызовите выпадающее меню, в котором выберите 
пункт Properties (Свойства). 
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Редактирование свойств слоя производится во вкладках General 
(Основные параметры), Plotting styles (Стили отображения) и Area 
(Площадь) диалогового окна Properties (Свойства) слоя (см. рис. 5-26). 

 
Рисунок 5-26. Редактирование параметров слоя 

Если линия импортирована из проекта TopSURV PC, то стиль 
отображения линии определяются кодом и строкой кода. Для 
редактирования параметров линии измените параметры кода. Вызовите 
выпадающее меню щелчком правой кнопкой мыши на линии (или по 
выбранным линиям) в виде CAD и в появившемся меню выберите пункт 
Properties (Свойства). Выберите нужный код или слой из списка Layer 
(Слой). 

 
Рисунок 5-27. Редактирование свойств линии 

В таблице Linework (Линии) отображены все линии текущего проекта. Для 
редактирования стиля отображения выбранной линии выделите линию и 
щелкните по подлежащему редактированию параметру. Задайте новое 
значение параметра и нажмите клавишу Enter или щелкните вне ячейки 
для принятия изменений. Колонка Icon редактированию не подлежит. 

 
Рисунок 5-28. Редактирование параметров линии в левой панели таблицы 

Linework (Линии) 
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Добавление точек к линии 
Функция добавления точек к линии становится доступной после выбора 
существующей линии в виде CAD. 

Вариант 1: Выбор линии, а затем выбор 
точки 
1. Выберите существующую линию или создайте новую. 
2. Выберите пункт меню Edit > Add > Append Points to Line 

(Редактирование > Добавить > Добавить точки к линии). Вид 
курсора в режиме добавления точек изменится. 

3. Щелкните курсором на виде CAD для добавления точки к линии. Новая 
точка будет добавлена к выбранной линии в правой панели таблицы 
Linework (Линии) (см. рис. 5-29). 

 
Рисунок 5-29. Добавление точки к линии 

4. Щелкните курсором для добавления следующей точки линии. 
Вершины линии отобразятся в правой панели таблицы Linework 
(Линии) (см. рис. 5-29). Повторяйте это действие для добавления 
необходимого количества точек к линии. Для создания замкнутой 
фигуры добавьте в качестве последней самую первую точку линии. 

5. Для окончания добавления точек выберите пункт меню Edit > Add > 
Append Points to Line (Редактирование > Добавить > Добавить 
точки к линии) еще раз. Вид курсора изменится на обычный. 
Сохраните проект. 
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Вариант 2: Выбор точки, а затем выбор 
линии 
1. Щелкните правой кнопкой мыши на точке в виде CAD, вызовите 

выпадающее меню и в нем выберите пункт Append Points to Line 
(Добавить точки к линии) (см. рис. 5-30). 
Вид курсора изменится, показывая использование режима добавления 
точек. 

 
Рисунок 5-30. Добавление точек с использованием выпадающего меню 

2. Щелкните на линии в виде CAD для автоматического добавления к ней 
выбранной точки (см. рис. 5-31). В таблице Linework (Линии) появится 
новая вершина линии. 

 
Рисунок 5-31. Пример: Добавление точек к линии 
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Вставка точек в линию 
Вставка точек в линию добавляет точку в выбранный сегмент. При вставке 
точки в сегмент программа Topcon Tools создает новую точку, удаляет 
выбранный сегмент между начальной и конечной точками и создает два 
новых сегмента (от начальной до новой точки и от конечной до новой 
точки). Для вставки точек в линию выберите нужный сегмент в виде CAD 
или в правой панели таблицы Linework (Линии) и включите режим вставки 
точек в линию. Вид курсора при этом изменится. Доступны два варианта 
вставки точек в линию. 

Вариант 1: Выбор линии, затем вставка 
(создание) точки 
1. Выберите нужный сегмент линии в виде CAD или соответствующие 

вершины в правой панели таблицы Linework (Линии). 
2. Выберите пункт меню Edit > Add > Insert Points to Line 

(Редактирование > Вставить > Вставить точки в линию). Вид 
курсора изменится, показывая использование режима вставки точек в 
линию. 

3. Щелкните на нужном месте в рабочем поле вида CAD. Будет создана 
новая точка и удалена выбранная линия, после чего три точки 
(начальная, конечная точки выбранной линии и новая точка), будут 
включены в линию (см. рис. 5-32). 
Новая (созданная) точка не будет иметь названия и не отобразится в 
таблице Points (Точки). 

 
Рисунок 5-32. Вставка новой точки в выбранную линию 
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4. Для редактирования названия и просмотра (редактирования) 
координат новой точки двойным щелчком по вершине в правой панели 
в таблице Linework (Линии) вызовите окно и введите название точки. 

 
Рисунок 5-33. Редактирование названия вставленной точки 

5. После выполнения изменений снова выберите пункт меню Edit > Add 
> Insert Points to Line (Редактирование > Добавить > Вставить 
точки в линию). Вид курсора изменится на обычный, показывая, что 
режим вставки точек в линию не используется. Сохраните проект. 

Вариант 2: Выбор точки, а затем выбор 
линии 
1. Щелкните правой кнопкой мыши на точке в виде CAD, вызовите 

выпадающее меню и в нем выберите пункт Insert Points to Line 
(Вставить точки в линию) (см. рис. 5-34). Вид курсора изменится, 
показывая использование режима вставки точек в линию. 

2. Щелкните по нужному сегменту линии. Точка будет вставлена 
автоматически. 
В виде CAD и в таблице Linework (Линии) отобразятся новые сегменты 
линии от начальной точки выбранного сегмента до выбранной точки и 
от этой точки до конечной точки сегмента (см. рис. 5-34). 

 
Рисунок 5-34. Пример вставки точки в линию 
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Удаление линии 
Для удаления линии из текущего проекта вызовите выпадающее меню 
щелчком по правой кнопке мыши на этой линии в левой панели таблицы 
Linework (Линии) и в выпадающем меню выберите пункт Delete (Удалить). 
Обратите внимание на то, что эта функция конечные точки линии 
(вершины) не удаляет. 

Удаление вершины из линии 
Для удаления вершины из линии вызовите выпадающее меню, щелкнув по 
правой кнопке мыши на описании нужной точки в правой панели таблицы 
Linework (Линии) и выберите в появившемся меню пункт Delete (Удалить) 
(см. рис. 5-35). 

 
Рисунок 5-35. Удаление вершины из линии 

Эта функция не удаляет точки, а только исключает начальную точку 
выбранного сегмента из линии и добавляет к линии отрезок, соединяющий 
конечную точку выбранного сегмента и начальную точку последнего 
сегмента (см. рис. 5-36). 

 
Рисунок 5-36. Удаление сегмента из линии 
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Использование контрольных кодов 
для создания дуги 
Контрольные коды дают возможность построения дуги по линейным 
сегментам, и двум или трем точкам. Для использования контрольных 
кодов включите пункт Display String and Control Code (Отображать 
Строковый и Контрольный коды) в настройках проекта (Job Configuration) 
(выберите пункт меню Job >Job Configuration). 

Создание дуги по двум точкам 
Двухточечная дуга использует три точки и два линейных сегмента. Одна 
точка назначается "началом дуги", а другая - "концом дуги", линейный 
сегмент между этими точками становится дугой. Третья точка и другой 
линейный сегмент становятся касательной дуги. Положение касательной 
определяет параметры дуги (см. рис. 5-37). 

 
Рисунок 5-37. Касательная линия определяет параметры дуги 

1. При необходимости, создайте линейный сегмент дуги. Используйте 
процедуру добавления точек к линии, описанную в разделе 
"Добавление точек к линии" на стр. 5-22 (см. рис. 5-38 на стр. 5-28). 

2. Выберите новый линейный сегмент. В рассматриваемом примере это 
линия между точками "User2" и "User3". 
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Рисунок 5-38. Создание линейных сегментов для дуги 

3. В правой панели таблицы Linework (Линии) щелкните по ячейке Control 
Code (Контрольный код) для линейного сегмента и выберите Arc Start 
(Начало дуги) (см. рис. 5-39). Нажмите клавишу Enter или щелкните 
вне ячейки. 

4. Щелкните по ячейке Control Code (Контрольный код) последней точки в 
линии и выберите Arc End (Конец дуги) (см. рис. 5-39). Нажмите 
клавишу Enter или щелкните вне ячейки. 

 
Рисунок 5-39. Выбор контрольного кода для начальной и конечной точек дуги 

 

 
СОВЕТ 

Редактирование контрольных кодов линии (точки) 
производится в диалоговом окне Properties (Свойства) 
(вызывается щелчком по правой кнопке мыши на линии 
(точке) и выбором пункта Properties). 
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Изображение в виде CAD обновится и отобразится созданная дуга (см. 
рис. 5-40). 

 
Рисунок 5-40. Дуга по двум точкам в виде CAD и таблице Linework (Линии) 

Создание дуги по трем точкам 
Трехточечная дуга использует построение из трех точек и двух линейных 
сегментов. Одна точка назначается "началом дуги", другая – 
"центральной" и третья – "концом дуги". Два линейных сегмента, 
становятся частью дуги. 
1. При необходимости, создайте линейный сегмент (см. рис. 5-41). 

Используйте процедуру добавления точек к линии, описанную в 
разделе "Добавление точек к линии" на стр. 5-22. 

 
Рисунок 5-41. Создание линейного сегмента для дуги 
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2. Выберите новый сегмент линии. В рассматриваемом примере это 
сегмент между точками "User2" и "User3". 

3. В правой панели таблицы Linework (Линии) щелкните по ячейке Control 
Code (Контрольный код) для первой точки в линии и выберите Arc Start 
(Начало дуги). Нажмите клавишу Enter или щелкните вне ячейки. 

4. Щелкните по ячейке Control Code (Контрольный код) последней точки в 
дуге и выберите Arc End (Конец дуги) (см. рис. 5-39). Нажмите клавишу 
Enter или щелкните вне ячейки. 

 
СОВЕТ 

Редактирование контрольных кодов линии (точки) 
производится в диалоговом окне Properties (Свойства) 
(вызывается щелчком по правой кнопке мыши на линии 
(точке) и выбором пункта Properties). 

Изображение в виде CAD обновится и отобразится созданная дуга (см. 
рис. 5-42). 

 
Рисунок 5-42. Дуга по трем точкам в виде CAD и таблице Linework (Линии) 

 

Использование контрольных кодов 
для создания четырехугольника 
Используя контрольные коды, на трех точках можно создать 
четырехугольник. Эти три точки будут тремя вершинами четырехугольника 
(параллелограмма). Для использования контрольных кодов, включите 
настройку Display String and Control Code (Отображать Строковый и 
Контрольный коды) в настройках проекта (Job Configuration) (для этого 
воспользуйтесь пунктом меню Job >Job Configuration и в панели Display 
выберите вкладку String). 
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Для использования контрольного кода четырехугольника необходимы три 
точки и два линейных сегмента. После того, как этот код будет присвоен 
третьей точке в линии, будет произведена автоматическая экстраполяция 
и создание четвертой точки и четырехугольника. Первой и третья точки 
задают диагональ параллелограмма. 
1. При необходимости, создайте линейный сегмент и точки для 

использования их в четырехугольнике. Используйте процедуру 
добавления точек к линии, описанную в разделе "Добавление точек к 
линии" на стр. 5-22 (см. рис. 5-43). 

 
Рисунок 5-43. Создание линейного сегмента для четырехугольника 

2. В правой панели таблицы Linework (Линии) щелчком по правой кнопке 
мыши на первой или последней точке линии вызовите выпадающее 
меню и в нем выберите пункт Properties(Свойства). 

3. Назначьте точке контрольный код Rectangle (Четырехугольник) (см. 
рис. 5-44) и щелкните на кнопке ОК. 

 
Рисунок 5-44. Выбор контрольного кода для начальной точки четырехугольника 
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Будет рассчитана четвертая вершина (точка) четырехугольника и 
добавлена в линию. Изображение в виде CAD обновится и отобразится 
созданный четырехугольник (см. рис. 5-45). 

 
Рисунок 5-45. Четырехугольник в виде CAD 

 

Использование контрольных кодов 
для соединения точек полигона 
Используя контрольные коды, на трех точках можно создать 
четырехугольник. Эти три точки будут тремя вершинами четырехугольника 
(параллелограмма). Для использования контрольных кодов, включите 
настройку Display String and Control Code (Отображать Строковый и 
Контрольный коды) в настройках проекта (Job Configuration) (для этого 
воспользуйтесь пунктом меню Job >Job Configuration и в панели Display 
выберите вкладку String). 
При использовании контрольного кода подключения необходимы три или 
более точек и два или более линейных сегмента. Применение 
контрольного кода к последней точке линии автоматически подключает эту 
точку к первой, создавая замкнутый полигон. 
1. При необходимости создайте линейный сегмент и точки для 

использования их в четырехугольнике. Используйте процедуру 
добавления точек к линии, описанную в разделе "Добавление точек к 
линии" на стр. 5-22 (см. рис. 5-43). См. рис. 5-46 на стр. 5-33. 
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Рисунок 5-46. Создание линейного сегмента для построения полигона 

2. В правой панели таблицы Linework (Линии) щелчком по правой кнопке 
мыши на последней точке линии вызовите выпадающее меню и в нем 
выберите пункт Properties (Свойства). 

3. Выберите для точки контрольный код Close (Замыкание) и щелкните 
на кнопке ОК. 
Будет создан новый линейный сегмент между первой и последней 
точками. Изображение в виде CAD обновится и созданный полигон 
отобразится (см. рис. 5-47). 

 
Рисунок 5-47. Полигон в виде CAD 
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Редактирование способа 
спутниковых измерений 
Способ (метод) измерений в сеансе спутниковых измерений (static 
(статика, пункт неподвижен относительно Земли) или kinematic 
(кинематика, пункт движется в СК, связанной с Землей)) для сеансов 
спутниковых измерений (GPS Occupations) являются одним из наиболее 
часто редактируемых полей. Таблица 5-1 на стр. 5-2 содержит список 
редактируемых ячеек. 
Для изменения метода измерений со статического на кинематический 
ячейку с названием точки, на которой производились измерения, задайте 
пустой (см. рис. 5-48). 
1. Выделите название точки, на которой производился сеанс 

спутниковых измерений, для редактирования и нажмите клавишу F2. 
2. Нажмите клавишу Delete для удаления названия точки и нажмите 

клавишу Enter для подтверждения действия. 
Сеанс статических измерений станет кинематическим (в примере ниже 
обратите внимание на изменение пиктограммы). 

 
Рисунок 5-48. Изменение типа сеанса со статического на кинематический 

Для изменения кинематического сеанса на статический задайте название 
точки стояния (см. рис. 5-49). 
1. Выделите название точки стояния для редактирования и нажмите 

клавишу F2. 
2. Выберите или введите название точки стояния и нажмите клавишу 

Enter для подтверждения действия. 

 
Рисунок 5-49. Изменение типа сеанса GPS с кинематического на статический 
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Обратите внимание, что Topcon Tools автоматически определяет, 
является ли сеанс статическим/кинематическим или наблюдается по 
способу stop-and-go (стой-иди), по следующему правилу: если в 
последовательности сеансов, по крайней мере, два статических и два 
кинематических сеанса, то вся последовательность выполнена методом 
stop-and-go (стой-иди). 

Редактирование кодов в виде 
Коды 
Коды являются сокращенным описанием признака измерения. Атрибуты 
определяют свойства описание признака (кода) более детально. 
При создании нового кода выберите слой, в котором будет определен 
стиль отображения кода. Если слой для кода не назначен, то коду 
присваивается текущий слой. В проектах Topcon Tools текущий слой 
используется для всех кодов и данных из импортируемых файлов, не 
поддерживающих слои. 

 ПРИМЕЧАНИЕ 

Если коды уже используются в проекте, изменить их  
атрибуты невозможно. 

Добавление кода 
При открытом и выбранном виде Коды (Codes) щелкните по правой кнопке 
мыши на левой панели и вызовите выпадающее меню. В нем выберите 
пункт New Code (Новый код) (см. рис. 5-50). При создании нового кода 
можно назначить слой. 

 
Рисунок 5-50. Добавление нового кода 



Редактирование данных 

Topcon Tools- Руководство пользователя 5-36 

Редактирование кода 
Если код уже использован в проекте, изменить его нельзя. Удаление кода 
из проекта описывается в разделе "Редактирование кодов точек" на стр. 5-
38. 
1. Вызовите выпадающее меню щелчком по правой кнопке мыши на 

выбранном коде и выберите пункт Properties (Свойства) (рис. 5-51). 
2. Во вкладке General (Основные параметры) отредактируйте название 

кода и выберите слой (см. рис. 5-51). 

 
Рисунок 5-51. Просмотр свойств кода и назначение слоя 

3. Во вкладке Plotting styles (Стиль отображения) выберите стиль, 
толщину и цвет линии, а также символ точки. Стиль отображения 
может быть изменен для любого кода с назначенным слоем и без 
такового (см. рис. 5-52). 

 
Рисунок 5-52. Настройка свойств отображения 
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Добавление и редактирование 
атрибута кода 
Если код уже использован в проекте, его свойства изменить невозможно. 
Удаление кода из проекта описывается в разделе "Редактирование кодов 
точек" на стр. 5-38. 
1. Для добавления атрибута вызовите выпадающее меню щелчком по 

правой кнопке мыши на выбранном коде и выберите пункт New 
Attribute (Новый атрибут) (см. рис. 5-53). 

 
Рисунок 5-53. Выбор характеристик добавляемого атрибута 

2. Выберите или введите необходимые параметры атрибута (Табл. 5-2). 

Таблица 5-2.Свойства атрибутов кода 

Для этого типа атрибута… Задайте эти параметры… 
Integer, Real Number, Text 
Целое число, действительное число, текст 
(см. рис. 5-54). 

 
Рисунок 5-54. Свойства атрибута 

• Name (Название) – введите 
название атрибута. 

• Default Value (Значение по 
умолчанию) – введите 
значение, принимаемое для  
атрибута по умолчанию. 
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Таблица 5-2.Свойства атрибутов кода (продолжение) 

Для этого типа атрибута… Задайте эти параметры… 
Menu (Меню), см. рис. 5-55. 

 
Рисунок 5-55 Свойства атрибута меню 

• Name (Название) – введите 
название атрибута. 

• Default Value (Значение по 
умолчанию) – введите значение, 
принимаемое для атрибута по 
умолчанию или выберите его из 
выпадающего списка 
− Щелкните на кнопке Add 

(Добавить) для добавления 
величины в список. 

− Щелкните на кнопке Remove 
(Удалить) для удаления 
выбранной величины из списка. 

3. Щелкните на кнопке Apply (Применить) для принятия изменений без 
закрытия окна. Щелкните на кнопке ОК для принятия изменений и 
закрытия окна. В правой панели вида Codes (Коды), отобразится 
список созданных атрибутов для выбранного в левой панели кода (см. 
рис. 5-56). 

 
Рисунок 5-56. Вид Codes (Коды) 

 

Редактирование кодов точек 
Используйте описанную ниже процедуру для назначения и удаления кодов  
точек для обработки или уравнивания. 
1. Для добавления атрибута вызовите выпадающее меню щелчком по 

правой кнопке мыши на выбранной точке и выберите пункт Properties 
(Свойства) (см. рис. 5-57). 

 
Рисунок 5-57. Просмотр свойств точки 
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2. Используя вкладку General (Основные параметры) выберите код и 
слой (см. рис. 5-58). Стиль отображения будет взят из настроек слоя. 

3. Щелкните на вкладке CAD для просмотра используемых кодов, 
добавления и удаления используемого кода точки или изменения 
символа и цвета. Все атрибуты точки отображаются в правой панели. 

4. Для добавления кода точке вызовите выпадающее меню щелчком по 
правой кнопке мыши в левой панели и выберите пункт New Code 
(Новый код). Выберите код из выпадающего списка и щелкните вне 
ячейки или нажмите клавишу Enter (см. рис. 5-58). Для точки может 
быть добавлен более чем один код. Коды точки отображаются в 
таблице Points (Точки). 
Внимание: задание нового кода в окне текстового ввода добавляет 
собственно код в файл проекта и к точке. Атрибуты кода можно 
добавить через окно Codes (Коды). 

5. Для редактирования связанных с кодом атрибутов меню выберите 
новое значение из выпадающего списка Value (Значение). 

 
Рисунок 5-58. Добавление кода к точке 

6. Для удаления кода точки щелкните по правой кнопке мыши в левой 
панели и в появившемся меню выберите пункт Delete (Удалить) (см. 
рис. 5-59 на стр. 5-40). Все атрибуты этого кода также будут удалены. 
Замечание: удаление кода во вкладке CAD позволяет удалить код у 
конкретной точки. В проекте этот код остается доступным. 

7. Щелкните на кнопке ОК для сохранения настроек. 
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Рисунок 5-59. Удаление кода у точки 

 

Редактирование слоев 
Слои часто используются при группировании информации по функциям, 
типам линий, цветам и другим атрибутам. В каждом проекте Topcon Tools 
слой под именем 0 (ноль) задан по умолчанию. Слой 0 не может быть 
удален или переименован. Тем не менее, атрибуты этого слоя можно 
изменить. Новые слои могут быть созданы непосредственно в проекте или 
импортированы из других файлов. Выбранный в настоящий момент слой 
(текущий) используется для размещения новых объектов. Любой объект 
(точка, линия, поверхность или дорога) будет иметь свойства отображения 
того слоя, в котором он создан. 

Добавление слоя 
1. Для создания нового слоя в текущем проекте выберите пункт меню 

Edit > Add > Layers (Редактирование > Добавить > Слой), или 
щелкните по правой кнопке мыши в виде Слои и в появившемся меню 
выберите пункт Add Layers (Добавить Слой). 

2. Введите необходимые параметры слоя (см. рис. 5-60 на стр. 5-41) во 
вкладке General (Общие параметры): 

• Name (Название) – название слоя. 

• Visible (Видимый) – при выборе Yes (Да) слой будет видим в 
видах CAD и 3D. При выборе No (Нет) слой будет скрыт. 
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• Note (Примечание) – поле ввода произвольных комментариев. 

• Breakline type (Тип границы) – выберите необходимый тип для 
линии, включаемой в поверхность: Auto, Breakline, Boundary, 
Exclusion (Авто, Обрыв, Граница, Исключение). 

3. Во вкладке Plotting styles (Стили отображения) задайте параметры 
отображения слоя (см. рис. 5-60): 

• Line Style (Стиль линии) – тип отображения линии. 

• Line Width (Толщина линии) – толщину линий слоя. 

• Color (Цвет) – цвет для всех объектов (точек и линий), 
размещенных в слое. 

• Point Symbol (Символ точки) – выберите символ для 
представления всех точек в слое. 

4. Во вкладке Area (Площадь) выберите Yes (Да) для заполнения 
площадных объектов в слое (см. рис. 5-60). 

 
Рисунок 5-60. Ввод и выбор атрибутов слоя 

 

Редактирование слоя в виде Слои 
При работе в проекте слои доступны для редактирования. Слой 0 не 
может быть удален из проекта или переименован, но стиль (параметры)  
отображения этого слоя можно редактировать. 
Редактирование слоя в виде Слои: 

• Выберите пункт меню View > Layers (Вид > Слои) и выберите 
нужный слой (слои) в виде Layers (Слои). 

• Выделите и щелкните на любой ячейке (за исключением Name 
(Название)) в виде Layers (Слои), выберите и отредактируйте 
нужные параметры (см. рис. 5-61 на стр. 5-42). 
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Рисунок 5-61. Редактирование слоя в виде Слои 

Редактирование слоя через диалоговое окно Properties (Свойства): 
• Двойным щелчком по комбинированному окну Слой на 

инструментальной панели, выберите нужный слой из выпадающего 
списка и щелкните на пиктограмме . 

• Выберите пункт меню View > Layers (Вид > Слои) и щелкните по 
правой кнопке мыши на нужном слое. В появившемся меню 
выберите пункт Properties (Свойства). 

В диалоговом окне Properties (Свойства) слоя измените свойства во 
вкладках General (Основные параметры), Plotting styles (Стили 
отображения) и Area (Площадь). 

 
Рисунок 5-62. Редактирование параметров слоя 
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Установки слоя для кодов 
При создании нового кода можно назначить слой. В этом случае стиль 
отображения этого кода заимствуется из параметров слоя. 

 
Рисунок 5-63. Коды и слои 

 
Для редактирования стиля отображения любого кода используйте вкладку 
Plotting styles (Стили отображения) диалогового окна Properties 
(Свойства) кода (см. рис. 5-64). 

 
Рисунок 5-64. Редактирование стиля отображения (символ точки) для кода 

Если для кода не выбран слой, то коду будет автоматически присвоен 
текущий слой. Параметры отображения текущего слоя применяются для 
всех проектов Topcon Tools без заданных слоев и при импорте файлов без 
поддержки разделения данных по слоям. 
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Назначение слоя новой или 
существующей точке 
Назначение слоя новой или существующей точке производится его 
выбором во вкладке General (Основные параметры) диалогового окон 
Add Point (Добавить точку) или Properties: Point (Свойства: Точка) 
(см. рис. 5-65). Атрибуты (цвет и стиль точки) выбранного слоя будут 
применены к этой точке. 

 
Рисунок 5-65. Выбор слоя для точки 

Для назначения кодов (вместо слоев) для точки выберите нужный код в 
поле Code (Код) и выберите значение "BYCODE" в поле Layer (Слой). 
Атрибуты (цвет и стиль точки) слоя будут применены к этой точке. На рис. 
5-19 показан пример для точки с кодом "101" в виде CAD. Для этой точки 
был назначен слой "BYCODE(For Points)", а этому коду присвоен слой "For 
Points". 

 
Рисунок 5-66. Назначение кода точке и ее просмотр 

• Если точка имеет несколько кодов, то принятие слоя "BYCODE" 
устанавливает ее принадлежность нескольким слоям. 

• Если точка не имеет кода, то выбор слоя "BYCODE" устанавливает 
ее принадлежность к слою 0 (ноль). 

 
Рисунок 5-67. Назначение слоя при принятии кода 
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Назначение слоя новой или 
существующей линии 
Для размещения новой линии в слое выберите любой слой из списка 
существующих слоев на инструментальной панели (комбинированное 
окно Слой (Layer)). Стиль отображения новой линии будет заимствован из 
соответствующих установок текущего слоя (см. рис. 5-68). 

 
Рисунок 5-68. Назначение слоя линии 

Для смены слоя для выбранной линии воспользуйтесь одним из 
следующих способов: 

• Дважды щелкните по колонке Layer (Слой) и выберите новый слой 
из выпадающего списка в левой панели таблицы Linework (Линии). 

 
• Щелчком по правой кнопке мыши на линии (или выбранной линии) в 

виде CAD вызовите выпадающее меню, в нем выберите пункт 
Properties (Свойства). В появившемся окне Properties выберите 
новый слой из выпадающего списка. 
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Назначение слоя новой или 
существующей поверхности 
Для назначения слоя новой или существующей поверхности выберите 
слой, используя диалоговое окна Add Surface (Добавить поверхность) 
или Properties (Свойства). Стили отображения текущего слоя будут 
применены к поверхности (см. рис. 5-69). 

 
Рисунок 5-69. Назначение слоя поверхности 

Для смены слоя существующей поверхности вызовите выпадающий 
список в таблице Surfaces (Поверхности) двойным щелчком по колонке 
Layer (Слой) и выберите другой слой (см. рис. 5-70). 

 
Рисунок 5-70. Назначение слоя существующей поверхности 

 

Назначение слоя новой или 
существующей дороге 
Для назначения слоя новой или существующей дороге выберите слой, 
используя диалоговое окно Add Road (Добавить дорогу) или Properties 
(Свойства). Стили отображения выбранного слоя будут применены к 
дороге (см. рис. 5-71). 

 
Рисунок 5-71. Назначение слоя дороге 
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Редактирование параметров 
электронного тахеометра 
Параметры электронного тахеометра задают высоту и тип измерений, 
которые обеспечивает этот инструмент. Таблица 5-1 на стр. 5-2 содержит 
список редактируемых ячеек. 
Параметры инструмента определяют точности выполненных измерений 
конкретной модели тахеометра. По умолчанию (тип инструмента не 
выбран) Topcon Tools использует определенные величины. 
Установленные точности тахеометрических измерений оказывают влияние 
на уравнительные вычисления; соответственно, задание адекватных 
точностей может немного улучшить результаты уравнивания. В 
большинстве случаев, тем не менее, точность измерения, выбранная по 
умолчанию, вполне адекватна. 
Список Custom TS-Instrument List (Пользовательский список 
тахеометров) позволяет добавлять определенные пользователем типы 
инструментов. 

Вариант 1: Редактирование в 
Табличном виде 
1. В колонке, свойства которой вы хотите изменить, выберите нужную 

станцию (точку стояния тахеометра). 
Для выбора станций тахеометрического хода с общими параметрами 
используйте диалоговое окно Select TS Occupations (Выбор 
тахеометрических станций) (см. раздел "Выбор тахеометрических 
станций" на стр. 4-49). 

2. Щелчком мыши выделите ячейку и отредактируйте необходимые 
параметры (см. рис. 5-72). 

• В поле Instrument Height (Высота инструмента) введите высоту 
тахеометра над центром. 

• Содержимое поля Instrument Type (Тип инструмента) выберите 
из списка моделей тахеометров. 

 
Рисунок 5-72. Редактируемые ячейки для инструмента в виде Таблица 
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3. После окончания изменения параметров щелкните по левой кнопке 
мыши вне ячейки или нажмите клавишу Enter для сохранения 
изменений. 

4. Повторите шаги 2 и 3 для каждой столбца до конца таблицы (см. рис. 
5-73). 

 
Рисунок 5-73. Редактирование параметров инструмента 

 

Вариант 2: Редактирование в 
диалоговом окне Properties 
1. Выберите нужную станцию (-ии). 

Для выбора станций тахеометрического хода с общими параметрами 
используйте диалоговое окно Select TS  Occupations (Выбор 
тахеометрических станций) (см. раздел "Выбор тахеометрических 
станций" на стр. 4-49). 

2. Щелкните по правой кнопке мыши на выбранных станции (-ях) и в 
появившемся меню выберите пункт Properties (Свойства) или же 
выберите пункт меню Edit > Properties (Редактирование > Свойства) 
(см. рис. 5-74). 

 
Рисунок 5-74. Варианты вызова окна Properties (Свойства) 

3. Во вкладке General (Основные параметры), при необходимости, 
отредактируйте высоту инструмента (см. рис. 5-75 на стр. 5-49). 
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4. Во вкладке Instrument Type (Тип инструмента), при необходимости, 
выберите необходимый тип тахеометра (см. рис. 5-75 на стр. 5-49). 

 
Рисунок 5-75. Ввод новых параметров тахеометра 

5. Щелкните на кнопке ОК для сохранения изменений. Произведенные 
изменения будут отображены в левой панели таблицы TS Obs 
(Тахеометрия) (см. рис. 5-76). 

 
Рисунок 5-76. Отредактированные параметры тахеометра 
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Добавление тахеометров из 
пользовательского списка 
тахеометров 
Каждая модель электронного тахеометра имеет известную 
инструментальную точность, указываемую в инструкции по эксплуатации 
прибора. Список стандартных тахеометров, размещенный в файле 
TSinstrument.XML, не доступен для просмотра и редактирования. 
1. Для добавления нового типа инструмента в список или 

редактирования текущего типа инструмента, щелкните по правой 
кнопке мыши по станции тахеометрии и в появившемся меню 
выберите пункт Properties (Свойства) (см. рис. 5-77). 

 
Рисунок 5-77. Открытие окна Properties (Свойства) 

2. Щелкните по кнопке Custom (Пользовательский) (см. рис. 5-78) для 
вывода на экран пользовательского списка тахеометров (Custom TS 
Instrument List). 

 
Рисунок 5-78. Открытие списка тахеометров пользователя 

3. Щелкните на кнопке Add (Добавить) (см. рис. 5-79 на стр. 5-51). Для 
удаления тахеометра из списка выделите строку удаляемого 
тахеометра и щелкните на кнопке Remove (Удалить). 
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4. Во вкладке General (Основные параметры) заполните поля Name 
(Название), Manufacturer (Производитель) и Note (Примечание) (см. 
рис. 5-79). Затем щелкните на кнопке Apply (Применить) для 
сохранения выполненных изменений. 

 
Рисунок 5-79. Новый тахеометр, задаваемый пользователем 

5. Во вкладке Parameters (Параметры) заполните поля точностей для 
EDM (Дальномер, постоянная величина [мм]), PPM (дальномер, 
величина в зависимости от длины измеряемой базы [мм/км]), Vertical 
accuracy (Точность вертикального круга, [“]), Horizontal accuracy 
(Точность горизонтального круга, [“]) и Maximum distance 
(Максимальная длина измеряемой базы [м]) (см. рис. 5-80).  

 
Рисунок 5-80. Новый тахеометр пользователя – параметры 

6. Щелкните на кнопке ОК для закрытия диалогового окна Properties 
(Свойства). 
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Редактирование свойств 
данных 
Для всех типов данных можно вызвать диалоговое окно Properties 
(Свойства) для просмотра и редактирования параметров. 
При выборе нескольких элементов данных одного типа всем выбранным 
элементам соответствует одно диалоговое окно и любые изменения, 
произведенные в редактируемых полях, будут применены ко всем 
выбранным элементам. 

Редактирование свойств точек 
Диалоговое окно Properties (Свойства) изменяется в зависимости от 
количества выбранных точек. При одновременном выборе нескольких 
точек вкладка CAD для просмотра их свойств недоступна. 
1. Для просмотра свойств одной или нескольких выбранных точек: 

• Щелкните по правой кнопке мыши и в появившемся меню 
выберите пункт Properties (Свойства). 

• Выберите пункт меню Edit > Properties (Редактирование > 
Свойства). 

Обратите внимание на то, что диалоговое окно Properties изменяется 
в зависимости от количества выбранных точек. 

2. Просмотрите или отредактируйте поля вкладки General (Основные 
параметры) (см. рис. 5-81): 

• Редактируемые поля – Name (Название) (только если выбрана 
единственная точка), Notes (Примечание), Codes (Коды), 
Layers(Слои) и Control (Исходный). 

• Выбор поля Enabled for Adjustment (Включен в уравнивание) 
позволяет включить эту точку в уравнивание, снятие флажка 
исключает точку из уравнивания. 

 
Рисунок 5-81. Вкладка General окна Properties 
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3. Если выбрана единственная точка, то параметры во вкладке CAD 
можно просмотреть и редактировать. Эти поля перечисляют коды 
точки. Щелчком по правой кнопке мыши можно вызвать выпадающее 
меню, через которое код точки добавляется, копируется, вставляется 
или удаляется (подробнее см. раздел "Редактирование кодов точек" на 
стр. 5-38). 

4. Просмотрите или отредактируйте поля вкладки Coordinates 
(Координаты) (см. рис. 5-82). Состав полей определяется 
установленной в проекте системой координат. 

5. Просмотрите вкладку Adjustment (Уравнивание), в которой содержатся 
среднеквадратические ошибки координат точки (см. рис. 5-82). 

 
Рисунок 5-82. Координаты и свойства уравнивания 

6. Во вкладке Strings (Строковые коды) редактируется строковый код и 
отображается контрольный код для точки (см. рис. 5-83 на стр. 5-54). 

7. Вкладка Quality Control (Контроль качества) содержит 
информационное сообщение по выбранной точке (выделенной в видах 
красным цветам), которая не прошла один из тестов качества (см. рис. 
5-83 на стр. 5-54). Для отключения этой функции поставьте флажок 
Ignore QC (Не использовать Контроль качества). 

8. По окончании просмотра и редактирования данных во вкладках окна 
щелкните на кнопке ОК для принятия изменений и его закрытия. 
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Рисунок 5-83. Вкладки Strings (Строковые коды) и Quality control (Контроль 

качества) 

Редактирование свойств сеансов 
спутниковых измерений 
Диалоговое окно Properties (Свойства) изменяется в зависимости от 
типа сеанса измерений. Для некоторых типов отображаются поля с 
дополнительной информацией. 
1. Для просмотра или редактирования свойств одного или нескольких 

сеансов спутниковых измерений: 
• Щелкните по правой кнопке мыши на сеансе и в появившемся 

меню выберите пункт Properties (Свойства). 
• Выберите пункт меню Edit > Properties (Редактирование > 

Свойства) 
2. Просмотрите или отредактируйте поля вкладки General (Основные 

параметры) (см. рис. 5-84 на стр. 5-55). Состав полей в этой вкладке 
зависит от типа выбранного сеанса спутниковых измерений. 

• Редактируемые поля – Original Name (Исходное название) и 
Point Name (Название точки) и Notes (Примечание). 

• Флажок в поле выбора Enabled (Включен) означает, что этот 
сеанс измерений будет использоваться для определения всех 
возможных базисов. Если этот параметр не выбран (флажок не 
установлен), то сеанс в обработке не используется. 

• Для сеансов типа PP (Postprocessing, камеральная обработка), 
поле Orbit (Эфемериды) отображает тип эфемеридных данных, 
используемых в обработке этого сеанса измерений. Если 
содержимое этого поля "None" ("Отсутствуют"), то сеанс 
маркируется красным цветом и во вкладке Quality Control 
(Контроль качества) появится текстовое описание ошибочной 
ситуации (например: "No ephemeris" – "Нет эфемерид").  
Обработку спутниковых измерений невозможно выполнить без 
орбитальных параметров. 
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Рисунок 5-84. Вкладка General(Основные параметры) окна Properties (Свойства) 

3. Просмотрите или отредактируйте поля вкладки Antenna (Антенна). 
См. также раздел "Вариант 2: Редактирование в диалоговом окне 
Свойства" на стр. 5-8. 

4. Просмотрите или отредактируйте поля вкладки Offset (Элементы 
приведения). См. также раздел "Редактирование элементов 
приведения антенны" на стр. 5-9. 

5. Вкладка Quality Control (Контроль качества) содержит текстовое 
описание ошибочной ситуации по сеансу, маркированному красным 
цветом и не прошедшему некоторые из тестов качества (см. рис. 5-85). 
Для отключения функции выделения сбойных сеансов поставьте 
флажок Ignore QC (Не использовать Контроль качества). 

 
Рисунок 5-85. Контроль качества 

6. По окончании просмотра и редактирования данных во вкладках окна 
щелкните на кнопке ОК для принятия изменений и закрытия окна. 
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Редактирование свойств 
тахеометрических измерений 
Диалоговое окно Properties (Свойства) изменяется в зависимости от 
панели, в которой были выбраны данные. 

Редактирование свойств станций 
тахеометрии 
Для станции тахеометрии в диалоговом окне Properties (Свойства) 
можно установить название точки, ее номер, высоту и тип инструмента. 
1. Для просмотра свойств одного или нескольких выбранных 

тахеометрических сеансов измерений, щелкните по правой кнопке 
мыши в левой панели вкладки TS Obs и воспользуйтесь одной из 
перечисленных ниже процедур: 

• В выпадающем меню выберите пункт Properties (Свойства). 
• Выберите пункт меню Edit > Properties (Редактирование > 

Свойства) 
2. Просмотрите или отредактируйте поля вкладки General (Основные 

параметры) (см. рис. 5-86). 
• Редактируемые поля – название точки, высота инструмента и 

номер точки. 
• Флажок в поле выбора Enabled (Включен) означает, что этот 

сеанс будет использоваться для определения всех возможных 
базисов. Если этот параметр не выбран (флажок не установлен), 
то сеанс в обработке не используется. 

 
Рисунок 5-86. Вкладка General (Основные параметры) 

3. Просмотрите или отредактируйте поля вкладки Instrument Type (Тип 
инструмента). Подробнее см. раздел "Вариант 2: Редактирование в 
диалоговом окне Properties" на стр. 5-48. 

4. По окончании просмотра и редактирования данных во вкладках 
щелкните на кнопке ОК для принятия изменений и закрытия окна. 
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Редактирование свойств тахеометрических 
измерений 
Для тахеометрического измерения в диалоговом окне Properties 
(Свойства) можно установить название точки, ее номер, высоту и тип 
инструмента. 
1. Для просмотра свойств одного или нескольких выбранных 

тахеометрических измерений: 
• Щелкните по правой кнопке мыши на измерении в правой панели 

таблицы TS Obs (Тахеометрия) и в появившемся меню выберите 
пункт Properties (Свойства). 

• Щелкните по измерению в правой панели TS Obs (Тахеометрия) и 
выберите пункт меню Edit > Properties (Редактирование > 
Свойства). 

2. Для просмотра и редактирования вкладки General (Основные 
параметры) (см. рис. 5-87). 
• Редактируемые поля – Point To (До точки), Notes (Примечания), # 

(Номер) и Code (Код). 
• Флажок в поле выбора Enabled (Включен) означает, что этот 

сеанс будет использоваться при обработке. Если этот параметр 
не выбран (флажок не установлен), то сеанс в обработке не 
используется. 

 
Рисунок 5-87. Вкладка General (Основные параметры) 

3. Просмотрите или отредактируйте параметры вкладки Observation 
(Измерение). При необходимости измените, значение полей Reflector 
Height (Высота отражателя) и Azimuth (Азимут) (см. рис. 5-88 на стр. 
5-58). Наличие других полей определяются настройками проекта. 

4. Просмотрите или отредактируйте поля вкладки Offset (Элементы 
приведения), в которой имеются поля ввода значений смещений и 
выбора их типа (см. рис. 5-88 на стр. 5-58). 
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Рисунок 5-88. Вкладки Observations и Offset 

5. Во вкладке String (Строковый код) отображается первый строковый 
код и контрольный код точки (см. рис. 5-89). 

 
Рисунок 5-89. Вкладка String (Строковый код) 

6. Поля вкладки Adjustment (Уравнивание) позволяют выбрать функцию 
AutoReject (Автоматическая отбраковка) и просмотреть статус и 
невязки измерения (см. рис. 5-90 на стр. 5-59). 

7. Вкладка Quality Control (Контроль качества) содержит текстовое 
описание ошибочной ситуации по измерению, маркированному 
красным цветом и не прошедшему некоторые из тестов качества (см. 
рис. 5-89). 

8. По окончании просмотра и редактирования данных во вкладках 
щелкните на кнопке ОК для принятия изменений и закрытия окна. 
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Рисунок 5-90. Вкладки Adjustment (Уравнивание) и Quality Control (Контроль 

качества) 

 

Редактирование свойств базисов 
GPS 
Диалоговое окно Properties (Свойства) изменяется в зависимости от 
типа выбранного базиса. Для некоторых типов базисов дополнительные 
поля предлагают расширенную информацию: для кинематических базисов 
"Adjustment status" ("Статус уравнивания") и "Reject mode" ("Режим 
отбраковки") не отображаются, поле "Point to" ("До точки") для RTK 
траекторий редактируемы. 
1. Для просмотра свойств одного или нескольких базисов GPS: 

• Щелкните по правой кнопке мыши на базисе в правой панели 
таблицы GPS Obs (базисы GPS) и в появившемся меню выберите 
пункт Properties (Свойства). 

• Выделите базис в правой панели таблицы GPS Obs (базисы GPS) 
и выберите пункт меню Edit > Properties (Редактирование > 
Свойства). 

2. Просмотрите или отредактируйте поля вкладки General (Основные 
параметры) (см. рис. 5-91 на стр. 5-60); состав полей зависит от типа 
выбранного базиса. 
• Редактируемые поля – Notes (Примечания) для всех типов 

базисов, Point to (До точки) для RTK траекторий. 
• Флажок в поле выбора Enabled (Включен) означает, что этот 

базис будет использоваться в обработке. Если этот параметр не 
выбран (флажок не установлен), то базис в уравнивании не 
используется. 
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Рисунок 5-91. Вкладка General (Основные параметры) 

3. Просмотрите вкладку Observation (Базис), содержащую поля 
элементов базиса (dX, dY, dZ, Азимут, Угол наклона, Длина, dN, dE, 
dHt) (см. рис. 5-92). 

 
Рисунок 5-92. Вкладка Observation (Базис) 

4. Просмотрите вкладку Quality (Качество), содержащую поля: 

• Horizontal/vertical precisions (плановая и высотные точности) 

• The solution type (тип решения) 

• Количество общих наблюденных эпох. 

• Количество спутников GPS и ГЛОНАСС. Для RTK базисов общее 
количество спутников для базового и подвижного комплектов в 
последнюю эпоху. Для РР базисов - общее количество спутников 
за весь период наблюдения. 
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• Геометрический фактор ухудшения точности (HDOP и VDOP, 
плановых и высотной компонент базиса) последней эпохи RTK 
(данные берутся из файла проекта TopSURV RTK). 

• Тип эфемеридных данных, использованных в решении. 

 
Рисунок 5-93. Вкладка Quality (Качество) 

5. Просмотрите или отредактируйте поля вкладки Adjustment 
(Уравнивание), состав которых определяется типом выбранного 
базиса. Для статических базисов можно установить функцию 
AutoReject (Автоматическая отбраковка) и просмотреть статус и 
невязки. Для кинематических базисов отображаются только невязки 
(см. рис. 5-94). 

 
Рисунок 5-94 Вкладка Adjustment (Уравнивание) 
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6. Вкладка Quality Control (Контроль качества) содержит текстовое 
описание ошибочной ситуации по базису, маркированному красным 
цветом и не прошедшему некоторые из тестов качества (см. рис. 5-95). 

 
Рисунок 5-95. Вкладка Quality Control (Контроль качества) 

7. По окончании просмотра и редактирования данных во вкладках 
щелкните на кнопке ОК для принятия изменений и закрытия окна. 

Редактирование свойств данных 
цифрового нивелира 
Диалоговое окно Properties (Свойства) изменяется в зависимости от 
панели, в которой были выбраны данные. 

Редактирование свойств цифрового 
нивелира 
В диалоговом окне Properties (Свойства) левой панели таблицы DL Obs 
(Нивелирование) устанавливаются название, порядок и примечания для 
нивелирного хода. 
1. Для просмотра свойств выбранного плеча нивелирного хода щелкните 

по DL dimension в левой панели таблицы DL Obs (Нивелирование) и 
выберите пункт меню Edit > Properties (Редактирование > Свойства) 

2. Просмотрите или отредактируйте поля вкладки General (Основные 
параметры). Возможно редактирование имени, порядка и примечаний 
нивелирного хода (см. рис. 5-96 на стр. 5-63). 
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Рисунок 5-96. Вкладка General (Основные параметры) 

3. По окончании просмотра и редактирования данных во вкладках 
щелкните на кнопке OK для принятия изменений и закрытия окна. 

Редактирование свойств точек 
нивелирования 
В диалоговом окне Properties (Свойства) правой панели таблицы DL 
Obs (Нивелирование) устанавливаются дальность, примечания и 
количество точек нивелирного хода. 
1. Для просмотра свойств выбранной точки хода или вне его, щелкните 

по точке в правой панели таблицы DL Obs (Нивелирование) и 
выберите пункт меню Edit > Properties (Редактирование > Свойства) 

2. Во вкладке General (Основные параметры) возможно редактирование 
полей Point (Точка) и Note (Примечание). Во вкладке Adjustment 
(Уравнивание) возможен выбор параметра AutoReject 
(Автоматическая отбраковка) (см. рис. 5-97). 

 
Рисунок 5-97. Вкладки General (Основные параметры) и Adjustment (Уравнивание) 

3. По окончании просмотра и редактирования данных во вкладках 
щелкните на кнопке ОК для принятия изменений и закрытия окна. 
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Редактирование свойств обмеров 
Диалоговое окно Properties (Свойства) изменяется в зависимости от 
панели, в которой были выбраны данные. 

Редактирование обмеров 
В диалоговом окне Properties (Свойства) устанавливается начальная и 
конечная точки обмера. 
1. Для просмотра одного или нескольких выбранных обмеров выделите 

их в левой панели таблицы Tape Dimension (Обмеры) и выберите 
пункт меню Edit > Properties (Редактирование > Свойства) 

2. Во вкладке General (Основные параметры), при необходимости, 
отредактируйте параметры Start Point (Начальная точка) и End Point 
(Конечная точка) (см. рис. 5-98). 

 
Рисунок 5-98. Вкладка General (Основные параметры) 

3. По окончании просмотра и редактирования данных во вкладке 
щелкните на кнопке ОК для принятия изменений и закрытия окна. 

Редактирование свойств точек обмеров 
Диалоговое окно Properties (Свойства) устанавливает точку, к которой 
проводилось измерение, дальность, примечания и информацию о 
количестве точек. 
1. Для просмотра свойств одной или нескольких выбранных линий, 

щелкните по обмеру в левой панели таблицы Tape Dimension 
(Обмеры) и выберите пункт меню Edit > Properties (Редактирование 
> Свойства) 

2. Просмотрите или отредактируйте поля вкладки General (Основные 
параметры) (см. рис. 5-99 на стр. 5-65). При необходимости, 
отредактируйте поля Point To (До точки), Distance (Длина), Notes 
(Примечания) и # (Номер). 

3. По окончании просмотра и редактирования данных во вкладке 
щелкните на кнопке OK для принятия изменений и закрытия окна. 
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Рисунок 5-99. Вкладка General (Основные параметры) 

 

Просмотр свойств изображений 
Левая панель таблицы Images (Изображения) позволяет просмотреть 
свойства выбранного изображения. Правая панель доступна только для 
просмотра собственно изображений. 
1. Для просмотра свойств выбранного изображения выберите пункт меню 

Edit > Properties (Редактирование > Свойства) 
2. Во вкладке General (Основные параметры) будет показан номер 

выбранного изображения (см. рис. 5-100). 

 
Рисунок 5-100. Вкладка General (Основные параметры) 

3. По окончании просмотра щелкните на кнопке OK для закрытия окна. 
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Для заметок: 
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Глава 6  
Обработка, 
уравнивание и 
трансформирование 
точек 
При работе с данными измерений GPS+ (GPS и ГЛОНАСС) следует, 
прежде всего, рассчитать базисы GPS, используя модуль GPS+ 
PostProcessing (для GIS – модуль DGPS PostProcessing), в результате 
будут получены точные приращения координат (базисы) и приближенные 
абсолютные координаты пунктов наблюдения. Для некоторых задач 
точностей приближенных координат достаточно, однако для высокоточных 
определений следует выполнить уравнивание базисов для получения 
максимальной точности. 
Функция уравнивания уравнивает сети, наблюденные тахеометрами, 
комбинаций GPS+ и тахеометрических сетей и производит пересчет RTK 
решений. В процессе уравнивания рассчитываются уточненные 
местоположения всех точек проекта (за исключением отключенных или 
отфильтрованных). 
Определение параметров преобразования координат между рабочей СК 
GPS (WGS84) и местной СК производится при помощи модуля Localization. 

Настройка обработки и 
уравнивания 
Диалоговое окно свойств обработки и уравнивания позволяет установить 
параметры уравнивания, обработки тахеометрии и модуля GPS+ 
PostProcess (камеральной обработки измерений GPS+). 
1. Для настройки параметров обработки и уравнивания воспользуйтесь 

одной из описанных ниже процедур: 
• Выберите пункт меню Process > Process Properties (Обработка 

> Свойства обработки) для отображения диалогового окна 
Process properties (Свойства обработки).  



Обработка, уравнивание и трансформирование точек 

Topcon Tools- Руководство пользователя 6-2 

•  Выберите пункт меню Job > Job Configuration (Проект > 
Конфигурация проекта), затем Process(Процесс) в левой 
панели диалогового окна Job Configuration (Настройка проекта). 

Панель Process(Процесс) в диалоговом окне Job Configuration 
(Настройка проекта) отобразит несколько параметров. 

2. Во вкладке Adjustment (Уравнивание), выберите перечисленные ниже 
параметры уравнивания: 

• Доверительный интервал процесса уравнивания (Confidence 
level): 68%, 95% или 99% (см. рис. 6-1). По умолчанию 
доверительный интервал принимается равным 95%. 

• Критерий отбраковки плохих измерений. По умолчанию 
принимается критерий By Quality Control (по контролю качества). 

• Тесты, запускаемые до уравнивания сети. По умолчанию 
используются все тесты. 

3. Во вкладке TS-Computations (Обработка тахеометрии), выберите 
коэффициент рефракции: 0, 0.14 или 0.2. По умолчанию он равен 0.14. 

4. Во вкладке GPS+ PostProcessing (обработка GPS+измерений), 
выберите минимальный угол возвышения, состав используемых 
спутниковых навигационных систем и минимальную 
продолжительность обрабатываемого сеанса измерений (см. рис. 6-1). 

 
Рисунок 6-1. Свойства обработки 
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Разрешение обработки 
кинематических съемок 
По умолчанию отображение и обработка данных кинематических съемок 
отключены. Для разрешения отображения и обработки кинематических 
данных выставите флажок "Enable continuous kinematic" ("Включить 
непрерывную кинематику") во вкладке GPS+ PostProcessing (см. рис. 6-2). 
Доступ к этой вкладке можно получить через диалоговые окна Job 
Configuration (Настройка проекта) и Process properties (Свойства 
обработки). 

 
Рисунок 6-2. Выбор отображения и обработки непрерывной кинематики 

Когда функция включения непрерывной кинематики включена, в проекте 
Topcon Tools отображаются перечисленные ниже данные: 

• Кинематические точки в видах Points (Точки) и Map (Карта). 
• Кинематические сеансы в виде GPS Obs. 
• Кинематические траектории в виде Map (Карта). 

Для каждой эпохи сеанса кинематических измерений, которая может быть 
обработана, Topcon Tools создаст кинематическую точку, имеющую 
уникальное название на основе названия сеанса и времени GPS эпохи. 
При импорте TPS файлов, созданных под управлением TopSURV в 
режиме RTK+PP, с генерацией точек по времени, Topcon Tools будет 
использовать те же самые интервалы для создания точек и тот же способ  
их именования. 
Следовательно, точки RTK Autotopo и полученные обработкой 
кинематических измерений в тот же интервал времени, будут объединены.
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Включение или отключение 
данных по точкам 
В видах таблица, карта или сеанс используйте выпадающее меню или 
меню Edit (Редактирование) для включения и исключения данных в 
процессы обработки и уравнивания. 

• Выделите одиночные или множественные данные, затем щелкните 
по правой кнопке мыши и в появившемся меню выберите пункт 
Enable (Включить) или Disable (Отключить). 

• Выделите одиночные или множественные данные, затем щелкните 
Edit (Редактирование) > Enable (Включить) или Edit 
(Редактирование)> Disable (Отключить). 

• Выделите одиночные или множественные данные, затем откройте 
диалоговое окно Properties (Свойства) включите или отключите 
параметр Enabled (Включен) во вкладке General (Основные 
параметры). 

Отключенные данные отображаются серым цветом во всех окнах 
программы. 

Включение или отключение 
эпох 
В виде Occupation отображаются данные по каждому сеансу спутниковых 
измерений. Опытные пользователи могут отключать или включать 
отдельные эпохи при обработке данных. 
Щелкните по узлу +/- сеанса или же щелкните по правой кнопке мыши на 
сеансе и в появившемся меню выберите пункт Show SVs (Показать 
спутники). После этого под сеансом отобразятся все эпохи по каждому 
спутнику (см. рис. 6-3). 

 
Рисунок 6-3. График сеанса спутниковых измерений 
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1. Выделите эпохи для их отключения и включения (можно приблизить 
данные по отдельному спутнику). 

2. Охватите прямоугольником или щелкните на спутниковой эпохе (см. 
рис. 6-4). 

• При выделении прямоугольником будет выбраны все эпохи, 
начальные моменты которых попадают в выбранный интервал. 

• При выборе нескольких эпох удерживайте нажатыми клавиши 
CTRL или Shift. 

• Для отмены и обращения выбора отдельных эпох, выберите ее, 
удерживая клавишу CTRL нажатой. 

 
Рисунок 6-4. Выбор эпох 

3. Щелкните по правой кнопке мыши на выделенных эпохах и в 
появившемся меню выберите пункт Disable (Отключить) или Enable 
(Включить). Отключенные эпохи на схеме будут показаны косой 
штриховкой (см. рис. 6-5). 

 
Рисунок 6-5. Отключение выбранных эпох 
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Обработка 
Функция обработки использует измерительные данные в соответствии с 
параметрами, введенными и выбранными в панелях Quality Control 
(Контроль качества) и Process (Обработка) при настройке проекта. См. 
также раздел "Настройка обработки и уравнивания" на стр. 6-1. 

Обработка всех базисов GPS+ 
Для запуска обработки всех базисов в проекте воспользуйтесь одним из 
перечисленных ниже способов: 

• Выберите пункт меню Process > GPS+ PostProcessing (Обработка 
>обработка GPS+). 

• Нажмите клавишу F7 клавиатуры. 

• Щелкните на кнопке GPS + PostProcessing (см. рис. 6-6) 

 
Рисунок 6-6. Кнопка инструментальной панели GPS + PostProcessing 

 

Обработка части базисов GPS+ 
1. Выделите нужные базисы в виде Map (Карта) или табличном 

представлении на странице GPS Obs. 
Для выбора базисов в соответствии с определенным набором 
критериев используйте диалоговое окно Select GPS Obs  (см. раздел 
"Выбор базисов GPS" на стр. 4-53). 

2. Щелкните по правой кнопке мыши на выбранных базисах в странице 
GPS Obs (базисы GPS) и в появившемся меню выберите пункт GPS+ 
PostProcessing (обработка GPS+) (см. рис. 6-7). 

 
Рисунок 6-7. Обработка выбранных базисов GPS 
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Интерпретация результатов 
обработки 
В окне Legend (Легенда) показаны и описаны пиктограммы и цвета 
каждого типа данных. 
В окне графического представления данных (окно Карта) обработанные 
данные показаны ярким зеленым и красным цветом. Базовые линии с 
плановой/ высотной точностью хуже, чем установленные допуски 
текущего проекта, отображаются красным. На рисунке 6-8 показан пример 
виде Map (Карта) с выбранными базисами до и после выполнения 
функции обработки. 

 
Рисунок 6-8. Пример обработки в виде Map (Карта) 

В окне табличного представления данных (окно Таблица) данные об 
уравнивании и обработке даются в следующих столбцах: 

• Плановая и высотная точности определения базиса. 

• Величины разностей координат концов базиса. 

• Тип решения: Fixed (Фиксированное) – все фазовые 
неоднозначности разрешены до целых чисел или Float (Плавающее) 
– оценки всех фазовых неоднозначностей являются нецелыми 
действительными числами. 

Рисунок 6-9 на стр. 6-8 иллюстрирует пример окна Таблица с выбранными 
базисами до и после выполнения функции обработки. 
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Рисунок 6-9. Пример обработки в табличном окне 

 

Способы обработки базисов 
Topcon Tools использует несколько способов для обработки статических 
базисов в зависимости от их длины. Эти способы выбираются 
автоматически и не могут быть изменены. 
В колонке Solution Type (Тип решения) на странице GPS Obs (базисы GPS) 
отражается тип используемого способа. 

• VLBL (очень длинные базовые линии) – используется при длине 
базиса более 40 км. Тип обработки VLBL основан на широко 
известной технике тройных разностей и дает ТОЛЬКО плавающее 
решение. Фазовые неоднозначности до целых величин не 
разрешаются. В этом случае в колонке Solution Type (Тип решения) 
отображается "Iono Free". 

• WideLane – используется при длине базиса от 30 до 40 км. В этом 
случае в столбце типа решения отображается "Fixed, Wide Lane" или 
"Float, Wide Lane". 

• L1&L2c – используется при длине базиса от10 и 30 км. В этом случае 
в столбце типа решения отображается "Fixed, Iono Free" или "Float, 
Iono Free". 

• L1&L2 – используется при длине базиса менее 10 км. В этом случае 
в столбце типа решения отображается "Fixed" или "Float". 

Столбец Solution Type (Тип решения) вкладки GPS Obs отображает тип 
решения, которым был определен базис.
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Уравнивание 
Тахеометрические, GPS и нивелирные измерения могут быть уравнены 
совместно или по отдельности, с ограничениями или без таковых 
(свободное уравнивание). В уравнивании с ограничениями координаты 
одной или нескольких (опорных) точек фиксируются пользователем. В 
свободном уравнивании фиксируется точка, самостоятельно выбираемая 
программой Topcon Tools.  
Обратите внимание на следующие особенности уравнивания: 

• Уравнивание базисов GPS должно выполняться в выбранных 
исходных геодезических датах (ИГД). Уравнивание 
тахеометрических измерений производится на сфере радиуса 
равного среднему радиусу Земли. Оба эти вида уравнивания 
используют параметры принятой для текущего проекта модели 
геоида. 

• До начала уравнивания сети, GPS/тахеометрические/нивелирные 
пункты будут заново определены на основании соответствующих 
измерений. 

• Уравнивание плановых координат и высотных отметок Topcon Tools 
выполняет раздельно. 

• Если исходные точки зафиксированы в плане либо по высоте, то 
уравнивание будет выполнено с ограничениями в плане или по 
высоте соответственно. 

• При использовании модуля Advanced можно выбирать (1D, 2D, 3D 
или Auto) размерность уравнивания сети,  

 ПРИМЕЧАНИЕ 

До выполнения уравнивания сети базисов GPS+ 
выполните их обработку. 

При выполнении сетевого уравнивания модуль уравнивания в первую 
очередь проводит анализ сети, а затем выполняет собственно 
уравнивание. Схема рис. 6-10 на стр. 6-10 иллюстрирует процесс 
уравнивания. 
Для выполнения уравнивания всех измерений в проекте воспользуйтесь 
одним из перечисленных ниже способов: 

• Выберите пункт меню Process > Adjustment (Обработка > 
Уравнивание) 

• Нажмите на клавише F8 клавиатуры. 
• Щелкните на кнопке Adjustment Network (Уравнивание сети). 
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Рисунок 6-10. Схема процесса уравнивания сети 
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После запуска процедуры уравнивания выполняется анализ сети. Во 
время анализа уравнивание может прерваться и появится диалоговое 
окно Adjustment Diagnostic (Диагностика уравнивания) (см. рис. 6-11). В 
этом окне отображаются результаты диагностики и описание возможных 
сбойных ситуаций, которые могут препятствовать уравниванию. В этом 
случае: 

• Щелкните на кнопке Continue (Продолжить) для продолжения 
уравнивания без какого-либо изменения в данных. 

• Щелкните на кнопке Cancel (Отмена) для прерывания процесса 
уравнивания. 

• Нажмите гиперссылку для редактирования данных, включенных в 
проект. Щелкните на кнопке Restart (Повтор) для продолжения 
уравнивания. 

• Щелкните на кнопке Save Preliminary Coordinates (Сохранить 
предварительные координаты) для просмотра предварительно 
вычисленных координат. 

 
Рисунок 6-11. Диагностика уравнивания 

При просмотре предварительно вычисленных координат, производимом 
по щелчку на кнопке Save Preliminary Coordinates (Сохранить 
предварительные координаты) в диалоговом окне Adjustment 
Diagnostic (Диагностика уравнивания), в окне Карта отобразятся 
положения точек с вычисленными координатами, но координаты 
некоторые точек могут быть не рассчитаны. Рисунок 6-12 на стр. 6-12 
показывает окно Карта для тахеометрических измерений до и после 
уравнивания в системе координат WGS-84. Координаты пунктов 
тахеометрии до уравнивания были определены в местной СК (не в СК 
WGS-84). После уравнивания щелчком на кнопке Save Preliminary 
Coordinates был определены параметры перехода с местной СК на 
WGS-84 (по одной точке, определенной в обеих СК). Определение 
параметров перехода по таким исходным данным не позволяет 
произвести уравнивание точек в СК WGS-84. 
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Рисунок 6-12. Пример использования Save Preliminary Coordinates 

Во вкладке Adjustment (Уравнивание) диалогового окна Process properties 
(Параметры обработки) устанавливаются некоторые параметры 
уравнительных вычислений (см. рис. 6-13). Ниже дается их подробное 
описание. 

 
Рисунок 6-13. Окно Process properties (Свойства процесса) 

По умолчанию эти проверки производятся. 
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Контроль уравнивания: проверка 
координат базиса 
Проверка координат базиса сравнивает разницу между приращениями 
координат конечных точек базиса и измерением этого базиса. 

• Для тахеометрических измерений при различии расстояний более 
40 м или по горизонтальному (вертикальному) углу более 25º в 
диалоговом окне Adjustment Diagnostic (Диагностика 
уравнивания) появится сообщение об ошибке (см. рис. 6-14). 

• Для спутниковых местоопределений при отличии длин базиса 
(рассчитывается как квадратный корень из суммы квадратов 
составляющих базиса по всем трем координатам), полученных по 
координатам абсолютных и относительных местоопределений  
более 1000 м уравнивание сети прерывается и в диалоговом окне 
Adjustment Diagnostic (Диагностика уравнивания) появится 
сообщение об ошибке (см. рис. 6-14). 

 
Рисунок 6-14. Сообщение после сравнения измерений по точкам 

При наличии таких ошибок в сети процесс уравнивания невозможен. 
1. Щелкните на гиперссылке для доступа к ошибочным данным. Эти 

измерения отобразятся на окнах Карта и Таблица. 
2. Отредактируйте данные. 
3. Щелкните на кнопке Restart (Повтор) для продолжения уравнивания. 
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Контроль уравнивания: поиск 
дублирующихся измерений 
Поиск дублирующихся измерений усредняет координаты концов базисов с 
общими начальными и конечными точками (например, измерения с точки 
N1 на N2 и с N2 на N1 считаются повторными). Затем среднее значение 
замещает исходные измерения. Тест считается пройденным успешно 
(passed) или не пройденным (failed) на основании допусков, 
установленных для тахеометрических и GPS (спутниковых) измерений во 
вкладке TS observations/ GPS observations  диалогового окна Job 
Configuration (Настройка проекта) 

• Тест проходит успешно, если разность между рассчитанным 
значением измеряемой величины и любым из повторных измерений 
меньше допуска, установленного в диалоговом окне Job 
Configuration (Настройка проекта). 

• Тест не проходит, если разность между рассчитанным значением 
измеряемой величины и любым из повторных измерений превышает 
допуск, установленный в диалоговом окне Job Configuration 
(Настройка проекта). В этом случае уравнительные вычисления 
прекращаются, и отображается окно Adjustment Diagnostic (см. рис. 
6-15). 

 
Рисунок 6-15. Сообщение после поиска повторных измерений GPS 

После изменения данных процесс уравнивания можно продолжить или  
начать заново. 

• Щелкните на кнопке Continue (Продолжить) для продолжения 
уравнивания сети. 

• Щелкните по гиперссылке для запроса по данным, связанным с 
ошибкой. Отредактируйте данные. Щелкните на кнопке Restart 
(Повтор) для продолжения уравнивания (см. рис. 6-16 на стр. 6-15). 
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Рисунок 6-16. Выбор дублирующихся измерений в окнах Карта и Таблица 

Контроль уравнивания: выявление 
совпадающих пунктов 
Тест выявления совпадающих пунктов рассчитывает разности координат 
для всех точек проекта. Тест считается пройденным успешно на 
основании допусков, установленных для точностей пунктов во вкладке 
Point Precisions (Точности точек) диалогового окна Job Configuration  
(Настройка проекта) (вызывается выбором пункта меню Job > Job 
Configuration > Quality Control). 

• Тест проходит успешно, если разность координат пунктов больше 
установленного в диалоговом окне Job Configuration (Настройка 
проекта) допуска точности плановых/высотных координат. 

• Тест не проходит, если разность координат точек меньше 
установленного в диалоговом окне Job Configuration (Настройка 
проекта) допуска точности плановых/высотных координат. В этом 
случае уравнительные вычисления прекращаются, и отображается 
окно Adjustment Diagnostic (см. рис. 6-17). 

 
Рисунок 6-17. Сообщение после выявления совпадающих пунктов 
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После изменения данных процесс уравнивания можно продолжить или  
начать заново. 

• Щелкните на кнопке Continue (Продолжить) для продолжения 
уравнивания сети. 

• Щелкните по гиперссылке для запроса по данным, связанным с 
ошибкой. Отредактируйте данные. Щелкните на кнопке Restart 
(Повтор) для продолжения уравнивания. 

Контроль уравнивания: анализ сети 
Тест анализа сети выявляет компоненты сети, не имеющие связей между 
собой или связанные малым количеством измерений. Этот тест 
проводится только для тахеометрических пунктов, на которых выполнен 
неполный набор дальномерных или угловых измерений. 

• В отсутствии критических ошибок изолированные компоненты 
уравниваются по отдельности. 

• Если критические ошибки обнаружены, процесс уравнивания будет 
остановлен для ВСЕХ элементов сети и отображается окно 
Adjustment Diagnostic с сообщением об ошибке (см. рис. 6-18) Для 
каждого компонента сети, в диалоговом окне будет указано наличие/ 
отсутствие плановых и высотных исходных точек. 

Если в сети нет исходных точек, то будет выполнено свободное 
уравнивание (уравнивание без ограничений). 

 
Рисунок 6-18. Сообщение после анализа сетевых компонент 

После изменения данных процесс уравнивания можно продолжить или  
начать заново. 

• Щелкните на кнопке Continue (Продолжить) для продолжения 
уравнивания сети. 
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• Щелкните по гиперссылке для запроса по данным, связанным с 
ошибкой. Отредактируйте данные. Щелкните на кнопке Restart 
(Повтор) для продолжения уравнивания. 

Контроль уравнивания: анализ 
наличия высотных и плановых 
исходных пунктов 
При наличии исходных пунктов в проекте происходит проверка, заданы ли 
для этих пунктов плановые координаты и высота. 

• Если найдены только высотные исходные точки, то уравнительные 
вычисления приостанавливаются, и отображается диалоговое окно 
Adjustment Diagnostic (Диагностика уравнивания) (см. рис. 6-19). 
Щелкните на кнопке Continue (Продолжить) для выполнения 
уравнивания, ограниченного ТОЛЬКО по высоте. 

 
Рисунок 6-19. В уравнивании только высотные исходные точки 

• Если найдены только плановые исходные точки, то уравнительные 
вычисления приостанавливаются, и отображается диалоговое окно 
Adjustment Diagnostic (Диагностика уравнивания) (см. рис. 6-20). 
Щелкните на кнопке Continue (Продолжить) для выполнения 
уравнивания, ограниченного ТОЛЬКО в плане. 

 
Рисунок 6-20. В уравнивании только плановые исходные точки 
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Контроль уравнивания: анализ 
согласованности исходных пунктов 
Если в плановом/ высотном уравнивании используется более чем один 
исходный пункт, то при уравнивании также проверяется точность 
координат исходных точек. Тест проверки согласованности сравнивает 
исходные координаты с рассчитанными из GPS/ Тахеометрических/ 
Нивелирных измерений. Полученные невязки используются для оценки 
точности исходной геодезической сети и для выявления возможных 
ошибок в координатах. 
На странице Adjustment (Уравнивание) диалогового окна Process 
properties, включите или отключите тест "Control Tie Analysis" ("Контроль 
согласованности") для применения в уравнивании (см. рис. 6-13 на стр. 6-
12). Тест считается пройденным успешно на основании допусков, 
установленных для точностей пунктов во вкладке Point Precisions 
(Точности точек) диалогового окна Job Configuration  (Настройка 
проекта) (вызывается выбором пункта меню Job > Job Configuration > 
Quality Control). 

• Тест проходит успешно, если разности координат пунктов меньше 
допуска точности плановых/высотных координат, установленного в 
диалоговом окне Job Configuration (Настройка проекта). 

• Тест не проходит, если разность координат точек больше 
установленного в диалоговом окне Job Configuration (Настройка 
проекта) допуска точности плановых/высотных координат. В этом 
случае уравнительные вычисления прекращаются, и отображается 
окно Control Tie Analysis (Контроль согласованности) (см. рис. 
6-21). 

 
Рисунок 6-21. Контроль согласованности исходных пунктов 

После изменения данных процесс уравнивания можно остановить, 
продолжить, изменить или начать заново. 

• Щелкните на кнопке Cancel (Отмена) для остановки анализа 
согласованности исходных пунктов. 
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• Щелкните на кнопке Finish (Завершить) для продолжения 
остановки анализа согласованности исходных пунктов без 
изменений. 

• Для исключения исходного пункта и повторного запуска процедуры 
проверки согласованности выберите исходный пункт и щелкните на 
кнопке Reject (Удалить). 

• Для автоматического исключения из процесса уравнивания 
исходных точек с максимальными величинами невязок и повтора 
процесса проверки согласованности исходных пунктов щелкните на 
кнопке Auto (Автомат). 

Оценка качества уравнивания сети 
Качество уравнивания сети можно проконтролировать с использованием 
тестов по контролю качества или критерия Тау. 
1. Выберите пункт меню Process > Process Properties 
2. На странице Adjustment (Уравнивание) диалогового окна Process 

properties (Параметры обработки) выберите соответствующий 
критерий (см. рис. 6-22). 

 
Рисунок 6-22. Выбор теста качества уравнивания 

3. Для включения/ выключения использования измерений 
недостаточного качества в сетевом уравнивании двойным щелчком 
колонке Autoreject напротив нужных измерений выберите. 
• Allowed (Использовать) – измерения недостаточного качества 

будут автоматически удаляться из уравнивания сети. 
• Not Allowed (Не использовать) – измерения недостаточного 

качества тем не менее будут включены в уравнивание сети. Т.е. 
измерения с произвольными невязками используются в 
уравнивании. 

 
Рисунок 6-23. Принятие/ не принятие измерений недостаточного качества в 

уравнивание сети 
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Отбор компонент сети в уравнивание производится согласно величинам, 
заданным во вкладках GPS Obs Precision / TS Obs Precision (Точность 
GPS измерений / Точность тахеометрии) диалогового окна Job 
Configuration (вызывается выбором пункта меню Job > Job Configuration 
> Quality Control). 

• Тест "By Quality Control" удаляет в процессе уравнивания из 
выбранной сети компоненты с невязками хуже, чем установленные в 
настройках текущего проекта. Эти невязки рассчитываются во время 
уравнивания для замкнутых построений и для повторных измерений. 

− в плановом уравнивании - все плановые компоненты базисов 
GPS, дальности и горизонтальные углы тахеометрических 
измерений. 

− в высотном уравнивании - все высотные компоненты базисов 
GPS и вертикальные углы тахеометрических измерений. 

• Тест "Tau Criterion" удаляет в процессе уравнивания из выбранной 
сети компоненты с величинами Tau хуже, чем Taucritical. Эти невязки 
рассчитываются во время уравнивания для закрытых построений 
(треугольников) или повторных базисов. 

− в плановом уравнивании - все плановые компоненты базисов 
GPS, дальности и горизонтальные углы тахеометрических 
измерений. 

− в высотном уравнивании - все высотные компоненты базисов 
GPS и вертикальные углы тахеометрических измерений. 

Формула расчета Tau: Tau = (RES) / δRES, 
где, "(RES)" – величина остаточного уклонения соответствующего 
измерения и δRES – его среднеквадратическая ошибка (СКО). 

Напомним, что Taucritical зависит только от числа степеней свободы и 
выбранного уровня доверительной вероятности (см. рис. 6-22 на стр.6-19). 
После окончания уравнивания появляется диалоговое окно Adjustment 
Result (Результат уравнивания) (см. рис.6-24 на стр. 6-21). 
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Рисунок 6-24. Результат уравнивания 

В этом окне даются результаты каждого выполненного теста. Приводятся 
следующие данные: 

• Результаты анализа согласованности исходных пунктов (тест 
выполнен или не выполнен). При не выполненном условии 
согласованности появится список исходных точек, которые были 
выведены из планового или высотного уравнивания. 

 
Рисунок 6-25. Результаты контроля согласованности исходных пунктов – 

примеры удачного и неудачного решения 

• Тип сетевого уравнивания: свободное (inner), только плановое 
(horizontal only), только высотное (vertical only), с одним плановым и 
одним высотным пунктами или же планово-высотное уравнивание с 
несколькими исходными пунктами (см. рис. 6-26 на стр. 6-22). 
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Рисунок 6-26. Типы уравнивания сети 

• Раздельно даются сведения по плановому и высотному 
уравниванию, в т.ч.: количество уравненных пунктов, исходных 
пунктов и пунктов с обозначенным весом, количество 
использованных и отбракованных измерений, ошибки единицы веса 
(UWE) и границы UWE. 

• Отбракованные измерения (или их части). В этой таблице красным 
цветом показаны удаленные из сети и не использованные в 
окончательном уравнивании измерения и их части. 

• Пункты, оценки точностей координат которых превышают 
установленные в настройках проекта величины. 

 
Рисунок 6-27. Результаты уравнивания - точности точек 
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• Измерения с невязками хуже установленных в настройках проекта 
величин. 

 
Рисунок 6-28. Результаты уравнивания - невязок измерений 

После выполнения процесса уравнивания данные в окнах Карта и 
Таблица обновляются. 

• В окне Карта уравненные точки будут обозначаться кружком с двумя 
закрашенными секторами. Исключенные из уравнивания базисы 
отображаются красным цветом. 

 
Рисунок 6-29. Окно Карта – пример уравнивания 

• В окне Таблица данные об уравнивании отображаются в следующих 
перечисленных ниже столбцах: 

− Во вкладке Points (Точки), отображаются 
среднеквадратические ошибки точек. 

− Во вкладке TS Obs / GPS Obs (Тахеометрия / базисы GPS), 
отображаются невязки измерений. 

 
Рисунок 6-30. Вкладки Points и Obs – пример уравнивания 
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Просмотр отчета об уравнивании 
После уравнивания данных в Topcon Tools отчет об уравнивании дает 
сводку достигнутых результатов. 
Выберите пункт меню Report > Adjustment (Отчет > Уравнивание) (см. 
рис. 6-31) для просмотра отчета: 

 
Рисунок 6-31. Просмотр отчета об уравнивании 

 

Окно Adjustment Report (Отчет об уравнивании) отображает данные о 
уравнивании. Подробнее см. раздел "Отчет об уравнивании" на стр. 7-2. 

• Для сохранения отчета в файле щелкните на кнопке Save As 
(Сохранить как). Выберите директорию для сохранения и введите 
название файла, после чего щелкните на кнопке Save (Сохранить). 

• Для копирования в текстовый редактор, например Microsoft® Word 
или Outlook Express, щелкните на кнопке Select All (Выделить все), а 
затем на кнопке Copy (Копировать). Откройте нужное приложение и 
вставьте (paste) эти данные. 

• Для печати отчета щелкните на кнопке Print (Печать). 

Вычисление незамыканий 
полигонов и создание отчетов 
Замыкание полигонов вычисляется по базисам GPS, формирующим 
замкнутые фигуры суммированием всех приращений координат в 
полигоне для получения суммарной невязки (отличия от нуля). Эта 
невязка сравнивается с пороговой величиной Horz Tolerance / Vert 
Tolerance (Допуск в плане / Допуск по высоте). Пороги рассчитываются 
следующим образом 
Horiz Tolerance = Horiz Tolerance abs + Horiz Tolerance rel L·10-6 
Vert Tolerance = Vert Tolerance abs + Vert Tolerance rel L·10-6 
где величины Horiz Tolerance abs / Vert Tolerance abs и Horiz Tolerance rel / 
Vert Tolerance rel вводятся во вкладке Job Configuration > Quality Control 
> Loop Closure, величина L – периметр полигона. 
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Невязки в отчете показываются красным цветом, если их величины 
превышают допустимое значение. 
1. Для создания отчета о невязках полигонов выберите пункт меню 

Process > Loop closures (Обработка > Замыкание полигонов). 
Появится диалоговое окно Loop closures (Замыкание полигонов) 
(см. рис. 6-32). 

 
Рисунок 6-32. Вычисление незамыканий полигонов 

2. В главном окне (Карта или базисы GPS), выберите статические базисы 
GPS, составляющие замкнутые полигоны (см. рис. 6-33). 

 
Рисунок 6-33. Выбор базисов, составляющих полигоны 

3. Выполните одну из перечисленных процедур для просмотра или 
редактирования отчета о незамыканиях: 
• Щелкните на кнопке Finish (Завершить) диалогового окна Loop 

closures для создания стандартного отчета о незамыканиях 
полигонов, который откроется в отдельном окне (см. рис. 6-34). 

• Щелкните на кнопке Cancel (Отмена) диалогового окна Loop 
closures для прекращения создания отчета по незамыканиям. 

• Щелкните на кнопке Options (Опции) диалогового окна Loop 
closures (Замыкание полигонов) для настройки отчета. 
Подробнее см. "Составление отчета о незамыканиях полигонов" 
на стр. 6-26. 
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Рисунок 6-34. Отчет по незамыканиям полигонов 

Стандартный отчет о незамыканиях полигонов содержит следующие 
данные для выбранных статических базисов GPS: 

• Loop (Полигон) – базисы, образующие замкнутую фигуру. 
• dHz и dU – плановые и высотные невязки для данного полигона. 
• Horiz Tolerance / Vert Tolerance (m) – пороговые допуски в метрах. 
• dHz (ppm), dU (ppm) – точность в относительной мере (единица на 

миллион). 
• Length (m) – длина полигона в метрах. 

Составление отчета о 
незамыканиях полигонов 
Для выбора типа данных, которые будут представлены в отчете о 
незамыканиях, щелкните на кнопке Options (Опции) диалогового окна 
Loop closures (Замыкание полигонов). 
Появится окно Loop closures Report Options (Состав отчета о 
незамыканиях). 

 
Рисунок 6-35. Состав отчета о незамыканиях полигонов 
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Используя диалоговое окно Loop closures Report Options (Состав 
отчета по незамыканиям) выберите и скомпонуйте информационные 
столбцы формы отчета. После завершения щелкните на кнопке ОК, после 
чего создайте отчет по описанной ранее процедуре. 

• Для переименования отчета (создание пользовательского шаблона 
отчетов) введите название отчета. 

• Для добавления величины в отчет выделите ее в левой панели, а 
затем щелкните на кнопке “>>”. 

• Для удаления величины из отчета выделите ее в правой панели, а 
затем щелкните на кнопке “<<”. 

• Используйте кнопки Move Up и Move Down (Вверх и Вниз), для 
упорядочения переменных. 

Трансформирование 
координат 
Трансформирование заключается в перерасчете координат пунктов из 
местной СК в геоцентрическую и в обратном направлении. 
Спутниковые GPS+ системы способны выполнять точные определения 
координат пунктов в глобальной референцной системе и используют 
представление координат в виде географической широты, долготы и 
высоты. Для использования в типовых проектах глобальные GPS 
координаты необходимо трансформировать в координаты в проекции, 
отнесенные к местной системе координат (определенные в терминах 
дальностей по направлениям на север и восток от некоторой начальной 
точки, и превышения от некоторой высотной отметки). Эти северная, 
восточная координаты и высота (общая аббревиатура - NEZ), могут быть 
региональной координатной системой – к примеру, государственная 
плановая система США или условной системой координат строительной 
площадки. Координаты NEZ должны соответствовать СК, использованной 
при составлении строительного проекта. В любом случае требуется 
определение параметров перехода от глобальной СК GPS к местной СК. 
Основой расчета параметров преобразования является наличие 
координат некоторого количества пунктов в двух системах координат. 
Пары координат состоят из: 

• Координат в местной СК, полученных по результатам съемки. 
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• Широты, долготы и высоты в глобальной СК. 
Эти пары координат необходимы для расчета параметров трансформации  
всех глобальных GPS координат (полученных из обработки данных GPS+ 
или GPS приемников) к местным NEZ координатам проекта. 
Придерживайтесь следующих правил для обеспечения точной основы для 
расчета параметров перехода между системами координат: 

• Исходные пункты в местной СК должны быть измерены точно. 
Качество исходных пунктов напрямую отражается точности 
определяемых параметров перехода. 

• Исходные пункты в местной СК должны быть равномерно 
размещены в районе проведения работ. Обычно, чем больше 
исходных пунктов – тем лучше, но если они сосредоточены только 
на одном участке или вытянуты в линию, параметры будут 
определены неоптимальным образом. 
Можно порекомендовать расположить пункты равномерно по 
периметру участка. При выборе пунктов следует обратить внимание 
также их доступность, располагать их вне лесных массивов, на 
удалении от зданий и сооружений, строительной техники и прочих 
препятствий. 

Если параметры трансформации были рассчитаны для проекта, то при 
внесении изменении в исходные данные параметры трансформации будут 
автоматически пересчитываться. 

Расчет плановой и высотной 
трансформации 
В программе Topcon Tools (а также и в Topcon Link и TopSURV) параметры 
плановой и высотной трансформации определяются раздельно. 

• Плановая трансформация использует двумерное конформное 
преобразование. Этот вид трансформации известен так же, как 
простая трансформация по четырем параметрам (вращение (α), 
масштаб и два параметра линейного смещения (DX, DY)). Для 
пересчета координат пунктов в геодезических координатах 
(местоопределения по приемникам GNSS) в местную СК (пункты, 
полученные из тахеометрических измерений) как промежуточное 
представление используется косоугольная стереографическая 
картографическая проекция: 
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• Для пересчета эллипсоидальной или ортометрической высот в 
местную высотную систему используется трехпараметрическая 
трансформация (один сдвиг (НО) и два наклона (Hx, Hy)). Эти три 
параметра задают плоскость, задающую разность между местным 
геоидом и эллипсоидом системы WGS-84: 

 
StereoStereoLocal EHyNHxHoUH ⋅+⋅++=  

 
Topcon Tools (а также и в Topcon Link и TopSURV) использует алгоритм 
определения параметров перехода от WGS84 к местной СК с 
использованием одного, двух или более исходных пунктов с высотами, 
определенными в обеих системах. Если в проекте присутствует модель 
геоида, Topcon Tools будет использовать ее в расчетах. Модель геоида 
учитывается перед использованием отметок в местной СК. Параметры 
трансформации, определенные с использованием модели геоида 
отличаются от вычисленных без ее применения. 

• При использовании ЕДИНСТВЕННОЙ исходной точки принимаются 
следующие дополнительные условия (Таблица 6-1): 

Таблица 6-1. Трансформация с одной исходной точкой 

Для плановой 
трансформации 

Система ориентирована на север. 
Плановый масштабный фактор (Kh) принимается 
равным единице. 
Определяются плановые смещения (DX, DY).  

Для высотной 
трансформации 

Компоненты наклонов равны нулю. 
Определяется смещение по высоте. 

Для плановой и 
высотной 

трансформации 

Система ориентирована на север. 
Комбинированный масштабный фактор равен 

( )( )RUKKK vhcomb /11 +⋅=⋅= , где R – средний радиус 
кривизны. 
Компоненты наклонов равны нулю. 
Определяются плановые смещения (DX, DY) и 
смещение по высоте (DH). 
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• При использовании ДВУХ исходных точек в планово-высотной 
трансформации: 

− - Компоненты наклона принимаются равными нулю. 

− - Определяются плановые смещения (DX, DY) и смещение по 
высоте (DH), азимут (вращение) и масштабный коэффициент. 

• Когда используются ТРИ или более исходных точек, 
рассчитываются все параметры планово-высотной трансформации. 

Оценка точности параметров 
трансформации 
Параметры трансформации рассчитываются по методу наименьших 
квадратов в следующих случаях: 

• В плановой трансформации при использовании трех или более 
исходных пунктов. 

• В планово-высотной трансформации при используется три или 
более исходных пунктов. 

В диалоговом окне Localization (Трансформация)  показаны невязки для 
всех исходных пунктов (см. рис. 6-36). 

 
Рисунок 6-36. Невязки при определении параметров трансформации 

При использовании менее трех исходных пунктов рассчитанные невязки 
будут иметь следующие величины: 

• При использовании ЕДИНСТВЕННОГО исходного пункта плановые и 
высотные невязки равны нулю. 
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• При использовании ДВУХ исходных пунктов плановые невязки 
равны нулю, высотная может отличается от нуля. 

• При использовании ТРЕХ исходных точек плановые невязки равны 
нулю, высотная может отличается от нуля. 

Определение параметров 
трансформации проекта 
 

 ПРИМЕЧАНИЕ 

Импортируйте файл опорных координат до выполнения 
расчета параметров трансформации. 

Для определения параметров пересчета глобальных координат в 
местные, во-первых, импортируйте в проект файл с исходными 
координатами в местной СК. Затем импортируйте файл с координатами 
пунктов в общеземной СК. Если импортируется проект TopSURV™ с уже 
определенными в нем параметрами трансформации, то они также 
импортируются. 
1. Для импорта файла координат пунктов в общеземной СК выберите 

пункт меню File > Import (Файл > Импорт). Найдите файл с 
координатами в СК WGS-84, затем щелкните на кнопке Open 
(Открыть) (см. рис. 6-37). 

 
Рисунок 6-37. Импорт файла координат 

Содержимое файла отобразится в окнах Таблица и Карта. 
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2. Выберите пункт меню Process > Localization (Обработка > 
Трансформация) или нажмите сочетание клавиш Shift+F8 для 
открытия диалогового окна Localization (Трансформация). Щелкните 
на кнопке Add Point (Добавить точку) (см. рис. 6-38). 

 
Рисунок 6-38. Добавление точки в трансформацию 

3. Выберите перечисленные ниже параметры (см. рис. 6-39): 

• Пункт для включения в определение параметров трансформации 
из выпадающего списка WGS Point. 

• Соответствующую точку из столбца Local Point. 

• Тип точки в столбце Use (Использовать). 

 
Рисунок 6-39. Выбор WGS Point, Local Point и типа использования 

4. Щелкните на кнопке Add Point (Добавить точку) и повторите шаги 2 и 
3 для выбора остальных точек. 
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5. Флажок Keep Scale 1.000 , выставленный перед запуском расчета, 
позволяет установить единичный линейный масштаб. 

6. Щелкните на кнопке Compute parameters (Расчет параметров) для 
расчета параметров трансформации (см. рис. 6-40). 
• В колонках невязок North, East Height в левой панели появятся 

значения апостериорные значения невязок. 
• В правой панели отображаются параметры трансформации, 

рассчитанные по использованным пунктам. 

 
Рисунок 6-40. Расчет параметров трансформации 

После расчета параметров они будут использованы для пересчета WGS 
координат в местную СК и в обратном направлении. 
Табличное окно и окно Карта обновятся с учетом пунктов, координаты 
которых можно трансформировать. Рисунок 6-41 на стр. 6-34 показывает 
окна Карта и Таблица до и после определения параметров 
трансформации. 



Обработка, уравнивание и трансформирование точек 

Topcon Tools- Руководство пользователя 6-34 

 
Рисунок 6-41. Окна Карта и Таблица до и после определения параметров 

трансформации 
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Глава 7  
Отчеты 
Topcon Tools создает отчеты, состоящие из требуемых данных. 
Представление и состав отчетов может определяться пользователем. 
Помимо отчетов своего формата, Topcon Tools поддерживает большое 
количество различных форматов файлов для экспорта данных, которые 
могут использоваться в другом программном обеспечении или 
устройствах. 

Стандартные отчеты 
Отчеты позволяют просматривать данные вне Topcon Tools или 
выполнять анализ после внесения изменений в процессе обработки. К 
достоинствам отчетов следует отнести то, что они содержат итоговую 
информацию в компактном представлении. 
В следующих ниже разделах описываются стандартные отчеты и их 
исходный состав. Изменение состава отчетов подробно описывается в 
разделе "Отчеты, настроенные пользователем" на стр. 7-14. 

• Для сохранения отчета в файле щелкните на кнопке Save As 
(Сохранить как). Выберите директорию для сохранения и введите 
название файла, после чего щелкните на кнопке Save (Сохранить). 

• Для копирования в текстовый редактор, например Microsoft® Word 
или Outlook Express, щелкните на кнопке Select All (Выделить все), а 
затем на кнопке Copy (Копировать). Откройте нужное приложение и 
вставьте (paste) эти данные.  

• Для печати отчета щелкните на кнопке Print (Печать).
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Отчет об уравнивании 
Для просмотра отчета об уравнивании выберите пункт меню Report > 
Adjustment (Отчет > Уравнивание). 

 
Рисунок 7-1. Просмотр отчета об уравнивании 

Стандартный отчет об уравнивании состоит из перечисленных ниже 
разделов (см. рис. 7-2 на стр. 7-3): 

• Project Summary (Сводка проекта). 

• Adjustment Summary (Сводка уравнивания). 

• Used GPS Observations (Использованные базисы GPS). 

• GPS Observations Residuals (Невязки базисов GPS). 

• Control Points (Исходные пункты). 

• Adjusted Points (Уравненные пункты). 
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Рисунок 7-2. Отчет об уравнивании 
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Отчет о базисах GPS 
Для просмотра отчета о базисах GPS выберите пункт меню Report > GPS 
Observations (Отчет > базисы GPS). 

 
Рисунок 7-3. Просмотр отчета о базисах GPS 

Стандартный отчет о базисах GPS состоит из перечисленных ниже 
разделов: 

• Project Summary (Сводка проекта). 

• GPS Observations (базисы GPS). 

 
Рисунок 7-4. Отчет о базисах GPS 
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Отчет о пунктах 
Для просмотра отчета о пунктах выберите пункт меню Report > Points 
(Отчет > Пункты). 

 
Рисунок 7-5. Просмотр отчета о пунктах 

Стандартный отчет о пунктах состоит из перечисленных ниже разделов: 

• Project Summary (Сводка проекта). 

• Points (Пункты). 

 
Рисунок 7-6. Отчет о пунктах 
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Отчет о контроле качества 
Для просмотра отчета о контроле качества выберите пункт меню Report > 
Quality Control (Отчет > Контроль качества). 

 
Рисунок 7-7. Просмотр отчета о контроле качества 

Стандартный отчет о контроле качества состоит из перечисленных ниже 
разделов: 

• Project Summary (Сводка проекта). 
• GPS Obs Quality (Качество базисов GPS). 
• RTK Obs Quality(Качество RTK местоопределений). 
• Repeated Observations (Повторные измерения). 
• Failed Loop Closures (Замыкания полигонов недостаточного 

качества). 
• Identical Points (Совпадающие пункты). 
• Misnamed GPS Occupations (Неверно названные сеансы GPS). 
• AutoRejected GPS Obs (Автоматически исключенные базисы GPS). 
• Adjusted Point Quality (Качество уравненных пунктов). 

 
Рисунок 7-8. Отчет о контроле качества 
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Отчет о тахеометрических 
измерениях 
Для просмотра отчета о тахеометрических измерениях выберите пункт 
меню Report > TS Observations (Отчет > Тахеометрия). 

 
Рисунок 7-9. Просмотр отчета о тахеометрических измерениях 

Стандартный отчет о тахеометрических измерениях состоит из 
перечисленных ниже разделов: 

• Project Summary (Сводка проекта). 

• TS Observations (Тахеометрические измерения). 

 
Рисунок 7-10. Отчет о тахеометрических измерениях 
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Координатная геометрия - отчет о 
решении обратной геодезической 
задачи 
Для просмотра отчета о решении обратной геодезической задачи 
щелкните по правой кнопке мыши на нижней панели диалогового окна 
Inverse (Обратная задача) и в появившемся меню выберите пункт 
Report (Отчет). 

 
Рисунок 7-11. Диалоговое окно Inverse (Обратная геодезическая задача) 

Отчет о решении обратной геодезической задачи состоит из 
перечисленных ниже разделов: 

• From and To points (Начальная и Конечная точки). 
• Forward and Backward Azimuths (Прямой и обратный азимуты). 
• Geodetic and Ground Distances (Длина геодезической линии и 

горизонтальное проложение). 
• Delta Ell. Height (Превышение геодезических высот). 
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Рисунок 7-12. Отчет о решении обратной геодезической задачи 

Координатная геометрия - отчет о 
пересечениях 
Для просмотра отчета о пересечениях щелкните по правой кнопке мыши 
на нижней панели диалогового окна Intersection (Пересечения) и в 
появившемся меню выберите пункт Report (Отчет). 

 
Рисунок 7-13. Диалоговое окно Intersection (Пересечения) 

Отчет о пересечениях состоит из перечисленных ниже разделов: 
• Name (Название) – название точки пересечения (по умолчанию – 

"cogo"). 
• Start1 и Start2  – начальные точки лучей или названия центров сфер. 
• Complete1 / Complete2 – конечные точки или азимут для луча или 

расстояние для сферы. 
• Latitude/ Longitude/ Ell. Height или Northing/ Easting/ Elevation 

(Широта/ Долгота/ Геодезическая Высота или Север/ Восток/ 
Превышение) – координаты точки пересечения. 

 
Рисунок 7-14. Отчет о пересечениях 
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Координатная геометрия - отчет о 
сравнении поверхностей 
Для просмотра отчета о сравнении поверхностей щелкните по правой 
кнопке мыши на нижней панели диалогового окна Compare Surfaces 
(Сравнение поверхностей) и в появившемся меню выберите пункт Report 
(Отчет). 

 
Рисунок 7-15. Диалоговое окно Сравнение поверхностей 

Отчет о сравнении поверхностей состоит из перечисленных ниже 
разделов: 

• Design/Existing (Проектная/Существующая) – названия 
поверхностей, для которых рассчитывается взаимное положение. 

• Cut/Fill (Срезать/Заполнить)  
- в случае сравнения двух поверхностей - объемы для удаления 

или заполнения при коррекции выбранной поверхности до 
проектной. 

- в случае сравнения поверхности и горизонтальной плоскости - 
объемы для удаления или заполнения для создания проектной 
поверхности относительно выбранного уровня. 

• Area – площадь участка, общего для двух поверхностей или 
поверхности и горизонтальной плоскости. 

 
Рисунок 7-16. Отчет о сравнении поверхностей 
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Координатная геометрия - отчет о 
расчете положения пункта 
относительно линии 
Для просмотра отчета о расчете положения пункта относительно линии 
щелкните по правой кнопке мыши на нижней панели диалогового окна 
Inverse Point to Line (Пункт относительно линии) и в появившемся меню 
выберите пункт Report (Отчет) (см. рис. 7-17). 

 
Рисунок 7-17. Просмотр отчета о положении точки относительно линии 

Отчет о положении пункта относительно линии состоит из перечисленных 
ниже полей (см. рис. 7-18 на стр. 7-12): 

• Name (Название) – название точки, для которой рассчитываются 
смещения относительно линии. 

• Latitude/ Longitude/ Ell. Height (широта/ долгота/ геодезическая  
высота) или Grid Northing/ Grid Easting/ Elevation (север/ восток/ 
превышение в координатах проекции) или Ground Northing/ Ground 
Easting/ Elevation (север/ восток/ превышение в местной СК) – 
координаты этой точки. 

• From Point (От точки) – название точки начала линии или луча. 
• Direction (Направление) – название конечной точки линии или 

значение азимута. 
• Offset Along (Смещение вдоль) – длина перпендикуляра, опущенного 

из выбранной точки на линию. Это значение положительное, если 
точка расположена справа от линии. 

• Offset Across (Смещение поперек) – длина отрезка от начальной 
точки до основания перпендикуляра (см. выше). Это значение 
положительное, если точка расположена в направлении луча. В 
противном случае значение отрицательное. 
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• Offset H (Превышение) – превышение выбранной точки над точкой 
начала линии или луча. 

 
Рисунок 7-18. Отчет о расчете положения точки относительно линии 

 

Координатная геометрия - отчет о 
ходе 
Для просмотра отчета о ходе щелкните по правой кнопке мыши на нижней 
панели диалогового окна Traverse (Ход) и в появившемся меню выберите 
пункт Report (Отчет) (см. рис. 7-19). 

 
Рисунок 7-19. Просмотр отчета о ходе 

Отчет по ходу состоит из перечисленных ниже полей: 
• Name (Название) – название точки хода. 
• Grid Northing/ Grid Easting/ Elevation (север/ восток/ превышение в 

координатах проекции) или Ground Northing/ Ground Easting/ 
Elevation (север/ восток/ превышение в местной СК)– рассчитанные 
координаты точки хода. 

• From Point (От точки) – название станции. 
• BS Point (Задняя точка) – название задней точки хода. 
• Azimuth (Азимут) – введенный или рассчитанный азимут 

направления от станции до точки хода. 
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• Bearing (Дирекционный угол) - рассчитанный дирекционный угол 
направления от станции до точки хода. 

• Hor. Dist / Vert. Dist - Горизонтальное проложение / Превышение от 
станции до точки хода. 

• BS Azimuth (Обратный азимут) – введенный или рассчитанный 
азимут направления от задней точки хода до станции. 

• BS Bearing (Обратный дирекционный угол) – рассчитанный 
дирекционный угол направления от задней точки хода до станции 

 

 
Рисунок 7-20. Отчет о ходе 

 

Координатная геометрия - отчет о 
пункте в заданном направлении 
Для просмотра отчета о точке в заданном направлении щелкните по 
правой кнопке мыши на нижней панели диалогового окна Point In Direction 
(Точка в направлении) и в появившемся меню выберите пункт Report 
(Отчет) (см. рис. 7-21). 

 
Рисунок 7-21. Просмотр отчета по точке в направлении 

Отчет по точке в направлении состоит из перечисленных ниже полей: 
• Name (Название) – название создаваемой точки (CoGo). 
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• Start1 (Старт1) – название начальной точки линии или луча. 
• Complete1 (Завершение1)– название конечной точка линии или 

значение азимута. 
• Distance (Дальность) – расстояние от начальной точки до 

рассчитываемой (CoGo), расположенной на выбранной линии. 
• Latitude/ Longitude/ Ell. Height (широта/ долгота/ геодезическая  

высота) или Grid Northing/ Grid Easting/ Elevation (север/ восток/ 
превышение в координатах проекции) или Ground Northing/ Ground 
Easting/ Elevation (север/ восток/ превышение в местной СК)  – 
координаты точки CoGo. Обратите внимание на то, что высота 
(геодезическая или ортометрическая) точки CoGo принимается 
равной высоте начальной точки линии. 

 
Рисунок 7-22. Отчет о точке в заданном направлении 

 
 
 

Отчеты, настроенные 
пользователем 
Суть настройки отчетов состоит в том, что пользователь выбирает состав 
данных, включаемых в отчет. 
Для настройки отчета выберите Report > Report Configuration (Отчет > 
Настройка отчета) (см. рис. 7-23). 

 
Рисунок 7-23. Просмотр настроек отчета 

Диалоговое окно Report Configuration (Настройка отчета) 
предоставляет набор инструментов для настройки отчета (см. рис. 7-24 на 
стр. 7-16). 
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• В поле Reports (Отчеты) показан список готовых форм отчетов. 
Щелкните по названию отчета для просмотра его состава. 

• Новую форму отчета можно создать, нажав на кнопку New report 
(Новый отчет). См. также раздел "Создание новой формы отчета" 
на стр. 7-25. 

• Удалить форму из списка можно кнопкой Delete (Удалить). 
• Нажатие на кнопку Copy report as (Копировать отчет как) копирует 

выбранную форму отчета. Используйте эту кнопку для копирования 
формы отчета для изменения без уничтожения оригинала. 

• Кнопку Execute (Выполнить) позволяет создать отчет по 
выделенной форме на основании данных текущего проекта. 

• В поле Available report templates (Доступные шаблоны отчета), 
перечислены поля, которые можно включить в форму выбранного 
отчета. 

• В поле Included report items (Включенные в отчет поля) 
перечислены поля, уже включенные в форму выбранного отчета. 

• Кнопки ">>", Move Up (Вверх), Move Down (Вниз) и 
Remove(Удалить) используются для включения, сортировки и 
удаления полей в форме отчета. 

• Кнопка Options (Параметры) позволяет настроить параметры 
выбранных полей. 

• Выбор Report format (Формат отчета) позволяет выбрать формат 
экспорта файла отчета. 

В одну форму отчета допускается включать одинаковые поля (но они, при 
этом, должны отличаться параметрами). Названия большинства полей 
можно изменить через кнопку Options (Параметры) (подробнее см. 
раздел "Редактирование параметров полей формы отчета" на стр. 7-19). 
При изменении названия поля в расположенном справа списке Included 
report items изменяется исключительно название, новое поле не 
создается. Поле по-прежнему видно под старым названием в 
расположенном слева списке Available report templates. 
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Рисунок 7-24. Диалоговое окно Настройка отчета 

Для формирования отчета в диалоговом окне Report Configuration 
(Настройка отчета) выберите из списка необходимую форму и щелкните 
на кнопке Execute (Выполнить). Созданная форма также будет 
добавлена в список пункта меню Reports. 

 
СОВЕТ 

Настройте инструментальную панель, создав кнопку 
быстрого запуска формирования основного отчета. 
Подробнее см. раздел "Настройка инструментальной 
панели" на стр. 1-20. 
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Настройка формы отчета 
Отчеты и составляющие их поля можно отредактировать, что дает 
возможность пользователю установить нужный состав данных в отчете. 

Копирование формы отчета 
1. Выберите нужную форму отчета в поле Reports (Отчеты) и щелкните 

на кнопке Copy report as (Копировать отчет как). В поле Reports 
(Отчеты) будет добавлена новая форма отчета, содержащая те же 
поля, что и исходная (см. рис. 7-25). 

 
Рисунок 7-25. Копирование выбранной формы отчета 

2. Задайте название новой формы. 
3. Для добавлении пунктов выберите нужные в левой панели и щелкните 

на кнопке (>>) (см. рис. 7-26 на стр. 7-18). 
4. Для удаления пункта выберите его в правой панели и щелкните на 

кнопке Remove (Удалить) (см. рис. 7-26 на стр. 7-18). 
5. Для сортировки пунктов в форме отчета используйте кнопки Move Up 

(Вверх) и Move Down (Вниз) (см. рис. 7-26 на стр. 7-18). 
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Рисунок 7-26. Редактирование формы отчета 

 

Редактирование полей в выбранной форме 
отчета 
1. Выберите нужную форму отчета в поле Reports (Отчеты). 
2. Для добавления пунктов выберите нужные в левой панели и щелкните 

на кнопке (>>) (см. рис. 7-26). 
3. Для удаления пункта выберите его в правой панели и щелкните на 

кнопке Remove (Удалить) (см. рис. 7-26 на стр. 7-18). 
4. Для сортировки пунктов в форме отчета используйте кнопки Move Up 

(Вверх) и Move Down (Вниз) (см. рис. 7-26). 
5. Создание отчета производится кнопкой Execute (Выполнить), 

сохранение формы отчета - кнопкой Done (Готово). 
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Редактирование параметров полей формы 
отчета 
Изменение параметров полей формы отчета производится только для 
выбранной в настоящий момент формы отчета. 
Выберите форму в поле Reports (Отчеты), после чего щелкните на 
нужном поле в столбце Included report items (Включенные в отчет 
пункты), и щелкните на кнопке Options (Параметры). 
В зависимости от выбранного поля диалоговое окно Options 
(Параметры) отображает набор его параметров. 

• Identical Points Report (Отчет о совпадающих пунктах) – возможно 
изменить его название. Для принятия изменений щелкните на кнопке 
ОК (см. рис. 7-27). 

 
Рисунок 7-27. Параметры полей отчета о совпадающих пунктах 

• Cut Sheet Report (Отчет о вынесенных в натуру точках) – возможно 
изменить его название. Для включения или исключения параметров 
используйте кнопки (>>) и (<<), а для упорядочивания кнопки Move 
Up (Вверх) и Move Down (Вниз). Для принятия изменений щелкните 
на кнопке ОК (см. рис. 7-28). 

 
Рисунок 7-28. Параметры полей отчета о вынесенных в натуру пунктах 
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• Misnamed Autotopo Rovers Report (Отчет о точках траектории с 
ошибочными названиями) – можно изменить его название. Для 
принятия изменений щелкните на кнопке ОК (см. рис. 7-29). 

 
Рисунок 7-29. Параметры полей отчета о точках траектории с ошибочными 

названиями 

• Repeated Observations (Повторные измерения) - можно изменить 
название и тип отчета. Для принятия изменений щелкните на кнопке 
ОК (см. рис. 7-30). 

 
Рисунок 7-30. Параметры полей отчета о повторных измерениях 

• Project Report (Отчет о проекте) – можно изменить название отчета и 
удалить поля из шаблона. Для принятия изменений щелкните на 
кнопке ОК (см. рис. 7-31). 

 
Рисунок 7-31. Параметры полей отчета о проекте 
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• Point Summary Report (Сводный отчет о пунктах) - можно изменить 
название отчета, включить или исключить поля (используйте кнопки 
>> и <<) и упорядочить поля отчета (кнопки Move Up (Вверх) и Move 
Down (Вниз)). Для принятия изменений щелкните на кнопке ОК (см. 
рис. 7-32). 

 
Рисунок 7-32. Параметры полей сводного отчета о точках 

• GPS Obs Report (Отчет о базисах GPS) - можно изменить название 
отчета, включить или исключить поля (используйте кнопки >> и <<) и 
упорядочить поля отчета (кнопки Move Up (Вверх) и Move Down 
(Вниз)). Также можно выбрать тип (ы) пунктов и метод (ы), которым 
были получены их координаты. Для принятия изменений щелкните 
на кнопке ОК (см. рис. 7-33 на стр. 7-22). 
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Рисунок 7-33. Параметры полей отчета о базисах GPS 

• Adjustment Report (Отчет об уравнивании) - можно изменить 
название отчета. Изменение шаблонов отображаемых полей должно 
производится аналогично тому, как они представлены в поле 
выбора. Можно также удалить поля. Для принятия изменений 
щелкните на кнопке ОК (см. рис. 7-34). 

 
Рисунок 7-34. Параметры полей отчета об уравнивании 
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• TS Obs Report (Отчет о тахеометрических измерениях)- можно 
изменить название отчета, включить или исключить поля 
(используйте кнопки >> и <<) и упорядочить поля отчета (кнопки 
Move Up (Вверх) и Move Down (Вниз)). Для принятия изменений 
щелкните на кнопке ОК (см. рис. 7-35). 

 
Рисунок 7-35. Параметры полей отчета о тахеометрических измерениях 

• Loop closures (Отчет о незамыканиях) - можно изменить название 
отчета, выбрать типы полигонов, включаемые в отчет, а также 
включить или исключить поля (используйте кнопки >> и <<) и 
упорядочить поля (кнопки Move Up (Вверх) и Move Down (Вниз)). 
Для принятия изменений щелкните на кнопке ОК (см. рис. 7-36). 

 
Рисунок 7-36. Параметры полей отчета о незамыканиях полигонов 
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• Misnamed GPS Occupation Report (Отчет о неверно названных 
сеансах GPS) - можно изменить название отчета. Для принятия 
изменений щелкните на кнопке ОК (см. рис. 7-37). 

 
Рисунок 7-37. Параметры полей отчета о неверно названных сеансах GPS 

• Compare Points (Отчет о сравнении пунктов) - можно изменить 
название отчета, включить или исключить поля (используйте кнопки 
>> и <<) и упорядочить поля отчета (кнопки Move Up (Вверх) и Move 
Down (Вниз)). Для принятия изменений щелкните на кнопке ОК (см. 
рис. 7-38). 

 
Рисунок 7-38 Параметры полей отчета о сравнении пунктов 
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Создание новой формы отчета 
1. В диалоговом окне Report Configuration (Настройка отчета), 

щелкните на кнопке New Report (Новый отчет). Новая форма отчета 
в окне Reports (Отчеты) изначально называется "User report" (см. рис. 
7-39). 

 
Рисунок 7-39. Создание новой формы отчета 

2. Выберите нужное поле для включения в шаблон отчета из списка 
Available report templates (Поля, доступные для включения в шаблон 
отчета) и щелкните на кнопке (>>) для его переноса в список Included 
report items (Поля, включенные в шаблон отчета). Продолжайте 
выбор до тех пор, пока все необходимые поля не будут включены в 
форму отчета (см. рис. 7-40). 

 
Рисунок 7-40. Добавление полей в шаблон отчета 



Обработка, уравнивание и трансформирование точек 

Topcon Tools- Руководство пользователя 7-26 

3. Используйте кнопки Move Up (Вверх), Move Down (Вниз) для 
упорядочивания полей в форме отчета (см. рис. 7-41). 

 
Рисунок 7-41. Упорядочивание полей в шаблоне отчета 

4. Для редактирования параметров поля выделите его и щелкните на 
кнопке Options (Параметры). Подробно о параметры каждого поля 
описаны в разделе "Настройка формы отчета" на стр. 7-17. 

5. Создание отчета производится кнопкой Execute (Выполнить), 
сохранение формы отчета - кнопкой Done (Готово). 
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Глава 8  
Экспорт 
Процедура экспорта позволяет сохранять данные в различных форматах 
для использования в других проектах Topcon Tools, для работы в других 
программных пакетах и для загрузки в полевые устройства. 
Программа Topcon Tools позволяет экспортировать данные в 
перечисленных ниже форматах: 
 
• Code Library files (Файлы 

библиотек кодов) 
DBF Code Library (*.dbf) 
TDD Code Library (*.tdd) 
XML Code Library (*.xml) 

• Coordinate files (Координатные 
файлы) 

APA Coordinates (*.zk) 
CR-5 Files (*.CR5) 
Текстовые файлы формата 
пользователя (Custom Text 
Format files) (*.*) 
FC-4 Points (*.xyz, *.fc4, *.pnt) 
FC-5 Points (*.xyz, *.fc5, *.pnt) 
GTS-210/310-10 Points (*.xyz, 
*.pnt) 
GTS-210/310-12 Points (*.xyz, 
*.pnt) 
GTS-7 Points (*.xyz, *.pnt) 
Land XML Points (*.xml) 
Name,E,N,Z,Code (*.csv) 
Name,Lat,Lon,Ht,Code (*.csv) 
Name,N,E,Z,Сode (*.csv) 
SIMA Coordinates (*.sim) 
Topcon Japan Coordinates (*.zt) 
Topcon XML Points (*.xml) 
TopSURV Coordinates (*.txt) 

 

• Файлы Cut Sheet 
Cut Sheet Standard (*.css) 
Cut Sheet User Defined (*.csu) 

• GPS+ Raw Data Files (Файлы 
измерений GPS+) 

Compact RINEX files (*.??D, 
*.??G, *.??N) 
RINEX files (*.??O, *.??G, *.??N) 
TPD files (*.tpd) 

• Localization Files (Файлы 
трансформирования) (*.gc3) 

• Roads File (Файлы дорожного 
проектирования) 

CLIP Road Files (*.PLT) 
ISPOL Road Files (*.ALI) 
Land XML Roads (*.xml) 
TDS Road Files (*.RD5) 
Topcon MC Road Files (*.RD3) 
Topcon SSS Road Files (*.HAL) 
Topcon XML Roads (*.xml) 
TopSURV Road Files (*,.THL) 
VGP Roads (*.VGP) 

• Topcon Tools Jobs (Проекты Topcon 
Tools () (*.ttp) 

• Topcon XML Files (Файлы Topcon 
XML) (*.xml) 

• TopSURV PC Job Files (Файлы 
проектов TopSURV PC) (*.tlsv) 
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• Design files (Файлы цифрового 
проектирования) 

DWG (*.dwg) 
DXF (*.dxf) 
LandXML (*.xml) 
TN3 Surface (*.tn3) 

• Данные Field Scan (*.fsc) 
• GIS files (Файлы ГИС) 

Shape files (*.shp) 
• GPS Obs Files (Файлы базисов 

GPS) 
BlueBook Sheet (*.gfl, *.bfl) 
Custom Text Format files 
(Текстовые файлы формата, 
задаваемого пользователем) 
(*.*) 
LandXML GPS Obs (*.xml) 
Файлы O (O*.*) 
Topcon RTK Vectors (*.tvf) 
Topcon RTK Vectors (*.tvf) 
Topcon XML GPS Obs (*.xml) 

 

• TS Obs Files (Файлы тахеометрических 
измерений) 

Custom Text Format files (Текстовые 
файлы формата, задаваемого 
пользователем) (*.*) 
FC-5 Raw (*.raw, *.dat, *.fc5) 
GTS-210/310 Raw (*.raw, *.dat, *.gts, 
*.gt6) 
GTS-6 No Station Raw (*.raw, *.dat, 
*.gts, *.gts6, *.gt6) 
GTS-6 Raw (*.raw, *.dat, *.gts, *.gts6, 
*.gt6) 
GTS-7 Raw (*.raw, *.dat, *.gts, *.gts7, 
*.gt7) 
GTS-7+ Raw (*.raw, *.dat, *.gts, *.gts7, 
*.gt7) 
LandXML TS Obs (*.xml) 
Topcon Japan TS Obs (*.olt) 
TDS RW5 TS Obs (*.rw5, *.raw) 
Topcon XML TS Obs (*.xml) 

• X-Section Template files (Файлы типовых 
поперечников) 

TDS TP5 (*.tp5) 
Topcon SSS XS-Template (*.xtl) 
Topcon XML X-Section Template 
(*.xml) 
TopSURV XS Template (*.xst) 

 
 

 ПРИМЕЧАНИЕ 

При экспорте данных в местной СК измените 
отображение координат на "ground", а затем выполните 
экспорт в файл, поддерживающий представление 
координат NEZ. 

Более детально форматы файлов описаны в соответствующем разделе 
главы 3. Topcon Tools экспортирует некоторые типы форматов файлов, не 
подлежащие импорту: 

• Cut sheet files (чертежи) содержат результаты съемки с указанием 
объемов земляных работ. При импорте проекта TopSURV с 
пикетами используйте этот формат для экспорта файла с указанием 
объемов выемки и насыпи. 

• Форматы файлов DWG, DXF и Shape часто применяются для 
обмена данными компьютерного проектирования и ГИС. Форматы 
DWG, DXF были разработаны для программы AutoCAD, а формат 
Shape – для программы ArcInfoTM. Большинство пакетов 
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программного обеспечения способны обмениваться данными 
(координатами и кодами пунктов) с использованием файлов этих 
форматов. В форматах DWG и DXF на основании кодов 
формируются объекты. 

• Формат файлов “O” был разработан в фирме Ashtech для передачи 
данных о базисах между пакетами программ обработки.  

• Формат Topcon vectors – простой текстовый формат с 
использованием запятых в качестве разграничителей полей, 
используется для передачи данных о базисах. 

Экспорт в файл 
Topcon Tools дает возможность экспорта части или всех данных текущего 
проекта в файлы соответствующих форматов. 
1. Для экспорта данных в файл выбранного формата: 

• Всех данных – выберите пункт меню Job > Export (Проект > 
Экспорт), нажмите клавишу F4 или щелкните на кнопке Export to 
File (Экспорт в файл) инструментальной панели. 

• Выбранных данных – выберите пункт меню Job > Export (Проект 
> Экспорт), нажмите клавишу F4, щелкните на кнопке Export to 
File (Экспорт в файл) инструментальной панели или щелкните 
по правой кнопке мыши и в появившемся меню выберите пункт 
Export (Экспорт). 

2. Укажите директорию сохранения файла. 
3. Выберите формат файла (Format name) (см. рис. 8-1). 

 ПРИМЕЧАНИЕ 
Выберите формат файла экспорта до продолжения 
операций по экспорту файла. 

 
Рисунок 8-1. Выбор формата экспорта 
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4. При необходимости настройте параметры экспорта в панели Advanced 
options (Расширенные настройки) (см. рис. 8-2). 

 ПРИМЕЧАНИЕ 
По умолчанию экспортируются ортометрические высоты 
для координат в проекции и местной СК и геодезические 
высоты для представления координат в виде широта/ 
долгота. 
• В зависимости от формата экспортируемого файла задайте тип 

проекции, ИГД, тип координат, параметры пересчета от СК 
проекции в местную СК, единицы размерности и модель геоида. 

• Для экспорта ортометрических высот выберите параметр 
Orthometric Height (Ортометрическая высота). 

 

 
Рисунок 8-2. Экспорт – Пример расширенных настроек 

 

 ПРИМЕЧАНИЕ 
Если детализация настроек экспорта не вызвана, то 
Topcon Tools будет использовать проекцию, ИГД и геоид 
текущего проекта. 

5. Задайте название файла и щелкните на кнопке Save (Сохранить). 
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Экспорт файлов в устройство 
В приведенных ниже разделах описывается экспорт из компьютера в: 

• Традиционные / роботизированные электронные тахеометры 
(файлы списков координат). 

• Любые файлы в полевые контроллеры TPS. 
Topcon Tools дает возможность экспорта данных двумя методами: 

• Используя Windows Explorer. 

• Используя кнопки инструментальной панели Topcon Tools. 
При установке программы Topcon Tools создает три дополнительных 
каталога (виртуальных диска). 
Для экспорта данных в электронный тахеометр или полевой контроллер, 
используя проводник Windows Explorer, щелкните курсором по 
соответствующему каталогу (виртуальному диску). 

 
Рисунок 8-3. Каталоги устройств Topcon 
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Экспорт в контроллер TPS 
1. Следуйте указанием производителя по подключению контроллера к 

компьютеру. 
2. Удостоверьтесь в том, что программа Microsoft ActiveSync установлена 

и запущена, связь между компьютером и устройством установилась. В 
этом случае, значок программы ActiveSync зеленый. 

Экспорт с использованием Windows 
Explorer 
1. Откройте проводник Windows Explorer и щелкните мышкой по каталогу 

Mobile Device (Мобильное устройство). В правой панели окна 
отобразится содержимое контроллера Topcon Controller (см. рис. 8-4). 
Выберите каталог в контроллере, куда будет экспортирован и 
сохранен файл, и выделите этот файл в файловой системе 
компьютера. 

 
Рисунок 8-4. Выбор каталога в контроллере TPS 

2. Для экспорта файла из компьютера в контроллер скопируйте файл в 
выбранный каталог файловой системы контроллера. 

3. При экспорте файла (ов) базы данных TopSURV из компьютера в 
контроллер, Topcon Tools конвертирует проекты в формате *.tslv в 
формат проекта *.tsv. 

4. Во время передачи и преобразования файла (ов) из компьютера в 
контроллер, отображается окно Copy & Convert Progress, 
описывающее передачу и преобразование (см. рис. 8-5 на стр. 8-7). 
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Рисунок 8-5. Экспорт и преобразование файла 

 

Экспорт с использованием Topcon Tools 
1. Запустите Topcon Tools и откройте проект. Для экспорта информации 

во внешнее устройство: 
• Выберите пункт меню Job > Export to Device (Проект > Экспорт 

в устройство) или воспользуйтесь комбинацией клавиш 
Shift+F4, или щелкните на кнопке Export to Device (Экспорт в 
устройство) инструментальной панели для экспорта всех данных 
проекта. 

• При экспорте неполного набора данных выберите его, после чего 
воспользуйтесь пунктом меню Job > Export to Device (Проект > 
Экспорт в устройство) или нажмите клавишу F4, или щелкните 
на кнопке Export to File (Экспорт в файл) инструментальной 
панели, или щелкните по правой клавише мыши и в появившемся 
меню выберите пункт Export to Device (Экспорт в устройство). 
Выберите формат и передайте созданный файл в указанный 
каталог внешнего устройства, как показано на рис. 8-6. 

 
Рисунок 8-6. Экспорт данных во внешнее устройство 

2. Двойным щелчком по каталогу Mobile Device в окне Export to Device 
выберите каталог в контроллере, предназначенный для размещения 
экспортируемого файла. Выберите формат и введите название 
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создаваемого файла. Щелкните на кнопке Save (Сохранить) окна 
Export to Device. 

 
Рисунок 8-7. Окно Экспорт в устройство 

3. Во время записи с преобразованием в выбранный формат и передачи 
создаваемого файла из текущего проекта в полевой контроллер в окне 
Copy & Convert Progress отображается состояние процесса. 

 
Рисунок 8-8. Строка состояния при экспорте и записи файла 

Экспорт в электронный тахеометр 
TPS 
В руководстве по эксплуатации тахеометра описывается порядок его 
подключения к компьютеру. 

Экспорт с использованием Windows 
Explorer 
1. Откройте проводник Windows Explorer и щелкните мышкой по каталогу 

Topcon Total Stations (Тахеометры Topcon). В правой панели окна 
отобразится значок "Add New Station" ("Добавить новый тахеометр"). 
Для добавления нового устройства щелкните по правой кнопке мыши 
на этом значке и в появившемся меню выберите пункт Create Station 
(Создать тахеометр). 

 
Рисунок 8-9. Создание нового тахеометра в окне Windows Explorer 
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2. Во вкладке General (Основные параметры) диалогового окна Create 
Station (Создать тахеометр), введите перечисленные ниже данные 
и щелкните на кнопке ОК (см. рис. 8-10). 
• Name (Название) – уникальное название устройства. 
• Notes (Примечания) – любые необходимые примечания. 
• Port (Порт) – выберите СОМ порт компьютера, к которому будет 

подключен тахеометр. 
• Model (Модель) – выберите модель тахеометра. 

3. Во вкладке Advanced (Расширенные настройки) диалогового окна 
Create Station (Создать тахеометр) введите скорость передачи 
данных, четность, длину слова данных, количество стоповые бит и 
протокол, используемый для связи тахеометра с компьютером (см. 
рис. 8-10). 

 
Рисунок 8-10. Свойства подключения тахеометра 

4. В правой панели Windows Explorer будет создан новый подкаталог 
(значок) для нового тахеометра в каталоге Topcon Total Stations 
(Тахеометры Topcon). Для изменения свойств (параметры связи, 
название, модель) этого тахеометра щелкните по правой кнопке мыши 
на значке и в появившемся меню выберите пункт Properties 
(Свойства). 

 
Рисунок 8-11. Изменение параметров тахеометра 
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5. Для экспорта файла-списка координат из компьютера в тахеометр 
скопируйте выбранный файл в тахеометр. 

6. Следуйте инструкциям, указанным в окне Upload File(s) to Total Station 
для подготовки тахеометра для приема файла. 

7. Когда все будет готово для передачи файла, нажмите кнопку F3 ("да")  
клавиатуры тахеометра для подтверждения экспорта. Щелкните на 
кнопке Start диалогового окна Upload File(s) to Total Station. Начнется 
процедура загрузки. 

 
Рисунок 8-12. Начало экспорта координатного файла в тахеометр 

8. Во время передачи данных из компьютера в тахеометр строка 
состояния в окне Upload File(s) to Total Station будет изменяться от 
"Waiting to start..." ("Ожидание начала…") до "Performing the transfer..." 
("Произвожу передачу..."). 

9. Файл будет сохранен в памяти электронного тахеометра. 

Экспорт с использованием Topcon Tools 
1. Запустите программу Topcon Tools и откройте проект. Для экспорта 

файла-списка координат в электронный тахеометр: 

• Выберите пункт меню Job > Export to Device (Проект > Экспорт 
в устройство), или нажмите комбинацию клавиш Shift+F4, или 
щелкните на кнопке Export to Device (Экспорт в устройство) 
инструментальной панели для экспорта всех точек проекта в 
выбранный координатный файл и передачи его в тахеометр. 



Экспорт файлов в устройство 

P/N 7010-0612 8-11 

• Для экспорта части данных проекта выберите пункт меню Job > 
Export to Device (Проект > Экспорт в устройство), или нажмите 
клавишу F4, или щелкните на кнопке Export to File (Экспорт в 
файл) инструментальной панели, или щелкните на правой кнопке 
мыши и в появившемся меню выберите пункт Export to Device 
(Экспорт в устройство) (см. рис. 8-13) для экспорта данных в 
выбранный координатный файл и передачи его в тахеометр. 

 
Рисунок 8-13. Экспорт части данных в электронный тахеометр 

2. Произведите двойной щелчок по значку Topcon Total Stations 
(Тахеометры Topcon) окна Export to Device. 

 
Рисунок 8-14. Окно Экспорт в устройство 

3. Для добавления нового устройства вызовите выпадающее меню 
одинарным щелчком по правой кнопке мыши или двойным по левой 
кнопке мыши на значке "Add New Station" ("Добавить новый 
тахеометр") и выберите пункт Create Station (Создать тахеометр). 

 
Рисунок 8-15. Описание нового тахеометра 
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4. Во вкладке General (Основные параметры) диалогового окна Create 
Station (Создать тахеометр) введите перечисленные ниже данные 
и щелкните на кнопке ОК. 
• Name (Название) – уникальное название устройства. 
• Notes (Примечания) – любые необходимые примечания. 
• Port (Порт) – выберите СОМ порт компьютера, к которому будет 

подключен тахеометр. 
• Model (Модель) – выберите модель тахеометра. 

5. Во вкладке Advanced (Расширенные настройки) диалогового окна 
Create Station (Создать тахеометр) введите скорость передачи 
данных, четность, длину слова данных, количество стоповые бит и 
протокол, используемый для связи тахеометра с компьютером. 

 
Рисунок 8-16. Свойства подключения тахеометра 

6. После этого в окне Export to Device появится значок для нового 
тахеометра. Для изменения его свойств (параметры связи, название, 
модель) щелкните по правой кнопке мыши и в появившемся меню  
выберите пункт Properties (Свойства). Диалоговое окно Station 
Properties для тахеометра аналогично окну Create Station при 
задании параметров нового тахеометра. 

 
Рисунок 8-17. Изменение свойств тахеометра 
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7. Для экспорта файла-списка координат из текущего проекта в 
тахеометр выберите его формат и задайте его название. Щелкните на 
кнопке Save (Сохранить) диалогового окна Export to Device. 

 
Рисунок 8-18. Выбор типа и задание названия экспортируемого файла 

8. Следуйте инструкциям, указанным в окне Upload File(s) to Total Station 
для подготовки тахеометра для приема файла. 

 
Рисунок 8-19. Начало экспорта координатного файла в тахеометр 

9. Во время передачи данных из компьютера в тахеометр строка 
состояния в окне Upload File(s) to Total Station будет изменяться от 
"Waiting to start..." ("Ожидание начала…") до "Performing the transfer..." 
("Произвожу передачу..."). 

10. Файл будет сохранен в памяти электронного тахеометра. 
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Для заметок: 
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Глава 9  
Модуль Design 
Модуль Design (Проектирование) программы Topcon Tools позволяет: 

• Создавать новые цифровые модели рельефа, именуемые далее 
"поверхностью", которые видны в главном окне вида CAD. 

• Открывать, просматривать и редактировать поверхности, созданные 
в программе TopSURV. 

• Решать задачи координатной геометрии (сравнение поверхностей, 
пересечения, обратная задача точки к линии, создание точки по 
направлению и расчет хода). 

• Открывать, просматривать и редактировать поверхности с формате 
*.tn3. 

• Создавать новые дороги. 

• Открывать, просматривать и редактировать дороги, созданные в 
программе TopSURV (*.tlsv и *.thl). 

• Открывать, просматривать и редактировать дороги в следующих 
форматах файлов: 

− Topcon MC Road (*.rd3). 

− Topcon SSS Road (*.hal). 

− TDS Road (*.rd5). 

− CLIP Road (*.plt). 

− ISPOL Road (*.ali). 

• Импортировать типовые поперечники (X-section templates) в 
следующих форматах: 

− TopSURV XS-Template (*.trd). 

− TDS XS-Template (*.tp5). 

− SSS XS-Template (*.rd). 
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До начала создания новой поверхности или дороги удостоверьтесь в том, 
что модуль Design разрешен к использованию. При этом он должен 
присутствовать в списке разрешенных модулей (см. пункт меню Help > 
Access Codes). 

 
Рисунок 9-1. Окно кодов доступа – список разрешенных модулей 

Пункты меню Surface (Поверхность), Add Surface (Добавить 
поверхность) и Road (Дорога), должны быть доступны для вызова в меню 
Topcon Tools (см. пункт меню Edit > Add). 

 
Рисунок 9-2. Выбор пункта меню Edit > Add 

Значок Surface (Поверхность) должен быть доступен в строке меню 
Topcon Tools. 

 
Рисунок 9-3. Значки “Добавить поверхность” и “Добавить точки и линии к 

поверхности” 
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Создание новой поверхности 
До создания новой поверхности отройте окно CAD и, используя строку 
состояния главного окна, выберите СК проекции или местную СК. 
1. Для создания новой поверхности выберите пункт меню Edit > Add > 

Surface (Редактирование > Добавить > Поверхность) или щелкните 
на кнопку Add Surface (Добавить Поверхность) инструментальной 
панели. 

2. Во вкладке  General (Основные параметры) диалогового окна Add 
Surface (Добавить Поверхность) введите название создаваемой 
поверхности, задайте слой и введите необходимые комментарии. 
• Поле Need Update (Следует рассчитать заново) отображает 

значение No (Нет), если изменения в поверхность не вносились. 
В противном случае отображается значение Yes (Да). 

• Для автоматического обновления поверхности при внесении 
изменений разрешите пункт Auto Update (Автоматическое 
обновление), иначе поверхность нужно будет обновлять вручную. 

3. Во вкладке Option (Параметры) задаются ограничения для создания 
треугольников внутри поверхности: 
• Минимальный допустимый внутренний угол для треугольника 
• Минимальная допустимая площадь для треугольника 

Параметры, задаваемые во вкладке Option (Параметры), определяют 
количество точек и треугольников в поверхности. 

 
Рисунок 9-4. Диалоговое окно Add Surface (Добавить поверхность) 
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4. Щелкните на кнопке ОК. Будет создана новая поверхность. Вкладка 
Surfaces (Поверхности) отображается в виде Таблица. В этой таблице 
содержится информация обо всех поверхностях в текущем проекте 
Topcon Tools. 

 
Рисунок 9-5. Вид Таблица – вкладка Surfaces (Поверхности) 

Для добавления точек и линий к этой поверхности воспользуйтесь пунктом 
Add to Surface (Добавить к поверхности). Для создания новой 
поверхности можно использовать уже присутствующие в проекте точки и 
линии. Линия в поверхности может быть только ее границей (линия между 
точками User2 и User8 на рис. 9-6).  
Для создания новой поверхности выделите нужные точки и линии в виде 
CAD и щелкните на кнопке Add Surface (Добавить Поверхность) 
инструментальной панели. 

 
Рисунок 9-6. Создание новой поверхности по выбранным точкам 

В этом случае диалоговое окно Add Surface (Добавить Поверхность), 
отобразит данные о создаваемой поверхности: количество точек и 
треугольников в модели и минимальные/максимальные величины для 
координат точек. Введите название поверхности, примечания и 
установите ограничения на треугольники поверхности во вкладке Option 
(Параметры), затем нажмите кнопку ОК. В таблице Surfaces 
(Поверхности) и в виде CAD отобразится созданная поверхность 
представленная линиями, связанными с выбранными точками (см. рис. 9-7 
на стр. 9-5). 
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Рисунок 9-7. Созданная поверхность 

Для скрытия поверхности в виде CAD разместите ее в невидимом слое, 
используя окно Properties (Свойства). 

 
Рисунок 9-8. Выбор слоя для скрытия поверхности 

Созданная поверхность (см. рис. 9-7) отобразится, как видимая из 
некоторой точки, расположенной над ней (адекватно такое отображение 
только для преимущественно горизонтальных поверхностей). Для 
вертикальной поверхности этот вид не будет отображать всю поверхность. 
Topcon Tools позволяет пользователю рассматривать поверхность из 
фокусной точки, расположенной в плоскости горизонта. 
Для выбора точки фокуса просмотра поверхности щелкните по правой 
кнопке мыши на нужной поверхности в таблице Surfaces (Поверхности) 
выделите точку и придайте ей свойство Focus point (Точка фокуса). 

 
Рисунок 9-9. Выбор точки фокуса 
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Окно CAD вид поверхности из выбранной точки. 

 
Рисунок 9-10. Просмотр созданной поверхности из точки Point7 

При создании новой поверхности или редактировании ранее созданной, в 
ней не будут участвовать точки из проекта Topcon Tools, координаты 
которых заданы не в СК проекции или местной СК. В этом случае, 
появится следующее окно предупреждения (cм. рис. 9-11): “Некоторые 
точки, по которым требуется создать цифровую модель рельефа, не 
имеют координаты в текущей СК проекции или местной СК. Эти точки не 
будут использоваться при создании треугольников". 

 
Рисунок 9-11. Точки без прямоугольных координат 
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Отображение поверхности 
Поверхности и другие объекты (точки и линии), не включенные в 
поверхность, могут быть отображены в виде CAD. В Topcon Tools 
изображение поверхности может быть получено в виде CAD или в виде 3D 
(перспективное изображение). Для просмотра поверхности щелкните по 
правой кнопке мыши на нужной строке в таблице Surfaces (Поверхности) 
и в появившемся меню выберите пункт CAD View (Вид CAD) или 3D View 
(Вид 3D). 

 
Рисунок 9-12. Поверхность в виде CAD 

 

 
Рисунок 9-13. Поверхность в виде 3D 

Для просмотра всех объектов в окне вида CAD выберите пункт меню 
Window > CAD View (Окно > Вид CAD). 
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Добавление объектов к 
поверхности 
Topcon Tools позволяет добавлять точки и линии к созданной поверхности 
(см. рис. 9-14). В виде CAD для поверхностей добавление новых объектов 
невозможно. 
Для добавления новых объектов к поверхности выделите новую точку или 
линию в виде CAD и воспользуйтесь одной из перечисленных ниже 
процедур: 

• Щелкните на кнопке Add Points and Lines to Surface (Добавить 
точки и линии к поверхности) инструментальной панели. 

• Выберите пункт меню Edit > Add > Add to Surface (Редактирование 
> Добавить > Добавить к поверхности). 

• В меню, появляющемся после щелчка по правой кнопке мыши на 
объектах, выбранных в таблице Points (Точки) или в виде CAD, 
выберите пункт Add to Surface (Добавить к поверхности) 

 
Рисунок 9-14. Добавление выбранных объектов к поверхности с использованием 

выпадающего меню 
Если проект Topcon Tools содержит более чем одну поверхность, то 
сначала нужно выбрать ту, к которой будет добавляться объекты. 

 
Рисунок 9-15. Выбор поверхности для добавления к ней объектов 

Для добавления точек или линий к поверхности с помощью выпадающего 
меню щелкните по правой кнопке мыши на нужной строке в таблице 
Surfaces (Поверхности) и в появившемся меню выберите пункт Add to this 
Surface (Добавить к этой поверхности). 
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Вид курсора изменится. Используя курсор, выберите нужные объекты в 
виде CAD. 

 
Рисунок 9-16. Добавление к поверхности во вкладке Surfaces 

Объекты будут добавлены к поверхности. 

 
Рисунок 9-17. Поверхность с добавленными точками и линиями 
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Редактирование поверхности 
Ниже описывается редактирование поверхности: 

• Удаление точек и линий из поверхности. 

• Создание отверстий в поверхности. 

Удаление точек из поверхности 
Для удаления точку из поверхности в виде CAD или таблице Points (Точки) 
вызовите выпадающее меню, щелкнув на правой кнопке мыши, и 
выберите в нем пункт Delete from Surface (Удалить из поверхности). 

 
Рисунок 9-18. Пример удаления точки из поверхности в виде CAD 

Эта точка по-прежнему отображается в окне CAD, но она уже не 
включается в состав поверхности. 

 
Рисунок 9-19. Пример удаления точки из поверхности в виде CAD 

 



Создание новой дороги 

P/N 7010-0612 9-11 

Удаление линии из поверхности 
Любая линия в поверхности может быть удалена. До удаления линии, 
сделайте поверхность видимой в виде CAD. При этом отображаются все 
объекты, входящие в поверхность. 
Для удаления линии из поверхности щелкните по правой кнопке мыши на 
линии в виде CAD или в таблице Linework (Линии), и в появившемся меню 
выберите пункт Delete from Surface (Удалить из поверхности). 

 
Рисунок 9-20. Удаление линии из поверхности 

Эта линия по-прежнему отображается в окне вида CAD, но не будет 
включена в виде CAD для поверхности. 

 
Рисунок 9-21. Пример отображения поверхности в виде CAD 
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Создание отверстий в поверхности 
Для создания отверстий в поверхности сделайте поверхность видимой в 
виде CAD. 
1. Создайте замкнутую фигуру внутри поверхности, добавляя новые 

точки и объединяя их линиями. 
2. Выделите эту фигуру. 
3. Щелкните правой кнопкой мыши и в появившемся меню-списке 

выберите нужную (другую) поверхность для добавления фигуры. 

 
Рисунок 9-22. Создание отверстия в поверхности 
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Вырезание отверстия на границе поверхности эквивалентно удалению ее 
участка. 

 
Рисунок 9-23. Вырезание отверстия из поверхности 

 

Установка границы поверхности 
Перед созданием поверхности пользователь может установить в слое, 
используемом для поверхности следующие типы границы: Auto 
(Автоматическая), Breakline (Линия обрыва), Boundary (Граница) и 
Exclusion (Исключение) (см. рис. 9-23 на стр. 9-13). 
Если выбран тип Auto, то границы при построении треугольников будут 
определяться по следующим правилам исключения и линии обрыва: 

• Если линия замкнута и не содержит точек триангуляции внутри, она 
становится исключением. 

• Если граница не задана, но присутствует система из замкнутых 
линий, образующих фигуру, заключающую в себе все точки 
триангуляции, то эти линии становятся границами. 

• Все другие линии являются линиями обрыва. 
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Рисунок 9-24. Пример создания поверхности  

 

Создание новой дороги 
Дорога является объектом, который может быть описан через плановые и 
высотные проекции осевой линии, которые называются элементами 
трассы дороги и линией поверхности дороги, проложенной 
перпендикулярно в плане к оси (поперечник, x-section). 
Дорогу можно разбить на участки, каждый из которых может быть описан с 
помощью алгебраических функций. 

• Плановое положение осевой линии (horizontal alignment) может быть 
описано через lines (линии), spirals (спирали), curves (дуги) и  
intersection points (точки пересечения). 

• Высотное положение осевой линии (vertical alignment), может быть 
описано через grade (уклон) и parabolas (параболу) или long section 
(длинный участок). 

• Поперечник может быть описан с использованием типового 
поперечника (см. "Создание поперечников" на стр. 9-35). 

До создания новой дороги проделайте следующее: установите Grid 
(Проекция) или Ground (Топоцентрическая) тип СК в строке состояния и 
создайте (при необходимости) начальную точку этой дороги (см. раздел 
"Создание новой точки" на стр. 5-15). 
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1. Для создания новой дороги выберите пункт меню Edit > Add > Road 
(Редактирование > Добавить > Дорога). 

2. Во вкладке Start Coordinates (Координаты начала дороги) диалогового 
окна Add Road (Добавить дорогу) из выпадающего списка выберите 
начальную точку дороги (см. рис. 9-25). Под выбранной точкой 
появятся ее координаты. 

3. Во вкладке General (Основные параметры) диалогового окна Add 
Road (Добавить дорогу) введите перечисленные ниже данные (см. 
рис. 9-25): 
• Название создаваемой дороги. 
• Начальную станцию или пикетаж. 
• Интервал между станциями в метрах (по умолчанию этот 

параметр равен 100м). 
• Выберите слой, в котором будет размещена дорога. 

 
Рисунок 9-25. Диалоговое окно Add Road (Добавить дорогу) 

4. Щелкните на кнопке ОК. В левой панели таблицы Roads (Дороги), 
отобразится название создаваемой дороги. В правой панели 
отобразятся плановые, высотные элементы и поперечники дороги в 
табличном и графическом представлениях. 

 
Рисунок 9-26. Вкладка Roads (Дороги), левая и правая панели 
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Для просмотра только одного из представлений осевой линии элемента 
или поперечника в правой панели выберите требуемый элемент в левой 
панели. 

 
Рисунок 9-27. Выбор элемента дороги 

 

Создание станции дорожного 
проектирования 
Плановое и высотное проектирование осевой линии производится по 
набору элементов. Каждый элемент (со второго) начинается с конечной 
точки предыдущего. Эти точки мы называем станциями дорожного 
проектирования (коротко – станции). Расстояние от начала дороги может 
отображаться на экране двумя способами. Для типа "Station" ("Станция") 
выберите пункт меню Job > Job Configuration (Проект > Конфигурация 
проекта), после чего выберите в левой таблице поле Display 
(Отображение) и в правой таблице выберите вкладку Roads (Дороги). 
Выберите из выпадающего меню пункта "Display CL as" ("Отображать 
осевую линию как") "Chainage" ("Пикетаж") или "Station" ("Станция") (по 
умолчанию, отображается станция). 

 
Рисунок 9-28. Установка выбора типа станции 

Для типа "Station" ("Станция") номер станций вычисляется как отношение  
расстояния от начальной точки дороги к интервалу между станциями. Это 
число состоит из двух частей: 

Первая часть является целой частью отношения )(
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Где "i" – количество участков в проектировании, "Length" – длина i-го 
элемента и "StationInterval" – интервал между станциями, равный 
100м. 

Вторая часть - это остаток того же отношения. 
Например, если длина осевой линии равна 1288.50 метрам, то величина 
номера конечной станции составляет 12+88.5 

 
Рисунок 9-29. Пример использования типа "Station" ("Станция") 

Для типа "Chainage" ("Пикетаж") номер станции равен расстоянию от 
начальной точки. 

 
Рисунок 9-30. Пример использования типа "Chainage" ("Пикетаж") 

Ненулевое название для начальной станции (пикета) дороги может быть 
введено для сквозной нумерации нескольких дорог. Номера станций 
дороги будут рассчитаны, как сумма не нулевой начальной величины и 
расстояния от первой станции. В приведенных ниже примерах 
представлен плановый проект с нулевым и ненулевым значением 
начальной станции (см. рис. 9-31 на стр. 9-18). 
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Рисунок 9-31. Плановый проект с нулевым и ненулевым значениями начальной 

станции 

Для изменения порядка нумерации станций (или пикетажа) при создании 
дороги щелкните по правой кнопке мыши на названии дороги в левой 
панели и в появившемся меню выберите пункт Properties (Свойства). В 
диалоговом окне Properties (Свойства) отредактируйте номер/пикетаж 
начальной станции. 

 
Рисунок 9-32. Редактирование начальной станции дороги 
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Создание плановых элементов 
дороги 
Таблица Horizontal alignment (Плановое положение осевой линии) 
отображает плановые участки оси дороги, схему планового 
проектирования и начальную станцию каждого элемента. В виде CAD, 
также отображается схема планового проектирования. 
Выпадающее меню правой и левой панелей обеспечивает возможность 
добавления плановых участков (линия, дуга, спираль, пересечение). 

• Щелкните по правой кнопке мыши на дороге или ее участке из левой 
панели и в появившемся меню выберите пункт Add Horz Element 
(Добавить плановый элемент) (см. рис. 9-33). 

 
Рисунок 9-33. Добавление планового участка в левой панели 

• Щелкните по правой кнопке мыши во вкладке Roads (Дороги) и в 
появившемся меню выберите пункт Add Horz Element (Добавить 
плановый элемент) (см. рис. 9-34). 

 
Рисунок 9-34. Добавление планового элемента в правой панели 

 

 ПРИМЕЧАНИЕ 

Пункт Insert Horz Element (Вставить плановый элемент) 
аналогичен пункту Add Horz Element (Добавить плановый 
элемент), за тем исключением, что новый элемент 
добавляется перед выбранным. 
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Добавление линии 
1. Для добавления линии выберите пункт меню Add Horz Element 

(Добавить плановый элемент), после чего выберите пункт Line 
(Линия) (см. "Создание плановых элементов дороги" на стр. 9-19). 

2. Во вкладке General (Основные параметры) диалогового окна Add 
Horz Element: Line (Добавить плановый элемент: Линия), введите 
параметры линии: 
• Azimuth (Азимут) – азимут линии (смотри "Задание азимута" на 

стр. 9-20). 
• Length (Длина) – длина линейного участка. 

Во вкладке End Position (Координаты конца участка) отобразятся 
рассчитанные координаты конечной станции линии. 

 
Рисунок 9-35. Диалоговое окно Add Horz Element: Line. Вкладки General и End 

Position 
3. Щелкните на кнопке ОК. В таблице Road (Дорога) в табличном и 

графическом представлениях на правой панели отобразится 
созданная линия. 

 
Рисунок 9-36. Табличное и графическое представление созданной линии 

 

Задание азимута 
По умолчанию азимут устанавливается по касательной к предыдущему 
элементу. Это поле доступно к редактированию только для начального 
элемента дороги. Для изменения азимута для всех других элементов, 
уберите флажок в поле "Tangential to previous segment" ("По касательной к 
предыдущему элементу") и введите необходимую величину азимута в 
поле Azimuth (Азимут). 
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Добавление дуги 
1. Для добавления дуги выберите пункт меню Add Horz Element 

(Добавить плановый элемент), после чего выберите пункт Curve 
(Дуга) (см. "Создание плановых элементов дороги" на стр. 9-19). 

2. Во вкладке General (Основные параметры) диалогового окна Add 
Horz Element: Curve (Добавить плановый элемент: Дуга) введите 
значения перечисленных ниже групп параметров: 
• Radius/ Deg Chord/ Deg Curve (Радиус/ Угол хорды/ Угол дуги) – 

радиус кривой или один из двух параметров, однозначно 
определяющих радиус: угол хорды или угол дуги. 
Радиус может быть вычислен по углу хорды (degree of chord – 
DCH) или углу дуги (degree of curve – DCV) следующим образом: 

⎟
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⎞

⎜
⎝
⎛ Π

×
=

1802
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R 1180100
×
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×
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• Length/ Chord/ Tangent/ Mid Ord/ External/ Delta (Длина/ Хорда/ 
Тангенс/ Средняя ордината/ Внешний отрезок/ Дельта) – длина 
дуги или один из пяти параметров, однозначно ее определяющих: 
длина хорды, тангенс (длина касательной), средняя ордината 
(расстояние между средней точкой хорды и средней точкой дуги), 
внешний отрезок (расстояние от средней точки дуги до точки 
пересечения касательных) или дельта (угол между радиусами 
кривой). 

 
Рисунок 9-37. Диалоговое окно Add Horz Element: Curve. Вкладки General и End 

Position 
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3. Введите перечисленные ниже параметры дуги (см. рис. 9-37): 
• Azimuth (Азимут) – азимут касательной к дуге (смотри "Задание 

азимута" на стр. 9-20). 
• Turn (Поворот) – направление поворота дуги. Выбор Right 

(Направо), устанавливает поворот дуги по часовой стрелке, Left 
(Налево) – против часовой стрелки. 

 
Рисунок 9-38. Параметры дуги 

4. Щелкните на кнопке ОК для создания (или добавления) дуги. В 
таблице Road (Дорога) в табличном и графическом представлениях на 
правой панели отобразится созданная дуга. 

 
Рисунок 9-39. Табличное и графическое представление созданной дуги 
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Добавление спирали (переходной кривой) 
1. Для добавления переходной кривой (далее – спирали) выберите пункт 

меню Add Horz Element (Добавить плановый элемент), после чего 
выберите пункт Spiral (Спираль) (см. "Создание плановых элементов 
дороги" на стр. 9-19). 

2. Во вкладке General (Основные параметры) диалогового окна Add 
Horz Element: Spiral (Добавить плановый элемент: Спираль), 
выберите направление спирали (см. рис. 9-40 на стр. 9-24). 

Способ построения "TS to SC" (Прямолинейный участок – 
Спираль – Спираль – Дуга), указывает, что начальная 
станция спирали – это конечная станция линии и конечная 
станция спирали – это начальная станция дуги (вход в 
поворот). 
Для спирали "TS to SC", определите один из параметров из 
следующих групп: End Radius/ End Deg Chord/ End Deg 
Curve (Конечный радиус/ Конечный угол хорды/ Конечный 
угол дуги): конечный радиус дуги или один из двух 
параметров, однозначно определяющих радиус – конечный 
угол хорды или конечный угол дуги.  
Способ построения "CS to ST" (Дуга – Спираль – Спираль – 
Прямолинейный участок) указывает, что начальная станция 
спирали является конечной станцией дуги и конечная 
станция спирали – это начальная станция линии (выход из 
поворота). 
Для спирали "CS to ST", определите один из параметров из 
следующих групп: Start Radius/Start Deg Chord/ Start Deg 
Curve (Начальный радиус/ Начальный угол 
хорды/Начальный угол дуги): начальный угол дуги или же 
один из двух параметров, однозначно определяющих 
радиус: начальный угол хорды или начальный угол дуги. 
Способ направления "CS to SC" (Дуга – Спираль – Спираль -
- Дуга), указывает, что начальная станция спирали является 
конечной станцией дуги и конечная станция спирали – это 
начальная станция дуги. 
Для спирали "CS to SC", определите один из параметров из 
следующих двух групп: Start Radius/Start Deg Chord/ Start 
Deg Curve (Начальный радиус/ Начальный угол 
хорды/Начальный угол дуги): начальный угол дуги или же 
один из двух параметров, однозначно определяющих 
радиус: начальный угол хорды или начальный угол дуги. 
End Radius/ End Deg Chord/ End Deg Curve (Конечный 
радиус/ Конечный угол хорды/ Конечный угол дуги): 
конечный радиус дуги или один из двух параметров, 
однозначно определяющих радиус – конечный угол хорды 
или конечный угол дуги. 
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Рисунок 9-40. Выбор направления спирали (переходной кривой) 

3. Введите перечисленные ниже параметры спирали: 

• Azimuth (Азимут) – азимут касательной к дуге (смотри "Задание 
азимута" на стр. 9-20). 

• Length/ Sp Const (Длина/ Константа спирали) – длина спирали 
или параметр, однозначно ее определяющий: константа спирали. 

• Turn (Поворот) – направление поворота спирали. Выбор Right 
(Направо) устанавливает поворот по часовой стрелке, Left 
(Налево) – против часовой стрелки. 

 
Рисунок 9-41. Диалоговое окно Add Horz Element: Spiral. Вкладки General и End 

Position 

4. Щелкните на кнопке ОК для создания (или добавления) спирали. В 
таблице Road (Дорога) в табличном и графическом представлениях 
правой панели отобразится созданная спираль (см. рис. 9-42 на стр. 9-
25). 
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Рисунок 9-42. Табличное и графическое представление созданной спирали 

Добавление пересечения 
Как было упомянуто выше, плановые участки дорожного проектирования 
могут быть описаны через точки пересечения. В этом случае две 
составная дуга описывается двумя касательными. Касательные задаются 
тремя точками: конечной станцией предыдущего участка и двумя точками 
пересечения. В большинстве случаев составная дуга состоит из двух 
спиралей и одной дуги (см. рис. 9-43). Для проектирования составной дуги 
следует добавить точку пересечение к плановому участку. 

• Задайте координаты первой точки пересечения, длину двух 
спиралей и радиус дуги. 

• Установите также координаты для второй точки пересечения. 

 
Рисунок 9-43. Составная дуга, определяемая точками пересечения 
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Если добавляется только одна точка пересечения, Topcon Tools 
автоматически создает сегмент, соединяющий конечную станцию 
предыдущего участка и точку пересечения. 
1. Для добавления пересечения выберите пункт меню Add Horz Element 

(Добавить плановый элемент), после чего выберите пункт 
Intersection (Пересечение) (см. "Создание плановых элементов 
дороги" на стр. 9-19). 

2. Во вкладке General (Основные параметры) диалогового окна Add 
Horz Element: Intersection (Добавить плановый элемент: 
Пересечение), введите значения перечисленных ниже параметров: 

• Задайте точку пересечения, используя один из следующих 
способов: 
Способ 1: Выберите точку пересечения из выпадающего списка 

Intersection Pt (Точка пересечения). В этом список 
перечислены все точки таблицы Points (Точки) текущего 
проекта:  

 
В полях Northing/Easting (Север/Восток), отобразятся 
координаты выбранной точки. Для выбранной точки эти 
координаты не могут быть изменены.  

Способ 2: Введите необходимые координаты в полях 
Northing/Easting (Север/Восток): 

 
• Length1 (Length2)/Sp Const1 (Sp Const2) (Длина1 

(Длина2)/Константа спирали1 (Константа спирали2) –длина 
первой и второй спиральных участков или параметр, однозначно 
определяющий длины спиралей: константа спирали (см. рис. 9-43 
на стр. 9-25). 

• Radius/ Deg Chord/ Deg Curve (Радиус/ Угол хорды/ Угол дуги) – 
радиус дуги (см. рис. 9-43 на стр. 9-25) или один из двух 
параметров, однозначно определяющих радиус: угол хорды или 
угол дуги. 
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Рисунок 9-44. Диалоговое окно Add Horz Element: Intersection. Вкладки General и 

End Position 

3. Щелкните на кнопке ОК для создания (или добавления) составной 
дуги. В таблице Road (Дорога) в табличном и графическом 
представлениях правой панели отобразится созданная составная дуга. 

 
Рисунок 9-45. Табличное и графическое представление созданной составной дуги 
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Создание высотных элементов 
дороги 
Таблица Vertical alignment (Высотные элементы осевой линии), 
отображает высотное положение участков оси дороги, схему высотного 
проектирования и начальную станцию каждого элемента. 
Выпадающие меню правой и левой панелей обеспечивает возможность 
добавления высотных элементов (уклон, парабола, длинный участок). 
Новый элемент добавляется к последнему созданному. 

• Щелкните по правой кнопке мыши на дороге или ее высотном 
участке в левой панели и в появившемся меню выберите пункт Add 
Vert Element (Добавить высотный элемент) (см. рис. 9-46). 

 
Рисунок 9-46. Добавление высотного участка в левой панели 

• Щелкните по правой кнопке мыши во вкладке Roads (Дороги) и в 
появившемся меню выберите пункт Add Vert Element (Добавить 
высотный элемент) (см. рис. 9-47). 

 
Рисунок 9-47. Добавление высотного элемента в правой панели 

 

 ПРИМЕЧАНИЕ 

Пункт Insert Vert Element (Вставить высотный элемент), 
доступный для уклона и параболы, аналогичен пункту Add 
Vert Element (Добавить высотный элемент), за тем 
исключением, что новый элемент добавляется перед 
выбранным. 
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Как было упомянуто выше, высотные элементы дорожного 
проектирования могут быть описаны через grade (уклон), parabola 
(параболу) или long section (длинный участок). В качестве первого 
высотного элемента можно задать любой из перечисленных типов. 

• Если в качестве первого элемента выбран уклон или парабола, 
следующим добавляемым элементом высотного проектирования 
могут быть только уклон или парабола. 

 
• Если в качестве первого участка выбран длинный участок, 

следующим добавляемым участком высотного проектирования 
может быть только длинный участок. 

 
 

Добавление уклона 
1. Для добавления уклона выберите пункт меню Add Vert Element 

(Добавить высотный элемент), после чего выберите пункт Grade 
(Уклон) (см. "Создание высотных элементов дороги" на стр. 9-28). 

2. Во вкладке General (Основные параметры) диалогового окна Add Vert 
Element: Grade (Добавить высотный элемент: Уклон) введите 
перечисленные ниже параметры: 

• Length (Длина) – длина уклона. 

• Grade (Уклон) – отношение длины уклона к превышению 
(разностью отметок конечной и начальной станции уклона) 
умноженное на 100%. 



Модуль Design 

Topcon Tools- Руководство пользователя 9-30 

 
Если уклон направлен вверх, то 
величина должна быть 
установлена положительной 

Если уклон направлен вниз, то 
величина должна быть 
установлена отрицательной 

 

 
Рисунок 9-48. Диалоговое окно Add Vert Element. Вкладка General (Основные 

параметры) 
3. Щелкните на кнопке ОК. В таблице Road (Дорога) в табличном и 

графическом представлениях на правой панели отобразится 
созданный уклон. 

 
Рисунок 9-49. Табличное и графическое представление созданного уклона 

 
Добавление параболы 
1. Для добавления параболы выберите пункт меню Add Vert Element 

(Добавить высотный элемент), после чего выберите пункт Parabola 
(Парабола) (см. "Создание высотных элементов дороги" на стр. 9-28). 

2. Во вкладке General (Основные параметры) диалогового окна Add Vert 
Element: Parabola (Добавить высотный элемент: Парабола), 
введите перечисленные ниже параметры: 
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• Length (Длина) – длина вертикального участка. 
• Start Grade/ End Grade (Начальный уклон/ Конечный уклон) – 

начальный и конечный уклоны в процентах. Если уклон 
направлен вверх, то его величина должна быть установлена 
положительной, в противном случае – отрицательной. 

 
Если величина начального уклона равна величине конечного уклона, 
парабола будет преобразована в уклон. 

 
Рисунок 9-50. Диалоговое окно Add Vert Element: Parabola. Вкладка General 

(Основные параметры) 
3. Щелкните на кнопке ОК. В таблице Road (Дорога) в табличном и 

графическом представлениях на правой панели отобразится 
созданная парабола. 

 
Рисунок 9-51. Табличное и графическое представление созданной параболы 
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Добавление длинного участка 
Как было указано выше, вертикальное проектирование может быть 
произведено длинным участком. В этом случае три точки используются 
для построения составной дуги. Составная дуга в вертикальной плоскости 
добавляется через три длинных участка. При создании составной дуги 
используются высоты для длинных участков 1, 2, 3 и протяженность 
длинного участка 2.  

 
Рисунок 9-52. Параметры составной дуги по трем уклонам 

1. Для добавления длинного участка выберите пункт меню Add Vert 
Element (Добавить высотный элемент) и выберите Long Section 
(Длинный участок) (см. "Создание высотных элементов дороги" на 
стр. 9-28). 

2. Во вкладке General (Основные параметры) диалогового окна Add Vert 
Element: Long Section (Добавить высотный элемент: Длинный 
участок) введите перечисленные ниже параметры (см. рис. 9-53 на 
стр. 9-33): 

• Sta/ Chainage (Станция/ Пикетаж) – название начальной стации 
или пикетаж для длинного участка. 

• Length (Длина) – длина дуги элемента длинного участка. 
Допускается установка нулевых длин начального и конечного 
отрезков длинного участка. 

• Elevation (Высота) – высота станции, используемой при создании 
длинного участка. 
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Рисунок 9-53. Диалоговое окно Add Vert Element: Long Section. Вкладка General 

(Основные параметры) 

3. Щелкните на кнопке ОК. В таблице Road (Дорога) в табличном и 
графическом представлениях правой панели отобразится созданная 
парабола. 

4. При необходимости, повторите предыдущие шаги для создания 
составных дуг. 

Например, необходимо создать вертикальную дугу по трем точкам с 
высотами +5, -1 и +4 метра. 

Примем, что расстояние между точками 1 и 2 равно 100 метрам и 
расстояние между точками 2 и 3 равно 125 метров. Длина дуги равна 
25 метрам. 
Для ввода соответствующих точек задайте эти величины в 
диалоговом окне Add Vert Element: Long Section (Добавить 
высотный элемент: Длинный участок). 
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Обратите внимание на то, что расстояние между станциями 
составной дуги влияет на наименование очередной станции: 

STn = STn-1+dD 
, где STn - название предыдущей станции и dD - расстояние 
между двумя станциями. 

В таблице Road (Дорога) в табличном и графическом представлениях 
правой панели отобразится составная дуга. 
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Создание поперечников 
В этом разделе описывается создание типовых поперечников для дорог и 
применение их к осевой линии на выбранных станциях. 

Создание типовых поперечников 
При проектировании дороги поперечное сечение должно быть выбрано из 
набора типовых поперечников (поперечных сечений). Topcon Tools 
предоставляет следующие способы работы с типовыми поперечниками: 

• Создание новых типовых поперечников и сохранение их в текущем 
проекте. 

• Импорт в текущий проект файлов (SSS Template (*.rd), TDS XSection 
Template (*.TP5), TopSURV Template (*.trd)) с типовыми 
поперечниками, созданными в других проектах или программах. 

• Экспорт любого в перечисленных форматах: SSS Template (*.rd), 
TDS XSection Template (*.TP5), TopSURV Template (*.trd). 

1. Для создания типового поперечника выберите пункт меню Edit > Add > 
X-Section Template (Редактирование > Добавить > Типовой 
поперечник). 

2. Во вкладке General (Основные параметры) диалогового окна Add X-
Section Template (Добавить поперечник), введите название 
типового поперечника, откос выемки (cut slope) и откос насыпи (fill 
slope). 
 
Параметры Cut Slope (Откос выемки) и Fill Slope (Откос насыпи) 
обозначают уклон откоса. Откос выемки используется, когда 
поверхность дороги должна находиться ниже уровня земли, а откос 
насыпи - выше уровня  земли. По умолчанию откос выемки и насыпи 
устанавливается равными 100 единицам (в процентах). 

 
Рисунок 9-54. Параметры типового поперечника 
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3. Для создания типового поперечного сечения (поперечника) щелкните 
на кнопке ОК. Он отобразится в табличном виде. 

• В левой панели таблицы X-Section Templates (Типовые 
поперечники) отображаются их названия и величины откосов 
выемки и насыпи в процентах. 

• В правой панели отображаются сегменты поперечника в 
табличном и графическом представлениях. 

 
Рисунок 9-55. Вид Таблица – типовые поперечники 

Правая панель таблицы X-Section Templates (Типовые поперечники), 
состоит (по умолчанию) перечисленные ниже столбцы, содержащие 
данные о сегментах, входящих в состав поперечника: 

• Icon (Пиктограмма) – символ сегмента. 

• Order (Порядок) – порядковый номер сегмента. 

• Code (Код) – код сегмента. 

• Hz. Dist (Горизонтальное расстояние) – горизонтальное смещение 
сегмента от оси дороги. 

• V. Dist (Вертикальное расстояние) – вертикальное смещение 
сегмента от оси дороги. 

• Grade % (Уклон %) – отношение V. Dist к Hz. Dist, умноженное на 
100%.  
Пользователь может задать только один параметр: или 
Вертикальное расстояние или Уклон. Второй параметр 
(Вертикальное расстояние или Уклон соответственно) будет 
рассчитан автоматически. 

• Hz. Offset from CL (m) (Смещение от оси в плане (метры)) – 
горизонтальное смещение начальной точки сегмента от оси дороги, 
рассчитываемое с использованием соответствующих параметров 
предыдущего сегмента (это значение  редактированию не 
подлежит). 
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• V. Offset from CL (m) (Смещение от оси по высоте (метры)) – 
вертикальное смещение начальной точки сегмента от оси дороги, 
рассчитываемое с использованием соответствующих параметров 
предыдущего сегмента (это значение  редактированию не 
подлежит). 

Добавление типового поперечника в 
текущий проект 
Для добавления нового типового поперечника в проект вызовите 
выпадающее меню, щелкнув по правой кнопке мыши на левой панели 
таблицы X-Section Templates (Типовые поперечники) и выбрав в 
появившемся меню пункт Add X-Section Template (Добавить типовой 
поперечник) (см. рис. 9-56). 

 
Рисунок 9-56. Создание нового типового поперечника 

Исходное название нового типового поперечника - "1", величины уклонов 
выемки и насыпи устанавливаются равными 100%. 
Для редактирования параметров типового поперечника щелкните на нем 
правой кнопкой мыши и в появившемся меню выберите пункт Properties 
(Свойства). Используйте диалоговое окно Properties (Свойства) для 
редактирования названия, откосов выемки и насыпи. 

 
Рисунок 9-57. Редактирование созданного типового поперечника 
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Создание нового сегмента типового 
поперечника 
В типовой поперечник может быть добавлено неограниченное количество 
сегментов. 
1. Для создания или добавления нового сегмента к типовому 

поперечнику вызовите выпадающее меню, щелкнув по правой кнопке 
мыши на левой панели таблицы X-Section Templates (Типовые 
поперечники). В появившемся меню выберите пункт Add Segment 
(Добавить сегмент). 

2. Во вкладке General (Основные параметры) диалогового окна Add 
Segment: X-Section Segment (Добавить сегмент: Сегмент 
поперечника) введите необходимые величины полей Hz. Dist 
(Горизонтальное расстояние), V. Dist (Вертикальное расстояние) или 
Grade % (Уклон %), Code (Код) и Order (Порядок). 

 
Рисунок 9-58. Создание нового сегмента 

3. Для создания нового сегмента щелкните на кнопке ОК. Сегмент 
отобразится в табличном и графическом представлениях в правой 
панели. 

 
Рисунок 9-59. Табличное и графическое представление созданного сегмента 
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Добавление поперечников к оси дороги 
Вкладка X-Section (Поперечники) содержит список станций, к которым 
могут быть добавлены поперечники, а также общий вид поперечного 
сечения. 
Количество типовых поперечников, используемых для дороги, не 
ограничивается. 
Выпадающее меню в правой и левой панели позволяет добавлять новые 
участки дороги. 

• Щелкните по правой кнопке мыши на дороге или поперечнике в 
левой панели и в появившемся меню выберите пункт Add X-Section 
(Добавить поперечник) (см. рис. 9-60). 

 
Рисунок 9-60. Добавление поперечника из левой панели вкладки Road (Дорога) 

• Щелкните по правой кнопке мыши на правой панели и в 
появившемся меню выберите пункт Add X-Section (Добавить 
поперечник) (см. рис. 9-61). 

 
Рисунок 9-61. Добавление поперечника из правой панели таблицы Road (Дорога) 

1. Для добавления поперечника вызовите диалоговое окно Add X-
Section (Добавить поперечник) (см. выше). 

2. Во вкладке General (Основные параметры) диалогового окна Add X-
Section (Добавить поперечник) установите перечисленные ниже 
параметры (см. рис. 9-62 на стр. 9-40): 
• Station (Станция) – введите станцию к которой применяется 

типовой поперечник. 
• Side (Сторона) – выберите левую или правую сторону дороги по 

ходу осевой линии, к которой применяется типовой поперечник. 
• Template (Типовой поперечник) – выберите название типового 

поперечника из списка заданных в текущем проекте. 
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Рисунок 9-62. Добавление поперечника 

3. Для добавления этого типового поперечника к осевой линии дороги 
для начальной станции щелкните на кнопке ОК. Типовой поперечник 
отобразится в табличном и графическом представлениях в правой 
панели таблицы и в виде CAD. 
При задании единственного типового поперечника (см. рис. 9-63) он 
будет использоваться для всей дороги, в противном случае Topcon 
Tools производит интерполяцию между поперечниками, заданными на 
соседних станциях. 

 
Рисунок 9-63. Пример использования единственного типового поперечника 
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Рисунок 9-64. Пример использования двух типовых поперечников 

 

Решение обратной 
геодезической задачи 
Функция решения обратной геодезической задачи вычисляет 
пространственное расстояние между двумя точками. 
1. Выберите пункт меню Cogo > Inverse (Координатная геометрия > 

Обратная задача). 
2. Выберите точку (точки) из левой колонки From (От) и точку (точки) из 

правой колонки To (До) (см. рис. 9-65 на стр. 9-42). 

• При выборе нескольких точек щелчком мышки выбирайте нужные 
точки, удерживая клавишу Ctrl нажатой.  

• Или вручную введите названия точек, отделяя их запятой. 

• Или выделите точки в виде Карта или Таблица. 
3. Щелкните на кнопке Calculate (Рассчитать) (см. рис. 9-65 на стр. 9-

42). 
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Рисунок 9-65. Выбор точек для расчета обратной задачи 

4. Результаты расчета представляются в нижней области окна (см. рис. 
9-66 на стр. 9-43). Состав отображаемые данных зависит от текущего 
представления координат проекта. 

• From / To (От / До) – выбранные точки для расчета задачи. 

• Forward Azimuth / Backward Azimuth (Прямой азимут / Обратный 
азимут) – прямой и обратный азимуты. 

• Geodetic Distance – кратчайшее расстояние между точками на 
эллипсоиде. 

• Ground Distance – горизонтальное проложение между точками, не 
редуцированное (за высоты точек) на эллипсоид. 

• Distance (Дальность) – расстояние между точками в плоскости 
проекции. 

• Hor. Distance (Горизонтальное проложение) – проекция на 
плоскость расстояния между точками 

• Delta Ell. Ht. (Разность геодезических высот) – разность между 
геодезическими высотами точек. 

• Delta H (Превышение) – разность между нормальными высотами 
точек. 

5. При необходимости повторите эти действия для других пар точек. 
Результаты расчета представляются в нижней области окна (см. рис. 
9-66 на стр. 9-43). 
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СОВЕТ 

Для формирования отчета о решении обратной задачи 
щелкните по правой кнопке мыши на нижней области окна и 
в появившемся меню выберите пункт Report (Отчет). 

6. После завершения вычислений нажмите кнопку Close (Закрыть). 

 
Рисунок 9-66. Результаты решения обратной геодезической задачи 
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Расчет пересечения 
Алгоритм определения точки пересечения рассчитывает положение точки 
пересечения лучей и сфер. Луч может быть задан различными способами: 

• Начальная и конечная точки. 

• Начальная точка и азимут. 
Луч идет из начальной точки по направлению к конечной или по заданному 
азимуту и распространяется “бесконечно” далеко. Если луч задан двумя 
точками, могут быть следующие варианты расположения точки 
пересечения (в варианте 3 точка пересечения отсутствует) (см. рис. 9-67). 

 
Рисунок 9-67. Различные варианты получения пересечения при задании луча по 

двум точкам 

Если луч задан начальной точкой и азимутом, могут быть следующие 
варианты расположения точки пересечения (в варианте 3 точка 
пересечения отсутствует) (см. рис. 9-68). 

 
Рисунок 9-68. Различные варианты получения пересечения при задании луча по 

начальной точке и азимуту 
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Сфера задается начальной точкой (центр сферы) и дальностью (радиусом 
сферы) (см. рис. 9-69). 

 
Рисунок 9-69. Различные варианты получения пересечения при задании сферы 

начальной точкой и дальностью 
Для расчета точки пересечения выполните следующие шаги: 
1. Выберите пункт меню Cogo > Intersection (Координатная геометрия 

> Пересечение). 
2. Выберите способ задания луча: 

• Для задания луча по начальной и конечной точкам, выделите 
начальные точки в колонках Start 1 / Start 2 (Начальная 1 / 
Начальная 2), затем выделите конечную точку в колонке Complete 
1 / Complete 2 (Завершение 1 / Завершение 2) во вкладках End 
Point (Конечная точка). 

 
Рисунок 9-70. Задание луча по начальной и конечной точкам 

• Для задания луча по начальной точке и азимуту выделите 
начальную точку в колонках Start 1 / Start 2 (Начальная 1 / 
Начальная 2), введите значение азимута в колонке Complete 1 / 
Complete 2 (Завершение 1 / Завершение 2) во вкладках Azimuth 
(Азимут) (см. рис. 9-71 на стр. 9-46). Введите значение азимута 
одним из следующих методов. 
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- Согласно принятого в проекте формата угловых единиц. 

 
- По азимуту луча, заданного по любым двум точкам проекта и 

произвольному углу доворота по форме "Р1-Р2+140 12 34.11". 

 
, где "Р1/Р2" - это названия точек и "140 12 34.11" – угол доворота 
(ГГ ММ СС.ссс). Величина угла доворота может быть 
положительной и отрицательной в пределах от 0 до 360°. 
В этом случае Topcon Tools создаст луч, начинающийся в 
заданной точке и направленный по азимуту, рассчитываемому 
как азимут направления между двумя точками плюс угол 
доворота. 

 
Рисунок 9-71. Задание луча по начальной точке и азимуту 

• Для задания сферы по начальной точке и расстоянию (радиусу 
сферы) выделите начальную точку в колонках Start 1 / Start 2 
(Начальная 1 / Начальная 2), установите дальность во вкладке 
Distance (Расстояние) в колонках Complete 1 / Complete 2 
(Завершение 1 / Завершение 2) (см. рис. 9-72 на стр. 9-47). Для 
ввода расстояния можно использовать следующие методы: 
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- Согласно принятого в проекте формата линейных единиц 

 
- По расстоянию между любыми двумя точками проекта и 

произвольному линейному домеру по форме "m-s2+100" или 
"m-s2-100". 

 
 

, где "m-s2" это названия точек, а "100" - линейный домер. 
В этом случае Topcon Tools создаст сферу с центром в заданной 
точке и радиусом, равным расстоянию между двумя заданными 
точками плюс заданный домер. 

 
Рисунок 9-72. Задание сферы по начальной точке и расстоянию 

3. Щелкните на кнопке Calculate (Рассчитать). 
4. Topcon Tools произведет определение положения точки пересечения, 

которая будет отображена во вкладке Points (Точки) с уникальным 
названием (cogo, cogo(2) и т.д.). Таблица в нижней области окна . 
− Name (Название) – название точки пересечения. 
− Start1 и  Start2 (Начальная точка 1 и Начальная точка 2) – 

название начальной точки луча или сферы. 
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− Complete 1 / Complete 2 (Завершение 1 / Завершение 2) – 
название конечной точки или азимута луча или радиус сферы 

− Latitude / Longitude / Ell. Height или Northing / Easting / Elevation 
(Широта / Долгота / Геодезическая высота или Север / Восток / 
Высота) – координаты точки пересечения (cogo)). 

5. При необходимости, повторите упомянутые действия для других лучей 
или сфер. Результаты будут отображены в нижней области окна. 

 
СОВЕТ 

Для формирования отчета о расчете пересечения щелкните 
на правой кнопке мыши в нижней области окна и в 
появившемся меню выберите пункт Report (Отчет). 

6. После завершения вычислений нажмите кнопку Close (Закрыть). 

 
Рисунок 9-73. Результаты расчета точки пересечения 
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Сравнение поверхностей 
Функция сравнения поверхностей (Compare Surfaces) позволяет 
рассчитать объем между двумя поверхностями и объем между 
поверхностью и выбранной горизонтальной плоскостью. 
Для сравнения поверхностей выполните следующие шаги: 
1. Выберите пункт меню Cogo > Compare Surfaces (Координатная 

геометрия > Сравнить поверхности). 
2. Выберите поверхность Design (Проектная) в левой колонке и 

поверхность Existing (Существующая) или горизонтальную плоскость 
на нужном уровне высоты в правой колонке (см. рис. 9-74). 

 
Рисунок 9-74. Выбор поверхностей или поверхности и горизонтальной плоскости 

3. Щелкните на кнопке Calculate (Рассчитать). 
4. Результаты расчета представлены в нижней области окна (см. рис. 9-

78): 

• Design/Existing (Проектная/Выбранная) – названия поверхностей, 
выбранных для сравнения. 

• Cut/Fill (Выемка/Насыпь) – 

− при сравнении двух поверхностей: необходимый объем для 
выемки или посыпания грунта для выведения выбранной 
поверхности до проектной. 

− при сравнении поверхности и горизонтальной плоскости: 
необходимый объем выемки или досыпания грунта для 
приведения плоскости к проектной поверхности. 

• Area (Площадь) – площадь перекрытия (в плане) двух 
поверхностей или поверхностью и плоскостью. 
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Если в правой колонке выбрана поверхность, Topcon Tools 
рассчитает разницу в объеме для двух поверхностей, см. 
приведенный ниже рисунок: 

 
Рисунок 9-75. Сравнение двух поверхностей 

В этом случае пользователь может сохранить результаты сравнения 
в виде новой поверхности. Для этого выберите поле "Save result as 
Surface" ("Сохранить результат как поверхность") и нажмите кнопку 
Calculate (Рассчитать). После этого в таблице Surfaces 
(Поверхности), отобразится созданная поверхность: 

 
Рисунок 9-76. Отображение в таблице Surfaces (Поверхности) созданной 

поверхности 
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Если в правой колонке выбрана горизонтальная плоскость с 
заданной отметкой, Topcon Tools рассчитает объем, см. рис. 9-77. 

 
Рисунок 9-77. Сравнение поверхности и горизонтальной плоскости с заданной 

отметкой 
5. При необходимости повторите приведенные выше шаги для сравнения 

других пар поверхностей или поверхностей и плоскостей. Результаты 
расчета будут в нижней таблице окна (см. рис. 9-78). 

 
СОВЕТ 

Для формирования отчет о расчете сравнения поверхностей 
щелкните по правой кнопке мыши и в появившемся меню 
выберите пункт Report (Отчет). 

6. После завершения вычислений нажмите кнопку Close (Закрыть). 

 
Рисунок 9-78. Результаты расчета сравнения поверхностей 
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Расчет смещения точки 
относительно линии 
Функция расчета смещения точки относительно линии подсчитывает 
составляющие смещения точки относительно линии или луча. Смещения 
рассчитать можно от любой точки текущего проекта, задав исходящий из 
нее луч по одному из перечисленных ниже наборов исходных данных: 

• Начальная и конечная точки. 
• Начальная точка и азимут. 

Луч идет из начальной точки по направлению к конечной или по заданному 
азимуту и распространяется “бесконечно” далеко. 
На рисунке 9-79 показан пример смещений точки относительно луча. 

 
Рисунок 9-79. Смещения точки относительно луча 

1. Для расчета смещений, нажмите COGO > Inverse Point To Line 
(Координатная геометрия > Смещение точки относительно линии). 

2. В области окна Point (Точка) выберите точку, относительно которой 
будут определяться смещения. 

 
Рисунок 9-80. Выбор точки 

3. В области окна Point From (От точки) выберите точку начала луча. 
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4. В области окна Direction (Направление) выберите направление 
распространения луча. 
• При использовании вкладки End Point (Конечная точка) (см. рис. 

9-81) выберите конечную точку луча. 
• При использовании вкладки Azimuth (Азимут) (см. рис. 9-81), 

введите азимут распространения луча одним из перечисленных 
ниже способов: 
− Угол азимута (вводится в формате ГГ ММ СС.ссс).  
− Названия двух точек (начальной и конечной) и угол доворота. 

В этом случае искомый азимут будет рассчитан как сумма 
угла доворота и азимута направления между двумя точками,  
 1-4+12 45 22 
Где, "1-4" – названия первой и второй точки и "+12 45 22" – 
угол доворота (вводится в виде ГГ ММ СС.ссс). Величина 
угла доворота может быть положительной и отрицательной в 
пределах от 0 до 360°. 

 
Рисунок 9-81. Задание направления 

5. Щелкните на кнопке Calculate (Рассчитать). Рассчитанное смещение 
точки относительно направления (линии или луча) отобразится в 
нижней области окна (см. рис. 9-82 на стр. 9-54). 

• Name (Название) – название точки, для которой рассчитываются 
смещения. 
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• Latitude/Longitude/Ell.Height или Grid Northing/Grid Easting/ 
Elevation или Ground Northing/Ground Easting/ Elevation 
(Широта/Долгота/Элл высота или Север/Восток/Высота в 
координатах проекции или Север/Восток/Высота в местной 
системе координат) – координаты этой точки. 

• From Point (От точки) – название точки начала линии (или луча). 
• Direction (Направление) – название конечной точки линии или 

значение азимута. 
• Offset Along (Смещение вдоль) – длина перпендикуляра, 

опущенного из выбранной точки на линию. Это значение 
положительное, если точка расположена справа от линии. 

• Offset Across (Смещение поперек) – длина отрезка от начальной 
точки до основания перпендикуляра (см. выше). Это значение 
положительное, если точка расположена в направлении луча. В 
противном случае значение отрицательное. 

• Offset H (Превышение) – превышение выбранной точки над 
точкой начала линии или луча. 

6. При необходимости повторите расчеты для других точек. 

 
Рисунок 9-82. Результаты расчета смещения точки относительно линии 

 
СОВЕТ 

Для формирования отчет о расчете смещения точки 
относительно линии щелкните по правой кнопке мыши на 
нижней области окна и в появившемся меню выберите пункт 
Report (Отчет). 

7. После завершения вычислений нажмите кнопку Close (Закрыть). 
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Расчет точки по направлению 
Функция расчета точки по направлению выполняет расчет координат 
точки, расположенной на линии или луче. Эти координаты могут быть 
рассчитаны после задания расстояния от начальной точки луча или линии, 
определенной по одному из перечисленных ниже наборов данных: 

• Начальная и конечная точки. 

• Начальная точка и азимут. 
Луч идет из начальной точки по направлению к конечной или по заданному 
азимуту и распространяется “бесконечно” далеко. 
Для определения координат точки выполните следующие действия: 
1. Выберите пункт меню COGO > Point To Direction (Координатная 

геометрия > Точка по направлению). 
2. В области окна Point From (От точки) выберите точку, от которой 

будут производиться вычисления. 
3. В области окна Direction (Направление) выберите направление 

распространения луча. 

• При использовании вкладки End Point (Конечная точка) (см. рис. 
9-83 на стр. 9-56) выберите конечную точку луча. 

• При использовании вкладки Azimuth (Азимут) (см. рис. 9-83 на 
стр. 9-56) введите азимут распространения луча одним из 
перечисленных ниже способов: 

− Угол азимута (вводится в формате ГГ ММ СС.ссс). 

− Названия двух точек (начальной и конечной) и угол 
доворота. В этом случае искомый азимут будет рассчитан 
как сумма угла доворота и азимута направления между 
двумя точками,  
 1-4+12 45 22 
Где, "1-4" – названия первой и второй точки и "+12 45 22" – 
угол доворота (вводится в виде ГГ ММ СС.ссс). Величина 
угла доворота может быть положительной и отрицательной 
в пределах от 0 до 360°. 
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Рисунок 9-83. Enter the Point From and the Direction  

4. Задайте расстояние от начальной точки до создаваемой точки одним 
из перечисленных ниже способов: 

• Введите расстояние, используя установленные линейные 
единицы проекта (см. рис. 9-84). 

• Используя две существующие точки проекта (начальную и 
конечную) и расстояние линейного домера в следующем 
формате (см. рис. 9-84). При использовании этого метода 
сначала будет определено расстояние между двумя точками, а 
потом к нему прибавлен линейный домер. 

ST1-8+12.2 

Где, "ST1-8" – названия начальной и конечной точек, "+12.2" – 
линейный домер. 

 
Рисунок 9-84. Ввод расстояния от начальной точки 
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5. Щелкните на кнопке Calculate (Рассчитать). После этого будет 
создана новая точка и рассчитаны ее координаты (см. рис. 9-85). В 
таблице Points (Точки) и в виде Map View (Вид Карта) отобразится 
созданная точка с уникальным именем, заданным по умолчанию (cogo, 
cogo(2), и т.д.). 
• Name (Название) – название созданной точки. 
• From Point (От точки) – название точки начала линии (или луча). 
• Direction (Направление) – или название конечной точки линии или 

значение азимута. 
• Distance (Расстояние) – расстояние от начальной точки до 

создаваемой. 
• Latitude/Longitude/Ell.Height или Grid Northing/Grid Easting/ 

Elevation или Ground Northing/Ground Easting/ Elevation 
(Широта/Долгота/Элл высота или Север/Восток/Высота в 
координатах проекции или Север/Восток/Высота в местной 
системе координат) – координаты созданной точки. 

6. При необходимости повторите расчеты для других точек. 
7. После завершения вычислений нажмите кнопку Close (Закрыть). 

 
Рисунок 9-85. Результаты расчета точки по направлению 

 

 
СОВЕТ 

Для формирования отчет о расчете точки по направлению 
щелкните по правой кнопке мыши на нижней области окна и 
в появившемся меню выберите пункт Report (Отчет). 
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Рисунок 9-86. Результаты расчета точки по направлению во вкладке Points и в 

виде Map View 
 

Расчет хода 
При расчете координат точек хода вычисления основываются на 
горизонтальном проложении и превышении выбранной точки и 
направлении, определяемом азимутом или правым / левым углом по 
направлению хода или углом отклонения. В качестве опорной допускается 
использование произвольной точки проекта, а направление задается 
любым из перечисленных ниже методов: 

• азимутом направления от 
станции к следующей точке 
хода. 
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• углом (-ами) между 

направлением на точку хода и 
направлением на заднюю 
точку (BS). 

• углом (-ами) между 
направлением на точку хода) 
и азимутом направления на 
заднюю точку хода. 

 
Начиная с первой точки хода любая другая точка проекта может быть 
выбрана в качестве очередной станции. После расчета координат для нее, 
для последующих расчетов она автоматически назначается задней точкой  
хода. 
1. Для начала расчета хода выберите пункт меню COGO > Traverse 

(Координатная геометрия > Ход). 
2. В области окна From Point (От точки) выберите станцию, от которой 

начнутся вычисления. 

 
Рисунок 9-87. Выбор опорной точки (станции) 
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3. Введите горизонтальное проложение и превышение очередной точки 
хода. 

 
Рисунок 9-88. Ввод гор. проложения и превышения следующей точки хода 

4. Задайте угол направления на точку хода, используя один из 
перечисленных ниже способов (см. рис. 9-89 на стр. 9-61): 
• Используя азимут направления от станции к точке хода. 

Выберите поле Azimuth (Азимут) и введите значение в угловых 
единицах, принятых для всего проекта. 

 ПРИМЕЧАНИЕ 

При использовании азимута для задания направления на 
точку хода, выбор задней точки (BS) и азимута на заднюю 
точку невозможен. 

• Используя любую точку проекта в качестве ориентирной (задней, 
BS). Выберите поле Angle Right (Угол справа) или Angle Left (Угол 
слева). Во вкладке BS Point (Задняя точка) выберите 
ориентирную точку, введите угол между линией, проходящей 
через станцию и ориентирную точку и линией, проходящей через 
станцию и создаваемую точку (см. вторую схему на стр. 9-59). 

 ПРИМЕЧАНИЕ 

Положительное направление счета горизонтальных углов - 
по часовой стрелке. 

• Используя угол (углы) между направлением линии, проходящей 
через станцию и линией проходящей через станцию и 
создаваемую точку хода (смотри третью схему на стр. 9-59). 
Выберите поле Angle Right (Угол справа) или Angle Left (Угол 
слева). В таблице BS Azimuth (Азимут на заднюю точку), 
введите значение азимута одним из следующих способов: 

− Угол азимута (вводится в формате ГГ ММ СС.ссс). 

− Названия двух точек (начальной и конечной) и угол 
доворота. В этом случае искомый азимут будет рассчитан 
как сумма угла доворота и азимута направления между 
двумя точками.  
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 5-9+12 34 22 
Где, "5-9" – названия первой и второй точки и "+12 34 22" – 
угол доворота (вводится в виде ГГ ММ СС.ссс). Величина 
угла доворота может быть положительной и отрицательной 
в пределах от 0 до 360° 

 
Рисунок 9-89. Выбор и ввод направления для точки хода 

5. Щелкните на кнопке Calculate (Рассчитать). После этого будут 
рассчитаны координаты новой точки хода (см. рис. 9-90). Во вкладке 
Points (Точки) и в виде Map View (Вид Карта), отобразится эта точка с 
уникальным именем, задаваемым по умолчанию (cogo, cogo(2), и т.д.). 
• Name (Название) – название созданной точки хода. 
• Grid Northing/Grid Easting/ Elevation или Ground Northing/Ground 

Easting/ Elevation (Север/Восток/Высота в координатах проекции 
или Север/Восток/Высота в местной системе координат) - 
координаты этой точки. 

• From Point (От точки) – название станции. 
• BS Point (Задняя точка) – название ориентирной точки. 
• Azimuth (Азимут) – введенная или рассчитанная величина 

азимута направления от станции к точке хода. 
• Bearing (Дирекционный угол) – рассчитанное значение 

дирекционного угла от станции к точке хода. 
• Hor. Dist/ Vert. Dist (Горизонтальное проложение/ Превышение) от 

станции до точки хода. 
• BS Azimuth (Азимут) – введенная или рассчитанная величина 

азимута линии, проходящей через станцию на заднюю точку. 
• BS Azimuth (BS Азимут) – введенная или рассчитанная величина 

азимута линии, проходящей через станцию на заднюю точку. 
• BS Bearing (BS Дирекционный угол) – рассчитанная величина 

дирекционного угла линии, проходящей через станцию на заднюю 
точку. 
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6. При необходимости повторите расчеты для других точек хода. 

 
Рисунок 9-90. Результаты расчета хода 

 
СОВЕТ 

Для формирования отчета о расчете точки по направлению 
щелкните по правой кнопке мыши на нижней области окна и 
в появившемся меню выберите пункт Report (Отчет). 

 
Рисунок 9-91. Результаты расчета хода по направлению в таблице Points (Точки) и 

в виде Map View (Вид Карта) 

7. После завершения вычислений нажмите кнопку Close (Закрыть). 
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Глава 10  
Модуль Image 
Программный модуль Image позволяет производить: 

• импорт, просмотр, редактирование сеансов сканирования (scan 
session). 

• импорт, просмотр стереопар (Stereopairs). 
• измерение координат любой точки на стереопаре. 

Обработка стереопар 
После импорта файла TopSURV PC со стереопарами появится вкладка 
Stereopairs (Стереопары), в ней отобразятся стереопары в виде 
ориентированном и стереоскопическом видах (подробнее см. раздел 
"Stereopairs (вкладка Стереопары)" на стр. 4-14. С помощью Topcon Tools 
вы можете редактировать стереопары, измерять координаты точек на 
изображениях и добавлять линии к измеренным точкам. Для отображения 
стереопары выберите местную СК (Ground) в выпадающем списке выбора 
систем координат в строке состояния. 
Для редактирования стереопар текущего проекта выберите вкладку 
Stereopairs (Стереопары) и щелчком по правой кнопке мыши на нужной 
стереопаре вызовите выпадающее меню. 

 
Рисунок 10-1. Выпадающее меню левой панели 

Это меню позволяет проделать перечисленные ниже операции: 
• Вырезать выбранную стереопару. 
• Копировать выбранную стереопару. 
• Удалить выбранную стереопару. 
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• Поменять изображения местами (левое с правым). 
• Открыть окно с отображением выбранных стереопар в их исходной 

форме (выберите "Orientation View"). 

 
Рисунок 10-2. Окно просмотра выбранной стереопары – ориентированный вид 

• Открыть окно для отображения стереопар в нормализованной 
форме (выберите "Stereo View"). 

 
Рисунок 10-3. Окно просмотра выбранной стереопары – стереоскопический вид 

Выпадающее меню, появляющееся при щелчке по правой кнопке мыши на 
нижней области правой панели позволяет отображать выбранные 
стереопары раздельно в окнах Stereo View и/или Orientation View: 

 
Рисунок 10-4. Выпадающее меню в нижней части правой панели 
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Измерение координат точек по 
стереопарам 
Topcon Tools позволяет произвести определение координат в местной СК 
(Ground координатах) любой точки, идентифицированной на левом и 
правом изображении стереопары, используя данные внешнего 
ориентирования (координаты станции фотографирования, вертикальный и 
горизонтальный углы ориентации оси фотокамеры) и внутреннего 
ориентирования (фокусное расстояние и координаты главной точки 
фотокамеры). 
Измерение координат точек производится в нижней части правой панели 
вкладки Stereopairs (Стереопары) в окне Stereo View или окне Orientation 
View. Можно также измерить координаты точки на стереопаре, используя 
режим добавления точек ("Add Point"). 
1. Включите режим добавления точек ("Add Point"), нажав кнопку Add 

Point инструментальной панели. 
2. Курсором (он примет вид режима "добавление точки"), щелкните по 

нужной точке на первом (левом или правом) изображении (см. рис. 
10-5). Курсор автоматически переместится на второе изображение. 
Если установлен режим Stereo View, эпиполярная линия отобразится 
на втором изображении. Эта же точка на втором изображении должна 
находится на эпиполярной линии. 

3. Щелкните на нужной точке второго изображения. Введите название 
созданной точки в окне Add Point и щелкните на кнопке ОК. 

 
Рисунок 10-5. Измерение координат точки по стереопаре 
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4. Topcon Tools рассчитает координаты этой точки в местной СК. 
Созданная точка отобразится во вкладках Points (Точки), 
Images(Изображения) и Stereopairs (Стереопары). 

 
Рисунок 10-6. Вкладка Points. Вкладка Images отображает измеренную точку 

Во вкладке Stereopairs (Стереопары) показываются две точки (см. рис. 10-
7): 

• Image measurement (Измерение по изображению) – точка, 
выбранная пользователем на изображении. 

• Image measured point (Точка, определенная по изображению) – 
точка, рассчитанная Topcon Tools с использованием данных 
внешнего и внутреннего ориентирования. 

 
Рисунок 10-7. Вкладка Stereopairs с отображением выбранной для измерения и 

рассчитанной точек 
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Создание линий по стереопарам 
Для добавления линии между двумя определенными по стереопаре 
точками проделайте следующее: 
1. Выберите инструмент Add Line (Добавить линию) инструментальной 

панели. 
2. Курсором (он примет вид режима "добавление точки"), щелкните по 

нужной точке на первом и втором изображениях. 
3. Повторите п.2 для второй точки. После этого Topcon Tools создаст 

линию между этими точками и на изображениях стереопары появится 
линия. 

4. Установите стиль отображения линии, используя окно Layers (Слои) 
инструментальной панели. 

Во вкладке Linework (Линии) и окне CAD (CAD View) появится линия 
созданная во вкладке Stereopairs (Стереопары) (см. рис. 10-8). 
Точки вершин линии не имеют названий и во вкладке Points (Точки) не 
отображаются. 

 
Рисунок 10-8. Создание линии 
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Создание поверхности по 
стереопарам 
Для создания поверхности по измеренным по стереопаре точкам, 
выберите эти точки и выберите пункт меню View > Add > Surface (Вид > 
Добавить > Поверхность). Введите название создаваемой поверхности и 
щелкните на кнопке ОК окна Add Surface (Добавить поверхность). 
После этого во вкладке Stereopairs (Стереопары) отобразится 
поверхность (см. рис. 10-9). 

 
Рисунок 10-9.Создание поверхности по измеренным точкам 

Поверхность могут отобразить программные окна CAD View и 3D View (см. 
рис. 10-11 на стр. 10-7). Допускается использование изображения 
созданной поверхности в качестве текстуры в окне 3D View. 
1. Выберите вкладку Image (Изображение). 
2. Щелчком по правой кнопке мыши на нужном изображении в левой 

панели вызовите выпадающее меню и выберите пункт Set as Surface 
Texture (Использовать как текстуру поверхности). 

 
Рисунок 10-10. Выпадающее окно левой панели вкладки Image 
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В окне 3D View будет отображена созданная поверхность с выбранной 
текстурой (см. рис. 10-11). 

 
Рисунок 10-11. Окна CAD и 3D с поверхностью 

 

Уравнивание измеренных точек 
Для оценки точности измерений по стереопарам выполняется процесс 
уравнивания (нажмите Process > Adjustment (Процесс > Уравнивание)). 
В этом случае в уравнивание включается сеть, содержащая тройку точек: 
измеренную и две станции стояния тахеометра. После уравнивания сети 
во вкладке Points (Точки) будут отображены среднеквадратические 
ошибки для каждой координаты измеренных точек. 

 
Рисунок 10-12. Точности измеренных точек 

 

 ПРИМЕЧАНИЕ 

Процесс уравнивания не выявляет ошибки установки 
точки на стереопаре. Предполагается, что эта ошибка 
не превышает ОДНОГО пикселя. 



Модуль Image 

Topcon Tools- Руководство пользователя 10-8 

Редактирование сеансов 
сканирования 
После импорта файла TopSURV PC с сеансом сканирования появится 
вкладка Scan Sessions (Сеансы сканирования). Topcon Tools позволяет 
пользователю просматривать точки сканирования со связанным 
изображением или без него и создавать поверхности по этим точкам. 

 
Рисунок 10-13. Вкладка Scan Sessions 

Для начала работы с сеансом сканирования текущего проекта выберите 
вкладку Stereopairs (Стереопары) и щелчком по правой кнопке мыши на 
левой панели вызовите выпадающее меню. 

 
Рисунок 10-14. Выпадающее меню левой панели 

Это меню позволяет проделать перечисленные ниже операции: 
• Вырезать выбранный сеанс сканирования. 
• Копировать выбранный сеанс сканирования. 
• Удалить выбранный сеанс сканирования. 
• Создать отсканированную поверхность. После выбора пункта меню 

Create Scan Surface (Создать отсканированную поверхность), 
появится соответствующее диалоговое окно. Точкой фокуса для 
создаваемой поверхности в этом случае автоматически выбирается 
точка стояния прибора. Для создания поверхности по 
отсканированным точкам введите название поверхности, выберите 
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слой и щелкните на кнопке ОК (см. рис. 10-15). В окне Image 
(Изображение) отобразится созданная поверхность. 

 
Рисунок 10-15. Создание поверхности по скану 

• Окно Image (Изображение) отобразит выбранный сеанс 
сканирования в вертикальной плоскости. 

 
Рисунок 10-16. Окно Image с выбранным сеансом сканирования 
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Допускается использование изображения созданной поверхности в 
качестве текстуры в окне 3D View: 
1. Выберите вкладку Image (Изображение). 
2. Щелчком по правой кнопке мыши на нужном изображении в левой 

панели вызовите выпадающее меню и выберите пункт Set as Surface 
Texture (Использовать как текстуру поверхности). 

 
Рисунок 10-17. Выпадающее окно левой панели вкладки Image 

В окне 3D View будет отображена созданная поверхность с выбранной 
текстурой. 

 
Рисунок 10-18. Окно 3D с поверхностью 
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Глава 11  
Модуль Advanced 
Программный модуль Advanced (Расширенная обработка) дает 
возможность осуществлять дополнительную обработку измерений и 
уравнивание. 
Удостоверьтесь в том, что применение модуля Advanced разрешено в 
Topcon Tools. Если он зарегистрирован, то должен присутствовать в 
списке разрешенных к использованию программных модулей 
(Help>Access Codes). 

 
Рисунок 11-1. Модули Topcon Tools, разрешенные к использованию 
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Модуль Advanced для 
обработки спутниковых 
измерений 
При включенном модуле Advanced в окне Process Properties 
(Параметры обработки) модуля GPS+ PostProcessing (обработка 
GPS+) появится три вкладки: General (Основные параметры), Engine 
(Алгоритм обработки) и Troposphere (Тропосфера). 

 
Рисунок 11-2. Параметры обработки измерений GPS+ 

Вкладка General 
Во вкладке General (Основные параметры) можно изменить 
перечисленные ниже параметры (см. рис. 11-2): 

• Предельный угол возвышения спутника. 
• Состав навигационных спутниковых систем, используемых для 

расчета базисов в текущем проекте (GPS и ГЛОНАСС или только 
GPS). 

• Один из двух вариантов минимальной продолжительности сеанса 
наблюдения базиса: 

1. Auto (Автоматический) - Topcon Tools будет рассчитывать 
базисы GPS при наличии перекрывающихся по времени 
сеансов спутниковых измерений, продолжительность которых 
зависит от расстояния между пунктами, количества 
одновременно наблюдаемых спутников и типом измерений 
(L1/L2 или только L1, GPS/ГЛОНАСС или только GPS) и т.п. 
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2. Fixed Time (Продолжительность задается) - Topcon Tools 
будет рассчитывать базисы GPS при наличии 
перекрывающихся по времени сеансов спутниковых 
измерений продолжительностью не менее заданной в поле 
Min. obs. time, sec (Минимальное время наблюдений, сек). 

• Флажок "Enable continuous kinematic" ("Включить непрерывную 
кинематику") разрешает выводить на экран и обрабатывать данные 
непрерывной кинематики. 

Эта страница аналогична окну GPS+ PostProcessing (Обработка GPS+) 
Topcon Tools без модуля Advanced. 

Вкладка Engine (Алгоритм 
обработки) 
Во вкладке Engine (Алгоритм обработки), см. рис. 11-2, можно выбрать 
необходимый алгоритм обработки, исходя из особенностей обработки 
измерений, выполненных в статическом, кинематическом Stop-Go (c 
остановками) или непрерывном кинематическом режимах. Для любого 
состава измерений (статические, кинематические с остановками или 
кинематические непрерывные) пользователь может выбрать следующие 
режимы: 

• PP Code Only – обрабатываются только псевдодальности. 
• PP L1 Only – обрабатываются измерения, произведенные только на 

частоте L1 (установка по умолчанию для одночастотных 
приемников). 

• PP L2 Only – обрабатываются измерения, произведенные только на 
частоте L2. 

• PP L1&L2 – (рекомендуется для коротких базовых линий). 
обрабатываются измерения на обеих частотах. Измерения на L1 и 
L2 рассматриваются алгоритмом как два независимых набора 
данных, синтетические измерения по L1 и L2 не формируются. 

• PP L1c – обработка двухчастотных измерений на длинных базисных 
линиях (> 30км). По L1 и L2 формируются комбинация, свободная от 
влияния ионосферы. Целое количество циклов не разрешается. 

• PP L1-L2 – обработка широкополосной (WideLane) комбинации L1 и 
L2 в основном используется для обработки длинных базовых линий 
и при исследовательских задачах. 

• PP L1+L2 – обработка узкополосных комбинации (narrowlane) 
используется для исследовательских задач. 

• PP L1&L2c – наиболее мощный метод обработки двухчастотных 
данных, включающий в себя разрешение неоднозначностей и 
формирование комбинации, свободной от влияния ионосферы. В 
основном используется для обработки базисов длиной менее 30 км, 
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но при спокойном состоянии атмосферы этот метод можно 
использовать для базисов длиной до 75км. 

• VLBL – обработка очень длинных базовых линий. Этот метод 
основан на использовании третьих разностей с вычислением 
ионосферных и тропосферных поправок. 

• Wide Lane –разновидность метода обработки PP L1-L2. В этом 
случае остаточные ионосферные ошибки слишком велики для 
фиксированного решения по методу PP L1&L2 или PP L1&L2c, но 
измерения достаточно качественные для правильного разрешения 
L1-L2 неоднозначностей. 

• RTK Fixed – обработка с использованием алгоритма RTK, 
используемого также и во встроенном программном обеспечении 
приемников TPS. 

• RTK L1 Only – обработка с использованием алгоритма RTK, 
использующего только одночастотных измерения. 

• RTK Code Only – обработка с использованием алгоритма RTK,   
использующего только кодовых измерения. 

При выборе режима AUTO, то режим обработки выбирается в 
зависимости от указанных ниже условий: 

• Если использовались только одночастотные измерения, то режим 
AUTO выбирает метод PP L1 Only. 

• Если обрабатываемый базис короче 10 км, то режим AUTO 
выбирает метод PP L1&L2. 

• Если обрабатываемый базис длиннее 10 км, но короче 30 км, то 
режим AUTO выбирает метод PP L1&L2c. 

• Если обрабатываемый базис длиннее 30 км, но короче 400 км, то 
режим AUTO выбирает метод Wide Lane. 

• Если обрабатываемый базис длиннее 400 км, то режим AUTO 
выбирает метод VLBL. 

Topcon Tools имеет возможность сохранения невязок вторых разностей 
для каждого статического GPS+ базиса проекта. Для этого выберите 
флажок Save residuals (Сохранять невязки). 
Режим AUTO для кинематики с остановками и непрерывной кинематики 
выбирает метод RTK Fixed. 
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Вкладка Troposphere (Тропосфера) 
Topcon Tools имеет возможность использования параметров тропосферы, 
задаваемых в соответствующих полях окна (см. рис. 11-2). 
Обратите внимание, что измеренные метеопараметры соответствуют 
отметке, указанной в поле Default meteo param at height (по умолчанию, 0 
метров). В этом поле следует ввести фактическую высоту точки, на 
которой выполнялось измерение метеопараметров. Алгоритм обработки 
по введенным метеопараметрам рассчитывает тропосферную задержку 
для всех точек стояния на основе их высот. 

Разбиение сеансов GPS+ 
Модуль Advanced дает возможность разделить сеанс измерений на два, 
или же два сеанса объединить в один. 
1. Для разбиения сеанса на два, щелчком по правой кнопке мыши на 

требуемом сеансе во вкладке Occupation (Сеансы) вызовите 
выпадающее меню и в нем выберите пункт Split (Разделить). 

 
Рисунок 11-3. Пункт меню Разбиение сеанса 

2. Сеанс в окне Split GPS Occupations можно разделить двумя 
способами. 

 
Рисунок 11-4. Окно Разбиение сеанса 
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• by Time (по времени) – в поле Split Time (Время разбиения) задается 
момент разбиения выбранного сеанса. По умолчанию он 
устанавливается равным середине сеанса. После нажатия на кнопку 
ОК будут созданы два сеанса. Во вкладке Occupation (Сеансы) 
отобразятся два сеанса взамен исходного. Созданные сеансы будут 
названы "<название исходного сеанса>(Head)" и "<название 
исходного сеанса>(Tail)" (см. рис. 11-5). 

 
Рисунок 11-5. Пример разбиения сеанса по времени 

• by Hour (часовые интервалы) – в этом случае выбранный сеанс 
делится на одночасовые сеансы по границам часа. Начальная и 
конечная эпоха таких сеансов (за исключением первого и 
последнего сеанса) расположены ровно на границах часа. Конечная 
эпоха первого сеанса и начальная последнего также расположены 
ровно на границах часа. 

 
Рисунок 11-6. Правило разделения сеанса на часовые интервалы 

После нажатия на кнопку ОК (см. рис. 11-7) будут созданы несколько 
сеансов. В таблице Occupation (Сеансы) отобразятся созданные 
сеансы вместо исходного. Первый сеанс будет назван "<название 
исходного сеанса>(Head)", а последующие - "<название исходного 
сеанса>(Tail_n)", где n – номер очередного сеанса. 
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Рисунок 11-7. Пример разделения сеанса на часовые интервалы 

Объединение сеансов производится по перечисленным ниже правилам: 
1. За одну операцию могут быть объединены только два сеанса. 
2. Два статических сеанса могут быть объединены только в том случае, 

когда они выполнены с одного пункта. 
3. Две кинематических сеанса могут быть объединены, если они 

являются частью одного файла кинематической съемки с остановками. 
4. Сеансы с различными интервалами записи (интервалами эпохи) не 

могут быть объединены. 
5. Не могут быть объединены сеансы с различающимися параметрами 

антенн и/или серийными номерами приемников. 
6. Не могут быть объединены сеансы измерений, выполненные с 

различными антеннами. 
7. Не могут быть объединены сеансы с различными типами приемников. 
8. Не могут быть объединены сеансы, если один из них содержит 

одночастотные, а другой - двухчастотные данные. 
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Просмотр и сохранение остаточных 
невязок вторых разностей 
Если флажок Save residuals (Сохранять невязки) установлен для 
статического решения, Topcon Tools создаст графики вторых разностей 
для всех GPS+ базисов проекта после их обработки. Для просмотра 
графика для статического базиса щелкните по правой кнопке мыши на 
выбранном базисе и в появившемся меню выберите пункт Residual View 
(см. рис. 11-8). 

 
Рисунок 11-8. Просмотр вторых разностей 

В открывшемся диалоговом окне Residual View (Просмотр невязок) 
отображены графики остаточных ошибок вторых разностей для каждой 
пары спутников, использовавшейся в обработке. 

• Ось X – время наблюдения базиса GPS+. 
• Ось Y – остаточные ошибки вторых разностей, в долях длины волны 

для всех измерений, выполненных в двух сеансах. 
Графики приводятся в различных цветах. Используйте окно выбора для 
отображения или скрытия пар спутников. 

 
Рисунок 11-9. Вид окна ошибок вторых разностей для выбранного базиса GPS+ 
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Для просмотра индивидуальной пары или просмотра всех графиков 
щелкните по правой кнопке мыши на графике и в появившемся меню: 

• Для отображения ошибки конкретной пары, выберите пункт Show 
Only (Показать только) <название пары> (см. рис. 11-10). 

• Для отображения всех пар выберите пункт Show All (Показать все). 
• Для удаления графиков всех пар с конкретным спутником выберите 

пункт Disable (Отключить) <номер спутника>. 

 
Рисунок 11-10. Просмотр только одной второй разности 

Измерения для спутника на выбранном временном интервале могут быть 
отключены или включены в обработку. 

• Для отключения измерений опишите прямоугольник вокруг графика 
(удерживая нажатой левую кнопку мыши), выбрав тем самым 
нужный временной интервал. Щелкните по правой кнопке мыши и в 
появившемся меню выберите пункт Disable (Отключить). 

• Для включения ранее отключенных данных, Щелкните по правой 
кнопке мыши и в появившемся меню выберите пункт Enable 
(Включить). 

 
Рисунок 11-11. Отключение и включение спутниковых измерений 
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Измерения для первого в паре спутника, входящего в название графика, 
могут быть отключены и включены. Для отключения второго спутника в 
паре измените опорный спутник, и обновите график. 

1. Щелкните по правой кнопке мыши на окне Residuals View 
(Просмотр невязок) и в появившемся меню выберите пункт Set 
GPS Relative (Установить опорный спутник). 

2. Выберите первый спутник, который будет принят в качестве 
опорного для отображения невязок. 

3. Отключите требуемый спутник. 

 
Рисунок 11-12. Изменение опорного спутника 

Для повторной обработки базиса GPS+ щелкните по правой кнопке мыши 
на измерении и выберите пункт меню Reprocess GPS Obs (Повторная 
обработка спутниковых измерений) (см. рис. 11-13) 

 
Рисунок 11-13. Повторная обработка базиса GPS+ 
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Расчет координат центра проекции 
фотокамеры 
Topcon Tools позволяет рассчитать координаты центра проекции 
фотокамеры в момент экспозиции. Для этих расчетов необходимы 
перечисленные ниже данные: 

• Координаты фазового центра антенны, полученные при обработке 
траектории залета с опцией "Enable Continuous Kinematic" 
("Включить непрерывную кинематику") в Topcon Tools. 

• Метка времени экспозиции фотокамеры записанная в файле *.tps. 
• Элементы приведения центра проекции фотокамеры к фазовому 

центру антенны. 
После обработки выбранного сеанса измерений алгоритм обработки 
кинематических измерений Topcon Tools рассчитывает координаты 
фазового центра GPS антенны, установленной на летательном аппарате 
на каждую эпоху измерений. Как правило, момент экспозиции фотокамеры 
не совпадает со временем эпохи измерения (см. рис. 11-14), которая: 

• совпадает со временем эпохи статического сеанса измерений, 
произведенного приемником, находящимся земле на точке с 
известными координатами. 

• совпадает со временем эпохи кинематического сеанса измерений, 
произведенного приемником, находящимся на борту самолета. 

 
Рисунок 11-14. События и GPS эпохи 

В фотограмметрии используются координаты центра проекции 
фотокамеры. Если известны координаты GPS антенны и элементы 
приведения (Offset Dist, Offset Ht, Offset Across) центром фотокамеры к 
фазовому центру антенны, можно определить координаты центра 
проекции фотокамеры (см. рис. 11-15 на стр. 11-12). 
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Рисунок 11-15. GPS антенна и фотокамера, установленные на самолете 

Сначала Topcon Tools интерполирует координаты фазового центра 
антенны на момент экспозиции фотокамеры, а затем редуцирует 
координаты позиции антенны на центр проекции фотокамеры. 
Для синхронизации работы GPS приемника и фотокамеры, электрический 
импульс камеры (TTL уровень) подается на вход детектора внешних 
импульсов приемника. Приемники TPS имеют возможность приема 
сигналов от двух источников событий и записывают их в текущий файл 
(формат *.tps). Первый детектор идентифицируется как сигналы событий 
ХА и производит соответствующие записи событий в файле *.tps. Второй 
детектор производит события с идентификацией ХВ таким же образом. 
Если в файле измерений *.tps Topcon Tools обнаружит записи событий, то 
во вкладке Points (Точки) отобразятся точки, соответствующие времени 
экспозиции (точки событий). 

 
Рисунок 11-16. Вкладка Точки (Points) с точками событий 
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Названия этим точкам присваиваются исходя из названия 
кинематического сеанса, даты и момента экспозиции. 
В колонке Code (Код), отображается название генератора событий, от 
которого пришел импульс (ХА или ХВ). В колонке Note (Примечание), 
отображается порядковый номер события. 
Величины смещений между центром проекции фотокамеры и фазовым 
центром антенны указываются во вкладке Offset (Смещение) в окне 
Properties Occupation (Параметры сеанса) (см. рис. 11-17). 

 
Рисунок 11-17. Свойства сеанса GPS измерений – вкладка Offset 

Величина Offset Dist (Продольное смещение) измеряется вдоль 
строительной оси самолета от фазового центра антенны до центра 
проекции фотокамеры (см. рис. 11-18). 

 
Рисунок 11-18. Смещение Offset Dist 
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Величина Offset Across (Поперечное смещение) измеряется поперек 
строительной оси самолета вдоль плоскости крыльев самолета от 
фазового центра антенны до центра проекции фотокамеры (см. рис. 11-
19). 

 
Рисунок 11-19. Смещение Offset Across 

Величина Offset Ht (Смещение по высоте) измеряется вдоль 
вертикальной оси от фазового центра антенны до центра проекции 
фотокамеры. 
Координаты центра проекции фотокамеры автоматически рассчитываются 
при выполнении процесса обработки траектории. Во вкладке Points 
(Точки), окне Map View (Карта) (см. рис. 11-20) и окне CAD View 
отображаются эти точки. 

 
Рисунок 11-20. Окно Map и вкладка Points с точками событий 
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Для создания отчета по точкам событий выберите их, щелкните по ним 
правой кнопкой мыши и в появившемся окне выберите пункт Report 
(Отчет) (см. рис. 11-21). 

 
Рисунок 11-21. Создание отчета по точкам событий 

 

Модуль уравнивания Advanced 
Если модуль Advanced разрешен к применению, окно Process Properties 
(Свойства обработки) в пункте Adjustment (Уравнивание) дополнится 
следующими полями (см. рис. 11-22): 

 
Рисунок 11-22. Окно Process Properties -> Adjustment 

• Выбор размерности уравнивания: 

− 1D: уравнивание ТОЛЬКО по высоте. 

− 2D: уравнивание ТОЛЬКО в плане. 

− 3D: уравнивание по высоте и в плане. 
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− AUTO: уравнивание по типу 1D, 2D или 3D, исходя из 
наличия исходных пунктов (высотных, плановых, высотных и 
плановых). 

• Выбор типа уравнивания: 

− Режим Automatic Blunder Rejection (Автоматическая 
отбраковка грубых ошибок). Этот режим позволяет удалять 
компоненты сети из уравнивания по критериям Quality 
Control (Контроль качества) и Tau Criterion (Критерий Тау). 
По критерию Quality Control (Контроль качества) 
отбраковка производится при погрешностях больших, чем 
заданные для данного проекта. По Tau Criterion (Критерий 
Тау) при величине Tau большей, чем Taucritical. 
Этот режим используется по умолчанию в уравнивании и без 
модуля Advanced. 

− Режим Interactive Blunder Rejection (Отбраковка грубых 
ошибок вручную). В этом режиме при наличии в сети грубых 
ошибок (базисы не прошли критерии отбраковки) процесс 
уравнивания сети прекращается и отображается список 
грубых ошибок. 

 
Уравнивание можно остановить, продолжить, изменить его 
параметры и повторить после изменения данных. 

− Щелкните на кнопке Cancel (Отмена) для остановки поиска 
грубых ошибок и уравнивания сети. 

− Щелкните на кнопке Finish (Завершение) для продолжения 
уравнивания сети без изменения данных. 
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− Выберите компонент сети и щелкните на кнопке Reject 
(Забраковать) для удаления его из процесса уравнивания и 
повторите анализ выявления грубых ошибок. Грубые 
ошибки, удаленные в предыдущем шаге, также будут 
отображаться. Для восстановления удаленного компонента, 
выделите нужный и щелкните Unreject (Восстановить): 

 
Рисунок 11-23. Отказ от отбраковки измерений 

− Щелкните на кнопке Auto (Автоматически) для 
автоматической отбраковки по величине невязки или 
критерию Тау из уравнивания и повтора выявления грубых 
ошибок. 

• Для назначения весов исходным пунктам введите требуемые 
величины во вкладке Adjustment (Уравнивание) окна Properties 
(Свойства). 

 
Рисунок 11-24. Окно Properties – вкладка Adjustment 

Исходные точки с ненулевыми весами будут участвовать в 
уравнивании с назначенными весами, но их координаты и С.К.О. 
координат не изменятся. 
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Для заметок: 
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Приложение A 
Использование 
модели глобального 
геоида 

Topcon Tools позволяют использовать набор различных моделей геоидов. 
Некоторые модели геоидов поставляются на компакт-диске Topcon Tools 
или могут быть загружены с интернет-сайта TPS. Для выбора 
соответствующей модели геоида для конкретного региона 
проконсультируйтесь у своего регионального представителя Topcon или 
же в сервисной службе Topcon. 
Для установки глобальной модели геоида EGM96 следует добавить два 
двоичных файла в список геоидов. 
При установленной глобальной модели геоида работа Topcon Tools может 
замедлиться, особенно на старых моделях компьютеров. 

 
СОВЕТ 

Используйте Topcon Link для преобразования глобального 
геоида в региональный геоид в формате *.gff. Обратите 
особое внимание на выбор участка для нового геоида – он 
должен соответствовать участку съемки. 

Модель глобального геоида EGM96 размещена в двух двоичных файлах: 
EGM96.glc и CORRCOEF.gla. 
1. Установку глобального геоида производите согласно инструкции, 

приведенной в разделе "Добавление модели геоида" на стр. 2-17. 
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2. В диалоговом окне Open (Открыть) выберите формат Global Geoid 
Files (Файлы глобального геоида) и файл EGM96.glc (см. рис. А-1), 
после чего щелкните на кнопке Open (Открыть). 

 
Рисунок А-1. Выбор формата файла геоида 

3. Выберите файл CORRCOEF.gla, затем щелкните на кнопке Open 
(Открыть) (см. рис. А-2). 

 
Рисунок А-2. Выбор файла поправок 
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4. Для проверки правильности установки модели геоида щелкните по 
правой кнопке мыши на глобальном геоиде в диалоговом окне Geoids 
List (Список геоидов) и в появившемся меню выберите пункт 
Properties (Свойства). 
В диалоговом окне Properties (Свойства) отобразятся данные о 
выбранной модели геоида (см. рис. А-3). 

 
Рисунок А-3. Свойства глобальной модели геоида 
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Для заметок: 
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Приложение B 
Сочетания клавиш 
В приведенной ниже таблице перечислены сочетания клавиш 
(сокращенные клавиатурные команды), используемые в Topcon Tools. 

Таблица В-1. Горячие клавиши Topcon Tools 

Команда Действие Команда Действие 
Ctrl+C Копировать Ctrl+E Включить 
Ctrl+V Вставить Ctrl+D Отключить 
Ctrl+X Вырезать Ctrl+Enter Свойства 
Ctrl+Y Повторно выполнить Ctrl+F Фильтры 
Ctrl+Z Отменить Ctrl+T Окно Таблица 
Ctrl+N Новый файл (проект) Ctrl+M Окно Карта 
Ctrl+O Открыть файл 

(проект) 
Ctrl+U Окно Сеансы 

Ctrl+P Печать Ctrl+L Расчет параметров 
трансформирования 

Ctrl+S Сохранить файл 
(проект) 

Ctrl+1 Отчет об 
уравнивании 

Ctrl+A Выделить все (в 
текущем окне) 

Ctrl+2 Отчет о базисах GPS 

Del Удалить Ctrl+3 Отчет о точках 
Ctrl+Backs
pace 

Уменьшить масштаб Ctrl+4 Отчет о контроле 
качества 

= Восстановить все 
(масштаб во весь 
проект) 

Ctrl+5 Отчет о тахеометрии 

Alt+Backsp
ace 

Отменить Ctrl+Alt+M Настройки окна 
Карта 

Shifl+Del Вырезать Ctrl+Alt+U Настройки окна 
Сеансы 

Ctrl+Insert Копировать Ctrl+Alt+T Настройки окна 
Таблица 

Shift+Insert Вставить Ctrl+Alt+P Настройки обработки
F1 Вызов справки F2 Редактирование 

выбранной ячейки (в 
таблице) 

Ctrl+F2 Настройка проекта F3 Импорт 
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Таблица В-1. Горячие клавиши Topcon Tools (продолжение) 
 

Команда Действие Команда Действие 
Shift+F3 Импорт из 

устройства 
F4 Экспорт 

F4+Ctrl Экспорт в 
устройство 

F7 обработка GPS+  

F8 Уравнивание Shift+F8 Расчет параметров 
трансформирования 

F9 Настройка отчета F12 Настройка 
инструментальной 
панели  

Ctrl+Shift+N Отмена выбора Ctrl+Shift+I Вставка выбранных 
объектов 

Ctrl+Shift+P Выбор точки Ctrl+Shift+T Выбор 
тахеометрической 
станции 

Ctrl+Shift+G Выбор сеанса GPS Ctrl+Shift+M Выбор 
тахеометрического 
измерения 

Ctrl+Shift+O Выбор базиса GPS Home Перевод графического 
вида в дальний левый 
угол 

Left/Right 
arrows 

Сдвиг графического 
вида влево/вправо 

End Перевод графического 
вида в дальний 
правый угол 

Up/Down 
arrows 

Сдвиг графического 
вида вверх/вниз 

+/- Увеличение / 
уменьшение масштаба

Page 
Up/Page 
Down 

Сдвиг графического 
вида вверх/вниз 
постранично 
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Приложение C 
Символы, 
используемые в 
табличном и 
графическом 
представлениях 

 ПРИМЕЧАНИЕ 

Символы маркируются красным, если данные не 
удовлетворяют критериям контроля качества (Quality 
Control test). Название не пройденного теста содержится 
во вкладке Quality Control, доступной выбором пункта 
Properties (Свойства) выпадающего меню. 

Символы точек в табличном 
представлении данных 
В таблице С-1 приведены символы, которые используются в Topcon Tools 
для представления различной информации во вкладке Points (Точки). 
Символы точек маркируются красным цветом, если данные не прошли 
тест на контроль качества (Quality Control test). Для определения того, 
какой именно тест качества не пройден для точки, в выпадающем меню 
выберите пункт Properties (Свойства) и перейдите во вкладку Quality 
Control (Контроль качества). 

Таблица С-1. Символы точек в окне Таблица 

Символ  
(тест качества 
пройден/нет) 

Описание 

 
Точка, введенная вручную (точка добавлена в проект с 
использованием команды Edit > Add > Point  
(Редактирование > Добавить > Точка)). 
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Символ  
(тест качества 
пройден/нет) 

Описание 

 
Неизвестная точка (импортированная точка из файла-
списка координат, не являющаяся исходной). 

 
Точка с фиксированными плановыми координатами и 
высотой. 

 Точка с фиксированными плановыми координатами. 

 Точка с фиксированной высотой. 

 
Вынесенная точка. 

 
Проектная точка. 

 
Точка с координатами, рассчитанными методом 
координатной геометрии. 

 Уравненная точка. 

 Станция тахеометрии. 

 Съемочная тахеометрическая точка. 

 
Задняя точка. 

 Базовая станция RTK. 

 
Съемочная точка RTK (точка, полученная при съемке в 
режиме RTK в статическом  сегменте). 

 
Съемочная точка RTK траектории (точка, полученная при 
съемке в режиме RTK в кинематическом сегменте). 

 Точка, обработанная статическим методом GPS. 

 
Обработанная статическая точка GPS кинематического 
метода с остановками.  

 
Обработанная точка траектории GPS кинематического 
метода с остановками.  

 Точка обмера (рулеткой). 

 GPS точка со смещением. 

 Смещенная относительно линии точка. 

 
Точка нивелирного хода. 

 Точка высотной опорной сети. 

 
Необработанные точки GPS (статические и 
кинематические). 

 
Точка сканирования. 

 Точка события. 

 Точка, измеренная по изображению. 
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В таблице С-2 приведены сообщения, отображаемые во вкладке Quality 
Control (Контроль качества), если символ во вкладке Points (Точки) 
отображен красным цветом. 
 

Таблица С-2. Сообщения вкладки Quality Control (Контроль качества) 

Сообщение Описание сообщения 
‘Control Point is not linked 
with network’ 
(Исходная точка не связана 
с сетью) 

Исходная точка не используется в уравнивании 
(например: исходные точки используются в расчете 
параметров трансформации систем координат и не 
используются уравнивании). 

‘The point is very close to 
point ‘NAME’. They are 
probably identical’ 
 
(Точка расположена 
слишком близко от точки 
"НАЗВАНИЕ ТОЧКИ". 
Вероятно, это одна и та же 
точка). 

Расстояние между этими точками меньше параметра 
Horizontal Precision / Vertical Precision (Плановая 
точность / Высотная точность), расположенного во 
вкладке Job > Job configuration > Quality Control > 
Point Precision  (Проект > Настройки проекта > 
Контроль качества > Точности точек). Эти измерения, 
вероятно, выполнены с одной и той же точки. 

'Failed to match the desired 
precision'  
(Точность не соответствует 
установленной). 

Параметры Horizontal Precision / Vertical Precision 
(Плановая точность / Высотная точность) для этой 
точки хуже, чем установленные в настройках проекта 
Job > Job configuration > Quality Control > Point 
Precision (Проект > Конфигурация проекта > Контроль 
качества > Точности точек). 

'Some GPS occupations 
autonomous positions are too 
far away from point. They are 
probably misnamed' 
(Автономные 
местоопределения 
некоторых сеансов GPS 
слишком далеки от 
координат точки. Вероятно, 
они названы неправильно). 

С этой точкой связаны несколько сеансов спутниковых 
измерений, но автономные местоопределения по этим 
сеансам удалены более чем на 30 метров.  
Следует изменить название точки для части сеансов.  

'Control Tie Test failed' 
(Тест контроля связей не 
пройден). 

Разности между фиксируемыми (Compare Both/Compare 
Horizontal/Compare Vertical) и уравненными 
координатами хуже величин выбранных в настройках 
проекта Job > Job configuration > Quality Control > 
Point Precision  (Проект > Конфигурация проекта > 
Контроль качества > Точности точек). 

 

Символы сеансов GPS 
измерений в табличном 
представлении данных 
В таблице С-3 приведены символы, которые используются в Topcon Tools 
для представления различной информации во вкладке GPS Occupations 
(сеансы GPS). 
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Таблица С-3. Символы, используемые во вкладке GPS Occupations (сеансы GPS) 
Символ  

(тест качества 
пройден/нет) 

Описание 

 Сеанс базовой станции RTK. 

 
Сеанс Topo (статический сегмент сеанса съемки RTK). 

 
Сеанс Auto Topo (кинематический сеанс съемки RTK). 

 Сеанс измерений на базовой станции. 

 
Сеанс статической точки кинематического метода GPS с 

остановками. 

 Сеанс кинематического метода GPS. 
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В таблице С-4 приведены сообщения, появляющиеся во вкладке Quality 
Control (Контроль качества), если символ во вкладке GPS Occupations 
(сеансы GPS) отображен красным цветом. 
 

Таблица С-4. Сообщения вкладки Quality Control сеансов GPS 
Сообщение Описание сообщения 

‘'No ephemeris' (Нет 
эфемеридных данных). 

В данных сеанса измерений присутствует только 
измерительная информация, но нет эфемеридных данных 
(ситуация возможна для формата RINEX). Следует 
дополнительно импортировать в проект навигационный файл. 

'Occupation's autonomous 
position is too far away from 
point. It is probably misnamed 
( Автономные координаты 
по данным сеанса слишком 
удалены от координат 
точки. Вероятно, сеанс 
измерений произведен на 
другой точке). 

Этот сеанс измерений произведен не на указанной точке, 
поскольку автономное местоопределение в нем отличается 
более чем на 30 метров других сеансов измерений, 
произведенных на этой точке. Следует изменить название 
точки, на которой был произведен отличающийся по 
координатам сеанс измерений. 

 

Символы тахеометрических  
измерений в табличном 
представлении данных 
В таблице С-5 приведены символы, которые используются в Topcon Tools 
для представления различной информации во вкладке TS Obs  
(Тахеометрия). 

Таблица С-5. Символы вкладки Тахеометрия в окне Таблица 

Символ  
(тест качества 
пройден/нет) 

Описание 

 Тахеометрическая станция. 

 Пикет. 

 Измерение вперед. 

 Измерение назад. 

 
Измерение назад на ориентирную точку. 

 
Плановая обратная засечка / Высотная обратная засечка / 

Обратная засечка. 
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В таблице С-6 приведены сообщения, появляющиеся во вкладке Quality 
Control (Контроль качества), если символ во вкладке TS Obs 
(Тахеометрия) отображен красным цветом. 
 

Таблица С-6. Сообщения вкладки Quality Control (Контроль качества) для 
тахеометрии 

Сообщение Описание сообщения 
'Outlier by Horizontal Angle' 
(грубая ошибка измерения 
горизонтального угла) 
'Outlier by Vertical Angle' 
(грубая ошибка измерения 
вертикального угла) 
'Outlier by Distance' (грубая 
ошибка измерения 
расстояния) 

В наборе повторных (более двух) тахеометрических 
измерений обнаружено измерение неудовлетворительного 
качества (горизонтальный, вертикальный угол или 
расстояние). Это измерение имеет точность хуже принятой в 
настройках проекта, вкладка Job > Job configuration > Quality 
Control > TS Obs Precision (Проект > Настройка проекта > 
Контроль качества > Точности тахеометрии). Этот тест 
выполняется в процессе сетевого уравнивания, и ошибочное 
измерение использоваться не будет. 

‘'Rejected by Horizontal 
Angle' (Отбракован по 
горизонтальному углу) 
'Rejected by Vertical Angle' 
(Отбракован по 
вертикальному углу) 
'Rejected by 
Distance'(Отбракован по 
расстоянию). 

По результатам сетевого уравнивания обнаружено измерение 
неудовлетворительного качества (горизонтальный, 
вертикальный угол или расстояние). Это измерение имеет 
точность хуже принятой в настройках проекта, вкладка Job > 
Job configuration > Quality Control > TS Obs Precision 
(Проект > Настройка проекта > Контроль качества > 
Точности тахеометрии). После теста ошибочное измерение 
использоваться не будет. 
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Символы базисов GPS в 
табличном представлении 
данных 
В таблице С-7 приведены символы, которые используются в Topcon Tools 
для представления различной информации во вкладке GPS Obs (базисы 
GPS).  

Таблица С-7. Символы базисов GPS в окне Таблица 
Символ  

(тест качества 
пройден/нет) 

Описание 

 
RTK базис от базовой станции до съемочной точки. 

 
RTK базис от базовой станции до точки траектории. 

 
Обработанный статический базис. 

 Обработанный кинематический базис. 

 Необработанный статический базис. 

 Необработанный кинематический базис. 

 
В таблице С-8 приведены сообщения, появляющиеся во вкладке Quality 
Control (Контроль качества), если символ во вкладке GPS Obs (базисы 
GPS) отображен красным цветом. 
 

Таблица С-8. Сообщения вкладки Quality Control для базисов GPS 
Сообщение Описание сообщения 

'Failed to match the desired 
precision'  
(Точность не соответствует 
установленной) 

Параметры Horizontal Precision / Vertical Precision (Плановая 
точность / Высотная точность) для этой точки хуже, чем 
установленные в настройках проекта Job > Job configuration 
> Quality Control > Point Precision (Проект > Конфигурация 
проекта > Контроль качества > Точности точек). 

'Failed to process' 
(Невозможно обработать) 

Базис невозможно обработать из-за отсутствия эфемеридных 
данных, соответствующих измерениям. Загрузите в проект 
навигационные данные. 

'Float solution' (Плавающее 
решение) 

Обработка базиса выполнена, но фазовая неоднозначность не 
разрешена 

'Rejected by Plane' 
(Отбраковано в плане) 
'Rejected by Height' 
(Отбраковано по высоте) 

По результатам сетевого уравнивания обнаружен компонент 
базиса неудовлетворительного качества (плановый или 
высотный). Этот компонент имеет точность хуже принятой в 
настройках проекта, вкладка Job > Job configuration > Quality 
Control > GPS Obs Precision (Проект > Настройка проекта > 
Контроль качества > Точности базисов GPS). После теста 
ошибочный компонент в уравнивании сети не используется. 
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Символы обмеров  в 
табличном представлении 
данных 
В таблице С-9 приведены символы, которые используются в Topcon Tools 
для представления различной информации во вкладке Tape Dimensions 
(Обмеры рулеткой). 

Таблица С-9. Символы вкладки Tape Dimension 
Символ Описание 

 
Начало опорной линии. 

 
Измерение рулеткой. 
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Символы нивелирных 
измерений  в табличном 
представлении данных 
В таблице С-10 приведены символы, которые используются в Topcon 
Tools для представления различной информации во вкладке DL Obs 
(Нивелирование). 

Таблица С-10. Символы вкладки DL Obs 
Символ  

(тест качества 
пройден/нет) 

Описание 

 Нивелирный ход. 

 Измерение назад. 

 Измерение вперед. 

 Измерение на точку вне хода. 

 
В таблице С-11 приведены сообщения, появляющиеся в столбце 
Adjustment Status (Состояние уравнивания), если символ во вкладке DL 
Obs (Нивелирные измерения) отображен красным цветом. 
 
Таблица С-11. Сообщения в колонке Adjustment Status для нивелирных измерений 

Сообщение Описание сообщения 
'Rejected by Height' 
(Отбраковано по высоте). 

По результатам сетевого уравнивания обнаружено 
нивелирное измерение неудовлетворительного качества. Этот 
измерение имеет точность хуже принятой в настройках 
проекта, вкладка Job > Job configuration > Quality Control > 
TS Obs Precision (Проект > Настройка проекта > Контроль 
качества > Точности тахеометрии). После пара точек, 
между которыми было обнаружено ошибочное измерение, 
исключается из уравнивания сети. 
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Символы графического 
представления данных 
Таблица С-12 содержит точечные символы, которые Topcon Tools 
использует для представления различной информации в графическом 
окне (окно Карта). 

Таблица С-12. Символы окна Карта 
Символ точки  
(тест качества 
пройден/нет) 

Описание 

 
Точка, введенная вручную (точка добавлена в проект с 
использованием команды Edit > Add > Point  
(Редактирование > Добавить > Точка). 

 
Неизвестная точка (импортированная точка из файла-
списка координат, не являющаяся исходной). 

 
Точка с фиксированными плановыми координатами и 
высотой. 

 Точка с фиксированной высотой. 

 
Вынесенная точка. 

 
Проектная точка. 

 
Точка с координатами, рассчитанными методом 
координатной геометрии. 

 Уравненная точка. 

 Станция тахеометрии. 

 Съемочная тахеометрическая точка. 

 
Задняя точка. 

 Базовая станция RTK. 

 
Съемочная точка RTK (точка, полученная при съемке в 
режиме RTK в статическом  сегменте). 
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Съемочная точка RTK траектории (точка, полученная при 
съемке в режиме RTK в кинематическом сегменте). 

 Точка, обработанная статическим методом GPS. 

 
Обработанная статическая точка GPS кинематического 
метода с остановками.  

 
Обработанная точка траектории GPS кинематического 
метода с остановками.  

 Точка обмера (рулеткой). 

 GPS точка со смещением. 

 Смещенная относительно линии точка. 

 Точка нивелирного хода. 

 Опорная точка нивелирного хода. 

 
В таблице С-13 приведены символы базисов, которые используются в 
Topcon Tools для представления различной информации в графическом 
окне Карта. 

 
Таблица С-12. Символы линий окна Карта 

Символ базиса  
(тест качества 
пройден/нет) 

Описание 

 
Тахеометрическое измерение (измерение от 
тахеометрической станции до съемочного пикета). 

 
RTK базовая линия от базовой станции до съемочной 
точки. 

 
Обработанная статическая базовая линия. 

 Необработанная статическая базовая линия. 

 Обмер рулеткой. 
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Символ базиса  
(тест качества 
пройден/нет) 

Описание 

 
Кинематическая траектория для RTK и обработанных 
кинематических измерений. 

 
Множественные измерения (для повторных измерений). 
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Приложение D 
Использование 
программы Topcon 
Link 
Программная утилита импорта/экспорта Topcon Link предназначена для 
осуществления связи и передачи данных между полевыми инструментами 
Topcon и IBM-PC совместимым персональным компьютером. Topcon Link 
доступен на компакт-дисках Topcon Tools, TopSURV и на интернет-сайте 
Topcon GPS. 

 
СОВЕТ 

Подробные инструкции по установке Topcon Link содержатся 
в справочном руководстве Topcon Link или к справке Topcon 
Tools. Подробное описание программы Topcon Link 
содержится там же. 

Ниже приводится упрощенное руководство по использованию Topcon Link. 
Это руководство разбито на разделы: 

• Электронные тахеометры. 

• Приемники TPS. 

• Проекты TopSURV PC. 
В каждом разделе описываются типичные процедуры использования 
файлов от этих источников данных в Topcon Link. 
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Использование Topcon Link с 
электронными тахеометрами 
Ниже описан типовой порядок создания, редактирования, экспорта, 
импорта и расчета данных электронных тахеометров с помощью Topcon 
Link. В примере показан пример использования электронного тахеометра 
GPT 3005W и файла в формате GTS-7 Points. 
До начала полевых работ с тахеометром, выполните следующие 
операции: 

• Создайте файл координат исходных точек. 

• Отредактируйте файл в Topcon Link и сохраните его в формате GTS-
7 Points (или файл тахеометра). 

• Экспортируйте этот файл в тахеометр GPT 3005W (или тахеометр). 
После завершения полевых работ тахеометром выполните следующие 
операции: 

• Импортируйте файл полевых измерений в Topcon Link. 

• Отредактируйте файл и рассчитайте координаты точек. 

• Конвертируйте файл измерений в формат XML (или другой формат, 
предназначенный для камеральной обработки). 

Создание файла координат 
исходных точек 
1. Используя текстовый редактор (например, Microsoft Notepad) создайте 

файл точек для экспорта в тахеометр. 
Формат структуры данных в виде "Название точки, Север, Восток, 
Высота" распознается Topcon Link. 

2. Сохраните файл под названием "Control_data1.csv". 

 
Рисунок D-1. Создание файла исходных точек 
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Редактирование файла координат 
исходных точек 
1. Запустите программу Topcon Link и щелкните на кнопке Open 

(Открыть) инструментальной панели. 
2. Выберите название формата (Format name) Name,N,E,Z,Code (*.csv). 
3. Найдите и выделите файл "Control_data1.csv" в файловой системе 

персонального компьютера и щелкните на кнопке Open (Открыть). 
Файл откроется в программе Topcon Link (см. рис. D-2). 

 
Рисунок D-2. Выбор формата и файла 

 

Добавление точки 
1. Для добавления новой точки в открытый файл щелкните на кнопку Add 

point (Добавить точку) на инструментальной панели. 
2. Введите название и координаты точки (Name, Coordinates) и щелкните 

на кнопке ОК (см. рис. D-3). 

 
Рисунок D-3. Добавление точки – ввод названия и координат 
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Сохранение файла в формате GTS-7 Points 
1. Выберите пункт меню File > Save As (Файл > Сохранить как). 
2. Выберите формат "GTS-7 Points" и щелкните на кнопке Save 

(Сохранить) (см. рис. D-4). 

 
Рисунок D-4. Сохранение файла для тахеометра 

 

Экспорт файла координат 
исходных точек 
1. Подключите тахеометр к компьютеру. Подробно порядок подключения 

описывается в справочном руководстве тахеометра. 
2. Откройте Topcon Link и нажмите кнопку Export to device (Экспорт в 

устройство) инструментальной панели. 
3. Передвигаясь по дереву папок в левой панели окна, найдите файл, 

предназначенный для экспорта. 
4. В правой панели выберите пункт "Topcon Total Station" из 

выпадающего списка. Щелкните на пункте Add New Station (Добавить 
тахеометр) правой панели (см. рис. D-5). 

 
Рисунок D-5. Добавление нового тахеометра 
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5. Задайте значения перечисленных ниже параметров (см. рис. D-6): 

• Вкладка General – введите название и выберите модель 
тахеометра, выберите порт компьютера. 

• Вкладка Advanced – выберите параметры подключения 
тахеометра (в этом примере для тахеометра GPT 3000W): Baud 
Rate (Скорость передачи) – 9600, Data Bits (Длина слова) – 8, 
Parity (Четность) – NONE, Stop Bits (Количество стоповых бит) 
– 1, Protocol (Протокол) при использовании приема данных в 
формате файла GTS-7 Points - ONE-WAY. 

6. Щелкните на кнопке ОК для добавления нового тахеометра. 

 
Рисунок D-6. Выбор настроек подключения тахеометра GPT 3005W 

7. Следуя шагам, описанным в диалоговом окне Upload File(s) to Total 
Station, подготовьте тахеометр к импорту файла формата GTS-7 
Points. В таблице D-1 описаны эти шаги для тахеометра GPT 3005W. 

Таблица D-1. Подготовка тахеометра к передаче данных 
 

Процедура Экран тахеометра 
1. Включите тахеометр. 
2. Нажмите кнопку MENU. 
3. Нажмите кнопку F3 для 

вызова Memory Manager. 
 

4. Нажмите дважды кнопку F4 
для перехода на 
следующую страницу. 

5. Нажмите кнопку F1 для 
вызова передачи данных. 

6. Нажмите кнопку F2 для 
выбора другого формата.  
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Таблица D-1. Подготовка тахеометра к передаче данных (продолжение) 
 

Процедура Экран тахеометра 
7. Нажмите на кнопку F2 для 

вызова передачи данных. 
8. Нажмите на кнопку F1 и 

введите название файла для 
загрузки. 

9. Нажмите кнопку F4 для 
завершения 
подготовительных действий. 

 

10. Нажмите кнопку F3 для 
начала передачи данных. 

 
 
Когда начнется процесс передачи данных, в диалоговом окне Upload 
File(s) to Total Station, отобразится сообщение "Performing the Transfer…" 
("Выполнение передачи данных…"). 
11. Дождитесь окончания передачи файла и его сохранения в тахеометре. 
12. После успешного экспорта Topcon Link отобразит сообщение о том, 

что файл был экспортирован. Тахеометр вернется к меню Data 
Transfer (см. рис. D-7). 

 
Рисунок D-7. Экспорт файла в тахеометр завершен успешно 

 

Импорт файлов данных полевых 
измерений 
После завершения полевых работ импортируйте файл с измерениями из 
тахеометра в Topcon Link. Пример файла измерений был сформирован в 
формате GTS-7 Raw в тахеометре GPT 3005W. 
1. Щелкните на кнопку Import from Device (Импорт из устройства) 

инструментальной панели. 
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2. В левой панели окна дважды щелкните по значку My computer (Мой 
компьютер) и дважды по значку Topcon Total Stations (Тахеометры 
Topcon). Дважды щелкните по значку тахеометра, подключенного к 
компьютеру. 
Topcon Link использует параметры связи, установленные при 
выполнении процесса экспорта. 

3. В правой панели найдите и выберите каталог файловой системы 
компьютера, предназначенный для импортированных данных. 

4. Выделите файл для импорта (file.txt) в левой панели и нажмите кнопку 
“>>”. 

 
Рисунок D-8. Выбор тахеометра и файла для импорта 

5. Следуйте инструкциям, появляющимся в окне Download File From Total 
Station. В таблице D-2 описаны эти шаги для тахеометра GPT 3003W. 

Таблица D-2. Подготовка тахеометра к передаче данных 
 

Процедура Экран тахеометра 
1. Включите тахеометр. 
2. Нажмите кнопку MENU. 
3. Нажмите кнопку F3 для 

вызова Memory Manager. 
 

4. Нажмите дважды кнопку F4 
для перехода на 
следующую страницу. 

5. Нажмите кнопку F1 для 
вызова передачи данных. 

6. Нажмите кнопку F2 для 
выбора другого формата. 
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Таблица D-2. Подготовка тахеометра к передаче данных (продолжение) 
 

Процедура Экран тахеометра 
7. Нажмите на кнопку F1 для 

вызова передачи данных. 
8. Выберите тип передаваемых 

данных. Например, нажмите на 
кнопку F1. 

9. Нажмите кнопку F1 и введите 
название передаваемого 
файла. 

10. Нажмите кнопку F4 для 
завершения подготовительных 
действий. 

 

11. Нажмите кнопку Next в 
диалоговом окне Import from 
Device.  

12. Нажмите кнопку F3 для 
передачи данных. 

 
Когда начнется процесс передачи данных, в диалоговом окне Upload 
File(s) to Total Station, отобразится сообщение "Downloading…" 
("Загрузка…"). 

13. Дождитесь окончания передачи файла и его сохранения в компьютере. 
14. После успешного импорта тахеометр вернется к меню Data Transfer. 

 
Рисунок D-9.Меню передачи данных 

 

Открытие, просмотр и 
редактирование файлов данных 
полевых измерений 
Примеры этого раздела используют описанный ниже рабочий проект (см. 
рис. D-10 на стр. D-9). Измерения выполнены с трех станций (ST1, ST2 и 
MARK). Координаты станций ST1 и MARK известны и сохранены в файле-
списке координат, экспортированном в тахеометр. Измерения на станцию 
ST2 получены со станций ST1 и MARK. Координаты станции ST2 получены 
от станции MARK. 
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На каждой станции проводились измерения точек съемки. Вертикальные 
углы при измерениях не превышали 45 градусов. 

 
Рисунок D-10. Использованный рабочий проект 

Для открытия файла данных полевых измерений: 
1. Выберите пункт меню File > Open File (Файл > Открыть файл). 
2. Выберите или введите название файла, импортируемого из 

тахеометра, например, "02_04_05_GTS-7.raw". 
3. Выберите название формата (Format name) и расширенные 

параметры (Advanced options). 
4. Выберите следующие расширенные параметры (см. рис. D-11): 

• Projection (Проекция) – "none" (не использовать). 
• Coordinate order (Порядок перечисления координат) – 

"Northing,Easting,Height" – “Север, восток, высота”. 
• Vertical angle is (Вертикальный угол - ) – "Horizontal level" (Угол 

возвышения). 

 
Рисунок D-11. Открытие файла данных полевых измерений 
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После импорта файлов полевых измерений данные отобразятся в 
следующих вкладках: 

• Во вкладке Points (Точки) перечислен список всех пикетов и станции 
файла (см. рис. D-12): 

− Значок точки (пикет):  
− Значок станции:  

Для формата GTS-7 Raw координаты Ground Northing, Ground 
Easting, Elevation (север, восток и высота в местной СК) 
отображаются только для станций. 

 
Рисунок D-12. Таблица Точки (Points Tab) 

Следующие этапы обработки и уравнивания выполнены от станции 
MARK. Для уравнивания координат и высот станции следует 
выполнить перечисленные ниже шаги (см. рис. D-13): 

1. Щелкните по правой кнопке мыши на точке и в появившемся 
меню выберите пункт Properties (Свойства). 

2. Во вкладке General (Основные параметры) выберите в 
выпадающем списке Control (Исходного пункта)  "Both" 
("План и Высота"), что означает фиксацию пункта по 
координатам и по высоте. 

3. Щелкните на кнопке OK. Значок станции изменится на значок 
"Fixed point" ("Исходный пункт") (см. рис. D-13). 

 
Рисунок D-13. Назначение исходного пункта. Значок исходного пункта 
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• Таблица TS Obs (Тахеометрия) состоит из двух панелей (см. рис. D-
14). 

 
Рисунок D-14. Вкладка TS Obs (Тахеометрия) 

− В левой панели содержится данные о станциях стояния 
тахеометра. 
Для редактирования высоты инструмента на станции MARK (см. 
рис. D-15): 
1. Дважды щелкните (с паузой) по ячейке высоты инструмента. 
2. Введите новое значение высоты. 
3. Нажмите клавишу Enter клавиатуры компьютера. 

 
Рисунок D-15. Редактирование высоты инструмента 

− В правой панели содержится информация о пикетах, 
наблюденных с выделенной в левой панели станции. 
Координаты этих точек (пикетов) неизвестны. 
Для редактирования значения азимута на точку BKB 
[BackSightBearing, измерение назад на ориентирную точку] 
(линия от точки MARK к точке ST2) (см. рис. D-16): 
1. Щелкните на столбце Point to (До точки) и выберите из 

выпадающего списка значение "no name". 
2. Дважды щелкните (с паузой) по ячейке Azimuth (Азимут) и 

отредактируйте значение азимута. 
3.  Нажмите клавишу Enter клавиатуры компьютера. 
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Рисунок D-16. Редактирование азимута 
Для изменения типа точки 5 (От точки MARK к точке 2) с SS 
(SideShot, пикет) на FS (ForeSight, измерение вперед) (см. рис. D-
17): 
1. Дважды щелкните по ячейке колонки Type (Тип) из выпавшего 

списка выберите тип FS. 
2. Нажмите клавишу Enter на клавиатуре компьютера. 

 
Рисунок D-17. Редактирование типа точки 

 ПРИМЕЧАНИЕ 

Во время редактирования данных (координаты точек, 
назначение исходных пунктов, высот антенны/ 
инструмента/ отражателя, типов точек, BKB азимутов 
(исходных дирекционных углов), смещений), нажмите на 
кнопку Calculate Coordinate (Расчет координат) для 
пересчета координат. 

Расчет и уравнивание координат 
точек 
По умолчанию, Topcon Link обрабатывает координаты без их уравнивания. 
Но возможно также проведение уравнивания. 
1. Для выбора сетевого уравнивания выберите пункт меню Process > 

Process Properties (Процесс > Свойства процесса). 
2. Выберите вкладку Compute Coordinates (Расчет координат) и 

выберите тип уравнивания (для этого примера – Least Squares 
(Наименьших квадратов)). Щелкните на кнопку ОК (см. рис. D-18 на 
странице D-13). 
Обратитесь к Справочному руководству Topcon Link (Topcon Link 
Reference Manual) для детального ознакомления с каждым типом 
уравнивания. 
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Рисунок D-18. Свойства процесса – таблица свойств расчета координат 

3. Нажмите кнопку Compute coordinates of points (Расчет координат 
точек) инструментальной панели. В таблице Points (Точки), 
отобразятся уравненные координаты (см. рис. D-19). 

 
Рисунок D-19. Уравненные координаты точек 

4. Щелкните на кнопке Save (Сохранить) инструментальной панели для 
сохранения рассчитанных координат. 

Преобразование файлов полевых 
измерений в формат данных 
цифрового проектирования 
1. Щелкните на кнопке Save as (Сохранить как) инструментальной 

панели. Выберите формат DXF из группы Design и введите название 
файла "MGIS" (см. рис. D-20). 

 
Рисунок D-20. Выбор формата DXF 

2. Щелкните на кнопке Save (Сохранить) для преобразования файла 
полевых измерений в формат DXF. 



Использование программы Topcon Link 

Topcon Tools- Руководство пользователя D-14 

Использование Topcon Link с 
приемниками GPS 
Ниже описан типовой порядок импорта данных в Topcon Link из 
приемников GPS и преобразование файлов данных в другой формат (в 
примере ниже – формат RINEX). 
После выполнения полевых работ приемником GPS выполните 
следующие операции: 

• Подключите приемник GPS к персональному компьютеру. Детальное 
описание подключения содержится в руководстве по эксплуатации 
приемника. 

• Импортируйте данные полевых измерений в Topcon Link. 

• Преобразуйте файл полевых измерений в формат RINEX. 

Импорт файлов приемника GPS 
Процесс импорта представлен также на рис. D-21 стр. D-15. 
1. Подключите приемник к компьютеру. См. подробное описание 

процедуры в руководстве по эксплуатации приемника. 
2. Запустите Topcon Link и щелкните на кнопке Import from device 

(Импорт из устройства) инструментальной панели. 
3. В правой панели выберите каталог файловой системы компьютера 

для сохранения импортированных данных. 
4. В левой панели дважды щелкните на значке My Computer, а затем на 

значке Topcon Receivers. Topcon Link осуществит поиск подключенных 
к компьютеру приемников. 

5. Дважды щелкните по значку нужного приемника для просмотра данных 
полевых измерений. 

6. Выделите нужный файл (файлы) для импорта и щелкните на кнопку 
(>>). 
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Рисунок D-21. Импорт файлов из приемника 

 

Преобразование файлов полевых 
измерений в формат RINEX 
1. Щелкните на кнопке Convert (Преобразование) инструментальной 

панели. Появится диалоговое окно Convert File (Преобразование 
файла) (см. рис. D-22). 

 
Рисунок D-22. Преобразование файла 
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2. В списке File format (Формат файла) области From (Из), выберите 
формат файла полевых измерений приемника GPS (см. рис. D-23). 

 
Рисунок D-23. Выбор формата файла полевых измерений 

3. Щелкните на кнопке "…"(Просмотр). Выберите файл и щелкните на 
кнопке Open (Открыть) (см. рис. D-24). 
Полный путь к файлу отобразится в поле Source (Источник) (см. рис. 
D-24). 

 
Рисунок D-24. Выбор файла для преобразования 

4. В правой панели нажмите кнопку Browse ("…"). 
5. Создайте каталог для сохраняемых файлов, выберите формат RINEX 

и введите название создаваемых файлов (например, "standard"). 
6. Щелкните на кнопке Select (Выбор). Полный путь к создаваемым 

файлам отобразится в поле Destination (Целевой каталог) (см. рис. D-
25). 

 
Рисунок D-25. Целевой каталог конвертируемого файла 

7. Щелчок на кнопке Convert (Преобразование) запускает 
преобразование файла в формат RINEX. 
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Использование Topcon Link с 
файлами TopSURV 
Ниже описан типовой порядок импорта, редактирования, расчета и 
создания итоговых отчетов данных TopSURV в программе Topcon Link. В 
примере показаны процедуры просмотра и редактирования данных после 
импортирования файла измерений из программы TopSURV. 
До импорта данных из TopSURV выполните следующие операции: 

• Установите программу Microsoft® ActiveSync® на компьютер. 

• Подключите полевой контроллер, управляемый программой 
TopSURV, используя Microsoft® ActiveSync®. 

После импорта данных из TopSURV, выполните следующие действия: 

• Импортируйте файл данных TopSURV (*.tsv) в Topcon Link. 

• Просмотрите координаты точек в системе координат WGS-84 и 
местной СК. 

• Отредактируйте высоты антенн и метод измерения. 

• Просмотрите базисы. 

• Задайте исходную точку для расчета параметров трансформации 
систем координат. 

• Пересчитайте координаты точек. 

• Создайте отчет о точках в местной системе координат. 

Импорт проектов TopSURV 
Контроллеры TPS сохраняют данные проектов в формате *.tsv. При 
импорте файлов формата *.tsv используйте только Topcon Link для 
гарантии сохранности полевых данных. Topcon Link преобразует файл 
*.tsv в формат *.tslv, с которым может работать на компьютере. 
1. Подключите контроллер к компьютеру, используя последовательный 

интерфейсный кабель или по беспроводной каналу связи Bluetooth® и 
Microsoft® ActiveSync®. 

2. Запустите Topcon Link и щелкните на кнопке Import from device 
(Импорт из устройства) инструментальной панели. 
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3. В правой панели найдите и выберите каталог файловой системы 
компьютера, предназначенный для импортированных данных. 

4. В левой панели дважды щелкните по значку My Computer, а затем по 
значку Mobile Device. Topcon Link начнет поиск контроллера, 
подключенного к компьютеру. 

5. В левой панели найдите каталог контроллера, в котором находится 
нужный файл или файлы в формате *.tsv. 

6. Выделите нужный файл или файлы для импорта и щелкните на кнопке 
“>>”. 

 
Рисунок D-26. Импорт файла проекта TopSURV 

В процессе выполнения импорта, Topcon Link преобразует файл в 
формате *.tsv  в распознаваемый компьютером формат TopSURV PC Job 
(формат *.tslv). 

Открытие, просмотр и 
редактирование файлов TopSURV 
GPS  
В примере используются данные проекта, выполненного в режиме GPS 
RTK (см. рис. D-27 на стр. D-19). 
Измерения были произведены от базовой станции 'Pion1' в режиме 
полевой съемки RTK с использованием настроек TopSURV 'My mmGPS+ 
RTK and PP' с технологией mmGPS+. Координаты четырех пунктов 
стояния известны в СК проекции. 
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Рисунок D-27. Проект GPS RTK  

Для открытия импортированного файла проекта TopSURV PC: 
1. Выберите пункт меню File > Open File (Файл > Открыть 

файл). 
2. Введите название файла проекта TopSURV (1014С.tslv). 
3. Выберите формат " TopSURV PC Job". 

Файл проекта TopSURV PC отобразится в пяти вкладках (см. рис. D-
28). 

 
Рисунок D-28. Вкладка Points (Точки) 
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Просмотр координат точек 
Во вкладкеPoints (Точки) (см. рис. D-28) содержится список всех точек 
файла. 
В этом примере в TopSURV были определены параметры трансформации 
между системами координат. Для этого использовались координаты 
четырех пунктов, координаты которых в СК проекции были заданы, а в СК 
WGS-84 – определены из обработки измерений. Все точки этого файла 
имеют координаты в двух системах. 
Для просмотра координат точек в СК проекции, двойным щелчком по 
выпадающему списку выбора СК в строке состояния выберите 'Grid' (см. 
рис. D-29). 

 
Рисунок D-29. Строка состояния – типы координат 

Редактирование высоты антенны и ее 
метода измерения 
1. Для редактирования высоты GPS антенны выберите таблицу GPS 

Occupations (Сеансы спутниковых измерений) щелкните по правой 
кнопке мыши на точке 'Pion1' и из появившегося меню выберите пункт 
Properties (Свойства). 

2. Выберите вкладку Antenna (Антенна) и введите новую высоту 
антенны (например, 1.555 м). Измените метод измерения высоты 
антенны из наклонного (slant) на вертикальный (vertical) (см. рис. D-30). 

3. Нажмите кнопку ОК. 

 
Рисунок D-30. Редактирование параметров антенны 

 

 ПРИМЕЧАНИЕ 
После изменения данных (координат точек, высоты 
антенн, типа антенн, метода измерения высоты 
антенны) координаты точек следует пересчитать. 
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Расчет координат 
Для расчета (в т.ч. повторного) координат точек нажмите кнопку Compute 
coordinates of points (Расчет координат точек) инструментальной 
панели. Обновленные координаты отобразятся в таблице Points (Точки). 

 
Рисунок D-31. Расчет координат 

 

Просмотр базисов 
В таблице GPS Obs (базисы GPS) отображается информация о базисах, 
содержащихся в файле TopSURV GPS. 
1. Для отображения компонент базиса и его ошибок щелкните по правой 

кнопке мыши на базисе и в появившемся меню выберите пункт 
Properties (Свойства). 
Плановые и высотные точности и компоненты базиса в системах 
координат XYZ и BLH приводятся во вкладке Observation 
(Местоопределение) диалогового окна Properties (Свойства) (см. 
рис. D-32). 

2. Для окончания просмотра щелкните на кнопке ОК. 

 
Рисунок D-32. Плановые и высотные точности 
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Добавление новой исходной точки в расчет 
параметров трансформации СК 
До расчета параметров трансформации добавьте новую исходную точку с 
известными в СК проекции координатами в файл. Удостоверьтесь, что тип 
координат выбран как 'Grid'. 
1. Для добавления новой точки в файл, нажмите кнопку Add point 

(Добавить точку) инструментальной панели. 
2. Задайте Name (Название) точки (Wmv2aLS) и ее Coordinates 

(Координаты) в СК проекции (см. рис. D-33). Щелкните на кнопке ОК. 
В рассматриваемом примере эта точка соответствует точке 'Wmv2a', 
координаты которой известны в СК WGS-84. 

 
Рисунок D-33. Диалоговое окно Add Point – вкладки General и Coordinates 

3. Для пересчета параметров трансформации между системами 
координат щелкните на кнопке Perform a localization (Расчет 
параметров трансформации) инструментальной панели. В 
диалоговом окне Localization (Трансформация) щелкните на кнопке 
Add point (Добавить точку). 

4. Выберите точку 'Wmv2a' из выпадающего списка в столбце WGS Point 
(см. рис. D-34). 

5. Выберите точку 'Wmv2aLS' из выпадающего списка Local Point  (см. 
рис. D-34). 

6. Выбор статуса точек 'Horizontal' ('План') (см. рис. D-34) приводит к 
тому, что эти точки используются только в расчете плановых 
параметров трансформации,. 
Новые параметры трансформации рассчитываются автоматически. 

 
Рисунок D-34. Точки для расчета трансформирования 
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Сохранение файла 
Для сохранения всех изменений, произведенных в файле, щелкните на 
кнопку Save (Сохранить) инструментальной панели (см. рис. D-35). 

 
Рисунок D-35. Сохранение файла 

Topcon Link создает резервную копию исходного файла с дополнительным 
расширением (*.initial -  например, 1014C.tlsv.initial). Этот резервный файл 
сохраняется в том же каталоге, что и файл *.tlsv (1014C.tlsv). Любые 
последующие изменения будут выполнены в файле *.tlsv. 

Преобразование файла TopSURV в 
файл-список координат 
В этом разделе описывается процесс преобразования файла базы данных 
TopSURV в '1014C.tlsv' в 'Name,N,E,Z,Code' формат файла-списка 
координат. 
1. Щелкните на кнопке Save As (Сохранить как) инструментальной 

панели. Выберите формат 'Name,N,E,Z,Code' и введите название 
создаваемого файла '1014C_points' (см. рис. D-36). 

 
Рисунок D-36. Выбор формата координатного файла 

2. Поставьте флажок Advanced options (Расширенные параметры). 
Введите параметры, необходимые после преобразования (см. рис. D-
37): 
• Выберите 'Localization' для типа проекции. 
• Выберите единицы измерения расстояний. 

 
Рисунок D-37. Выбор расширенных параметров 

3. Щелкните на кнопке Save (Сохранить) для преобразования файла 
формата TopSURV в файл-список координат. 
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Просмотр преобразованных файлов 
1. Щелкните на кнопке Open (Открыть) инструментальной панели. 
2. Выберите формат файла-списка координат, выберите файл 

'1014C_points.csv' и щелкните на кнопке Open (Открыть). 
Содержимое файла отобразится в рабочей области Topcon Link (см. 
рис. D-38). 

 
Рисунок D-38. Содержимое преобразованного файла 
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Приложение E 
Разъемы 
интерфейсных портов 
 

Разъем последовательного 
интерфейса RS-232C  
Этот кабель используется для подключения приемника TPS (порты A и D) 
к компьютеру. На рисунке Е-1 показана схема разъема приемника. 

 
Рисунок Е-1. Интерфейсный разъем приемника RS-232C 

В таблице Е-1 приведено описание этого разъема. 
Таблица Е-1. Описание разъема RS-232 

Номер Название 
сигнала Направление Описание 

1 Power_OUT P Power Output (I<0.2 A) (питание 
внешних устройств) 

2 GND - Signal ground (сигнальный общий) 
3 CTS I Clear to send 
4 RTS O Request to send 
5 RXD I Receive data (Прием данных) 
6 TXD O Transmit data (Передача данных) 
7 - - Not used (Не используется) 



Разъемы 

Topcon Tools- Руководство пользователя E-2 

Тип разъема - SEALED RECEPTACLE, 7-pin W.W. FISHER, INC, p/n DBEU 
102 A056. В таблице Е-2 приведена схема разводки интерфейсного 
кабеля. 

Таблица Е-2. Схема разводки кабеля RS-232 

Приемник TPS DB9 Female 

1 - 
2 5 
3 7 
4 8 
5 3 
6 2 
7 1 

 

Настройки COM порта 
приемника 
В таблице Е-3 перечислены настройки RS-232C интерфейса, принятые по 
умолчанию. 

Таблица Е-3. Настройки COM порта приемника, принятые по умолчанию 

Опция подключения Настройки по умолчанию 

Port input mode 
(Поддерживаемый 
протокол ) 

В этом режиме приемник распознает команды, 
посылаемые пользователем по протоколам  
CMD языка GRIL или Command программы 
PC-CDU. 

Hardware handshaking 
(аппаратное 
квитирование) 

Не используется 

Скорость обмена 115200 Бод 
Количество стоповых 
бит 

1 

Четность N (не проверяется) 

Длина слова [бит] 8 

 




